EMS User’s Manual

EMS Enterprise 7.0
EMS Professional 13.0
EMS Campus 4.0
EMS Legal 7.0
EMS Workplace 7.0
EMS District 7.0
Table of Contents

Chapter 1: Getting Started with EMS ................................................................. 27
Starting EMS ............................................................................................................ 29
To start EMS ............................................................................................................. 29
The EMS Window ....................................................................................................... 31
Title bar ....................................................................................................................... 31
Menu bar .................................................................................................................... 32
Toolbar ......................................................................................................................... 32
To customize the toolbar .......................................................................................... 32
Main menu .................................................................................................................. 33
An EMS Browser Window .......................................................................................... 35
To group data by columns in an EMS Browser window ............................................. 36
To rearrange the columns in an EMS Browser window ............................................ 36
To change the width of the columns in an EMS Browser window ........................... 37
To use the context menu for data columns in an EMS Browser window .................. 37
To filter the data in an EMS Browser window ......................................................... 38
To change the sort order of data in an EMS Browser window .................................. 40

Chapter 2: Reservations and Bookings ............................................................... 41
Reservation Structure ................................................................................................. 43
Reservation and bookings ......................................................................................... 43
Booking details .......................................................................................................... 43
Event Timeline .......................................................................................................... 44
Making a Reservation Using the Reservation Wizard ............................................... 45
To specify the event date ............................................................................................ 46
To specify the event time and status ......................................................................... 49
To select the event location ....................................................................................... 50
To search for a standard room .................................................................................. 50
To search for a best fit room ..................................................................................... 53
To search for a specific room................................................................. 55
To specify the event information .......................................................... 57

Viewing and Editing Reservations in the Reservation Book.................. 62
Reservation Book ............................................................................... 62

To change the Reservation Book display ............................................ 64
List of Rooms (Room Properties) ......................................................... 65
List of Rooms (Specific Rooms) ......................................................... 66
Reservation Book view ..................................................................... 66
Display Options ............................................................................... 67

Tooltips .......................................................................................... 69
Display Date (Calendar) .................................................................. 69
Display Date (Scroll Features) .......................................................... 70

To view reservation information ....................................................... 70
Room Bookings .............................................................................. 71
Room Properties ............................................................................. 71
Room Pricing .................................................................................. 72
Room Images .................................................................................. 72
Room UDFs .................................................................................... 73
Room Information .......................................................................... 73
Time Zone ..................................................................................... 73

To make a new reservation ............................................................... 74
To edit an existing reservation ......................................................... 74

Chapter 3: The Navigator .................................................................. 77
Navigator Overview .......................................................................... 79
Opening a reservation in the Navigator ............................................ 79
Opening a reservation directly in the Navigator ................................. 79
Opening a reservation through the Reservation Book .................... 80
To edit the booking status........................................................................................ 116
To edit the rooms for bookings ............................................................................... 118
  To search for rooms ......................................................................................... 119
  To select a specific room .................................................................................... 123
  To edit miscellaneous booking information....................................................... 125
Moving Bookings to a Different Reservation .......................................................... 127
  To move bookings to a different reservation ...................................................... 127
Copying Multiple Bookings in the Navigator ......................................................... 129
  To copy multiple bookings in the Navigator ...................................................... 129
Booking Details and Items Overview..................................................................... 133
  Service order ...................................................................................................... 136
Adding Booking Details and Items to Individual Bookings ................................... 138
  To add booking details and items to individual bookings ................................... 138
    To add a booking detail from a non-resource category ................................... 139
      To add setup notes ....................................................................................... 139
      To add attendees ......................................................................................... 140
      To add an agenda (activities) ....................................................................... 141
      To add a room charge .................................................................................. 142
    To add a booking detail from a resource, service order, or catering category .... 144
Adding Booking Details and Items to Multiple Bookings ....................................... 148
  To add booking details and items to multiple bookings ..................................... 148
    To add a booking detail from a non-resource category .................................. 149
      To add a booking detail from a resource, service order, or catering category ... 151
Adding Booking Detail Items to Multiple Bookings .............................................. 155
  To add booking detail items to multiple bookings .......................................... 155
Editing Booking Detail Items for Individual Bookings ........................................... 157
  To edit booking detail items for individual bookings ....................................... 157
    To edit a booking detail item from a non-resource category ......................... 158
To edit a booking detail item from a resource, service order, or catering category ................................................................. 158

Editing Booking Detail Item Charges for Multiple Items ................................................................. 161

To edit booking detail item charges for multiple items ................................................................. 161

Editing Count Information for a Booking ..................................................................................... 163

To edit count information for a booking ..................................................................................... 163

Applying a Reservation Discount .................................................................................................. 165

To apply a reservation discount .................................................................................................. 165

Copying Booking Details Between Bookings .............................................................................. 167

To copy booking details between bookings .............................................................................. 167

Deleting Booking Detail Items from Multiple Bookings ............................................................. 170

To delete booking detail items from multiple bookings ............................................................. 170

Deleting Booking Details from Multiple Bookings ..................................................................... 173

To delete booking details from multiple bookings ..................................................................... 173

Working with Comments and Reminders in the Navigator ....................................................... 175

To work with a comment or reminder in the Navigator .............................................................. 175

To add a comment ...................................................................................................................... 176

To edit a comment ..................................................................................................................... 177

To delete a comment .................................................................................................................. 177

To view the history for a comment ............................................................................................ 177

Adding Multiple Comments and Reminders to a Reservation .................................................. 179

To add multiple comments and reminders to a reservation ..................................................... 179

Working with User Defined Fields in the Navigator ................................................................. 181

To work with user-defined fields in the Navigator ..................................................................... 181

To add a user-defined field ........................................................................................................ 182

To edit a user-defined field ........................................................................................................ 182

To delete a user-defined field ..................................................................................................... 182

To the view history for a user-defined field .............................................................................. 183
Working with Attachments in the Navigator ................................................................. 184
To work with attachments in the Navigator .............................................................. 184
To add an attachment to a reservation or booking .................................................. 185
To edit an attachment for a reservation or booking ................................................ 186
To delete an attachment from a reservation or booking ........................................ 186
To view an attachment for a reservation or booking .............................................. 187
Working with Drawings in the Navigator ................................................................. 188
To work with drawings in the Navigator ................................................................. 188
To attach a stored drawing to a booking ............................................................... 189
To create a drawing “on the fly” and attach it to a booking .................................... 190
To detach a drawing from a booking ................................................................. 190
To edit a drawing for a booking ....................................................................... 190
To view a drawing for a booking ................................................................. 191
Running the Resource Utility Conflicts Tool .......................................................... 192
To run the Resource Utility Conflicts tool ........................................................... 192

Chapter 4: Search Tools .................................................................................... 195
Searching with the Browser or with the Web Reservation Tool ......................... 197
To carry out a search in the Browser ................................................................. 197
To carry out a basic search in the Browser ...................................................... 198
To carry out an advanced search in the Browser ........................................... 201
To set up favorite fields for a Browser search .................................................. 205
Searching with the Calendar .............................................................................. 206
To carry out a search in the Calendar ................................................................. 206
To carry out a basic search in the Calendar ...................................................... 207
To carry out an advanced search in the Calendar .......................................... 211
To set up favorite fields for a Calendar search ............................................... 214
Searching with the Resource Calendar .............................................................. 215
To carry out a search in the Resource Calendar .......................................................... 215
To carry out a basic search in the Resource Calendar .............................................. 216
To carry out an advanced search in the Resource Calendar .................................. 218
To set up favorite fields for a Resource Calendar search ........................................ 221
Searching with the Service Order Management Browser ...................................... 222
To search with the Service Order Management browser ...................................... 222

Chapter 5: EMS Dashboard ................................................................................. 227
Overview of the EMS Dashboard and Dashboard Options ...................................... 229
Dashboard options ................................................................................................. 230
Notifications Tab .................................................................................................... 232
Reminders Tab ......................................................................................................... 234
To change the Reminders tab view ........................................................................ 235
To create an unattached reminder ........................................................................ 236
To edit a reminder ................................................................................................... 237
To delete a reminder ............................................................................................... 237
To print a reminder .................................................................................................. 238
To go to the item to which a reminder is attached .................................................. 238
To complete a reminder .......................................................................................... 238
To reassign multiple reminders between EMS users .......................................... 239
Web Reservations Tab ........................................................................................... 240
Web Requests Tab .................................................................................................. 241
To edit a web request ............................................................................................ 242
To delete a web request ......................................................................................... 244
To print a web request ........................................................................................... 244
Wait List Tab ........................................................................................................... 245
Reconfirm Dates Tab ............................................................................................... 246
Building Hours Exceptions Tab ............................................................................. 247
Chapter 6: Groups and Contacts .................................................................253
Searching for and Configuring Groups......................................................255
To search for a group and/or contact .....................................................255
To configure groups ..............................................................................257
Configuring Additional Information for a Group ....................................263
To create a web user from a group ..........................................................263
To assign the group to a web user ..........................................................266
To add a reminder to a group .................................................................268
To add a comment to a group ...............................................................269
To add attachments to a group ...............................................................271
To add user defined fields to a group ....................................................272
To assign calculations to a group .........................................................273
To configure a list of billing reference numbers .................................275
To configure a list of PO numbers .......................................................276
Configuring Contacts for a Group .........................................................278
To configure contacts ..........................................................................278
To configure a contact manually ..........................................................279
To configure a contact from a group .....................................................281
To create a web user from a contact .....................................................283
Editing Group Information ....................................................................286
To edit group information .................................................................286
To edit summary, billing, and/or other group information ....................287
To edit the contacts for a group ...........................................................287
To edit the reminders for a group .......................................................288
To edit the comments for a group .......................................................288
To edit the attachments for a group................................................................. 289
To the edit user defined fields (UDFs) for a group ............................................ 290
To edit the calculations for a group ................................................................. 290
To edit the billing reference numbers for a group.......................................... 291
To edit the PO numbers for a group ............................................................... 291
To edit the web users for a group ................................................................. 292
Importing Groups ......................................................................................... 294
   To import groups...................................................................................... 294
Working with Reservations for a Group ......................................................... 295
   To work with reservations for a group....................................................... 295
      To search for and view reservations by group from the group-specific window .............................................................................. 295
      To search for and make a reservation for a group from the group-specific window ................................................................. 296
      To reassign a reservation for a group from the group-specific window ... 296
   To make a group reservation from the Group Reservation window
      (EMS Workplace only).......................................................................... 298
Emailing a Group ......................................................................................... 300
   To email a group.................................................................................... 300
Printing and Exporting Group Information.................................................... 301
   To print group information................................................................. 301
   To export a list of groups to an Excel spreadsheet................................. 302
Printing and Exporting Web User Information................................................. 303
   To print or export web user information.............................................. 303
      To print web user information ......................................................... 304
      To export a list of web users to an Excel spreadsheet...................... 305

Chapter 7: Confirmations.................................................................................. 307
Specifying your Confirmation Settings........................................................... 308
To specify your confirmation settings ................................................................. 308
Generating a Single Confirmation at a Time .......................................................... 311
  To manually generate a single confirmation at a time .......................................... 311
  To automatically generate a confirmation ............................................................. 314
Generating Word Merge Documents for Custom Documentation .......................... 316
  To generate Word Merge Documents ................................................................ 316

Chapter 8: Reports and Queries ............................................................................ 319
Generating an EMS Report ..................................................................................... 321
  To generate a report ............................................................................................. 321
Working with Memorized Reports ........................................................................ 323
  To create a memorized report “from scratch” ....................................................... 323
  To create a memorized report by copying ............................................................ 325
  To edit or delete a memorized report .................................................................. 326
Report Descriptions and Options ......................................................................... 328
  Daily reports ......................................................................................................... 329
  Sales reports ......................................................................................................... 334
  Statistics reports .................................................................................................. 337
  Other reports ........................................................................................................ 340
  Exceptions reports ............................................................................................... 342
  Hoteling reports (EMS Workplace only) ............................................................... 345
Working with a Query ............................................................................................ 348
  To create a query .................................................................................................. 348
    Query Builder Filter tab .................................................................................... 350
    Display Fields tab ............................................................................................. 351
    Filter tab ............................................................................................................ 353
    Sort tab .............................................................................................................. 354
    Chart tab ............................................................................................................ 355
Users tab ........................................................................................................................................ 356
To edit a query .............................................................................................................................. 357
To delete a query .......................................................................................................................... 357
To view and print a query .............................................................................................................. 358
To run a query ....................................................................................................................................... 359

Chapter 9: Billing ......................................................................................................................... 361
Overview of Billing in EMS ........................................................................................................... 363
Working with Invoices ..................................................................................................................... 364
To generate an invoice ................................................................................................................... 364
To reprint an invoice ....................................................................................................................... 368
To specify invoices for reprinting ................................................................................................. 368
To search for invoices to reprint .................................................................................................... 370
To void an invoice ......................................................................................................................... 372
To specify invoices to void ............................................................................................................. 372
To search for invoices to void ......................................................................................................... 375
Searching for Transactions ............................................................................................................. 378
To search for a transaction ............................................................................................................. 379
To carry out a basic transaction search ......................................................................................... 379
To carry out an advanced transaction search ............................................................................... 381
To set up favorite fields for a Transaction search ......................................................................... 384
Working with Transactions ........................................................................................................... 385
To enter a deposit or damage deposit for a reservation ................................................................. 385
To enter a payment or pre-payment .............................................................................................. 387
To enter an adjustment for an invoice .......................................................................................... 389
To enter a refund ............................................................................................................................. 390
To void a transaction ..................................................................................................................... 391
To void a transaction from the Transactions tab ......................................................................... 391
To void a transaction from the Payment Entries window ........................................ 392
Generating an EMS Billing Report ........................................................................ 394
   To generate a report ......................................................................................... 394
Report Descriptions and Options ......................................................................... 396
   Invoice reports .................................................................................................. 397
   Reports .............................................................................................................. 397

Chapter 10: User Settings .......................................................................................... 401
Setting User Preferences and Default Values ........................................................ 403
   To set user preferences and default values ...................................................... 403
Changing your Password ........................................................................................ 406
   To change your password ................................................................................. 406
Resetting Window Coordinates ............................................................................ 407
   To reset window coordinates ......................................................................... 407
Resetting Column Settings .................................................................................... 408
   To reset column settings .............................................................................. 408
Defining Your Views .............................................................................................. 409
   To define your views ....................................................................................... 409

Chapter 11: Other Reservation Functions .............................................................. 411
Recording Actual Attendance Numbers for Bookings ............................................. 413
   To record actual attendance numbers for bookings ...................................... 413
Sending Email from EMS ...................................................................................... 414
   To send an email from within an EMS Browser window ................................ 414
   To send a confirmation or invoice ................................................................. 415
   To send a generic email .................................................................................. 417
Viewing a History of Sent Emails ......................................................................... 418
   To view a history of sent emails ...................................................................... 418
Generating Multiple Confirmations ...................................................................... 420
To generate multiple confirmations............................................................................ 420

Managing Attendees and Visitors ........................................................................... 424
To manage registered attendees and visitors............................................................ 424
To check in/check out unregistered visitors for an event........................................... 427
To print visitor badges ............................................................................................ 430
To import a list of attendees and visitors to an event .............................................. 430

Chapter 12: EMS Workplace ....................................................................................... 435
Managing Groups’ Check In/Check Out Statuses ...................................................... 437
To manage groups’ check in/check out statuses..................................................... 437
To run the No Show Wizard.................................................................................... 441

Chapter 13: Academic Planning (EMS Campus)....................................................... 443
Overview of the Academic Scheduling Process ....................................................... 445
Academic scheduling specific terms used in EMS Campus ..................................... 445
Academic scheduling configuration process........................................................... 447
  Academic Planning phase...................................................................................... 447
  Post-Publishing phase......................................................................................... 447
Overview of Importing an Academic Term ............................................................. 451
Synchronizing an Academic Term ........................................................................... 452
To synchronize an academic term........................................................................ 452
Synchronizing Courses............................................................................................ 453
To synchronize courses......................................................................................... 453
Overview of Defining and Editing Courses............................................................. 457
Enabling/Disabling a Term for Define & Edit Mode.................................................. 458
To enable/disable a term for Define & Edit mode.................................................... 458
Reviewing and Editing Courses.............................................................................. 461
To review and edit courses.................................................................................... 461
To add a new course in EMS Campus..................................................................... 462
To add a new section for a course ................................................................. 464
To add a course date in EMS Campus .......................................................... 465
To edit a course in EMS Campus ................................................................. 467
To edit a course date in EMS Campus ......................................................... 469
To cancel a course date in EMS Campus ...................................................... 471
To cancel a course in EMS Campus ............................................................. 473
Working with Shared Space .................................................................... 475
To assign shared space to courses ............................................................... 475
To change the parent designation for shared space/cross-listed spaces .......... 477
To reverse the shared space designation ...................................................... 479
To review shared space designations ........................................................... 480
Identifying New/Edited/Canceled Courses ............................................... 482
To identify new/edit/canceled courses ......................................................... 482
Overview of Specifying Room Preferences .............................................. 487
Enabling/Disabling a Term for Set Preferences Mode ................................. 488
To enable/disable a term for Set Preferences mode .................................... 488
Specifying Room Preferences/Requirements ........................................... 491
To use the Manage Terms Copy Preferences tool ..................................... 493
To use the Academic Browser Set Course Preferences tool ....................... 495
To use the Course Navigator to set preferences and requirements ............. 498
Reviewing and Verifying Room Preferences ............................................ 501
To review and verify room preferences ...................................................... 501
Overview of Room Assignments and Optimization ................................. 505
About Creating Scenarios and Optimization ............................................. 506
Scenario dialog box .................................................................................. 507
Optimization logic ..................................................................................... 509
Creating Scenarios .................................................................................. 513
To create a pre-assignment scenario ........................................................ 513
To create an optimization scenario ................................................................. 516
To resolve room assignments ......................................................................... 520
Assigning Rooms .......................................................................................... 522
To assign rooms to courses ........................................................................... 522
To search for rooms to assign to a course ....................................................... 524
Evaluating Optimization Scenarios ................................................................. 527
Overview of Publishing an Academic Term ....................................................... 531
Publishing a Term .......................................................................................... 533
To publish a term ............................................................................................ 533
Manually Updating Course Locations in the SIS .............................................. 537
To manually update course locations in the SIS .............................................. 537
Unpublishing a Previously Published Term ...................................................... 539
To unpublish a term ......................................................................................... 539
Reviewing Reservations and Resolving Room Assignments ......................... 543
To change the course rooms (locations) for one or more bookings ................ 544
To swap rooms between courses .................................................................... 545
Post-Publish Processing of Courses ................................................................ 546
To manually process courses post-publish .................................................... 546
To process a canceled course post-publish ..................................................... 548
To process a changed course post-publish ..................................................... 548
To process a new course date post-publish .................................................... 550
To process a new course post-publish ............................................................ 553
To process a Room Capacity Violation post-publish ....................................... 555
To automatically process courses post-publish .............................................. 556
To process courses post-publish for enrollment ............................................ 559
Setting a Final Exam Schedule ...................................................................... 562
To create a final exam schedule template ...................................................... 562
To manually create a final exam schedule template ........................................ 564
To import a term to create a final exam schedule template ........................................ 565
To import a file to create a final exam schedule template ........................................ 566
To specify final exam settings for a specific course .................................................. 567
To specify final exam settings for multiple courses .................................................. 569
Publishing a Final Exam Session .......................................................................... 572
To create a final exam session .............................................................................. 572
To publish the final exam session ......................................................................... 574
Searching with the Academic Browser ................................................................... 579
To carry out a search in the Academic Browser ...................................................... 579
To carry out a basic search in the Academic Browser ............................................. 580
To carry out an advanced search in the Academic Browser .................................... 582
To set up favorite fields for an Academic Browser search ...................................... 585
Using the Academic Book ...................................................................................... 586
To change the date display .................................................................................... 587
To change the view of courses by room .................................................................. 588
To change the view of courses by instructor ......................................................... 589
To set options for the Academic Book .................................................................... 590
To open a course in the Course Navigator .............................................................. 592
To display the details for a room ........................................................................... 593
Using the Course Navigator .................................................................................... 594
To access the Course Navigator ........................................................................... 594
Course Navigator window layout .......................................................................... 595
Available Actions in the Course Navigator ............................................................. 597
Using the Search for Rooms Tool .......................................................................... 598
To search for rooms using the Search for Rooms tool ........................................... 598
Generating Academic Reports ............................................................................... 601
To generate an academic report ............................................................................. 601
Course List .......................................................................................................... 603
Course Changes ................................................................................................................................. 604
Course Preferences .......................................................................................................................... 605
Preferences Summary ...................................................................................................................... 605
Unmet Preferences ........................................................................................................................... 605
Instructor Back to Back ..................................................................................................................... 606
Instructor Summary .......................................................................................................................... 606
Time Block Violations ....................................................................................................................... 607
Time Block Room Availability/Usage ................................................................................................. 607
Academic Class Meeting Utilization ............................................................................................... 608
Classroom Utilization ....................................................................................................................... 608
Hourly Classroom Utilization .......................................................................................................... 608
Over/Under Utilization .................................................................................................................... 609
Prime Time Usage ............................................................................................................................ 609
Academic Unit Statistics .................................................................................................................. 610
Course Type Analysis ....................................................................................................................... 610
Final Exam Settings .......................................................................................................................... 611
Final Exam Schedule ....................................................................................................................... 611
Trend Report ....................................................................................................................................... 612

Index ..................................................................................................................................................... 613
Preface

Welcome to the *EMS User’s Manual*. The purpose of the *EMS User’s Manual* is to answer your questions and guide you through the procedures necessary to use the EMS application efficiently and effectively.

Using the manual

You will find the *EMS User’s Manual* easy to use. You can simply look up the topic that you need in the table of contents or the index. Later, in this Preface, you will find a brief discussion of each chapter to further assist you in locating the information that you need.

Special information about the manual

The *EMS User’s Manual* has a dual purpose design. It can be distributed electronically and then printed on an as-needed basis, or it can be viewed online in its fully interactive capacity. If you print the document, for best results, it is recommended that you print it on a duplex printer; however, single-sided printing will also work. If you view the document online, a standard set of bookmarks appears in a frame on the left side of the document window for navigation through the document. For better viewing, decrease the size of the bookmark frame and use the magnification box to increase the magnification of the document to your viewing preference.

*If you do print the document using a single-sided printer, you might see a single blank page at the end of some chapters. This blank page has been added solely to ensure that the next chapter begins on an odd-numbered page. This blank page in no way indicates that your book is missing information.*

Conventions used in the manual

The *EMS User’s Manual* uses the following conventions:

- The tab, field, and menu labels that are described in this User’s manual are those used in the standard implementation of EMS. Your EMS administrator might have customized some of these labels to better suit your organization’s business needs. Therefore, the labels that are referenced in this User’s manual might be different than what you observe for your implementation.

- The colors that are shown in this User’s manual for the windows and their components (for example, a reservation in the Reservation Book or the colors for the booking statuses) are those used in the standard implementation of EMS. Your EMS administrator might have customized some of these colors to better suit your organization’s business needs.
Therefore, the colors that are shown in this User’s manual might be different than what you observe for your implementation.

• The fields (required and optional), categories, and dropdown list values that are described in this User’s manual are those used in the standard implementation of EMS. Your EMS administrator might have customized some of these values to better suit your organization’s business needs. Therefore, the fields, categories, and values that are referenced in this User’s manual might be different than what you observe for your implementation.

• The EMS application provides multiple ways of accessing the same EMS functions and although this manual does not address all these ways, you can use whatever method best suits your working needs.

• Information that can vary in a command—variable information—is indicated by alphanumeric characters enclosed in angle brackets; for example, <Room Type>. Do not type the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the cover and ending on the last page of the index.

Although numbering begins on the cover page, this number is not visible on the cover page or front matter pages. Page numbers are visible beginning with the first page of the table of contents.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries are also hyperlinks. Click the hyperlink to advance to the referenced information.
Assumptions for the manual

The *EMS User’s Manual* assumes that:

- You are familiar with windows-based applications and basic Windows functions and navigational elements.

Organization of the manual

In addition to this Preface, the *EMS User’s Manual* contains the following chapters and appendices:

- **Chapter 1, “Getting Started with EMS,” on page 27** details the procedures for opening and logging on to the EMS application as well as an overview of the major functional areas in the application, including the title bar, the main window, the toolbar, and the main menu.

- **Chapter 2, “Reservations and Bookings,” on page 41** details the two essential EMS components for meeting and event scheduling—reservations and bookings. It explains the structure of a reservation in EMS, it explains the concept of an event timeline for a reservation booking, and it describes the three ways to make a reservation in EMS.

- **Chapter 3, “The Navigator,” on page 77** details the Navigator, which is a window in EMS that you use to view and manage all aspects of a reservation including bookings and booking details. It also provides detailed procedures for using the Navigator to add one or more bookings to a reservation, edit and copy reservations, edit and copy one or more bookings, cancel one or more bookings, add comments to reservations and bookings, and to manage booking details and items.

- **Chapter 4, “Search Tools,” on page 195** details the variety of options that are available to you for searching for reservations and bookings in your EMS database, including the Browser, the Calendar, the Navigator, Groups, and Web Requests.

- **Chapter 5, “EMS Dashboard,” on page 227** details the EMS Dashboard, which is a window that centralizes critical information about reservations and web requests in a single location. The information that is displayed on this window provides you with the necessary input to manage your work in the EMS application.

- **Chapter 6, “Groups and Contacts,” on page 253** details the procedures for adding and editing groups and contacts in your EMS database. It also details the procedures for sending an email to a group or a contact, deleting a group or a contact, and printing and exporting group and contact information.

- **Chapter 7, “Confirmations,” on page 307** details a confirmation, which is a document that details the critical information for a reservation—the date, the time, the location, the scheduled resources, and so on. The chapter describes how to specify the settings for confirmations and how to generate a confirmation both manually and automatically. It also describes the procedures for printing a confirmation and for emailing a confirmation.
• Chapter 8, “Reports and Queries,” on page 319 details the reports that are available in EMS, including daily reports, statistical reports, and exception reports.

• Chapter 9, “Billing,” on page 361 details the functions that are available in EMS for working with invoices and transactions for reservations and bookings and for reporting on this information.

• Chapter 10, “User Settings,” on page 401 details the preferences that are available to you for customizing some of the basic functions of your EMS user account.

• Chapter 11, “Other Reservation Functions,” on page 411 details several miscellaneous standalone functions that are available in EMS to assist you in managing and maintaining reservations and bookings in your system as well as managing your general work requirements.

• Chapter 12, “EMS Workplace,” on page 435 details the EMS Workplace module, which is a facility scheduling system for managing hoteling requirements, as well as the booking of meeting/event space and resources.

• Chapter 13, “Academic Planning (EMS Campus),” on page 443 details the EMS Campus module, which is a complete campus-wide space management package.
Chapter 1
Getting Started with EMS

EMS is user-friendly room scheduling software that is designed to manage the meetings and events that take place in your facility. Standard features, which you use to create, manage, and report on events, include the following:

• The Reservation Wizard room booking tool
• A graphical reservation book
• The Browser and month-at-a-glance Calendar Inquiry
• Numerous daily, sales, and statistical reports

This chapter covers the following topics:

• “Starting EMS” on page 29.
• “The EMS Window” on page 31.
• “An EMS Browser Window” on page 35.
Chapter 1
Getting Started with EMS
Starting EMS

After EMS has been installed on your desktop, a shortcut icon for the application is placed on your desktop. An option for the application is also available from your Start menu. You can double-click the desktop icon to launch the EMS application, or you can select the option from your Start menu.

To start EMS

The following procedure is written from the perspective of EMS Enterprise; however, it is applicable for any EMS product (EMS Professional, EMS Campus, and so on).

1. Do one of the following:

   • On your desktop, double-click the EMS icon.

   • Open the Windows start menu, in the Search field, enter EMS and then select the EMS Enterprise option.

2. In the User ID field, enter your User ID.

3. In the Password field, enter your password.

   If you do not know your User ID or password, contact your EMS administrator.
4. Click OK.

The EMS Enterprise application opens. The main menu is open in the application.

*Figure 1-2: EMS Enterprise main window with main menu*
The EMS Window

The EMS main window is your starting point for the EMS application. The window provides quick access to all the EMS functions (Reservations, Reports, Configuration, and so on) and system tools. The EMS Main window has four major components:

- The title bar. See “Title bar.”
- The menu bar. See “Menu bar” on page 32.
- The toolbar. See “Toolbar” on page 32.
- The main menu. See “Main menu” on page 33.

Figure 1-3: EMS main window with main menu

The following section is written from the perspective of EMS Enterprise; however, it is applicable for any EMS product (EMS Professional, EMS Campus, and so on).

Title bar

The name “EMS Enterprise” and the version number of the application appear in the title bar across the top of the EMS Enterprise main window.

Figure 1-4: Title bar

EMS Enterprise 7.0
Menu bar

The menu bar is set up in a standard Windows menu format with menu commands grouped into menus (File, Settings, Reservations, and so on) across the menu bar. Some of these menu commands are also available in the main menu.

*Figure 1-5: Menu bar*

Toolbar

The toolbar provides quick access to the most commonly used EMS functions. The toolbar buttons that are always displayed by default are the buttons for Book, Calendar, Wizard, Navigator, Browser, Web Reservations, Clients, Email, Dashboard, and Manage Services. Other buttons for other functions are also displayed by default depending on the version of EMS that you are running, for example, EMS Campus or EMS Workplace. Some of the functions that are available on the toolbar are also available from the main menu. You can customize the appearance of this toolbar to best suit your business needs.

*Figure 1-6: Toolbar*

**To customize the toolbar**

1. Right-click the toolbar and click Customize.

   The Customize Toolbar dialog box opens.

*Figure 1-7: Customize Toolbar dialog box*
2. Do one or more of the following:
   • To display the toolbar icons as large icons, select Large Icons; otherwise, click Small Icons.
   • To hide an icon from the toolbar display, in the Show Buttons panel, select an icon, or CTRL-click to select multiple icons, and then click the Hide button (<). Conversely, to show an icon on the toolbar display, in the Hide Buttons panel, select an icon, or CTRL-click to select multiple icons, and then click the Show button (>).
   
   You can also move a toolbar icon between the Hide and Show panels by double-clicking the icon. To move all icons from one panel to another in a single step, you do not have to select any icons. Instead, click the appropriate Hide All button (<<) or Show All button (>>).
   
   • To change the order (from left to right) in which the icons are displayed on the toolbar, select the icon, and then click Move Up or Move Down as needed.

3. Click OK.
   The Customize Toolbar dialog box closes. The toolbar display is updated to reflect the changes that you made.

Main menu

Every time you open EMS, the main menu opens in the EMS main window. You can access the primary EMS system functions—Reservations, Reports, Billing, Configuration, and System Administration—from the main menu.

Figure 1-8: EMS main menu
The main menu is arranged in a Windows Explorer-style folder structure. The top-level folders are the system functions of Reservations, Reports, Billing, Configuration, and System Administration. The available tasks for each top-level folder are further organized into subfolders. For example, to carry out a system administration task, you must first open the top-level System Administration folder, and then open the correct subfolder to view the list of available tasks.

*Figure 1-9: Opening a System Administration subfolder*

You can always close the main menu by clicking the Close button (x) in the upper right hand corner of the menu. To open the main menu again, on the menu bar, click File > Show Main Menu.
An EMS Browser Window

Many EMS functional areas use a *Browser* window. For example, the Groups window, the Query Builder window, and the Service Order Management window are all EMS Browser windows. You use an EMS Browser window to search for data, add new data, and edit and/or delete existing data. For example, in the Groups Browser window, you can search for groups or contacts, add new groups or contacts, and edit or delete existing groups or contacts. Regardless of the EMS functional area, all EMS Browser windows have the following features in common:

- A click and drag feature that you can use to group data by a specific column, rearrange the order of the data columns, or change the width of a column. See “To group data by columns in an EMS Browser window” on page 36, “To rearrange the columns in an EMS Browser window” on page 36, and “To change the width of the columns in an EMS Browser window” on page 37.

This feature is always indicated by the option to drag and group by a column header at the top of an EMS Browser window. If a window/window pane does not display this option, then the window/window pane is not an EMS Browser window.

- A column context menu that has a multitude of options for sorting data, grouping data, sizing columns and so on. See “To use the context menu for data columns in an EMS Browser window” on page 37.

- A filtering feature that you can use to find and work with a subset of data in the window. See “To filter the data in an EMS Browser window” below.

- A column sorting feature that you can use to sort data by a specific column. See “To change the sort order of data in an EMS Browser window” on page 40.

The following examples are explained using the Groups window; however, the instructions are applicable for any Browser window in EMS.
To group data by columns in an EMS Browser window

In any browser window, you can drag a column header to the indicated location and group the data by the selected column. You can drag multiple column headers to the location. If you sort data by multiple columns, then the first column is the parent column. All other columns are placed as child columns, and the data is grouped accordingly in the browser window.

*Figure 1-10: Grouping data by a column in an EMS Browser window*

To rearrange the columns in an EMS Browser window

You can rearrange the column order by dragging a column to a new location using the column heading.

*Figure 1-11: Rearranging columns in an EMS Browser window*
To change the width of the columns in an EMS Browser window

You can change the width of a column by resting the mouse pointer on the right side of a column heading until the pointer changes to a double-headed arrow, and then dragging the boundary until the column is the width that you want.

*Figure 1-12: Changing the width of a column in an EMS Browser window*

To use the context menu for data columns in an EMS Browser window

Right-click in any column in a browser window to open a context menu that has a multitude of options for sorting data, grouping data, sizing columns, and so on.

*Figure 1-13: Context menu for a column in an EMS Browser window*
To filter the data in an EMS Browser window

1. Open a browser window, for example, the Groups window.

2. Place your cursor in the data column by which you want to filter the data. For example, to filter data based on the City for group records, place your cursor in the City column.

   A Filter icon is displayed in the column.

   Figure 1-14: Filter icon displayed in a data column

3. Click the Filter icon to open a list of filter options, and then select the appropriate option for creating the filter.

   Any filter that you create is always displayed in the bottom left corner of the browser window.

   Figure 1-15: Example of filtering options in a browser window
4. Optionally, click Edit Filter in the lower right corner of the browser window to open the Filter Editor dialog box and edit the current filter.

- To add a new condition to a filter, click the Add/Insert icon.
- To remove a condition from a filter, click the Delete icon at the end of the filter.
- To apply a new filter, click Apply.
- To close the Edit Filter dialog box and return to the browser window, click OK.

*Figure 1-16: Edit Filter dialog box*
To change the sort order of data in an EMS Browser window

When a browser window first opens, data are sorted in ascending order based on the data in the first column of the window. For example, when the Groups window first opens, the group records are displayed on the Results tab alphabetically by Group name. To change the sort order of the data in a browser window:

1. Click once in any column header to display a Sort Order icon.

   The Sort Order icon is an “Up” arrow indicating that the data is sorted in ascending order.

   *Figure 1-17: Sorting by columns on the Groups window, Ascending sort*

2. Click the Sort Order icon to sort the records in descending order by the data in the column.

   *Figure 1-18: Sorting by columns on the Groups window, Descending sort*

3. Click the Sort Icon again to sort the records in ascending order.
Chapter 2
Reservations and Bookings

The two essential EMS components for meeting and event scheduling are reservations and bookings. To use EMS efficiently and effectively, you must understand the structure of a reservation in EMS, you must understand the concept of an event timeline for a reservation booking, and you must know how to make a reservation.

This chapter covers the following topics:

• “Reservation Structure” on page 43.
• “Event Timeline” on page 44.
• “Making a Reservation Using the Reservation Wizard” on page 45.
• “Viewing and Editing Reservations in the Reservation Book” on page 62.

You can also make a reservation for a group by finding the group in EMS and then making a reservation for the group from the Groups window. In EMS Workplace, you can make a group reservation from the Group Reservation window. See “Working with Reservations for a Group” on page 295.
Chapter 2
Reservations and Bookings
Reservation Structure

An event in EMS is comprised of the following:

- A **reservation**
- One or more **bookings**
- **Booking details**

These three components exist in a hierarchy—a reservation contains one or more bookings and each booking can have one or more details associated with it.

Reservation and bookings

*A reservation* is the who and the what of an event. For example, Group X (the who) can reserve some space for an Event Y (the what). A *booking* is the where and the when of an event. For example, Group X can schedule the conference room (the where) for a staff meeting on the second Monday in January (the when). Group X now has a single reservation with a single booking in EMS. If, however, Group X schedules the conference room (the where) for a staff meeting on the second Monday of each month for a calendar year (the when), then Group X now has a single reservation with twelve bookings in EMS.

Booking details

A booking can have one or more booking details associated with it. *Booking details* are the resources or services that are needed for an event, the notes for the event, the activities for the event, the room charges for the event, or any combination of these. For example, for Group X’s staff meeting, the resources could include the requested catering (coffee service, bagels and muffins, and so on) and the A/V equipment (a projector, a speaker’s podium, and so on).
Chapter 2
Reservations and Bookings

Event Timeline

The following time designators are used for an event in EMS:

- Event Time: The time period during which the event actually takes place.
- Setup/Teardown Hours: The hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up after the event.
- Reserved Time: The total time for which the space (the where) is reserved. This time is the event time plus the setup/teardown time.

For example:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reserved Start Time</td>
<td>8:00 am</td>
</tr>
<tr>
<td>Setup Hours</td>
<td>1 hour</td>
</tr>
<tr>
<td>Event Start Time</td>
<td>9:00 am</td>
</tr>
<tr>
<td>Event End Time</td>
<td>4:00 pm</td>
</tr>
<tr>
<td>Teardown Hours</td>
<td>1.5 hours</td>
</tr>
<tr>
<td>Reserved End Time</td>
<td>5:30 pm</td>
</tr>
<tr>
<td>Reserved Time</td>
<td>9.5 hours</td>
</tr>
</tbody>
</table>
Making a Reservation Using the Reservation Wizard

You use the Reservation Wizard to check for available space for an event and to make a reservation for the event. You can search for rooms that are available for a particular time on one day (a simple reservation with one booking) or on multiple days (a series reservation with multiple bookings). You can also create a series reservation by selecting one date and time, but multiple rooms. To make a reservation using the wizard, you must:

- Specify the event date and time information. See “To specify the event date” on page 46.
- Specify the event time and status. See “To specify the event time and status” on page 49.
- Select the event location. See “To select the event location” on page 50.
- Specify the event information. See “To specify the event information” on page 57.

The following procedure describes how to make a reservation by selecting values for the required and optional fields.

- If your EMS administrator has configured reservation wizard templates, then a Reservation Wizard Template dropdown list is displayed at the top of the Reservation Wizard. You can facilitate the making of a reservation in the Reservation Wizard by selecting the appropriate template from the list, which automatically sets the default values for many of the fields in the Reservation Wizard.

- If your job entails making multiple reservations that require the same information, and you are not using reservation wizard templates, then you can set your own default values for many of the fields in the Reservation Wizard. See “Setting User Preferences and Default Values” on page 403.
To specify the event date

1. On the toolbar, click the Wizard icon.

   The Reservation Wizard opens.

   All required fields in the wizard are marked with a red dot. Your EMS administrator configures the required fields.

   Figure 2-1: Reservation Wizard

2. If needed, use the scroll features on the top of the Calendar to open the calendar for a different month (< or >) or for a different year (<< or >>).

   You can also click a month at the top of the calendar to open a dropdown list from which you can select a different month and you can also click a year at the top of the calendar to open a dropdown list from which you can select a different year.
3. If the event dates do not follow a pattern, use one or more of the following options for entering a date; otherwise, go to Step 4.
   • Click on the dates on the calendar that the event is to take place.
   • To select all five days in a work week, click in the blank space that is to the left of the week.
   • To select all seven days in a week, double-click in the blank space that is to the left of the week.

*Figure 2-2: Example of selecting the days of the week*

- To select every occurrence of a specific day of the week for the displayed month (for example, all Tuesdays in November, 2012), click the heading (S, M, T, and so on) for the day.
- To select every occurrence of a specific day of the week that is currently displayed onscreen (regardless if the day falls within the same month), double-click the heading (S, M, T, and so on) for the day.

*If you need to clear a single selected date, click the date again. To clear multiple selected dates in a single step, click Clear Month to clear all currently selected dates for the currently displayed month or click Clear All to clear all currently selected dates regardless of month or year.*
Chapter 2
Reservations and Bookings

4. If the event dates do follow a pattern, (for example, the third Friday of every month), click Date Pattern to open the Date Pattern dialog box and enter your event date information.

*Figure 2-3: Date Pattern dialog box*

As you specify the event dates, the following occurs:

- The Selected Dates tab is automatically updated with the selected dates.
- If your EMS administrator has configured any of the dates that you selected as a holiday or as closed, then messages open indicating this.
- Dates that are closed are displayed in red on the Calendar tab and are linked to information about the closure. Dates that are holidays are displayed in green on the Calendar tab and are linked to information about the holiday.

For any date, after you select the date on the Calendar tab, you can:

- Toggle between the Calendar tab and the Selected Date tab. Open the Selected Dates tab, select the date, and then click Go To Date.
- Remove the date from the list of selected dates. Open the Selected Dates tab, select the date, or CTRL-click to select multiple dates, and then click Remove.

*When you make a reservation for multiple dates, the process is easier if you first remove all holidays or closed dates from the list of selected dates; however, be very careful when selecting dates for removal as you are not prompted to confirm your selection before you click Remove.*

For dates that are configured as a holiday or as closed, you can click the link on the Calendar tab to open a dialog box that displays information about the date.

*Figure 2-4: Viewing information about a holiday or closed date from the Calendar tab*
In addition, for dates that are configured as holidays, after you select the date on the Calendar tab, you can:

- View information about the date from the Selected Dates tab. Open the Selected Dates tab, scroll to and select the date, and then click Holidays.

5. Continue to “To specify the event time and status” below.

**To specify the event time and status**

1. Do one of the following to specify the start time and end time for the event:
   - Select a time from the dropdown list for each field.
   - Manually enter the time in each field.

   *When you manually enter the time, you can use a shortcut. For example, for 9:00 am, you need to enter only “9a” and for 2:00 pm, you need to enter only “2p,” and so on. If you enter an end time that is earlier than the start time, then the system assumes that the end time is the next day and the phrase “Next Day” is displayed to the right of the End time field.*

2. Do one of the following to specify the Setup and Teardown times.
   - To use the default setup and teardown times that your EMS administrator has assigned to the rooms in your system, leave Use Default selected.
   - To override the default setup/teardown times, clear Use Default, select Minutes or Hours, and then enter your own setup and teardown times.

   *Remember, setup and teardown times are the hours, or fractions of hours, that you add to the event time to allow staff to prepare a room for the event or to clean up after the event. For example, for a 30 minute setup time, you can enter 30 minutes or 0.5 hours.*

3. Select the status for the event.

   *Depending on the status that you select, for example, Tentative or Hold, you might be required to enter a reconfirm date. You can monitor reservations that must be reconfirmed on the Reconfirm Dates tab on the EMS Dashboard. See Chapter 5, “EMS Dashboard,” on page 227.*

   *Time zone is discussed in “To select the event location” on page 50.*

4. Continue to “To select the event location” on page 50.
Chapter 2
Reservations and Bookings

To select the event location

You have three options for selecting the event location, which are indicated on the first window of the Reservation Wizard:

<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
</table>
| Standard        | Use this option to display a list of all the available rooms that meet all the requested dates. See “To search for a standard room” below.  
**Note:** Standard search is required for Video Conference room assignments.                                                             |
| Best Fit        | Use this option if no one room can meet all the requested dates. The system lists the available rooms along with the number of bookings for which you can reserve each room. You can piece together the entire reservation using Best Fit, or just part of it. See “To search for a best fit room” on page 53. |
| Specific Room   | Use this option to confirm the availability and reserve of one specific room for the scheduled event. See “To search for a specific room” on page 55.                                                                |

By default, EMS looks for an available room or rooms in only the first 50 rooms that it finds in the pre-configured Rooms list. To search more than 50 rooms, before you begin any search, click Options > Max. Number of Rooms to Search, and then select a different number of rooms to search.

To search for a standard room

By default, when you search for a standard room, rooms that are available all day are marked with an asterisk (*). To set or clear this option, click Options > Standard Search > Show Available All Day Indicator.

1. Select Standard.
2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to search for a standard room.
3. If applicable, select the appropriate time zone for the event.

Your selection on the Building dropdown list determines the options that are available on the Time Zone dropdown list. If you select (all) buildings, then you can select a time zone. If you select a specific building, then by default, a time zone is selected for the building, and you cannot select a different value.
4. Do one or more or all of the following for room specifications:

- **Type** is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type dropdown list.

- **Floor** is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown list.

- **Setup Type** is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type dropdown list.

- **Setup count** is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count.

   The selected setup type and setup count are applied to all the bookings that you add to this reservation. If any of the bookings require a different setup type or count, you can change this information after you complete the reservation. See “To edit a booking in the Navigator” on page 110 or “Editing Multiple Bookings in the Navigator” on page 112.

5. Optionally, open the Features tab, and then select the feature, or CTRL-click to select the multiple features that the room must have.

6. Click Next.

   Up to two tabs are displayed:

   - The Available tab, which is the active tab and is always displayed, lists all the rooms that meet all your event criteria.

     - If you have elected to show the Available All Day Indicator, the rooms that are available all day are marked with an asterisk (*).

     - By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

   - The Conflicts tab is displayed only if there are rooms that are not available for the requested dates/times. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling as well as list of the events that are scheduled for each room.

   See Figure 2-5 on page 52.
7. Select the room, or CTRL-click to select the multiple rooms that you are scheduling for the event.

   If the reservation is for a video conferencing meeting, then you must select a minimum of two rooms. You must designate one of these rooms as the Host Location on the Video Conference tab on the last page of the Reservation Wizard.

8. Optionally, do one or both of the following; otherwise, go to Step 9.
   - Click Room Info to open the Room Info dialog box and view information about any bookings for the room, the room properties, its pricing, and/or to view an image of the room.
   - Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

9. Click the Move button (>) to move the rooms to the Selected list.

   If you select more than one room, all the selected rooms are booked for all the event dates.

10. Click Next to continue to “To specify the event information” on page 57.
To search for a best fit room

1. Select Best Fit.
2. Leave Building set to the default value of (all), or select a specific building, area, or view in which to search for a standard room.
3. If applicable, select the appropriate time zone for the event.

Your selection on the Building dropdown list determines the options that are available on the Time Zone dropdown list. If you select (all) buildings, then you can select a time zone. If you select a specific building, then by default, a time zone is selected for the building, and you cannot select a different value.

4. Do one or more or all of the following for room specifications:
   • Type is the class or category of the room, for example a meeting room, a workspace, and so on. Leave Type set to the default of (all) to search for all pre-configured room types or select a specific room type from the Type dropdown list.
   • Floor is optional information when you are searching for a room. Leave Floor set to the default value of (all) to search for all pre-configured floors or select the floor from the Floor dropdown list.
   • Setup Type is the physical layout or arrangement of a room, for example, rounds of 6 or theater-style. Leave Setup Type set to the default value of (all) to search for all pre-configured setup types or select the setup type from the Setup Type dropdown list.
   • Setup count is the anticipated attendance for the event. If you selected a specific setup type, then you must enter the setup count.

The selected setup type and setup count are applied to all the bookings that you add to this reservation. If any of the bookings require a different setup type or count, you can change this information after you complete the reservation. See “To edit a booking in the Navigator” on page 110 or “Editing Multiple Bookings in the Navigator” on page 112.

5. Optionally, open the Features tab, and then select the feature, or CTRL-click to select the multiple features that the room must have.
Chapter 2
Reservations and Bookings

6. Click Next.

Up to two tabs are displayed:

• The Available tab, which is the active tab and is always displayed, has two lists. The list in the left pane is a list of all the rooms that meet some or all of your event criteria. The list in the right pane is a list of all the event dates that must be fulfilled.

    By default, the available rooms are sorted alphabetically by room code. If your EMS administrator has configured the rooms for your EMS implementation with a book sequence, then under Options, select Sort Rooms by Book Sequence to sort the rooms from lowest to highest book sequence. (If two rooms have the same sequence, then the rooms are sorted alphabetically by name within the sequence.)

• The Conflicts tab is displayed only if there are rooms that are not available for the requested dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling for the event as well as list of the events that are scheduled for each room.

Figure 2-6: Example of best fit room search results

7. Optionally, do one or both of the following; otherwise, go to Step 8.

    • Select a room on the Available tab, and then click Room Info to open the Room Info dialog box and view information about any bookings for the room, the room properties, its pricing, and/or to view an image of the room.

    • Select a room on the Available tab, and then click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.
8. Do one of the following:

- If one is available, select the single room that is available for all the requested dates, and then click the Move button (>) to move the room to the Event Dates list.

- If a single room is not available, select a room that is available for some of your requested dates, and then click the Move button (>) to move the room to the Event Dates list. Repeat this step as needed to fulfill all the event dates.

9. Click Next to continue to “To specify the event information” on page 57.

To search for a specific room

You can use the specific room search to book a standard EMS room or a room or area that is not managed in EMS. An override room, or “override description,” is used to book an event in a space that has not been configured in your EMS system. For example, your EMS administrator might have configured an override room named “Other Area” in the Engineering building. To book an event in Dr. Wilson's office, which is a room that is not defined in EMS, in the Engineering building, you can select the “Other Area” room and specify “Dr. Wilson's Office” for the location. EMS does not track availability for events booked in override rooms; however, EMS reports on events that are scheduled in an override room just like any other event scheduled for any other room.

1. Select Specific Room.

The Room Selector dialog box opens.

*Figure 2-7: Room Selector dialog box*
2. Do one of the following:
   • To select a room from a list of all rooms in all available buildings, select (all) on the Building dropdown list, select a room, and then click OK. If the room is configured as an override room, go to Step 3; otherwise, go to Step 4.
   • To select a room from a list of rooms in a specific building, area, or view, select the building, area, or view on the Building dropdown list, select the room, and then click OK. If the room is configured as an override room, go to Step 3; otherwise, go to Step 4.

3. In the Location field, enter the location of the override room, and then click Next to continue to “To specify the event information” on page 57.

4. Click Next.

   Two results are possible:
   • If the event is scheduled for a single date and the room is available, then continue to “To specify the event information” on page 57.
   • In all other cases, (for example, the event is scheduled for a single date but the room is not available or it is a multiple date event), the Available tab opens. This tab lists all the event dates for which the specific room is available. Continue to Step 5.

   You can open the Conflicts tab to view the list of dates for which the specific room is not available as well as list of the events that are scheduled for the room.

5. Optionally, before you move a date to the Selected list, do one or both of the following; otherwise, go to Step 6.
   • Click Room Info to open the Room Info dialog box and view information about any bookings for the room, the room properties, its pricing, and/or to view an image of the room.
   • Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.

6. Do one of the following:
   • If the specific room is available for all the event dates, then click the Move All button (>>) to schedule the room for all the event dates.
   • If the specific room is not available, try another approach such as reserving a different specific room, or using the Standard or Best Fit search method.

7. Click Next to continue to continue to “To specify the event information” on page 57.
To specify the event information

After you select an event location or locations, you must specify other information for the event. You must enter information in the required fields.

**Figure 2-8: Event Information window**

8. Enter the event information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event</strong></td>
<td></td>
</tr>
<tr>
<td>Event Name</td>
<td>A name or description for the event.</td>
</tr>
<tr>
<td>Event Type</td>
<td>The classification for the event.</td>
</tr>
<tr>
<td>VIP Event</td>
<td>Select this option to mark the event as a Very Important event.</td>
</tr>
<tr>
<td>Source</td>
<td>The reservation source.</td>
</tr>
<tr>
<td>Video Conference</td>
<td>Select this option for a video conference event.</td>
</tr>
<tr>
<td><strong>Group/Contact</strong></td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>Dropdown list of all groups that are available in your system for hosting/</td>
</tr>
<tr>
<td></td>
<td>sponsoring an event.</td>
</tr>
<tr>
<td>Note: <strong>Group</strong></td>
<td>If the pre-configured list of groups is too extensive to scroll, then click</td>
</tr>
<tr>
<td></td>
<td>the Search icon to open the Groups window and search for a specific group.</td>
</tr>
<tr>
<td>Note: <strong>Group</strong></td>
<td>See “To search for a group and/or contact” on page 255. If the group that</td>
</tr>
<tr>
<td></td>
<td>you want to select for the reservation is not available on the pre-configured</td>
</tr>
<tr>
<td></td>
<td>list, then you can add the group. See “To configure groups” on page 257.</td>
</tr>
<tr>
<td>Note: <strong>Group</strong></td>
<td>Optionally, after you select a group for the event, you can click Group</td>
</tr>
<tr>
<td></td>
<td>Info to open a dialog box that provides information (Properties, User</td>
</tr>
<tr>
<td></td>
<td>Defined Fields, and Comments) about the group.</td>
</tr>
</tbody>
</table>
### Chapter 2
Reservations and Bookings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Contact</td>
<td>When you select a group, if a default contact has been defined for the group, then this field is automatically populated with the name of the contact; otherwise, the field is blank. You have several options for defining the 1st Contact for a reservation:</td>
</tr>
<tr>
<td>Temp Contact</td>
<td>• If the field is blank, but contacts have been configured for the group, you can select a contact from the pre-configured list.</td>
</tr>
<tr>
<td></td>
<td>• If the field is populated with a default value, but other contacts have been configured for the group, you can select a different contact from the pre-configured list.</td>
</tr>
<tr>
<td></td>
<td>• If the field is blank, and no contacts have been configured for the group, or the contact that you want to select for the group is not available on the pre-configured list, you can click the Contact icon to open the Contact dialog box and create a permanent contact for the group. See “To configure contacts” on page 278.</td>
</tr>
<tr>
<td></td>
<td>• If you want to create a temporary contact just for this event, then select (temporary contact), and in the Temp Contact field, enter the name for the temporary contact.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If a default contact has been configured for the group, then any modifications that you make for the contact apply to this reservation only. The next time you or anyone else creates a reservation for this group, the 1st Contact field is again automatically populated with the name of the default contact.</td>
</tr>
<tr>
<td>Phone</td>
<td>One more of these fields might be automatically populated depending on how a selected contact has been configured. You can manually edit these values if needed.</td>
</tr>
<tr>
<td>Fax</td>
<td><strong>Note:</strong> The Phone and Fax fields have a dropdown list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.</td>
</tr>
<tr>
<td>Email Address</td>
<td><strong>Note:</strong> If default values have been configured for a selected contact, then any modifications that you make apply to this reservation only. The next time you or anyone else creates a reservation for the same contact, these fields are again automatically populated with the default information.</td>
</tr>
<tr>
<td>2nd Contact</td>
<td>Define if necessary for the event.</td>
</tr>
<tr>
<td>Temp Contact</td>
<td></td>
</tr>
<tr>
<td><strong>Room Setup tab</strong></td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is set to (default). You can edit this value.</td>
</tr>
<tr>
<td>Setup Type</td>
<td>If you selected a specific value for the setup type when searching for an event location, this value is carried forward to this field; otherwise, the field is blank. You can enter a value in this field.</td>
</tr>
<tr>
<td>Setup Count</td>
<td></td>
</tr>
</tbody>
</table>
## Chapter 2
### Reservations and Bookings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Billing tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Depending on the group that you select, one or more of these fields on this tab might be automatically populated with default values. You can edit these default values but any modifications that you make apply to this reservation only. The next time you or anyone else creates a reservation for the same group, these fields are again automatically populated with the default billing information.</td>
</tr>
<tr>
<td>Pricing Plan</td>
<td>Indicates what type of pricing is to be used for the event.</td>
</tr>
</tbody>
</table>
| Billing Reference Number| The internal alphanumeric billing code that is associated with the group. You can manually enter a value in this field, or if a master list of billing reference numbers has been configured for the group, you can click the Search icon to open a Billing Reference Numbers dialog box, and select the appropriate value from this list.  
**Note:** To search for a specific billing reference number, enter a search string in the Find field, and then click Display. Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive and it can appear anywhere in the search results. For example, if you enter `co` as the search string, the search results can include `CO-123`, and `123-CO`. |
| Sales Category         | How the group is sorted for purposes of tracking sales figures, for example, local, regional, national, and so on.                                                                                              |
| Payment Type           | Indicates how the group paid for the event (cash, check, charged, and so on).                                                                                                                                   |
| PO Number              | The internal alphanumeric purchase order number that is associated with the group. You can manually enter a value in this field, or if a master list of PO numbers has been configured for the group, you can click the Search icon to open a PO Number dialog box, and select the appropriate value from this list.  
**Note:** To search for a specific billing reference number, enter a search string in the Find field, and then click Display. Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive and it can appear anywhere in the search results. For example, if you enter `co` as the search string, the search results can include `CO-123`, and `123-CO`. |
| Salesperson            | The user who “sold” the event to the group.                                                                                                                                                                   |
| **Other tab**          |                                                                                                                                                                                                             |
| Event Coordinator      | The Event Coordinator who is assigned to the event.                                                                                                                                                         |
| Estimated Event Attendance| The estimated number of people who are expected to attend the event.                                                                                                                                           |
| Calendar Style         | Dropdown list of all the available formats for printing this event on the Event Calendar and Event Schedule reports.                                                                                         |
| URL                    | The event URL.                                                                                                                                                                                              |
## Chapter 2

### Reservations and Bookings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Virtual tab</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Web User | To specify the web users who can view/manage this reservation in VEMS, click the Search icon to open the Web Users dialog box and search from a list of registered web users.  
  - You can search by User Name or Email Address.  
  - To search a list of all available web users, leave the Search field in the Web Users dialog box blank, and then click Display.  
  - To search for a specific web user, enter a search string in the Search field, and then click Display.  
  **Note:** The string is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of *bob* returns *bob.worth@dea.com* but not *dbobbett@dea.com*.  
  - To return this field to the (no change) value at any time, click Reset. |
| Web Process Template | The web process template that defines the functions that are available for the selected web user.  
  **Note:** A web user might be assigned to more than one web process template, so make sure to select the template that is applicable for this reservation. |
| **User Defined Fields tab** |  |
| | User-defined fields are additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields.  
  - To enter or edit a value for a field, select the field, and then click Set Value.  
  - To clear a value for a field, select the field, and then click Clear Value.  
  **Note:** If a user-defined field is not required here, you can always supply a value for it at a later date in the Navigator. See "Working with User Defined Fields in the Navigator" on page 181. |
| **Video Conference tab** |  |
| | Displayed only if you selected the Video Conference option on this window. N/A for a Best Fit room or Specific Room meeting assignment. You identify the host endpoint for the video conference on this tab.  
  **Note:** Not available in EMS Professional. |
Chapter 2
Reservations and Bookings

9. Click Finish.

The Navigator window opens. The reservation information appears in the window. You use this window to add booking details and to make any needed modifications to the reservation and its bookings. See Chapter 3, “The Navigator,” on page 77.

---

A reservation is not complete and rooms are not removed from the Available list until you click Finish. Although unlikely, it is possible for another user to select and reserve a room during the time period after you have selected the room but before you have finalized the reservation. If this occurs, after you click Finish, a message opens stating that your reservation conflicts with an existing reservation.

---

Depending on how your EMS administrator has configured your system, user defined questions (UDFs), comments, and/or reminders might be automatically displayed for the reservation in the Navigator. Contact your EMS administrator if you have any questions about this.
Chapter 2
Reservations and Bookings

Viewing and Editing Reservations in the Reservation Book

The Reservation Book provides a graphical view of all the confirmed reservations (the reserved time as well as the room for which the reservation is scheduled) for your organization. (Cancelled bookings are not shown.) You use the Reservation Book to view information for a reservation, to edit an existing reservation, and to make a new reservation. In addition, before you edit or make a reservation, you can change the Reservation Book display so that it better suits your working needs.

Reservation Book

To open the Reservation Book, on the EMS toolbar, click the Book icon . The first time that you open the Reservation Book for your EMS implementation, by default, the Room Filter dialog box opens on top of a blank Reservation Book. You can leave the room filtering criteria set to their default values, or you can select different values as needed, and then click OK. All reservations that meet the filtering criteria and that are scheduled for the current day’s date are displayed in the book in the Daily view.

You might need to use the book’s scroll features to scroll through all the reservations that are scheduled for the current day’s date.

The Reservation Book has the following appearance:

• Minimum and maximum capacities are displayed next to room descriptions.
• The current time is shown by a vertical line in the grid, called the Current Time Indicator.
• If building hours have been configured for a building, then this information is displayed for the building.
• The reservations are displayed with three components:
  • A left bar that indicates the setup time.
  • A middle bar that indicates, by default, the event name.
  • A right bar that indicates the teardown time.

See Figure 2-9 on page 63.
If an event is scheduled for a room that is a component of a combination room, then the reservation text is displayed in black. A duplicate reservation is also shown for the combination room; however, the reservation text is displayed in gray to indicate that a component of the combination room is currently booked for the indicated time and therefore, the combination room is not available.

Conversely, if an event is scheduled for a combination room, then the reservation text for the combination room is displayed in black and the reservation text for each component is displayed in gray. This reversed color coding indicates that the component room is currently booked for the selected time and that none of the components is available.
Chapter 2
Reservations and Bookings

You can carry out the following actions in the Reservation Book:

- Change the Reservation Book display. See “To change the Reservation Book display” below.
- View reservation information. See “To view reservation information” on page 70.
- Make a new reservation. See “To make a new reservation” on page 74.
- Edit an existing reservation. See “To edit an existing reservation” on page 74.

To change the Reservation Book display

1. On the toolbar, click the Book icon .

   The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

2. Optionally, you can do one or more of the following to change the Reservation Book display:

   - Change the list of rooms that are displayed in the Reservation Book based on room properties. See “List of Rooms (Room Properties)” on page 65.
   - Change the list of rooms that are displayed in the Reservation Book based on a specific room or rooms. See “List of Rooms (Specific Rooms)” on page 66.
   - Change the Reservation Book view. See “Reservation Book view” on page 66.
   - Change multiple display options for a reservation. See “Display Options” on page 67.
   - Select which items to include in the tooltip that opens when you place the cursor over an event in the Reservation Book. See “Tooltips” on page 69.
   - Change the display date using the calendar. See “Display Date (Calendar)” on page 69.
   - Change the display date using the Reservation Book scroll features. See “Display Date (Scroll Features)” on page 70.
List of Rooms (Room Properties)

If the Filter Rooms dialog box is not already open, then above the Rooms list, do the following:

1. Click Filter.

   The Filter Rooms dialog box opens. The room filtering criteria is set to the following default values—Filter Type is Room Properties, Room Type is None, and Room Availability is All Rooms.

   Figure 2-12: Filter Rooms dialog box, Room Properties selected

2. Select Room Properties, and then do one or more of the following

   • Leave the Building dropdown list set to the default value of (all) buildings, or select a specific building, area, or view.
   • Select a specific floor.
   • Select a specific room type.
   • Select Capacity and then enter a capacity.
   • Select Academic to limit the search to academic rooms. (This option is available only if you have an EMS Campus.)

   *The Academic option is available only in EMS Campus.*

   • Select a Room Availability option.

3. Click OK.

   The Filter Rooms dialog box closes. The room display in the Reservation Book is changed accordingly.
Chapter 2
Reservations and Bookings

After you carry out a search, you can click Reset at the top of the Rooms list to reset all room filtering criteria (Filter Type, Room Type, and Room Availability) to their default values.

List of Rooms (Specific Rooms)

If the Filter Rooms dialog box is not already open, then above the Rooms list, click Filter to open the dialog box and select Specific Room. Select the room, or CTRL-click to select multiple rooms on the Available list, and then click the Move (>) button to move the selected rooms to the Selected list. The Reservation Book is updated to show bookings only for the selected rooms.

Figure 2-13: Filter Rooms dialog box, Specific Room selected

Reservation Book view

On the View dropdown list, select Daily, Weekly, or Monthly.

Figure 2-14: View dropdown list

Although you can view currently scheduled reservations in either the daily, weekly, or monthly view, you can make a new reservation only in the daily view.
Display Options

Click Options (upper right hand corner of Reservation Book) to open the Book Options dialog box (the General tab is the active tab) and change multiple display options not only for the Reservation Book, but also a reservation in the book.

*Figure 2-15: Book Options dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Hour</td>
<td>The daily start time for the Reservation Book display.</td>
</tr>
<tr>
<td>Automatically Refresh</td>
<td>The time interval at which the Reservation Book display is automatically refreshed.</td>
</tr>
<tr>
<td>Display</td>
<td>The information that is displayed in the middle bar for a reservation.</td>
</tr>
<tr>
<td>Time Display Interval</td>
<td>Changes the granularity of the time display interval.</td>
</tr>
<tr>
<td>Maximum No. of Rooms</td>
<td>The maximum number of rooms to display in the Reservation Book.</td>
</tr>
<tr>
<td>Booking Colors Based On</td>
<td>The color of the bookings in the reservation. Select one: Status, Event Type, or Check-in Status (for EMS Workplace only.)</td>
</tr>
<tr>
<td>Rooms Without Bookings</td>
<td>Whether to highlight rooms without bookings and if so, the highlight color. If both Highlight Rooms and Booked Space Status Only are selected, then only those rooms that do not have a Booked Space status are highlighted.</td>
</tr>
<tr>
<td>Room Display</td>
<td>Display the room code or the room name for a reservation.</td>
</tr>
<tr>
<td>Building Display</td>
<td>Display the building code or the building name for a reservation.</td>
</tr>
</tbody>
</table>
Chapter 2
Reservations and Bookings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To Today on Startup</td>
<td>If selected, the Reservation Book opens to the current day's date; otherwise, it opens to the last date viewed.</td>
</tr>
<tr>
<td>Always Prompt for Room Filter on Startup</td>
<td>If Show '(all)' in Building List is also selected, then when you open the Reservation Book, the Room Filter dialog box opens on top of the Reservation Book. You can select different options on this dialog box to display only specific reservations in the book, for example, bookings only for selected rooms. If you do not select any options on this dialog box, but instead simply close it, then all reservations for all rooms in all buildings are displayed in the book.</td>
</tr>
<tr>
<td>Hide Current Time Indicator</td>
<td>Show or hide the vertical bar that indicates the current time for current day.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Current Time indicator is displayed only if the view is the Daily or Weekly view and the view includes the current day's date.</td>
</tr>
</tbody>
</table>
| Show '(all)' in Building List               | Show the "all" option on the Building dropdown list; otherwise, a user must select a specific building. If this option is selected in conjunction with Always Prompt for Room Filter on Startup, then when you open the Reservation Book, then the Room Filter dialog box always opens on top of the Reservation Book. If you are setting your Reservation Book options, and you do not want to the Room Filter dialog box to open on top of the Reservation Book when you open the book, then do the following:  
  • Clear Always Prompt for Room Filter on Startup.  
  • Clear Show ('all') in Building List.  
  • On the Building dropdown list in the Reservation Book, select any building, area, or view.  
  **Note:** The building, area, or view that you select is not important. This last step just clears the "all" building option from the Reservation Book cache and ensures that the Room Filter dialog box does not open on top of the Reservation Book. Going forward, you can always select all buildings, or any specific building, area, or view as needed when you are working in the Reservation Book. |
| Show Capacity                               | Show the minimum and maximum capacities next to the room description.                                                                        |
| Hide Booking Shadow                         | Hide the vertical shadow bar that highlights the reserved and/or event start times and end times when a user moves a booking in the Reservation Book. |
Chapter 2
Reservations and Bookings

**Tooltips**

Click Options (upper right hand corner of Reservation Book) to open the Book Options dialog box, and then open the Tooltip Display tab and select which items to include in the tooltip that opens when you rest the mouse pointer on an event in the Reservation Book.

*Figure 2-16: Book Options dialog box, Tooltip Display tab*

**Display Date (Calendar)**

On the Date field, click the dropdown arrow to open the Calendar. Use the scroll features (< and >) at the top of the calendar to change the month or year. To select a different date for a month, click the date.

*Figure 2-17: Reservation Book calendar*
Chapter 2
Reservations and Bookings

Display Date (Scroll Features)

Use the scroll features at the top of the reservation book display to scroll to a different day, week, month, year, or any different combination of these.

*Figure 2-18: Reservation Book calendar scroll features*

<table>
<thead>
<tr>
<th>Day</th>
<th>Week</th>
<th>Month</th>
<th>Year</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Fri, Jan 29, 2010</td>
</tr>
</tbody>
</table>

To view reservation information

1. On the toolbar, click the Book icon.

   The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

   *Optionally, when the Reservation Book first opens, before you view, edit or make a reservation, you can change the Reservation Book view so that it better suits your working needs. See “To change the Reservation Book display” on page 64.*

2. Optionally, you can do one or more of the following to view the reservation information:
   - View the reservation in the Navigator by doing one of the following:
     - Double-click the middle bar for the reservation entry.
     - Right-click the reservation entry and on the context menu that opens, click Open.
   - View the bookings for a room. See “Room Bookings” on page 71.
   - View the properties for a room. See “Room Properties” on page 71.
   - View the pricing for a booked room. See “Room Pricing” on page 72.
   - View any images of the room. See “Room Images” on page 72.
   - View the user defined fields (UDFs) that are associated with the room. See “Room UDFs” on page 73.
   - View the setup information, event information, or teardown information for a reservation. See “Room Information” on page 73.
   - Change the time zone in which to view all your bookings. See “Time Zone” on page 73.
Room Bookings

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box. The tab on this dialog box lists all the bookings for the selected room based on the current view (Daily, Weekly, Monthly) and on the date that is shown in the Date field. To view a booking in the Navigator, select the booking, and then click Open.

*Figure 2-19: Room Info dialog box, Bookings tab*

Room Properties

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box, and then open the Room tab. The tab on this dialog box lists all the properties for the room, such as the room code, the room name, the room classification, and so on. It also lists the setup type and capacity for the room, and any notes that have been entered for the room.

*Figure 2-20: Room Info dialog box, Room tab*
Chapter 2
Reservations and Bookings

Room Pricing

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box, and then open the Pricing tab. This tab displays any pricing information that was defined for the room.

*Figure 2-21: Room Info dialog box, Pricing tab*

Room Images

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box, and then open the Images tab. This tab displays any uploaded images of the room.

*Figure 2-22: Room Info dialog box, Images tab*
Room UDFs

Click the room name or code in the Rooms list to open the Bookings tab for the Room Info dialog box, and then open the User Defined Fields tab. This tab displays any UDFs that have been associated with the room.

*Figure 2-23: Room Info dialog box, User Defined Fields tab*

Room Information

Rest the mouse pointer on the left bar, middle bar, or right bar for the reservation entry. A tooltip showing the respective setup, event, or teardown information opens.

*Figure 2-24: Viewing setup information*

Time Zone

If buildings that are located in multiple time zones are currently displayed, you can specify the time zone in which to view all of your bookings.

*Figure 2-25: Changing the time zone*
To make a new reservation

1. On the toolbar, click the Book icon.

   The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

2. Change the display to show the room for which you are making the reservation.

3. Select the date for which you are making the reservation.

   *You must leave the Date view in the Daily display.*

4. In the Time Grid next to the room, click and hold the left mouse button, drag the mouse to schedule the room and time, and then release the mouse button to open the Reservation Wizard.

   *As you drag the mouse, the cursor changes to a double-headed arrow and a blue horizontal bar is displayed.*

*Figure 2-26: Making a new reservation in the Reservation Book*

5. Continue to “Making a Reservation Using the Reservation Wizard” on page 45.

To edit an existing reservation

1. On the toolbar, click the Book icon.

   The Reservation Book opens in the Daily view. See Figure 2-9 on page 63.

   *Optionally, when the Reservation Book first opens, before you view, edit or make a reservation, you can change the Reservation Book view so that it better suits your working needs. See “To change the Reservation Book display” on page 64.*
2. Optionally, you can do one or more of the following to edit an existing reservation:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the setup time for a reservation</td>
<td>• Drag the left bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the event time</td>
<td>• Drag the middle bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Change the teardown time for a reservation</td>
<td>• Drag the right bar horizontally to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Edit the reservation building, room, time, or both</td>
<td>• Drag and drop the reservation to a new room that is the same building or in a different building, and/or to a new time.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
</tbody>
</table>

3. Optionally, you can right-click on a reservation in the Reservation Book, and on the context menu that opens, select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a reservation in the EMS Navigator.</td>
</tr>
<tr>
<td>Add to Personal Calendar</td>
<td>Adds the reservation to your personal calendar.</td>
</tr>
<tr>
<td>Move Forward</td>
<td>Move the reservation date forward by one day or one week.</td>
</tr>
<tr>
<td>Move Backward</td>
<td>Move the reservation date backward by one day or one week.</td>
</tr>
<tr>
<td>Move to Specific Date</td>
<td>Move the reservation to a specific date.</td>
</tr>
<tr>
<td>Change Status</td>
<td>Change the status of the reservation.</td>
</tr>
<tr>
<td>Copy Bookings</td>
<td>Opens the Copy Bookings wizard. See “Copying Multiple Bookings in the Navigator” on page 129.</td>
</tr>
<tr>
<td>Swap Rooms With Another Booking (EMS)</td>
<td>Swap the room assignments of two events. The swap option is applicable only for two events that have identical meeting patterns. To swap rooms:</td>
</tr>
<tr>
<td></td>
<td>• Right-click on one of the two reservations that you are swapping, and on the context menu that opens, click Swap Rooms.</td>
</tr>
<tr>
<td></td>
<td>• Click on the other of the two reservations that you are swapping.</td>
</tr>
<tr>
<td></td>
<td>• Click Yes in the Confirm Change dialog box.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the rooms that you are swapping have been configured with a default setup type, and the setup count is not within the capacity of one or both rooms, a message opens indicating this, but you are not prevented from swapping rooms.</td>
</tr>
<tr>
<td>Swap Rooms With Another Booking (EMS Campus)</td>
<td>Swaps only the two bookings selected for the indicated day. (Just like Swap Rooms With Another Booking in EMS.)</td>
</tr>
</tbody>
</table>
Chapter 2
Reservations and Bookings

Swap Rooms With Another Course (EMS Campus)
If the meeting patterns of two courses are identical, then the swap is allowed and all bookings between the two courses for the entire term are swapped.

Highlight Related Bookings
Highlights the bookings that belong to the same reservation.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swap Rooms With Another Course (EMS Campus)</td>
<td>If the meeting patterns of two courses are identical, then the swap is allowed and all bookings between the two courses for the entire term are swapped.</td>
</tr>
<tr>
<td>Highlight Related Bookings</td>
<td>Highlights the bookings that belong to the same reservation.</td>
</tr>
</tbody>
</table>
Chapter 3
The Navigator

The Navigator is a window in EMS that you use to view and manage all aspects of a reservation including bookings and booking details.

This chapter covers the following topics:

- “Navigator Overview” on page 79.
- “Adding Bookings to a Reservation in the Navigator” on page 97.
- “Editing a Reservation in the Navigator” on page 98.
- “Repricing Categories and Room Charges for a Reservation” on page 100.
- “Changing the Status for a Reservation from the Reservation Summary tab” on page 102.
- “Copying a Reservation in the Navigator” on page 106.
- “Editing a Booking in the Navigator” on page 109.
- “Editing Multiple Bookings in the Navigator” on page 112.
- “Moving Bookings to a Different Reservation” on page 127.
- “Copying Multiple Bookings in the Navigator” on page 129.
- “Booking Details and Items Overview” on page 133.
- “Adding Booking Details and Items to Individual Bookings” on page 138.
- “Adding Booking Details and Items to Multiple Bookings” on page 148.
- “Adding Booking Detail Items to Multiple Bookings” on page 155.
- “Editing Booking Detail Items for Individual Bookings” on page 157.
- “Editing Booking Detail Item Charges for Multiple Items” on page 161.
- “Editing Count Information for a Booking” on page 163.
- “Applying a Reservation Discount” on page 165.
- “Copying Booking Details Between Bookings” on page 167.
- “Deleting Booking Detail Items from Multiple Bookings” on page 170.
- “Deleting Booking Details from Multiple Bookings” on page 173.
- “Working with Comments and Reminders in the Navigator” on page 175.
- “Adding Multiple Comments and Reminders to a Reservation” on page 179.
Chapter 3
The Navigator

- “Working with User Defined Fields in the Navigator” on page 181.
- “Working with Attachments in the Navigator” on page 184.
- “Working with Drawings in the Navigator” on page 188.
- “Running the Resource Utility Conflicts Tool” on page 192.
Navigator Overview

This section provides an overview of opening a reservation in the Navigator, the Navigator’s layout and folder structure, and the commands that are available in the Navigator.

Opening a reservation in the Navigator

After you create a new reservation using the Reservation Wizard, the reservation opens automatically in the Navigator. You can also manually open the Navigator by:

- Selecting a reservation, booking, or service order to open directly in the Navigator. See “Opening a reservation directly in the Navigator” below.
- Opening a reservation through the Reservation Book. See “Opening a reservation through the Reservation Book” on page 80.
- Opening a reservation through a group. See “Opening a reservation through a group” on page 80.
- Opening a reservation through a search. See “Opening a reservation through a search” on page 80.

Opening a reservation directly in the Navigator

1. On the toolbar, click the Navigator icon to open the Open Navigator dialog box.

![Open Navigator dialog box](image)

2. On the Open dropdown list, select the item that you are opening—reservation, booking, or service order.
3. Do one of the following:

- In the No. field, enter the number for the reservation, service order, or booking, and then click OK.
- To enter the last reservation, booking, or service order that you made during your current or last EMS session, double-click in the field, and then click OK.

If you do not know the reservation number, you can search for the reservation. On the Open Navigator dialog box, click Browse to open the Browser, and then continue to “Searching with the Browser or with the Web Reservation Tool” on page 197.

Opening a reservation through the Reservation Book

On the toolbar, click the Book icon to open the Reservation Book, and then in the Reservation Book, double-click a booking for the reservation to open the reservation in the Navigator. See “Viewing and Editing Reservations in the Reservation Book” on page 62.

Opening a reservation through a group

You can search for a reservation for a group and open the reservation in the Navigator from the group-specific window. See “Working with Reservations for a Group” on page 295.

Opening a reservation through a search

You can search for a reservation using the Browser, the Web Reservation Tool, and/or the Calendar, and then double-clicking the search result entry to open the reservation in the Navigator. See Chapter 4, “Search Tools,” on page 195.

You can also click Browse on the Open Navigator dialog box to open the Browser search tool.
Layout and folder structure

The Navigator has three panes—a left pane, a top right pane, and a bottom left pane. The left pane displays a selected reservation, all the bookings for the reservation, and the details for each booking in a Windows Explorer-style folder structure. The top-level folder is the reservation folder. The folders that are located beneath a reservation folder are the booking folders. The folders that are located beneath a booking folder are the booking detail folders. The top right pane of the Navigator displays different tabs and options depending on the folder or item that is selected in the left pane of the Navigator. The bottom right pane of the Navigator functions just like a browser window (see “Getting Started with EMS” on page 27), and it also displays different information and options depending on the folder or item that is selected in the left pane.

Figure 3-2: Navigator window with a reservation folder selected

Reservation folder

A reservation folder contains the who and the what information for the reservation. When you select a reservation folder in the left pane of the Navigator, the reservation number is displayed in the title bar of the Navigator, and the following tabs are displayed in the upper right pane of the Navigator:

- Reservation Summary tab—The Reservation Summary displays information about the selected reservation, including the event name, the group for which the reservation was made, the group contact name, the group contact phone number, and the reservation number.

- Properties tab—The Properties tab displays not only the same information as the Reservation Summary tab, but also information such as the event type, the second group contact, the date that the reservation was added, the date that the reservation was changed, and so on.
• Billing Reference Allocation tab—By default, the charge for a reservation is allocated to a single billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a reservation to multiple billing reference numbers by percentage. See “To allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.

• PO Number Allocation tab—By default, the charge for a reservation is allocated to a single purchase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reservation to multiple billing PO numbers by percentage. See “To allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.

• Reminders tab—The Reminders tab displays any reminders that were created for the selected reservation. See “Working with Comments and Reminders in the Navigator” on page 175.

• Comments—The Comments tab displays any text entries that were made for the selected reservation. See “Working with Comments and Reminders in the Navigator” on page 175.

• Attachments tab—The Attachments tab displays any attachments (files) that have been saved with the reservation. See “Working with Attachments in the Navigator” on page 184.

• User Defined Fields—The User Defined Fields tab displays the additional fields that store custom data for a reservation. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields. See “Working with User Defined Fields in the Navigator” on page 181.

• Transactions—The Transactions tab displays any invoices that were generated for the selected reservation or any payments that were applied to the selected reservation. See Chapter 9, “Billing,” on page 361 for detailed information about invoices and other financial transactions in EMS.

• History tab—The History tab displays the history for the reservation—the date that a change was made to the reservation, the ID of the user who made the change, the field that was changed, the old field value, and the new field value.

• Emails tab—The Emails tab displays any summarizing information for any emails that were sent via SMTP to the group for whom the reservation was made. See “Sending Email from EMS” on page 414.
Also, when you select a reservation folder:

- All the tabs in the upper pane of the window have some of the basic features of an EMS browser window. You can change the width of the data columns, you can sort the data columns on a tab in either ascending or descending sort order, and you can rearrange the column order by dragging a column to a new location using the column heading. See “An EMS Browser Window” on page 35.

- The bookings for the selected reservation are displayed in the Bookings pane (the lower right pane) of the Navigator. The colored rectangle to the left of a booking indicates the booking’s status. If a booking has been canceled, a Canceled icon is displayed on the booking folder in both the Reservation (left) pane and the Bookings pane.

- You can right-click in the upper pane and open a context menu with options for emailing the group for which the reservation was made, or the first contact for the group.

**To allocate charges to multiple billing reference numbers and/or PO numbers**

1. For a selected reservation, open the Billing Reference Allocation tab, and then click Edit.

   The Billing Reference Allocation dialog box opens. By default, when this dialog box first opens, it displays the charge for the reservation allocated 100% to a single billing reference number placeholder.

*Figure 3-3: Billing Reference Allocation dialog box*
2. Select the billing reference number placeholder, and then click Edit.

The Split Billing Add dialog box opens.

*Figure 3-4: Split Billing Add dialog box*

3. Do one of the following:

   - Enter the billing reference number to which you are allocating the reservation charges, and then click OK.

     The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with the newly added billing reference number allocated at 100%. Continue to Step 5.

   - Click the Search icon to open a Billing References dialog box, and then do one of the following:
     - Select a billing reference number from the list, click Select, and then click OK.
     - In the Find field, enter a search string, and then click Display to display a list of all billing reference numbers that meet your search criteria. Select the appropriate billing reference number from the search results, click Select, and then click OK.

---

*Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive, and it can appear anywhere in the search results. For example, a search string of 445 returns both 123.445.678 and 445.678.123.*

The Billing References dialog box closes. You return to the Split Billing Add dialog box with the selected billing reference number displayed in the dialog box. Continue to Step 4.

4. Click OK.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with the selected billing reference number allocated at 100%.
5. Do one of the following:
   - To allocate the reservation charges to only this single billing reference number, click OK.
     The Billing Reference Allocation dialog box closes and you return to the Navigator. The newly added billing reference number, allocated at 100%, is displayed on the Billing Reference Allocation tab.
   - To allocate the reservation charges to multiple billing reference numbers, continue to Step 6.

6. Click New.
   The Split Billing Add dialog box opens.

7. Do one of the following:
   - In the Billing Reference field, enter a billing reference number, and then click OK.
   - Click the Search icon to open a Billing References dialog box, and then do one of the following:
     - Select a billing reference number from the list, click Select, and then click OK.
     - In the Find field, enter a search string, and then click Display to display a list of all billing reference numbers that meet your search criteria. Select the appropriate billing reference number from the search results, click Select, and then click OK.

Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive, and it can appear anywhere in the search results. For example, a search string of 445 returns both 123.445.678 and 445.678.123.

The Split Billing Add dialog box closes. You return to the Billing Reference Allocation dialog box with each of the newly added billing reference numbers displayed with a 0% allocation.

8. Repeat Step 6 and Step 7 until you have added all the needed billing reference numbers.
9. For each new billing reference number, double-click in the Percent field to select the percent, and then change the percent to the appropriate value.

The percentages must add up to 100%.

10. Click OK to close the Billing Reference Allocation dialog box and return to the Billing Reference Allocation tab.

All the billing reference numbers and their percent allocations are displayed on the tab.

Booking folder

Booking folders contain the where and when information for the reservation. If you can expand a booking folder, this indicates that details have been added to the booking. The booking details for the selected booking are displayed in the Booking Details pane (the lower right pane) of the Navigator. A green background for a booking detail folder indicates that one or more booking detail items have been invoiced for the booking.

Figure 3-6: Navigator window with a booking folder selected

When you select a booking folder in the left pane of the Navigator, the booking number is displayed in the title bar of the Navigator, and the following tabs are displayed in the upper right pane of the Navigator:

- **Booking Summary tab**—The Booking Summary displays information about the selected booking, including the event date, the reserved time, the event time, and so on. If you use Outlook as your email program, you can do the following from this tab:
  - To add the selected booking to your personal calendar, click Outlook > Add to Personal Calendar.
  - To send invitations for the meeting to one or more contacts in your Outlook Address Book, click Outlook > Send Invitation.
Chapter 3
The Navigator

• Properties tab—The Properties tab displays not only the same information as the Booking Summary tab, but also information such as the event type, the setup count, the date that the booking was added, the date that the booking was changed, and so on.

• Billing Reference Allocation tab—By default, the charge for a booking is allocated to a single billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a booking to multiple billing reference numbers by percentage. See “To allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.

• PO Number Allocation tab—By default, the charge for a booking is located to a single purchase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reservation to multiple billing PO numbers by percentage. See “To allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.

• Reminders tab—The Reminders tab displays any reminders that were created for the selected booking. See “Working with Comments and Reminders in the Navigator” on page 175.

• Attachments—The Attachments tab displays any attachments that were saved with the booking. See “Working with Attachments in the Navigator” on page 184.

• Comments—The Comments tab displays any comments that were made for the selected booking. See “Working with Comments and Reminders in the Navigator” on page 175.

• Drawings—The Drawings tab displays a list of files that were attached to the selected booking. See “Working with Drawings in the Navigator” on page 188.

• History—The History tab displays a list of changes made for the selected booking—the date the change was made to the booking, the user who made the change to the booking, and information (field) that was changed for the booking.

Also, when you select a booking folder, all the tabs in the upper pane of the window have some of the same basic features of an EMS browser window. You can change the width of the data columns, you can sort the data columns on a tab in either ascending or descending sort order, and you can rearrange the column order by dragging a column to a new location using the column heading. See “To group data by columns in an EMS Browser window” on page 36 and “” on page 39.
Chapter 3  
The Navigator

**Booking detail folder**

If you can expand a booking folder, this indicates that details have been added to the booking. *Booking details*, which are also called *categories*, are the services (catering, A/V equipment, and so on), notes, attendees, activities, and room charges that you can add to a booking.

*Figure 3-7: Navigator window with a booking detail folder selected*

---

*Booking detail folders and booking detail items are discussed in “Booking Details and Items Overview” on page 133.*
Navigator commands

The Navigator has two constant commands in the upper left hand corner—Open Reservation and View Alerts and three constant commands in the upper right hand corner—Print, Refresh, and Settings.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Reservation</td>
<td>Allows you to open and work with multiple reservations in the same Navigator session. See “Opening a reservation directly in the Navigator” on page 79.</td>
</tr>
<tr>
<td>View Alerts</td>
<td>Open and view any alerts that have been generated for the selected reservation, booking, or a booking detail that is a service order or catering category.</td>
</tr>
</tbody>
</table>
| Print           | • Printing an invoice or a confirmation at the reservation level. See Chapter 7, “Confirmations,” on page 307.  
|                 | • Printing the Transaction report. See “Generating an EMS Billing Report” on page 394.  
|                 | • Printing the history of a reservation, all its bookings, and all its booking detail items. |
| Refresh         | For refreshing the Navigator display based on the settings that you have specified in the Navigator Options dialog box. See “Navigator Options dialog box” on page 90. |
| Settings        | • Options—Opens the Navigator Options dialog box in which you can specify such things as what is to be displayed in the Navigator, mouse actions in the Navigator, and so on. See “Navigator Options dialog box” on page 90.  
|                 | • Confirmation Settings—Opens the Confirmation Settings dialog box which provides a variety of options that you can specify for manual and automatic generation of a confirmation for a reservation or a booking. See Chapter 7, “Confirmations,” on page 307. |

All other navigator commands are available as buttons in the upper right pane and lower right pane of the Navigator.
Chapter 3
The Navigator

Navigator Options dialog box

The Navigator Options dialog box has three tabs—General, At A Glance, and Highlight Categories.

General tab

General tab—On the General tab, you select the options for such things as which types of bookings to show in the Navigator (old bookings and/or canceled bookings), the result of double-clicking a listed folder (opens the item or expands the folder), the booking time that is displayed (reserved time or event time), and the highlight color for invoiced items.

Figure 3-8: Navigator Options dialog box, General tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Show Old Bookings</td>
<td>Show bookings in the Navigator that occurred before the current day’s date.</td>
</tr>
<tr>
<td>Show Cancelled Bookings</td>
<td>Selected, show bookings in the Navigator with a canceled status.</td>
</tr>
<tr>
<td>Show Wizards in Tools menu</td>
<td>Show all on the Tools menu in the Bookings pane. If cleared, show only the “Wizards” option, which you must click to open a form from which you can select a tool.</td>
</tr>
<tr>
<td>Show Deleted Items</td>
<td>Show all deleted items (bookings, deleted resource items, and so on) for a reservation in the Navigator.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide Empty Tabs</td>
<td>Hide the tabs that do not have any data displayed on them for a selected reservation, booking, or booking detail.</td>
</tr>
<tr>
<td>Double-Clicking a Listed Folder</td>
<td></td>
</tr>
<tr>
<td>Opens the item</td>
<td>Opens the item for editing.</td>
</tr>
<tr>
<td>Expands folder</td>
<td>Opens the next level of folders.</td>
</tr>
<tr>
<td>Wizard Results</td>
<td></td>
</tr>
<tr>
<td>Always Show</td>
<td>Show a confirmation of all changes, regardless if they were successful, on a Wizard Results page.</td>
</tr>
<tr>
<td>Show Unchanged Only</td>
<td>Show only those changes that were not successful on a Wizard Results page.</td>
</tr>
<tr>
<td>Confirmation</td>
<td></td>
</tr>
<tr>
<td>Always prompt</td>
<td>When you click Confirmation, opens a Confirmation filter which you can use to change the default filter options for a confirmation before generating it.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>When you click Confirmation, opens an onscreen preview of the confirmation.</td>
</tr>
<tr>
<td>Email</td>
<td>When you click Confirmation, opens an email of the confirmation.</td>
</tr>
<tr>
<td>Print</td>
<td>When you click Confirmation, prints an immediate confirmation.</td>
</tr>
<tr>
<td>Booking Display Time</td>
<td></td>
</tr>
<tr>
<td>Reserved Time</td>
<td>Show the total time for which the space is reserved. This time is the event time plus the setup/teardown times.</td>
</tr>
<tr>
<td>Event Time</td>
<td>Show only the event time for which the space is reserved.</td>
</tr>
<tr>
<td>Invoiced Items</td>
<td></td>
</tr>
<tr>
<td>Highlight Color</td>
<td>The color with which invoiced items are highlighted in the Navigator window.</td>
</tr>
<tr>
<td>Service Orders</td>
<td></td>
</tr>
<tr>
<td>Show Pricing</td>
<td>Show pricing on a service order.</td>
</tr>
<tr>
<td>Show Item Notes</td>
<td>Show item notes on a service order.</td>
</tr>
<tr>
<td>Show Item Special Instructions</td>
<td>Show special instructions for items on a service order.</td>
</tr>
<tr>
<td>Highlight Changes Made Within (days)</td>
<td>Highlight any changes that have been made to a service order within the specified number of days.</td>
</tr>
<tr>
<td>Footer Message</td>
<td>Show reconfigured blocks of text that appear in footer of a service order (for example, a Cancellation policy).</td>
</tr>
<tr>
<td>Booking Edit</td>
<td></td>
</tr>
<tr>
<td>Auto Adjust Reserved Time When Event Time is Changed</td>
<td>If the reservation includes setup and/or teardown times, then automatically adjust the total time for the reservation (the event time plus the setup/teardown time) when the event time is changed.</td>
</tr>
</tbody>
</table>
At A Glance tab

On the At A Glance tab, you specify whether reminders, comments, attachments, and so on are to be displayed in the left pane of the Navigator when a reservation folder, booking folder, booking detail folder, and/or booking detail item is opened.

*Figure 3-9: Navigator Options dialog box, At A Glance tab*
Highlight Categories

On the Highlight Categories tab, you indicate whether a checkmark is to be displayed on all booking detail item folders for the selected booking detail. The default is to Highlight All, which means every booking detail item folder for every booking detail is denoted with a checkmark.

Figure 3-10: Navigator Options dialog box, Highlight Categories tab
Other Navigator commands

All other Navigator commands are available as buttons in the upper right pane and lower right pane of the Navigator. The buttons that are available are dynamically updated based not only on the folder or item that is currently selected in the left pane of the Navigator, but also on the tab that is open in the upper right pane of the Navigator.

Figure 3-11: Buttons available in the Navigator window with a reservation folder selected

Figure 3-12: Buttons available in the Navigator window with a booking folder selected
Many of these same commands are also available on a context menu, which is a menu that opens when you right-click on a folder or item in the Navigator. All the context menus that are available in the Navigator offer a limited set of choices based on the folder or item that is selected in the Navigator. See Figure 3-14 below and Figure 3-15 on page 96.

Figure 3-14: Comparing context menus
Chapter 3
The Navigator

Figure 3-15: Comparing context menus

Booking Detail context menu

Booking Detail Item context menu
Adding Bookings to a Reservation in the Navigator

You can use the Navigator to add one or more bookings to an existing reservation.

To add bookings to a reservation

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are adding the bookings, and then in the Bookings pane, click New.

   The Reservation Wizard opens. See “Making a Reservation Using the Reservation Wizard” on page 45.
Chapter 3
The Navigator

Editing a Reservation in the Navigator

When you edit a reservation in the Navigator, you are working with the who и the what information for the event—the event name, the group name, and so on. When you edit a reservation, you can edit the reservation information (event name, event coordinator, and so on), and you can edit the billing information (pricing plan, payment type, and so on).

---

When you edit a reservation, if you select a different pricing plan, then the pricing plan is applied at the reservation level only. Categories и room charges are not automatically repriced. To reprice your categories or room charges based on a new pricing plan, you must use the Update Pricing Plan wizard. See “Repricing Categories and Room Charges for a Reservation” on page 100.

---

To edit a reservation in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” на page 79.
   - “Opening a reservation through the Reservation Book” на page 80.
   - “Opening a reservation through a group” на page 80.
   - Chapter 4, “Search Tools,” на page 195.

2. In left pane the Navigator, select the reservation that you are editing, and then on the Reservation Summary tab or on the Properties tab, click Edit.

   The Reservation window opens. The Reservation tab is the active tab.

*Figure 3-16: Reservation window, Reservation tab*
3. Do one or both of the following:
   - On the Reservation tab, edit any and all the reservation information as needed.
   - Open the Billing tab, and then edit any and all the billing information as needed.

   **Figure 3-17: Reservation window, Billing tab**

   ![Reservation window, Billing tab](image)

   If you select a different pricing plan, then the pricing plan is applied at the reservation level only. Categories and room charges are not automatically repriced. To reprice your categories or room charges based on a new pricing plan, you must use the Update Pricing Plan Wizard. See “Repricing Categories and Room Charges for a Reservation” on page 100.

4. Click OK.

   The Reservation window closes and you return to the Navigator, which now shows the updated information for the reservation.
Repricing Categories and Room Charges for a Reservation

When you edit a reservation, if you select a different pricing plan, then the pricing plan is applied at the reservation level only. Categories and room charges are not automatically repriced. To reprice your categories or room charges based on a new pricing plan, then you must use the Update Pricing Plan Wizard.

To reprice categories and room charges for a reservation

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In left pane of the Navigator, select the reservation that you are repricing, and then on the Reservation Summary tab, click Update Pricing.

   The Update Pricing Plan Wizard opens. The current pricing plan for the reservation is displayed in the Pricing Plan field. The window displays all the categories, including room charges, that can be repriced in one or more of the reservation bookings.

*Figure 3-18: Update Pricing Plan Wizard*
3. Select the category, or CTRL-click to select the multiple categories that you are repricing for the reservation.

4. Click Next.
   The Select Bookings window opens. This window lists all the bookings with one or more of the selected categories that can be repriced.

   Figure 3-19: Update Pricing Plan Wizard, Select Bookings window

5. Select the booking, or CTRL-click to select the multiple bookings for which you are repricing the categories and/or room charges, or click Select All to select all the displayed bookings in a single step, and then click Finish.

   A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator.

---

You can reprice a room charge for a booking only if the room charge has not been invoiced. To reprice a room charge that has been invoiced, you must first void the invoice. See “To void an invoice” on page 372.
Chapter 3
The Navigator

Changing the Status for a Reservation from the Reservation Summary tab

Even though the Change Booking Status Wizard is available for changing the status of multiple bookings in a reservation, most reservationists who approve reservations that are submitted from VEMS do so by using the Change Status function that is available on the Reservation Summary tab in the Navigator. This is because unlike the Change Booking Status Wizard, when you use the Change Status function in the Navigator to change the status of a reservation, an option is available for automatically generating and sending a confirmation to the group for whom the reservation was made.

Your EMS administrator must grant you the appropriate security access to change the status of a booking, which includes canceling a booking. If you want to change the status of a booking using the Change Booking Status Wizard, see “Editing Multiple Bookings in the Navigator” on page 112.

An email can be automatically generated and sent only if Email is selected for the Confirmation setting on the General tab of the Navigator Options dialog box, and if the group for which the reservation was made has an email address in its record. See “Navigator Options dialog box” on page 90 and “Searching for and Configuring Groups” on page 255.

To change the status for a reservation

1. Open the reservation in the Navigator. See:
   • “Opening a reservation directly in the Navigator” on page 79.
   • “Opening a reservation through the Reservation Book” on page 80.
   • “Opening a reservation through a group” on page 80.
   • Chapter 4, “Search Tools,” on page 195.
2. In left pane the Navigator, select the reservation that you are editing, and then on the Reservation Summary tab, click Change Status.

   The Change Booking Status window opens. See Figure 3-20 on page 103.
3. On the Status dropdown list, select the new status for the bookings.

   *If you select any type of Canceled status, then three additional fields—Reason, Who Cancelled and Notes—are displayed on the Change Booking Status window. You must enter data in all three of these fields before you can continue in the Wizard.*

4. Enter a Reconfirm Date if it is required for the new status that you selected.

5. Optionally, do one or both of the following:
   - Leave Update Reservation Status selected to have the reservation-level status changed as well.
   - Select Send Confirmation If Successful to have an email automatically generated and sent to the group for whom the reservation was made.

   *The confirmation is generated based on the system confirmation settings that you have specified. See “Specifying your Confirmation Settings” on page 308.*
6. Click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date and that do not have invoiced items. By default, all the bookings are selected.

*Figure 3-21: Select Bookings window*

---

7. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the status, and then click Finish.

The Change Booking Status Results window opens. This window lists all the bookings for the reservation, whether the status was successfully changed or not.

*Figure 3-22: Change Booking Status Results window*
Optionally, to view only the bookings for the selected reservation that were NOT successfully changed, select Show Unchanged Only. To view the details for a specific booking that was changed, select the booking, and then click Go To.

8. Click Close to close the Change Status Results window and return to the Navigator.

If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens onscreen. If you close this report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
Chapter 3
The Navigator

Copying a Reservation in the Navigator

An easy way for you to make a new reservation in the Navigator is to copy an existing reservation and then make any necessary changes to the reservation. When you copy an existing reservation, you must provide a new start date and a new status; however, you can copy the existing reservation reminders, comments, user-defined fields, and drawings as is, and you can copy one or more or all the existing booking details.

To copy a reservation in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation that you are copying, and then in the Bookings pane, click Tools, and then click Copy Reservation Wizard.

   The Copy Reservation Wizard opens.

   Figure 3-23: Copy Reservation Wizard
3. Enter the information for the new reservation.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Start Date</td>
<td>The date of the first booking for the new reservation.</td>
</tr>
<tr>
<td>New Status</td>
<td>The status for the new reservation.</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>You must enter a date if it is required for the new status that you selected.</td>
</tr>
<tr>
<td>Conflict Status</td>
<td>You must enter a conflict status in the event that the new bookings are in conflict with any existing bookings.</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>You must enter a date if it is required for the new conflict status that you selected.</td>
</tr>
<tr>
<td>Copy Reminders</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Comments</td>
<td></td>
</tr>
<tr>
<td>Copy User Defined Fields</td>
<td></td>
</tr>
<tr>
<td>Copy Attachments</td>
<td></td>
</tr>
<tr>
<td>Copy Drawings</td>
<td></td>
</tr>
<tr>
<td>Copy Booking Details</td>
<td>Select the booking details that are being copied (CTRL-click to select multiple details) or to select all the details for copying, click Select All. <strong>Note:</strong> By default, only active booking details are displayed. To show inactive booking details for copying, click Show Inactive.</td>
</tr>
<tr>
<td>Copy Inactive Resources/Rooms</td>
<td>Selected by default. Copies the inactive resource and/or rooms from the existing reservation to the new reservation. Clear this option if you do not want to copy the inactive resources and rooms.</td>
</tr>
</tbody>
</table>

4. Click Next.

The Select Bookings window opens. This window displays all the bookings for the reservation that you are copying.

*Figure 3-24: Copy Reservation Wizard, Select Bookings window*
5. Select the booking, or CTRL-click to select the multiple bookings that you are recreating in the new reservation, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

The start date that you specified becomes the date of the first booking for the new reservation. In addition, the copied bookings are scheduled according to the same pattern as the existing reservation. For example, if the existing reservation has three bookings and each booking was scheduled every seven days (12/14, 12/21, and 12/28), and the start date for the new reservation is 12/15, then the new reservation has three bookings with dates of 12/15, 12/22, and 12/29.

When you copy multiple bookings, the bookings are simply copied and pasted as is—the bookings are not moved to a different location. If you need to move a booking to a different location, see “To edit the rooms for bookings” on page 118.

6. Click OK to close the message and return to the Navigator.

Both the existing reservation and the new reservation are now displayed in the left pane of the Navigator. The new reservation is assigned a number based on the next available reservation number in the database. If any of the new bookings are in conflict with existing bookings, this conflict is indicated in the Navigator.
Chapter 3
The Navigator

Editing a Booking in the Navigator

When you edit a booking in the Navigator, you are working with the when and where information for the event—the event time, the event location, and so on. To edit a booking, you must have the appropriate security access. For example, you cannot move a booking to a room if your EMS administrator has not granted you access to the room. Likewise, you cannot change the status for a booking from Tentative to Confirmed if your EMS administrator has not granted you access to the Confirmed status.

Under certain circumstances, bookings or booking details in EMS can become locked. Locked items are displayed in EMS, but you cannot edit or cancel the items. This locking can affect the basic booking information (date, time, room, and so on) or the details for the booking (catering, equipment, and so on). Locks are typically independent of one another. Just because one item is locked does not mean other items in the reservation are locked. Bookings can be locked in the following situations:

- Insufficient security—To edit a booking, you must have access to the room and status and as well as the correct security processes assigned to your user account.

Contact your EMS administrator for assistance.

- Old bookings—A booked event is locked a certain number of days after it has taken place. Your EMS administrator sets the value for this system parameter. Old bookings are locked to prevent you and other users from changing the facts for a past event, which could cause discrepancies between documents printed for the event and the information in EMS. When a booking is locked because it is old, all of its details are also locked. You cannot edit or delete existing details, and you cannot add new details.

- Invoiced bookings—When you create an invoice for a booking, you can bill for the entire booking (the room fee plus all the fees for all the booking details) or for only certain items that you choose (for example, the room fee and the equipment fees, but not the catering fees). In either case, if a booking has one or more invoiced items, the booking is locked. This means that you cannot edit or delete the booking, which includes changing the booking status, and editing and deleting invoiced resources. You can, however, still add more details to the bookings. For rooms, this means you cannot edit the room charge. You also cannot move bookings that are invoiced to a new or existing reservation. You can, however, still copy these bookings to a new or existing reservation.

To edit billable information for a booking, see “Editing Booking Detail Item Charges for Multiple Items” on page 161.

Remember, you can also edit certain booking information in the Reservation Book. See “To edit an existing reservation” on page 74.
To edit a booking in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible.

3. Select the booking that you are editing, and then on the Booking Summary tab or on the Properties tab, click Edit.

   The Booking window opens. A message is displayed at the top of the window that indicates the hours for the building that contains the selected room. If the booking has any type of booking detail assigned to it, then “This Booking has Service Orders” is displayed at the top of the window.

   Figure 3-25: Booking window
4. On the Booking tab, edit the information for the booking as needed, and then click OK.

If you have been granted the appropriate security access, you change the status of a booking, which includes cancelling a booking.

Two results are possible:

- If you edited anything other than the date, time, or location for a booking, the Booking window closes and you return to the Navigator, which now shows the updated information for the booking.

If you cancel a booking, a Cancel Status dialog box opens in which you must identify the user who canceled the booking and provide notes (for example, a cancellation reason) about the cancellation. If you change the status for a booking, you can select Update Reservation Status to have the reservation-level status changed as well.

- If you edited the date, time, or location for a booking, a dialog box opens, warning you that critical booking information has changed and asking you if you want to continue. Continue to Step 5.

5. Click Yes.

The Booking window closes and you return to the Navigator, which now shows the updated information for the booking.

If you edit a booking for a video conference event, then any date and time changes that you make to the booking automatically cascade to all related bookings.

If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens onscreen. If you close this report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
Editing Multiple Bookings in the Navigator

Four Wizards are available for editing the *when* and *where* information for *multiple* bookings in a reservation:

- The Change Booking Date/Time Wizard
- The Change Booking Status Wizard (which includes canceling multiple bookings in a single step)
- The Change Rooms Wizard
- The Change Miscellaneous Booking Information Wizard (which includes type, setup type, and setup count)

To edit billable information for a booking, see “Editing Booking Detail Item Charges for Multiple Items” on page 161.

Remember, you can also edit certain booking information in the Reservation Book. See “To edit an existing reservation” on page 74.

To edit multiple bookings in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation for which you are editing the bookings.

3. Continue to the following as appropriate:
   - “To edit the booking date and/or time” on page 113.
   - “To edit the booking status” on page 116.
   - “To edit the rooms for bookings” on page 118.
   - “To edit miscellaneous booking information” on page 125.
To edit the booking date and/or time

1. In the Bookings pane, click Tools > Change Booking Date/Time Wizard.
   The Change Booking Date/Time Wizard opens.

   **Figure 3-26: Change Booking Date/Time Wizard**

2. Select a different value for the date, time, or both.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td></td>
</tr>
<tr>
<td>(no changes)</td>
<td>The default value.</td>
</tr>
<tr>
<td>Reschedule Booking Earlier</td>
<td>Reschedule the bookings to an earlier date that is based on the number of days that you specify.</td>
</tr>
<tr>
<td>Reschedule Booking Later</td>
<td>Reschedule the bookings to a later date based on the number of days that you specify.</td>
</tr>
<tr>
<td>Reschedule Booking to Specific Date</td>
<td>Reschedule the bookings to a new date that you specify.</td>
</tr>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>(no changes)</td>
<td>The default value.</td>
</tr>
<tr>
<td>End Booking Earlier</td>
<td>Resets the event end time and the reserved end time to an earlier time, based on the number of hours that you specify.</td>
</tr>
<tr>
<td>End Booking Later</td>
<td>Resets the event end time and the reserved end time to a later time, based on the number of hours that you specify.</td>
</tr>
<tr>
<td>Reschedule Booking Earlier</td>
<td>Resets both the event start and end times and the reserved start and end times to an earlier time, based on the number of hours that specify.</td>
</tr>
</tbody>
</table>
Chapter 3  
The Navigator

3. Click Next.

The Select Bookings window opens. By default, this window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date.

**Figure 3-27: Change Booking Date/Time Wizard, Select Bookings window**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reschedule Booking Later</td>
<td>Resets both the event start and end times and the reserved start and end times to a later time, based on the number of hours that you specify.</td>
</tr>
</tbody>
</table>
| Reschedule Booking to Specific Time | Resets the following values based on the specific times that you select:  
  - Reserved Start  
  - Event Start  
  - Event End  
  - Reserved End |
| Set Setup/Teardown         | Resets the setup or teardown times based on the hours or minutes that you specify. |
| Start Booking Earlier      | Resets the event start time and the reserved start time to an earlier time, based on the number of hours that you specify. |
| Start Booking Later        | Resets the event start time and the reserved start time to a later time, based on the number of hours that you specify. |

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.
4. Select the booking, or CTRL-click to select the multiple bookings that you are editing, or click Select All to select all the displayed bookings in a single step, and then click Finish.

The Change Booking Date/Time Results window opens. This window displays a list of all the selected bookings, whether the date/time change was successful or not.

Figure 3-28: Change Booking Date/Time Results window

5. Click Close to close the Change Booking Date/Time Results window and return to the Navigator.

Optionally, to view only the bookings for the selected reservation that were NOT successfully changed, select Show Unchanged Only. To view the details for a specific booking that was changed, select the booking, and then click Go To.

If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens onscreen. If you close this report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
To edit the booking status

If your EMS administrator has granted you the appropriate security access, you can change the status of a booking, which includes canceling a booking. If you change the status for a booking, you can leave the option of Update Reservation Status selected to have the reservation-level status changed as well.


This is the same Wizard that opens if you select a reservation in the Navigator, and then on the Reservation Summary tab, click Change Status. See “Changing the Status for a Reservation from the Reservation Summary tab” on page 102.

Figure 3-29: Change Booking Status Wizard

2. On the Status dropdown list, select the new status for the bookings.

If you select any type of Canceled status, then three additional fields—Reason, Who Cancelled and Notes—are displayed on the Change Booking Status window. You must enter data in all three of these fields before you can continue in the Wizard.

3. Enter a Reconfirm Date if it is required for the new status that you selected.

4. Optionally, leave Update Reservation Status selected to have the reservation-level status changed as well.
5. Click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date and that do not have invoiced items. By default, all the bookings are selected.

*Figure 3-30: Change Booking Status Wizard, Select Bookings window*

6. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the status, or click Select All to select all the displayed bookings in a single step, and then click Finish.

The Change Booking Status Results window opens. This window displays a list of all the selected bookings, whether the status change was successful or not.

*Figure 3-31: Change Booking Status Results window*

> To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.
7. Click Close to close the Change Status Results window and return to the Navigator.

Optional, to view only the bookings for the selected reservation that were NOT successfully changed, select Show Unchanged Only. To view the details for a specific booking that was changed, select the booking, and then click Go To.

To edit the rooms for bookings

1. In the Bookings pane, click Tools > Change Room Wizard.

   The Change Room Wizard opens. Search for Rooms is selected by default.

   Figure 3-32: Change Room Wizard

2. Do one of the following:
   - To search for rooms, continue to “To search for rooms” on page 119.
   - To select a specific room, select Specific Room, and then continue to “To select a specific room” on page 123.
To search for rooms

1. Click Next.

   The Change Room Wizard Select Bookings window opens with a list of all the bookings for the selected reservation with a date greater than or equal to the current day’s date.

   *Figure 3-33: Change Room Wizard, Select Bookings window*

2. Select the time/room combination with which to work, and then click Next. (For example, an 8 a.m. event and a 2 p.m. event in the same room are displayed as two separate items; however, multiple 10 a.m. bookings in the same room on different dates are displayed as a single item with the number of bookings indicated in the Number of Bookings field.)

   The Change Rooms window is refreshed with options for changing the building, the room, the status, or any combination of these. See *Figure 3-34 on page 120.*
3. In the left pane of the Change Rooms window, select the booking, or CTRL-click to select the multiple bookings that you are moving to a new room, or click Select All to select all the displayed bookings in a single step.

4. In the right pane, change the building, the room specifications, the status, the room features, or any combination of these as needed for the selected bookings, and then click Next.

5. If you did not select a specific Setup Type, then go Step 7; otherwise, in the Setup Count field, enter a new setup count.

   Make sure that this count is the maximum that you expect the new room to hold.

6. Optionally, select one or both of the following to update the selected bookings with the following information for the new room:
   - Update Setup Type on Selected Bookings.
   - Update Setup Count On Selected Bookings (use Minimum).

7. Optionally, if you change the booking status, select Update Reservation Status to have the reservation-level status changed as well.
8. Click Next.

The Change Room Wizard is refreshed with an Available tab, and if applicable, a Conflicts tab. The Available tab is always the active tab.

- The Available tab contains two panes. The left pane lists all the rooms that meet some or all of your event criteria. The right pane lists all the event dates that must be fulfilled.
- The Conflicts tab lists all the rooms that are not available for the requested dates. Optionally, you can open the Conflicts tab to view the list of rooms that were not available for scheduling for the event as well as list of the events that are scheduled for each room.

The Conflicts tab is displayed only if there are any rooms that are not available for the requested dates based on your room search specifications. If no rooms are in conflict, then the tab is not displayed.

Figure 3-35: Change Rooms Wizard, Available tab

9. Select the new room that you are scheduling for the event.

10. Optionally, do one or both of the following; otherwise, go to Step 11.

- Click Room Info to open the Room Info dialog box and view information about the room properties, setup type, features, and pricing.
- Click Building Hours to open the Building Hours dialog box which displays the hours that the selected room/building is open on the reserved date.
11. Click the Move button (>) to move the room to the Selected list.

The selected room is displayed in the Rooms list in the right pane of the Available tab for every event date for which the room is available.

12. If all the event dates are fulfilled, click Finish; otherwise, repeat Step 9 through Step 11 until all the event dates are fulfilled, and then click Finish.

A message opens, asking you if you want to change any more rooms.

13. Click Yes to repeat this procedure for any other bookings for the selected reservation; otherwise, click No close the message.

The Change Rooms Results window opens. This window displays a list of all the selected bookings, whether the room change was successful or not.

*Figure 3-36: Change Room Wizard, Results window*

![](image)

*Optionally, to view only the bookings for the selected reservation that were NOT successfully changed, select Show Unchanged Only. To view the details for a specific booking that was changed, select the booking, and then click Go To.*

14. Click Close to close the Change Room Results window and return to the Navigator.

If you reserve a resource and then edit the date, time, location, or status of a booking, and there is a resource inventory conflict, a Resource Inventory Conflicts report opens onscreen. If you close this report, you can manually run a Resource Inventory Conflict check. In the Bookings folder of the Navigator, select Tools > Resource Inventory Conflict.
To select a specific room

When you search for a specific room, you can search for a room within your facilities, or you can search for an override room, which is a room that is within your facilities but is not typically scheduled for events or it is outside of your facilities. If you specify an override room for an event, you must manually specify the location for the event.

1. Click the Search icon.

   The Room Selector dialog box opens. This dialog box lists all the rooms in all the buildings to which you have been granted access.

---

2. Do one of the following:
   - Open the Building dropdown list and select (all) buildings, or a specific building, area, or view.
   - Select the room, and then click OK.

---

\[ If \text{ you are selecting an override room, make sure to select the appropriate room, for example, one named OVR.}\]

   - If you are selecting a standard room or a combo room, go to Step 4; otherwise, if you are selecting an override room, go to Step 3.

3. In the Location field, enter the location for/description of the override room.
4. Click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date.

*Figure 3-38: Change Room Wizard, Select Bookings window*

5. Select the booking, or CTRL-click to select the multiple bookings that you are moving to a new room, or click Select All to select all the displayed bookings in a single step, and then click Finish.

The Change Rooms Results window opens. This window displays a list of all the selected bookings, whether the room change was successful or not.

*Figure 3-39: Change Rooms Results window*
6. Click Close to close the Change Rooms Results window and return to the Navigator.

To edit miscellaneous booking information

Miscellaneous information that you can edit for multiple bookings includes the event name, the event type, the setup type, the setup count, and the attendance.

1. In the Bookings pane, click Tools > Change Miscellaneous Booking Information Wizard.

The Change Miscellaneous Booking Information Wizard opens.

Figure 3-40: Change Miscellaneous Booking Information Wizard

2. Select the information that you are changing, enter the new value for the selected information, and then click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date. See Figure 3-41 on page 126.
Figure 3-41: Change Miscellaneous Booking Information Wizard, Select Bookings window

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

3. Select the booking, or CTRL-click to select the multiple bookings for which you are changing the information, or click Select All to select all the displayed bookings in a single step, and then click Finish.

   A message opens, indicating that the changes were made successfully.

4. Click OK to close the message and return to the Navigator.
Moving Bookings to a Different Reservation

You use the Move Bookings reservation to move one or more bookings that do not have invoiced items from a selected reservation to an existing reservation or to an entirely new reservation. When you move a booking from a selected reservation, the booking and all its associated details are removed entirely from the selected reservation.

To move bookings to a different reservation

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are moving the bookings.

3. In the Bookings pane, click Tools, and then click Move Bookings Wizard.
   The Move Bookings Wizard opens. The option to move the bookings to an Existing Reservation is selected by default.

*Figure 3-42: Move Bookings Wizard*
4. Do one of the following:
   - In the Existing Reservation field, enter the reservation number for the existing reservation to which you are moving the bookings.
   - Click New Reservation.

5. Click Next.

The Select Bookings window opens. This window lists all the bookings for the selected reservation that do not have invoiced items.

*Figure 3-43: Move Bookings Wizard, Select Bookings window*

6. Select the booking, or CTRL-click to select the multiple bookings that you are moving to the new or existing reservation, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.

Both the old reservation and the new or existing reservation are now displayed in the left pane of the Navigator. If you moved the bookings to a new reservation, then the new reservation that is created is assigned the next available reservation number in the database. If you moved the bookings to an existing reservation and any of the moved bookings are in conflict with bookings in the existing reservation, then this conflict is indicated in the Navigator.
Copy Bookings in the Navigator

You use the Copy Bookings Wizard to copy one or more bookings to a new date or to a set of dates, either within the same reservation or to a new reservation.

To copy multiple bookings in the Navigator

1. Open the reservation in the Navigator. See:
   • “Opening a reservation directly in the Navigator” on page 79.
   • “Opening a reservation through the Reservation Book” on page 80.
   • “Opening a reservation through a group” on page 80.
   • Chapter 4, “Search Tools,” on page 195.
2. In the left pane of the Navigator, select the reservation from which you are copying the bookings.
3. In the Bookings pane, click Tools, and then click Copy Bookings Wizard.
   The Copy Bookings Wizard opens. Copy to Reservation No. is selected by default and the number for the reservation from which you are copying the bookings is displayed in the field.

Figure 3-44: Copy Bookings Wizard
4. Do one of the following:

- To copy the bookings to an existing reservation, click the Search icon to open the Open Navigator dialog box and search for the reservation. (See “Opening a reservation in the Navigator” on page 79.)
- To copy the bookings to a new reservation, click Copy to New Reservation.

5. Enter the information for the reservation to which you are copying the bookings.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description/Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Start Date</td>
<td>The date of the first booking for the new reservation.</td>
</tr>
<tr>
<td>New Status</td>
<td>The status for the new reservation.</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>Enter if required for the new status that you selected.</td>
</tr>
<tr>
<td>Conflict Status</td>
<td>You must enter a conflict status in the event that the new bookings are in conflict with the existing bookings.</td>
</tr>
<tr>
<td>Reconfirm Date</td>
<td>Enter if required for the new conflict status that you selected.</td>
</tr>
<tr>
<td>Copy Reminders</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Comments</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy User Defined Fields</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Attachments</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Drawings</td>
<td>Leave the appropriate options selected to copy the existing items as is, or clear the option for each item that is not to be copied to the new reservation.</td>
</tr>
<tr>
<td>Copy Booking Details</td>
<td>Select the booking details that are being copied (CTRL-click to select multiple details) or to select all the details for copying, click Select All. <strong>Note:</strong> By default, only active booking details are displayed. To show inactive booking details for copying, click Show Inactive.</td>
</tr>
<tr>
<td>Copy Inactive Resources/Rom</td>
<td>Selected by default. Copies the inactive resource and/or rooms from the existing bookings to the new bookings. Clear this option if you do not want to copy the inactive resources and rooms.</td>
</tr>
</tbody>
</table>

6. Click Next.

The Select Bookings window opens. This window displays all the bookings for the copied reservation, regardless of the date or status. See Figure 3-45 on page 131.
Figure 3-45: Copy Bookings Wizard, Select Bookings window

7. Select the booking, or CTRL-click to select the multiple bookings that you are recreating in the existing or new reservation, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.

The start date that you specified becomes the date of the first new booking. In addition, the copied bookings are scheduled according to the same pattern as the existing reservation. For example, if the existing reservation has three bookings and each booking was scheduled every seven days (12/14, 12/21, and 12/28), and the new start date for the first booking is 12/15, then the existing or new reservation has three bookings with dates of 12/15, 12/22, and 12/29.

When you copy multiple bookings, the bookings are simply copied and pasted as is—the bookings are not moved to different location. If you need to move a booking to a different location, see “To edit the rooms for bookings” on page 118.
8. Click OK to close the message and return to the Navigator.

The reservation from which you copied the bookings and the reservation to which you copied the bookings are displayed in the left pane of the Navigator. If you moved the bookings to a new reservation, then the new reservation that is created is assigned the next available reservation number in the database. If any of the new bookings are in conflict with bookings in the existing reservation, this conflict is indicated in the Navigator.
Chapter 3
The Navigator

Booking Details and Items Overview

*Booking details*, which are also called *categories*, are the services (catering, A/V equipment, and so on), notes, attendees, activities, or room charges that you can add to a booking. *Booking detail items*, also called *resources*, are the individual items (coffee, sandwich, projector, and so on) that you add to a booking detail. When you add a resource to a booking, for example, coffee, various selections might be available or required, for example, regular, decaf, Italian roast, breakfast blend, and so on. Depending on how your EMS administrator has configured your categories, a resource might require *service order* times to be specified.

---

*Your EMS administrator can configure buildings and categories so that a particular category can be used only in a particular building or buildings. This means that when you are adding booking details to a reservation, some booking details (categories) might not be displayed as an option.*

The booking details for a selected booking are displayed in the Booking Details pane (the lower right pane) of the Navigator.

---

*From this point on in the manual, categories that contain resources, but do not require service times are referred to as “resource categories.” Categories that contain resources and that require service times are referred to as “service order categories.” Categories that are used to manage food service are referred to as “catering categories.” Categories that are used to manage miscellaneous notes (setup notes), agenda items, attendees/visitors, or room charges are referred to as “non-resource categories.”*

*Figure 3-46: The Navigator window with a booking folder selected*
If you select a booking detail folder that is for a Resource with Service Order category or a Catering category, then the service order number is displayed in the title bar of the Navigator.

Figure 3-47: The Navigator window with a booking detail folder selected

When you select a booking detail folder in the left pane of the Navigator, the tabs that are displayed in the upper right pane of the Navigator depend on the type of booking detail that you selected.

- **<Booking Detail> Summary tab**—The Summary displays information about the selected booking detail, including the event date, the event location, and the event status.

- **Properties tab**—The Properties tab also displays information about the booking detail, including the date that it was added to the booking, who added the detail, and, if applicable, the date that the detail was changed and who made the change.

If the booking detail has a price/charge associated with it, for example, a room charge, then the following two tabs are also displayed:

- **Billing Reference Allocation tab**—By default, the charge for a booking detail can be allocated to a single billing reference number. On the Billing Reference Allocation tab, you can allocate the charge for a reservation to multiple billing reference numbers by percentage. See “To allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

---

Your EMS administrator must enable the Use Billing Reference Allocation parameter for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.
• PO Number Allocation tab—By default, the charge for a booking detail can be allocated to a single purchase order (PO) number. On the PO Number Allocation tab, you can allocate the charge for a reservation to multiple billing PO numbers by percentage. See “To allocate charges to multiple billing reference numbers and/or PO numbers” on page 83.

Your EMS administrator must enable the Use PO Number Allocation parameter for this tab to be displayed. See EMS System Parameters in the EMS Setup Guide.

If the selected booking detail requires a service order or catering category, then the following four tabs are also displayed:

• User Defined Fields tab—The User Defined Fields tab displays the additional fields that store custom data for the booking detail. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields. See “Working with User Defined Fields in the Navigator” on page 181.

• Reminders tab—The Reminders tab displays any reminders that were created for the selected booking detail. See “Working with Comments and Reminders in the Navigator” on page 175.

• Comments tab—The Comments tab displays any comments that were made for the selected booking detail. See “Working with Comments and Reminders in the Navigator” on page 175.

• History tab—The History tab displays the history for the booking detail—the date that a change was made to the detail, the ID of the user who made the change, the field that was changed, the old field value, and the new field value.

Also, when you select a booking detail folder:

• Most of the tabs in the upper pane of the window have some of the basic features of an EMS Browser window. You can change the width of the data columns, you can rearrange the column order by dragging a column to a new location using the column heading, and you can sort the data columns in either ascending or descending sort order. See “An EMS Browser Window” on page 35.

• The booking detail items for the selected booking detail are displayed in the Items pane (the lower right pane) of the Navigator. A green check mark appears in front of each individual item that has been added to a booking. If the item is a package, then a green checkmark is displayed not only in front of the package, but also, in front of each individual item in the package. A red “x” is displayed in front of any booking detail and/or booking detail item that has been deleted from a booking. The Items pane has all the features of an EMS Browser window. See “An EMS Browser Window” on page 35.

If you select a booking details item in the left pane of the Navigator, then the entire right pane of the Navigator is refreshed with three tabs—a Properties tab that displays for the selected item, a Selections tab that displays the selections for the booking detail item (if applicable), and a History tab that details the history of the item.
Service order

A booking detail might include a service order. A service order is a request to use the resource for a specified time period as opposed to using the resource for the entire event. For example, an event that meets from 10:00 am to 2:00 pm, might have food service from 11:00 am to noon. A service order consists of the service type, start and end times, and a unique, system-generated service order ID. For a catering booking detail, you can also indicate estimated count, guaranteed count, and actual count. You can create multiple service orders in the same booking. For example, you might have a number of catering services (breakfast, lunch, and afternoon refreshments) in the course of a one day training event. In this case, multiple folders are displayed under the booking folder on the left side of the Navigator window, with each folder representing a unique service order.

Figure 3-48: The Navigator window with a booking detail item selected

Figure 3-49: The Navigator window showing multiple service orders in the same booking
If you reserve an item from a category that does not require a service order, your only choices are to reserve the item for the event time or for the entire reserved time.

*Your EMS administrator might have configured a default service type for some or all of your system’s categories, but you can always select a different value. In addition, your EMS administrator might have configured states to manage your service order process. For detailed information about states, see Configuring Categories in the EMS Setup Guide.*
Adding Booking Details and Items to Individual Bookings

The steps that you follow to add booking details and items to individual bookings depend on the category type. Also, you can add multiple occurrences of a booking detail to a booking only if the booking detail is a Resource with Service Order category or a Catering category. If the booking detail is not a Resource with Service Order category or a Catering category, and the detail is already added to a booking, you cannot add the detail again to the booking. You can, however, add more items to the booking detail.

To add booking details and items to individual bookings

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible.

3. Select the booking folder, and then in the Booking Details pane, click New. The Booking Details list opens.

   Figure 3-50: Example of a Booking details List

4. Select the booking detail that you are adding to the booking.

   A dialog box opens.
Continue to one of the following:

- “To add a booking detail from a non-resource category” below.
- “To add a booking detail from a resource, service order, or catering category” on page 144.

To add a booking detail from a non-resource category

A booking detail that is from a non-resource category can be setup notes, attendees, agenda (activities), or a room charge.

To add setup notes

*Image: Setup Notes dialog box*

1. Enter the sequence number for the setup notes.

   The sequence number determines the order in which the notes are displayed in the Items pane in the Navigator when the booking detail (Setup Notes) is selected for a booking.

2. Enter the appropriate notes or comments.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be excluded from external reports like a confirmation), then select Internal.
4. Click OK.

The Setup Notes dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

---

*After you add setup notes for the first time to a booking, Setup Notes is no longer an available option on the Booking Details dropdown list. To add more setup notes to the booking, select the Setup Notes folder for the booking or click a Setup Note in the Items pane, and then click New.*

To add attendees

*Figure 3-52: Attendees dialog box*

1. Enter the information for the attendee. At a minimum, you must enter the attendee name.
2. If the attendee is a visitor (that is, not registered for the event), then select Visitor.
3. Click OK.

The Attendee dialog box remains open.

4. Repeat Step 1 through Step 3 until you have added all the needed attendees/visitors to the booking.
5. Click Cancel.

The Attendees dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

---

If you close the Attendees dialog box before you have added all the needed attendees/visitors to the booking, then Attendees is no longer an available option on the Booking Details dropdown list. To add more attendees/visitors to the booking, select the Attendees folder for the booking or click an attendee/visitor in the Items pane, and then click New.

To add an agenda (activities)

Figure 3-53: Agenda dialog box

1. Enter the start time, the end time, and a description for the agenda.
2. Optionally, in the Description field, enter a name or description for the agenda.

   The description can be a maximum of 50 characters, including spaces.

3. Optionally, if these notes are to be printed on internal reports only (the notes would be excluded from external reports like a confirmation), then select Internal.
4. Click OK.

The Agenda dialog box remains open.
5. Repeat Step 1 through Step 4 until you have added all the needed agendas.

6. Click Cancel.

   The Agenda dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

   **If you close the Agenda dialog box before you have added all the needed agendas/activities to the booking, then Agenda is no longer an available option on the Booking Details dropdown list. To add more agenda/activities to the booking, select the Agenda folder for the booking or click an agenda in the Items pane, and then click New.**

**To add a room charge**

*Figure 3-54: Room Charge dialog box*

1. Enter the sequence number for the room charge.

   **The sequence number determines the order in which the charges are displayed in the Items pane in the Navigator when the booking detail (Room Charge) is selected for a booking.**

2. Optionally, enter notes or comments about the room charge.

3. If needed, edit the quantity.
4. Select the appropriate pricing method, and then enter any other additional information as needed after you select a pricing method.

<table>
<thead>
<tr>
<th>Pricing Method</th>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>• Unit Price</td>
</tr>
<tr>
<td>Half Day/Full Day (Event Time)</td>
<td>• Half Day Price</td>
</tr>
<tr>
<td></td>
<td>• Full Day Price</td>
</tr>
<tr>
<td></td>
<td>• Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Reserved Time)</td>
<td>• Half Day Price</td>
</tr>
<tr>
<td></td>
<td>• Full Day Price</td>
</tr>
<tr>
<td></td>
<td>• Hours</td>
</tr>
<tr>
<td>Hourly (Event Time)</td>
<td>• Hourly Price</td>
</tr>
<tr>
<td></td>
<td>• Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>• Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>• Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Reserved Time)</td>
<td>• Hourly Price</td>
</tr>
<tr>
<td></td>
<td>• Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>• Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>• Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Specific)</td>
<td>• Hourly Price</td>
</tr>
<tr>
<td></td>
<td>• Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>• Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>• Initial Flat Charge</td>
</tr>
</tbody>
</table>

5. Optionally, enter a discount percent and/or a reservation discount.

6. Click OK.

The Room Charge dialog box closes. The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.

---

*If you must add multiple room charges to a booking, then after you add charges for the first time to a booking, Room Charge is no longer an available option on the Booking Details dropdown list. To add more charges to the booking, select the Room Charge folder for the booking or click a room charge in the Items pane, and then click New.*
To add a booking detail from a resource, service order, or catering category

- If you select a service order or catering category, a Service Order dialog box opens with, at a minimum, options for Service, Reviewed, Service Start Time, and End Time. If a catering category is selected, additional fields for Estimated, Guaranteed and Actual Counts are displayed. Go to Step 1.

*Figure 3-55: Example of a Service Order dialog box for a catering category*

- If you select a resource category, then a Resource Selection dialog box opens. The Resources tab is the active tab. Go to Step 4.

*Figure 3-56: Example of a Resource Selection dialog box, Resources tab*

1. Select the service type.
2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and if applicable, select Reviewed and/or a state.

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.

3. Click OK.

A Resource Selection dialog box. The Resources tab is the active tab.

4. Do one of the following

   • To select one or more resources from the pre-configured list of resources, leave the Resources tab open, and then go to Step 5.
   
   • To add multiple resources to the booking in a single step, open the Packages tab, and then go to Step 7.

5. Do one of the following on the Grouping dropdown list:

   • Leave the default value of (all) as is to search for all items in all groupings.
   
   • Select a specific grouping to search for only those items in the grouping. For example, if the selected resource category is A/V Equipment, then available groupings could include Computer, Phone, Video, and so on. To search only for the available phones to add to a booking detail, select the Phones grouping.

6. Optionally, in the Filter field, enter a search string by which to filter your search.

   Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of co returns coffee service, conference phone, and mini-copier.

7. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

   If you change the quantity for a resource package, then the quantity for each individual resource that makes up the package is also changed.
8. Do one of the following:

- For the Resources tab—On the Items list, select the resource item, or CTRL-click to select the multiple resource items that you are adding to the booking.

Your EMS administrator might have configured an override resource (also known as an override description) so that you can book a resource that has not been configured in your EMS database. For example, the administrator might have configured an override resource named “Other.” If you select the “Other” resource, then a Description field is displayed on the Resource Selection dialog box. You must enter a description or name for the override resource before you can continue. EMS does not track availability of override resource items; however, EMS reports on override resource items just like any other resource item.

- For the Package tab—Select the package that contains the multiple resources that you are adding to the booking.

9. Click Select.

- For items on the Resources tab—if your EMS administrator configured selections for the resource, then either you might be required to make selections for the resource, or you have the option to make selections for the resource (see Figure 3-57 below); otherwise, go to Step 10.

Figure 3-57: Example of a Resource Selections dialog box

- For packages on the Packages tab—the package is added to the booking. An entry for the package as well as entry for each item in the package is displayed in the Booking Detail Items pane of the Navigator.

10. Repeat Step 4 through Step 9 until you have added all the necessary booking detail items for the selected booking.
11. Click Close.

The Resource Selection dialog box closes. The resource and its items are displayed as folders under the Booking folder in the Navigator.

---

If you close the Resource Selection dialog box before you have added all the needed resource items to the booking, and the booking detail is not from a catering or service order category, then the booking detail is no longer an available option on the Booking Details dropdown list. To add more resource items to the booking, you can select the Booking Detail folder for the booking or you can click a booking detail item in the Items pane, and then click New.
Adding Booking Details and Items to Multiple Bookings

You use the Add Booking Details Wizard to add booking details and items to multiple bookings in a single step. The steps that you follow depend on the category type. Also, you can add multiple occurrences of a booking detail to bookings only for service order and catering categories. If the booking detail is not a service order or catering category, and the detail is already added to the bookings, you cannot add the detail again to the bookings. (You can, however, add more items to the bookings. See “Adding Booking Detail Items to Multiple Bookings” on page 155.)

You can also manually copy booking details and items from one booking to another. To copy a booking detail, right-click on the booking detail that is being copied, and on the context menu that opens, click Copy. Right-click on the booking to which the booking detail is being copied, and on the context menu that opens, click Paste.

To add booking details and items to multiple bookings

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are adding the booking details and items.

3. In the Bookings pane, click Tools, and then click Add Booking Details Wizard.
   The Add Booking Details Wizard opens. See Figure 3-58 on page 149.
4. Select the booking detail that you are adding to one or more of the bookings for the selected reservation, and then continue to one of the following:

   - “To add a booking detail from a non-resource category.”
   - “To add a booking detail from a resource, service order, or catering category” on page 151.

To add a booking detail from a non-resource category

If you select a booking detail of any type other than resource, service order, or catering, (for example, attendees or setup notes), then to add the detail to the bookings, you follow the same general steps:

1. Select the booking detail.
2. Click Next, and then enter the information for the booking detail.
   - If you are adding setup notes, see “To add setup notes” on page 139.
   - If you are adding attendees/visitors, see “To add attendees” on page 140.
   - If you are adding an agenda or activities, see “To add an agenda (activities)” on page 141.
   - If you are adding room charges, see “To add a room charge” on page 142.
3. Click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date, and that do not already have the selected booking detail added.

Figure 3-59: Add Booking Details Wizard, Select Bookings window

4. Select the booking, or CTRL-click to select the multiple bookings to which you are adding the details, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens asking you if you want to add more booking details.

5. Do one of the following:
   • Click Yes to return to the Add Booking Details Wizard.
   • Click No.

A message opens indicating that the changes were made successfully.

6. Click OK to close the message and return to the Navigator.

The booking detail and its items are displayed as folders under the Booking folder in the Navigator window.
To add a booking detail from a resource, service order, or catering category

- If you select a service order or catering category, then the Add Booking Details Wizard is updated with, at a minimum, options for Service, Reviewed, Start Time, and End Time. If you select a catering category, additional fields for Estimated, Guaranteed and Actual Counts are displayed. In both cases, a State option might also be displayed. Go to Step 1.

![Figure 3-60: Example of the Add Booking Details Wizard for a resource with a service order](image)

- If you select a resource category, then two results are possible:
  - The Add Booking Details Wizard is updated with options for Reviewed and/or State. If applicable, select Reviewed and/or select a State, click Next to open the Add Booking Details Wizard, and then go to Step 3.
  - The Add Booking Details Wizard opens with two tabs—Resources and Packages. The Resources tab is the active tab. This tab displays a pre-configured list from which you can select one or more resources. Go to Step 3.

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.

1. Select the service type.
2. Enter the start time, and optionally, the end time, estimated count, guaranteed count, and select Reviewed and/or a state.

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.
3. Do one of the following:
   • To choose one or more resources from the pre-configured list of resources, leave the Resources tab open, and then go to Step 4.
   • To add multiple resources to the booking in a single step, open the Packages tab, and then go to Step 6.

4. Do one of the following on the Grouping dropdown list:
   • Leave the default value of (all) as is to search for all items in all groupings.
   • Select a specific grouping to search for only those items in the grouping. (For example, if the selected resource category is A/V Equipment, then available groupings could include Computer, Phone, Video, and so on. To search only for the available phones to add to a booking detail, select the Phones grouping.)

5. Optionally, in the Filter field, enter a search string by which to filter your search.

Your search is limited to the exact order of the characters in the string, but the string can is not case-sensitive and it can appear anywhere in the search results. For example, a search string of co returns coffee service, conference phone, and mini-co-pier.

6. In the Quantity field, leave the default value of 1.00; otherwise, enter a new value.

If you change the quantity for a resource package, then the quantity for each individual resource that makes up the package is also changed.
7. Do one of the following:
   • For the Resources tab—On the Items list, select the resource item, or CTRL-click to select the multiple resource items that you are adding to the booking.

![Your EMS administrator might have configured an override resource (also known as an override description) so that you can book a resource that has not been configured in your EMS database. For example, the administrator might have configured an override resource named “Other.” If you select the “Other” resource, then a Description field is displayed on the Resource Selection dialog box. You must enter a description or name for the override resource before you can continue. EMS does not track availability of override resource items; however, EMS reports on override resource items just like any other resource item.](image)

8. Click Next.
   • For items on the Resources tab—If your EMS administrator configured selections for the resource, then either you might be required to make selections for the resource, or you have the option to make selections for the resource (see Figure 3-62 below); otherwise, go to Step 9.

![Use the Move Up and Move Down options to order the selected items. To edit a selected item before you add it to multiple bookings, select the item, and then click Edit.](image)

   • For the Package tab—Select the package that contains the multiple resources that you are adding to the booking.

![Figure 3-62: Example of a Resource Selections dialog box](image)
• For packages on the Packages tab—The package is added to the booking. An entry for the package as well as entry for each item in the package is displayed in the Booking Detail Items pane of the Navigator.

9. Click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date, and that do not already have the selected booking detail added.

**Figure 3-63: Add Booking Details Wizard, Select Bookings window**

10. Select the booking, or CTRL-click to select the multiple bookings to which you are adding the details, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens asking you if you want to add more booking details.

11. Do one of the following:

   • Click Yes to return to the Add Booking Details Wizard.
   
   • Click No.

   A message opens indicating that the changes were made successfully.

12. Click OK to close the message and return to the Navigator.

The booking detail and its items are displayed as folders under the Booking folder in the Navigator.

---

*To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.*
Adding Booking Detail Items to Multiple Bookings

You use the Add Item Wizard to add booking detail items to multiple bookings for categories that are already added to the bookings. For example, you can use this Wizard to add food service items only if any of the bookings already has food service added as a booking detail.

---

To add booking details and items for categories that are not already in use, see “Adding Booking Details and Items to Multiple Bookings” on page 148.

---

To add booking detail items to multiple bookings

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are adding the booking detail items.

3. In the Bookings pane, click Tools, and then click Add Item Wizard.

   The Add Item Wizard opens. The first window in this Wizard, the Select Category window, displays only those categories that are already in use for any of the bookings in the reservation. See Figure 3-64 on page 156.
4. Select the category to which you want to add items.
5. Click Next.

The steps that you now must follow depend on the category type. See:

- “To add a booking detail from a non-resource category” on page 149.
- “To add a booking detail from a resource, service order, or catering category” on page 151.
Chapter 3
The Navigator

Editing Booking Detail Items for Individual Bookings

After you have added booking details and items to bookings for a reservation, you can edit any non-invoiced item on an individual basis.

To edit the pricing information for multiple non-invoiced items in a single booking, or for multiple non-invoiced items in multiple bookings, see “Editing Booking Detail Item Charges for Multiple Items” on page 161.

To edit booking detail items for individual bookings

1. Open the reservation in the Navigator. See:
   • “Opening a reservation directly in the Navigator” on page 79.
   • “Opening a reservation through the Reservation Book” on page 80.
   • “Opening a reservation through a group” on page 80.
   • Chapter 4, “Search Tools,” on page 195.
2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking detail items folder is visible, and then do the following:
   • Select the booking detail folder that contains the items that you are editing.
   • In the Items pane, select the item that you are editing.
3. Continue to one of the following:
   • “To edit a booking detail item from a non-resource category” on page 158.
   • “To edit a booking detail item from a resource, service order, or catering category” on page 158.
To edit a booking detail item from a non-resource category

1. Click Edit.
   
   The <Booking Detail> dialog box opens.

2. Edit the item as necessary, and then click OK to close the <Booking Detail> dialog box and return to the Navigator.

   For detailed information about editing a booking detail item from a non-resource category, see:
   
   • “To add setup notes” on page 139.
   • “To add attendees” on page 140.
   • “To add an agenda (activities)” on page 141.
   • “To add a room charge” on page 142.

To edit a booking detail item from a resource, service order, or catering category

1. Click Edit.

   The <Resource> dialog box opens. The Resource tab is the active tab. If selections are available for the resource, then the dialog box also has a Selections tab.

   Figure 3-65: <Resource> dialog box, Resource tab
2. On the Resource tab, edit the information as necessary.
   - If applicable, select a completely different item for the resource.
   - The sequence number determines the order in which the items (for example, juice, muffins, and so on) are displayed in the list in the Items pane in the Navigator when the booking detail (for example, Catering) is selected for a booking. If needed, edit the sequence number.
   - The Time in Use indicates the time that the resource is to be available for the booking. If needed, edit the Time in Use.

   For a definition of Event Time or Reserved Time, see “Event Timeline” on page 44. You can edit the Time In Use only if the item is not from a resource from a service order or catering category. (The Time in Use is applied at the category level for these types of resources).

   - If the notes are to be printed on internal reports only (the notes would be excluded from external reports like a confirmation), then select Internal.
   - If you edit the pricing method, then make sure to enter any other additional information as needed.

<table>
<thead>
<tr>
<th>Pricing Method</th>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>Unit Price</td>
</tr>
<tr>
<td>Half Day/Full Day (Event Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Reserved Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td></td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Half Day/Full Day (Service Time)</td>
<td>Half Day Price</td>
</tr>
<tr>
<td><strong>Note:</strong> Available only for a resource with a service order.</td>
<td>Full Day Price</td>
</tr>
<tr>
<td></td>
<td>Hours</td>
</tr>
<tr>
<td>Hourly (Event Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
<tr>
<td>Hourly (Reserved Time)</td>
<td>Hourly Price</td>
</tr>
<tr>
<td></td>
<td>Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>Initial Flat Charge</td>
</tr>
</tbody>
</table>
Chapter 3
The Navigator

### Pricing Method

<table>
<thead>
<tr>
<th>Pricing Method</th>
<th>Additional Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly (Service Time)</td>
<td>• Hourly Price</td>
</tr>
<tr>
<td></td>
<td>• Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>• Maximum Charge</td>
</tr>
<tr>
<td></td>
<td>• Initial Flat Charge</td>
</tr>
<tr>
<td><strong>Note:</strong> Available only for a resource with a service order.</td>
<td></td>
</tr>
<tr>
<td>Hourly (Specific)</td>
<td>• Hourly Price</td>
</tr>
<tr>
<td></td>
<td>• Minimum Charge</td>
</tr>
<tr>
<td></td>
<td>• Maximum Charge</td>
</tr>
</tbody>
</table>

- If applicable, open the Selection tab, and edit the resource selections as needed.

3. Click OK.

The <Resource> dialog box closes, and you return to the Navigator with the edited item still selected in the Items pane.

---

*If you need to edit counts and/or times for individual items in a resource, service order, or catering, category, see “Editing Count Information for a Booking” on page 163.*
Editing Booking Detail Item Charges for Multiple Items

You can edit resource quantities and billing information (price, pricing method, and so on) for individual items (see “Editing Booking Detail Items for Individual Bookings” on page 157) or you can use the Edit Charges tool to edit this information for multiple non-invoiced items.

To edit the billing information for invoiced items, you must first void the invoice. See “To void an invoice” on page 372.

To edit booking detail item charges for multiple items

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In left pane of the Navigator, do one of the following:
   - To edit all billable items in all the bookings for a reservation, select the reservation.
   - To edit only the billable items in a selected booking, expand the reservation folder, and under the expanded reservation folder, select the booking that contains the items that you are editing.

3. In the Bookings/Booking Details pane, click Tools > Edit Charges.

   The Edit Charges window opens. If you selected a reservation, then all non-invoiced billable items in all the bookings for the selected reservation are displayed in the window; otherwise, only the non-invoiced billable items for the selected booking are displayed. See Figure 3-66 on page 162.
4. Optionally, on the Category dropdown list, select a category to narrow the list of items that are displayed.

5. To edit the quantity, pricing method, price, or discount percentage for an item, click in the appropriate field for the item and make the necessary edits.

6. Click Close.

Any resulting recalculations are carried out automatically. The Edit Charges window closes and you return to the Navigator.
Editing Count Information for a Booking

You use the Edit Counts tool to edit the count information for a booking, including the setup count and attendance count, the estimated count, guaranteed count, and actual count for a booking detail with a category type of catering, as well as the counts for non-invoiced booking detail items. You can edit the counts for all bookings in a reservation or for just a selected booking.

---

Much of the information that you can edit using the Edit Counts tool is also available for editing in other areas of the application. The purpose of this tool is simply to collate all the count information in a single location for editing.

---

To edit count information for a booking

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, do one of the following:
   - Select the reservation.
   - Expand the reservation folder, and under the reservation folder, select a specific booking.

3. In the Bookings pane, click Tools, and then click Edit Counts.

   The Edit Counts window opens. If you selected the reservation, then the Bookings (top) pane of the window lists all the bookings for the selected reservation; otherwise, the pane lists just the selected booking. See Figure 3-67 on page 164.
4. Select the booking for which you are editing the count information.

5. On the Category dropdown list, select the booking detail (category) for which you are editing the count information.

   The Booking Details (middle) pane is refreshed with the information for the selected category. If the category is a resource with a service order, then the pane displays the service type and the start and end times for the category. If the category is catering, then the pane also displays the estimated count, guaranteed count, and actual count for the booking detail.

6. In the Booking Details pane, select the booking detail that contains the items for which you are editing the count information.

   The Items (lower) pane is refreshed with a list of all the non-invoiced items for the selected detail.

7. To Edit the count information for any booking detail or detail item, click in the appropriate field and make the necessary edits.

8. To edit the count information for multiple bookings, repeat Step 4 through Step 7 as needed for each booking.

9. Click Close.

   The edits are made. You return to the Navigator.
Applying a Reservation Discount

You use Apply Reservation Discount Wizard to apply a reservation discount to non-invoiced details in a booking. The discount is applied as a percentage of the total charge for an item and it is added to any existing discounts that have already been applied to the item.

To apply a discount to invoiced items, you must first void the invoice. See “To void an invoice” on page 372.

To apply a reservation discount

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation to which you are applying the discount.

3. In the Bookings pane, click Tools, and then click Apply Reservation Discount.

   The Apply Reservation Discount window opens. All the bookings for the selected reservation with their categories that have not been invoiced are displayed.

   Figure 3-68: Apply Reservation Discount window
4. Leave the Category set to the default value of (all), or optionally, to apply a discount to all the items in a specific category, on the Category dropdown list, select a category. The Apply Reservation Discount window is updated with the bookings that have the selected category.

5. Enter the discount percentage.

6. Optionally, enter any notes that are relevant about the discount.

7. Select the booking, or CTRL-click to select the multiple bookings to which you are applying the discount, or click Select All to select all the displayed bookings in a single step, and then click Finish.

   A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.

---

*After you apply a reservation discount, you can view it and/or edit it when you are editing the reservation on the Billing Information tab of the Reservation window in the Navigator. See “Editing a Reservation in the Navigator” on page 98.*
Copy booking details between bookings

1. Open the reservation to which you are copying the booking details in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.
2. In the left pane of the Navigator, select the reservation from which you are copying the details.
3. In the Bookings pane, click Tools, and then click Copy Booking Details Wizard.
   The Copy Booking Details Wizard opens. The first window in this Wizard, the Select Booking Details to Copy window, displays all the bookings for the selected reservation, regardless of date. By default, the Copy From Reservation No. field displays the reservation number for the selected reservation.

Figure 3-69: Copy Booking Details Wizard, Select Booking Details to Copy window
4. Optionally, in the Copy From Reservation No. field, click the Search icon to open the Open Navigator dialog box and search for and select a different reservation from which to copy the booking details.

The Select Booking Details to Copy window is refreshed with all the bookings details for the selected reservation.

5. Optionally, do one or both of the following:
   - On the Category dropdown list, select a specific category of booking details to display on the Select Booking Details to Copy window.
   - Leave Copy Inactive Resources/Rooms selected to copy this information for the bookings. Clear this option if you do not want to copy this information.

6. Select the booking, or CTRL-click to select the multiple bookings from which you are copying the booking details, and then click Next.

The Select Bookings window opens. This window displays all the bookings with a date greater than or equal to the current day’s date to which you can copy the booking details.

*Figure 3-70: Copy Booking Details Wizard, Select Bookings window*

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.
7. Select the booking, or CTRL-click to select the multiple bookings to which you are copying the booking details, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

8. Click OK to close the message and return to the Navigator.
Deleting Booking Detail Items from Multiple Bookings

If you add booking detail items to bookings for a reservation in error, or a booking item is no longer valid for one or more bookings, and the item has not been invoiced, you can use the Delete Item Wizard to delete the item. You can delete each item on an individual basis, or you can delete all the items for a booking detail in a single step. If you delete an item at the package level, then the deletion cascades down to all the items in the package. You can also delete individual items from a package.

To delete booking detail items from multiple bookings

1. Open the reservation from which you are deleting the booking detail items in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are deleting the booking detail items.

3. In the Bookings pane, click Tools, and then click Delete Item Wizard.

   The Delete Item Wizard opens. The first window that opens is the Select Categories window.

   Figure 3-71: Delete Item Wizard, Select Categories window
4. Select the category (booking detail) from which you are deleting the items, and then click Next.

The Select Categories/Items window opens.

*Figure 3-72: Delete Item Wizard, Select Categories/Items window*

5. Optionally, do one or both of the following:
   - Select a specific grouping to limit the display to only those items in the grouping.
   - Select Delete Empty Categories to also delete a category after the last item is deleted from the category.

6. On the Resources list, select the resource item, or CTRL-click to select the multiple resource items that you are deleting.

7. Click Next.

The Select Bookings window opens. This page lists all the bookings for the selected reservation with a date greater than or equal to the current day’s date and that have the resource items that were selected for deletion. See Figure 3-73 on page 172.
8. Select the booking, or CTRL-click to select the multiple bookings from which you are deleting the resource items, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

9. Click OK to close the message and return to the Navigator.
Deleting Booking Details from Multiple Bookings

You use the Delete Booking Details Wizard to delete one or more booking details that do not have invoiced items from multiple bookings in a single step. When you delete a booking detail from a booking, any items that have been added for the detail are also deleted.

To delete booking details from multiple bookings

1. Open the reservation from which you are deleting the booking details in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation from which you are deleting the booking details.

3. In the Bookings pane, click Tools, and then click Delete Booking Details Wizard.

   The Delete Booking Details Wizard opens. The first window in this Wizard, the Select Categories window, displays all the categories (booking details) that are already in use for any of the bookings in the selected reservation.

   Figure 3-74: Delete Booking Details Wizard, Select Categories window
4. Select the category, or CTRL-click to select the multiple categories that you are deleting from the reservation, or click Select All to select all categories in a single step.

5. Click Next.

The Select Booking Details window opens. This page lists all the bookings for the selected reservation with a date greater than or equal to the current day’s date that have the categories (booking details) that were selected for deletion but do not have any invoiced items.

Figure 3-75: Delete Booking Details Wizard, Select Booking Details window

6. Select the booking, or CTRL-click to select the multiple bookings from which you are deleting the categories, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens indicating that the changes were made successfully.

7. Click OK to close the message and return to the Navigator.
Chapter 3
The Navigator

Working with Comments and Reminders in the Navigator

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a booking detail that is a service order. A reminder is a comment that has a due date associated with it, and if it is attached to a reservation, booking, group, or service order, then it is called an attached reminder. You can select from a pre-configured list of comment types and reminder types, or you can create a user-specified comment type or reminder type if none of the pre-configured types meets your working needs. You can add comments/reminders directly to a reservation, booking, or service order in the Navigator. You can also edit a comment/reminder, delete a comment/reminder, and view the history for a comment/reminder.

A reminder that you add to a reservation, booking, group, or booking details is called an attached reminder. To work with unattached reminders, see “Reminders Tab” in “Overview of the EMS Dashboard and Dashboard Options” on page 229.

To work with a comment or reminder in the Navigator

The following procedures are written from the perspective of working with a single comment. By analogy, you can follow these procedures to work with a single attached reminder. To add multiple comments and/or reminders to a reservation in a single step, see “Adding Multiple Comments and Reminders to a Reservation” on page 179.

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.
2. In the left pane of the Navigator, select the reservation, booking, or service order, and then in the top right pane of the Navigator, open the Comments tab.
3. Continue to one of the following:
   - “To add a comment” on page 176.
   - “To edit a comment” on page 177.
   - “To delete a comment” on page 177.
   - “To view the history for a comment” on page 177.
To add a comment

1. Click New.
   
The Comment dialog box opens.

*Figure 3-76: Comment dialog box*

2. On the Comment Type dropdown list, select the type of comment that you are adding; otherwise, if none of the pre-configured comment types meets your working needs, select (user-specified comment), and then in the Description field, enter a description for the comment type.

3. In the Notes field, enter the comment.

4. Optionally, do one or both of the following:
   - To alert any EMS user that opens this reservation, booking, or service order that this comment has been added, select Alert Users.
   - Click Spelling to spell check the comment before you add it to the reservation, booking, or service order.

5. Click OK.
   
The Comment dialog box closes. The comment is added to the reservation, booking, or service order. The Comments tab remains open.
To edit a comment

1. Select the comment that you are editing, and then click Edit.
   The Comment dialog box opens, populated with the information for the selected comment.

2. Edit the comment as needed, including its type, description (if applicable), its Notes, and/or its Alert User status.

3. Optionally, click Spelling to spell check the comment before you save the edited comment.

4. Click OK.
   The Comment dialog box closes. The edited comment is saved for the reservation, booking, or service order. The Comments tab remains open.

To delete a comment

1. Select the comment that is you are deleting, and then click Delete.
   A message opens asking you if it is OK to delete the selected comment.

2. Click Yes.
   The selected comment is deleted from the reservation, booking, or service order. The Comments tab remains open.

To view the history for a comment

1. Select the comment for which you viewing the history, and then click Edit.
   The Comment dialog box opens populated with the information for the selected comment.

2. Open the History tab.
   The tab displays the following information for each change that was made to the comment—the date of the change, the login ID for the user who made the change, and the old and new values for the comment. See Figure 3-77 on page 178.
3. Click OK.

   The Comment dialog box closes. The Comments tab remains open.
Adding Multiple Comments and Reminders to a Reservation

When you add a comment or a reminder to a reservation from the Comments tab or Reminders tab, respectively, then you can add only a single comment or reminder at a time. To add multiple comments or reminders to a reservation in a single step, you must use an option on the context menu for reservations in the Navigator.

To add multiple comments and reminders to a reservation

1. Open the reservation to which you are adding multiple comments and/or reminders in the Navigator. See:
   - "Opening a reservation directly in the Navigator" on page 79.
   - "Opening a reservation through the Reservation Book" on page 80.
   - "Opening a reservation through a group" on page 80.
   - Chapter 4, "Search Tools," on page 195.
2. In the left pane of the Navigator, right-click the reservation, and on the context menu that opens, click Add Reminders and Comments.

The Add Reminders and Comments window opens. This window lists all the available pre-configured reminder and comment types in the Available list. See Figure 3-78 on page 180.
3. In the Available list, select the comment/reminder type, or CTRL-click to select the multiple comment/reminder types that you are adding to the reservation, and then click the Move (>) button to move the selected comment/reminder types to the Selected list.

4. To enter the text for the selected comment/reminder types, select a comment/reminder type in the Selected list, and then click Edit.

   A Notes dialog box opens in which you can enter the text for the selected comment/reminder type.

5. After you have entered the text for a selected comment/reminder type, click OK to close the Notes dialog box and return to the Add Reminders and Comments window.

6. Repeat Step 4 and Step 5 for each selected comment/reminder type.

7. Click Finish.

   A message opens indicating that the comment/reminder types were added successfully.

8. Click OK to close the message and return to the Navigator.
Working with User Defined Fields in the Navigator

The User Defined Fields tab displays the additional fields that store custom data for a reservation, booking, or a booking detail that is a service order. Your EMS administrator configures the types of fields that are available as well as the allowed values for these fields. You can add new user defined fields to a reservation or booking detail, edit the value for a user defined field, and delete user defined fields. You can also view the history for a user defined field.

To work with user-defined fields in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation or booking detail (remember, the booking detail must be a service order), and then in the top right pane of the Navigator, open the User Defined Fields tab.

3. Continue to one of the following:
   - “To add a user-defined field” on page 182.
   - “To edit a user-defined field” on page 182.
   - “To delete a user-defined field” on page 182.
   - “To the view history for a user-defined field” on page 183.
Chapter 3
The Navigator

To add a user-defined field

1. Click New.
   The User Defined Field dialog box opens.

*Figure 3-79: User Defined Field dialog box*

2. On the Field dropdown list, select the type of field that you are adding.
3. On the Value dropdown list, select an allowed value for the field.
4. Click OK.
   The User Defined Field dialog box closes. The field is added to the reservation and the User Defined Fields tab remains open.

To edit a user-defined field

1. Select the user defined field that you are editing, and then click Edit.
   The User Defined Field dialog box opens. The field type and field value are displayed for the selected user defined field.
2. Edit the field type, field value, or both as needed.
3. Click OK.
   The User Defined Field dialog box closes. The edited field is saved for the reservation or booking detail and the User Defined Fields tab remains open.

To delete a user-defined field

1. Select the user-defined field that you are deleting, and then click Delete.
   A message opens asking you if it is OK to delete the selected field.
2. Click Yes.
   The selected field is deleted. The User Defined Fields tab remains open.
To the view history for a user-defined field

1. Select the user-defined field for which you are viewing the history, and then click Edit. The User Defined Field dialog box opens. The field type and field value are displayed for the selected user defined field.

2. Open the History tab.

   The tab displays the following information for each change that was made to the field—the date of the change, the login ID for the user who made the change, and the old and new values for the field.

   ![Figure 3-80: User Defined Field dialog box, History tab](image)

   You can use the scroll feature at the bottom of the dialog box to view all the history for a selected change, or you can click a change, and then click View.

3. Click OK.

   The User Defined Field dialog box closes. The User Defined Fields tab remains open.
Working with Attachments in the Navigator

The term *attachment* is used to describe any file that you can **add** to or **store** on a reservation or booking. (Unlike a drawing, which is simply referenced, an attachment is actually stored in the EMS database with the reservation or booking record.) You can also **delete** an attachment from a reservation or booking, and **view** and **edit** an attachment.

---

You can also add an attachment to a group record. See “Configuring Additional Information for a Group” on page 263.

To work with attachments in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, select the reservation or expand the folder structure for the reservation until the appropriate booking folder is visible, and then select the booking folder.

3. In the top right pane of the Navigator, open the Attachments tab.

4. Continue to one of the following:
   - “To add an attachment to a reservation or booking” on page 185.
   - “To edit an attachment for a reservation or booking” on page 186.
   - “To delete an attachment from a reservation or booking” on page 186.
   - “To view an attachment for a reservation or booking” on page 187.
To add an attachment to a reservation or booking

1. Click New.

   The Attachment dialog box opens.

   *Figure 3-81: Attachment dialog box*

![Attachment dialog box](image)

2. In the Description field, enter a name or description for the attachment.

   *The description can be a maximum of 50 characters, including spaces. If you leave this field blank, then the Description field is populated with the name of the file after you attach it to a reservation or booking.*

3. On the Type dropdown list, select the attachment type.

4. Click the Search icon to open the Find Attachment dialog box, and then browse to and select the attachment.

   The Find Attachment dialog box closes. The file name for the attachment is displayed in the Attachment field.

5. Optionally, do one or more of the following as needed:

   - If you left the Description field blank, then the name of the attached file is used by default for the file description, and you can edit this if needed.
   - If the attachment is to be displayed in VEMS when it is attached to a reservation or booking, then select Display on Web.
   - If a VEMS user is to be able to delete this attachment when it is attached to a reservation or booking, then select Allow Web Delete.
   - Enter any pertinent notes for the attachment.
   - Click Spelling to spell check the description before you attach the drawing to the booking.
6. Click OK.

   The Attachment dialog box closes. The attachment is added to the booking. The Attachments tab remains open.

**To edit an attachment for a reservation or booking**

1. Select the attachment that you are editing, and then click Edit.

   The Attachment dialog box opens populated with the information for the selected attachment.

2. Do any of the following as needed:
   - Edit the description.
   - Click the Search icon to open the Find Attachment dialog box and scroll to and select a different attachment.
   - Edit the notes and/or web options.
   - Optionally, click Spelling to spell check the description.

3. Click OK.

   The Attachment dialog box closes. The Attachments tab remains open.

**To delete an attachment from a reservation or booking**

1. Select the drawing or CTRL-click to select the multiple attachments that you are deleting from the reservation or booking.

2. Click Delete.

   A message opens asking you if it is OK to delete the selected attachments.

3. Click Yes.

   The selected attachments are deleted from the reservation or booking. The Attachments tab remains open.
To view an attachment for a reservation or booking

Your computer must have the appropriate application installed to view attachments of a specific type. For example, to open a .docx that is attached to a booking, Microsoft Word must be installed on your computer.

1. Select the attachment that you are viewing, and then click Open.
   The file opens in the appropriate application.

2. Close the application after viewing the attachment, or if the application allows it, edit the attachment as needed, and then save the attachment.
   The next time you open the attachment in the Navigator, you can see the changes that you made.
Chapter 3
The Navigator

Working with Drawings in the Navigator

The term *drawing* is used to describe a file (text-based or image file) that you can add to a booking. The file can stored on your organization’s network, or you can create a drawing “on the fly,” in the default drawing program on your EMS client, and then add it to a booking. Typically, a drawing is a setup diagram of the booking room. You can also detach a drawing from a booking, and view and edit a drawing.

To work with drawings in the Navigator

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, expand the folder structure for the reservation until the appropriate booking folder is visible, and then select the booking.

3. In the right pane of the Navigator, open the Drawings tab.

4. Continue to one of the following:
   - “To attach a stored drawing to a booking” on page 189.
   - “To create a drawing “on the fly” and attach it to a booking” on page 190.
   - “To edit a drawing for a booking” on page 190.
   - “To detach a drawing from a booking” on page 190.
   - “To view a drawing for a booking” on page 191.
To attach a stored drawing to a booking

1. Click New > Attach.

   The Drawing dialog box opens.

   **Figure 3-82: Drawing dialog box**

   ![Drawing dialog box]

2. In the Description field, enter a name or description for the drawing.

   *The description can be a maximum of 50 characters, including spaces. If you leave this field blank, then the Description field is populated with the name of the file after you attach it to the booking.*

3. Click the Search icon 📂 to open the Find Drawing dialog box, and then browse to and select the drawing.

   The Find Drawing dialog box closes. The file name for the drawing is displayed in the Drawing field.

4. Optionally, do one or both of the following:
   - If you left the Description field blank, then the name of the attached file is used by default for the file description, and you can edit this if needed.
   - Click Spelling to spell check the description before you attach the drawing to the booking.

5. Click OK.

   The Drawing dialog box closes. The drawing is attached to the booking. The Drawings tab remains open.
To create a drawing “on the fly” and attach it to a booking

1. Click New > Create.

The application that you have selected as your default drawing application for your EMS client opens, for example, Microsoft Paint.

2. Create and save the drawing.

3. Continue to “To attach a stored drawing to a booking” on page 189.

To detach a drawing from a booking

1. Select the drawing, or CTRL-click to select the multiple drawings that you are detaching from the booking.

2. Click Detach.

A message opens asking you if it is OK to detach the selected drawings.

3. Click Yes.

The selected drawings are detached from the booking. The Drawings tab remains open.

To edit a drawing for a booking

1. Select the drawing that you are editing, and then click Edit.

The Drawing dialog box opens.

2. Do one or both of the following as needed:
   • Edit the description.
   • Click the Search icon to open the Find Drawing dialog box and scroll to and select a different drawing.

3. Optionally, click Spelling to spell check the description before you attach the drawing to the booking.

4. Click OK.

The Drawing dialog box closes. The Drawing tab remains open.
Chapter 3
The Navigator

To view a drawing for a booking

*Your computer must have the appropriate application installed to view drawings of a specific type. For example, to open a .vsd file that is attached to a booking, Microsoft Visio must be installed on your computer.*

1. Select the drawing that you are opening, and then click Open.
   The file opens in the appropriate application.

2. Close the application after viewing the drawing, or if the application allows it, edit the drawing as needed, and then save the drawing.
   The next time you open the drawing in the Navigator, you can see the changes that you made.
Running the Resource Utility Conflicts Tool

Resource conflicts can occur if bookings for the same date and time require the same resource, and there are insufficient quantities of the resource to accommodate all the bookings. When you reserve any resource for which the inventory is maintained (for example, equipment, personnel, and so on), EMS checks the available quantity and automatically notifies you in an Inventory Conflict message if there is an insufficient quantity of the selected resource to accommodate your event.

Figure 3-83: Inventory Conflict message

You have the option of dismissing this message and over-committing the resource; however, although you are aware that the resource has been over-committed, other users will not necessarily be aware of this fact. If you need to confirm that an over-commitment of resources does not exist for a single reservation, then you can manually run the Resource Inventory Conflicts tool from the Navigator to generate an onscreen report that lists the resources that are in conflict by booking for the reservation.

To confirm that an over-commitment of resources does not exist across multiple reservations, run any of the various resource usage reports that are available. See “Statistics reports” in “Generating an EMS Report” on page 321.

To run the Resource Utility Conflicts tool

1. Open the reservation in the Navigator. See
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the Bookings pane, click Tools, and then click Resource Inventory Conflicts.

   The Resource Inventory Conflicts report opens onscreen. The report lists the resources that are in conflict by booking. See Figure 3-84 on page 193.

3. Optionally, edit the booking details for the involved bookings to resolve the conflict.
Figure 3-84: Resource Inventory Conflicts report

The onscreen preview of the Resource Inventory Conflict report contains options for printing a hard copy of the report, for emailing the report, and so on.
Chapter 3
The Navigator
Chapter 4
Search Tools

EMS has a variety of options available to you for searching for reservations, bookings, service orders, resources, and queries. These options include the Browser, the Web Reservation tool, the Calendar, the Navigator, a Group, the Web Request tool, the Resource Calendar, and the Service Order Management browser.

This chapter covers the following topics:

- “Searching with the Browser or with the Web Reservation Tool” on page 197.
- “Searching with the Calendar” on page 206.
- “Searching with the Resource Calendar” on page 215.
- “Searching with the Service Order Management Browser” on page 222.

Remember, a fast way to view and edit bookings is through the Reservation Book. See “Viewing and Editing Reservations in the Reservation Book” on page 62.

For information about searching with the Navigator, see Chapter 3, “The Navigator,” on page 77. For information about searching for reservations by group, see “Working with Reservations for a Group” on page 295. For information about searching with the Web Request tool, see Chapter 5, “EMS Dashboard,” on page 227.
Chapter 4
Search Tools
Searching with the Browser or with the Web Reservation Tool

You can use the Browser to search for reservations, bookings, service orders, resources, web reservations, and queries. The results are displayed in a list view. When you carry out a search in the Browser, you can carry out a basic search or an advanced search. A basic search is based on the basic information that you specify for a reservation when you first create it, such as the starting date, the end date, the group for which the event was scheduled, the group contact name, and so on. An advanced search is a field level search that is carried out at the reservation level, the booking level, the booking detail level, the booking detail item level, the service order level, or any combination of these. For example, in an advanced search, you can specify criteria as granular as who added a specific booking detail item.

A web reservation is any reservation that a user has submitted through VEMS. The Web Reservation searching tool is identical to the Browser searching tool with one exception—when the Browser opens for the first time, the Browse for function is set to Reservations whereas the Web Reservation tool is set to Web Reservations. As a result, although this section is written from the perspective of using the Browser, all the information can be applied when using the Web Reservation searching tool. To open the Web Reservation searching tool, click the Web Reservations icon on the EMS toolbar.

To carry out a search in the Browser

1. On the EMS toolbar, click the Browser icon.

   By default, the first time that the Browser window opens, the Filter tab is set to a basic search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you last carried out. See Figure 4-1 on page 198.
2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and then continue to one of the following:

- “To carry out a basic search in the Browser” below.
- “To carry out an advanced search in the Browser” on page 201.

To carry out a basic search in the Browser

1. On the Browse For dropdown list, select the item for which to search.
2. Enter the search criteria.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Starting Time</td>
<td>Both are optional.</td>
</tr>
<tr>
<td>• Ending Time</td>
<td></td>
</tr>
<tr>
<td>Use Specific Times</td>
<td>Available only if the Starting Date is the same as the Ending Date.</td>
</tr>
<tr>
<td>Include Cancelled</td>
<td>By default, search results are not set to show canceled reservations. Select this option to search for canceled reservations as well.</td>
</tr>
<tr>
<td>Group</td>
<td>If the pre-defined list of groups is too extensive to scroll, then click the Search icon to open the Groups window and search for a specific group. See “To search for a group and/or contact” on page 255.</td>
</tr>
<tr>
<td>• 1st Contact</td>
<td>Enter a search string by which to filter your search. The string is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a search string of ed returns Ed, Edward, Eddie, and so on, but not Ted or Fred.</td>
</tr>
<tr>
<td>• Reservation Event Name</td>
<td></td>
</tr>
</tbody>
</table>
3. Optionally, click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, When Filtering By Specific Room, and Show Service Order Items.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab.

**Figure 4-2: Browser window, Results tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific building, area, or view.</td>
</tr>
</tbody>
</table>
| Building/Room   | • If you select a specific building, then (all) rooms in the building are selected by default. You can select a specific room in the building.  
                   • If you select an area, then you can select a specific building that is contained in the area.  
                   • If you select a view, then Room is left blank; however, you can select a specific room to search. |
| Category        | The default value is set to (all). You can leave this value as is, or you can select a specific category (booking detail). |
| Resource        | Available only if you select a category that is a resource or service order.  
                   The default value is set to (all). You can leave this value as is, or you can select a specific resource item. |
| Booking Status  | The default value is set to (all). You can leave this value as is, or you can select a specific booking status. |
5. Optionally, do one or more of the following:

- The Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this tab.

- Double-click an event entry on the Results tab to open the event in the Navigator.

- Click Print to print the search results.

- In the Reservation view, select a search result entry, and then click Email to open a pre-addressed SMTP email to the group that is associated with the selected reservation. Complete and send the email as you would normally. See “Sending Email from EMS” on page 414.

- Click Export to export the search results to a Microsoft Excel spreadsheet.

- In the Bookings view, click Outlook to download the search results to your personal calendar.

- In the Service Orders view, to mark a service order as Reviewed, select the service order, or CTRL-click to select multiple service orders, and then click Review > Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click Review > Mark as Unreviewed.

- In the Service Orders view, to change the state of a service order in a booking, select the appropriate booking in the Results list, or CTRL-click to select multiple service orders of the same category, and then click Change State. A Change State dialog box opens. The dialog box lists all the available states for the service order. Select the new state for the service order on the State dropdown list.

Your EMS administrator must set a system parameter to enable this function. If this function is not available, contact your EMS administrator for assistance.

- In the Service Orders view, to change the state of a service order in a booking, select the appropriate booking in the Results list, or CTRL-click to select multiple service orders of the same category, and then click Change State. A Change State dialog box opens. The dialog box lists all the available states for the service order. Select the new state for the service order on the State dropdown list.

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.

- In the Browse For field, select a different item to search for. The Results tab is refreshed with the search results based on the item that you selected and the search criteria on the Filter tab.

- Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

- Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, width, and so on) remain in effect for any other searches that you carry out. To reset the columns to their default values, see “Resetting Column Settings” on page 408.
To carry out an advanced search in the Browser

Figure 4-3: Browser window, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.
2. Optionally, do one or more or all of the following:
   - Enter a Starting Date, an Ending Date, or both.
   - If the Starting Date and the Ending Date are the same, select Use Specific Times and enter specific time periods to search.

   *Use Specific Times is available only if the Starting Date is the same as the Ending Date.*

   - Click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, When Filtering By Specific Room, and Show Service Order Items.
3. For each field level option by which to carry out the search:
   - Select the field level option, and then click the Move button (>).

   ![Figure 4-4: Viewing a selected field option in the Filter Summary list](image)

   To filter the list of available fields, in the Field Search field, enter a search string. Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of `add` returns `Added by`, `Date Added`, and `Group Address Line 1`. The list of fields that meet your search criteria is dynamically updated as you enter your search criteria.

   - When prompted, enter a value or define the limits for the option, and then click OK. The option is moved to the Filter Summary list.

   ![If you have specific fields and/or values by which you always want to carry out a search, then you can set up these fields to be your Favorite fields. See “To set up favorite fields for a Browser search” on page 205.](image)

   To view a selected field option in its entirety in the Filter Summary list, rest the mouse pointer on the entry. A tooltip showing the complete field option information opens.
4. Click Get Data or Refresh.
   The search results are displayed on the Results tab.

**Figure 4-5: Browser window, Results tab**

```
<table>
<thead>
<tr>
<th>Group Type</th>
<th>Reservation Event Type</th>
<th>First Booking</th>
<th>Last Booking</th>
<th>Group</th>
<th>Reservation Event Name</th>
<th>1st Contact</th>
<th>Reservation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staff</td>
<td>Video Conference</td>
<td>2/27/2012 Mon</td>
<td>3/2/2012 Fri</td>
<td>Wright, Shane</td>
<td>Tour of California Preview</td>
<td>Shane, Wright</td>
<td></td>
</tr>
<tr>
<td>Staff</td>
<td>Meeting - Internal</td>
<td>2/20/2012 Mon</td>
<td>2/20/2012 Fri</td>
<td>Anderson, Scott</td>
<td>Test Room</td>
<td>(none)</td>
<td></td>
</tr>
<tr>
<td>Staff</td>
<td>Meeting - Internal</td>
<td>2/20/2012 Mon</td>
<td>2/20/2012 Fri</td>
<td>Anderson, Scott</td>
<td>Test 2</td>
<td>(none)</td>
<td></td>
</tr>
<tr>
<td>(none)</td>
<td>Training</td>
<td>5/18/2012 Fri</td>
<td>5/18/2012 Fri</td>
<td>Denver Cycling Club</td>
<td>Tour of California - Stage Preview</td>
<td>(none)</td>
<td></td>
</tr>
<tr>
<td>(none)</td>
<td>Training</td>
<td>3/5/2012 Mon</td>
<td>3/5/2012 Fri</td>
<td>Denver Cycling Club</td>
<td>Tour of California - Stage Preview</td>
<td>(none)</td>
<td></td>
</tr>
<tr>
<td>(none)</td>
<td>Training</td>
<td>2/12/2012 Mon</td>
<td>2/12/2012 Fri</td>
<td>Denver Cycling Club</td>
<td>Tour of California - Stage Preview</td>
<td>(none)</td>
<td></td>
</tr>
<tr>
<td>(none)</td>
<td>Meeting - Internal</td>
<td>1/22/2012 Wed 2/24/2012 Fri</td>
<td>1/22/2012 Wed 2/24/2012 Fri</td>
<td>Johnston, Dean</td>
<td>After Hours Team Building</td>
<td>Johnston, Dean</td>
<td></td>
</tr>
<tr>
<td>Partner</td>
<td>Meeting - Internal</td>
<td>2/22/2012 Wed 2/24/2012 Fri</td>
<td>2/22/2012 Wed 2/24/2012 Fri</td>
<td>Raasch, Keolin</td>
<td>Design Review</td>
<td>Taylor, Angela</td>
<td></td>
</tr>
</tbody>
</table>
```

5. Optionally, do one or more of the following:

   - The Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this tab.
   - Double-click an event entry on the Results tab to open the event in the Navigator.
   - Click Print to print the search results.
   - In the Reservation view, select a search result entry, and then click Email to open a pre-addressed SMTP email to the group that is associated with the selected reservation. Complete and send the email as you would normally. See “Sending Email from EMS” on page 414.
   - Click Export to export the search results to a Microsoft Excel spreadsheet.
   - In the Bookings view, click Outlook to download the search results to your personal calendar.

---

*Your EMS administrator must set a system parameter to enable this function. If this function is not available, contact your EMS administrator for assistance.*
• In the Service Orders view, to mark a service order as Reviewed, select the service order, or CTRL-click to select multiple service orders, and then click Review > Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select the appropriate booking in the Results list, or CTRL-click to select multiple service orders of the same category, and then click Change State. A Change State dialog box opens. The dialog box lists all the available states for the service order. Select the new state for the service order on the State dropdown list.

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.

• In the Browse For field, select a different item to search for. The Results tab is refreshed with the search results based on the item that you selected and the search criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, width, and so on) remain in effect for any other searches that you carry out. To reset the columns to their default values, see “Resetting Column Settings” on page 408.
To set up favorite fields for a Browser search

If you have specific fields and/or values by which you always want to carry out a Browser search, you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Browser, and make sure that the Advanced search features are displayed.
2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then click Add to Favorites.
   The field is added to the Favorite Fields tab.
3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog box.
   The next time that you carry out a search, you can simply open the Favorite Fields tab or the Saved Values tab to carry out a search based on your customized list of search fields.
Searching with the Calendar

You use the Calendar to search for reservations, bookings, and service orders in your EMS database. The results are displayed in a calendar view. When you carry out a search in the Calendar, you can carry out a basic search or an advanced search. A basic search is based on the basic information that you specify for a reservation when you first create it, such as the starting time, the end time, the group for which the event was scheduled, the group contact name, and so on. An advanced search is a field level search that is carried out at the reservation level, the booking level, the booking detail level, the booking detail item level, or any combination of these. For example, in an advanced search, you can specify criteria as granular as who added a specific booking detail item.

To carry out a search in the Calendar

1. On the EMS toolbar, click the Calendar icon .

The Calendar window opens. By default, the first time that the Calendar window opens, the Results tab is the active tab and it is set to the current month and year. If you never edit the Get Data when Calendar Opens option (under Options), then the Results tab is always the active tab when the Calendar window opens; otherwise, the Filter tab is the active tab.

Figure 4-6: Calendar window, Results tab
2. If needed, click Filter to open the Filter tab.

The first time that the Filter tab opens, it is set by default to a Basic search; otherwise, the Filter tab displays the search type (Basic or Advanced) that you last carried out.

3. Click the Basic/Advanced toggle to select the type of search that you want to carry out and then continue to one of the following:
   - “To carry out a basic search in the Calendar.”
   - “To carry out an advanced search in the Calendar” on page 211.

To carry out a basic search in the Calendar

Figure 4-7: Calendar window, Filter tab with Basic search options

1. On the Browse For dropdown list, select the item for which to search.
2. Enter the search criteria.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>The default value is the current month and year, but you can change one or both of these values if needed.</td>
</tr>
<tr>
<td>Year</td>
<td></td>
</tr>
<tr>
<td>Include Cancelled</td>
<td>By default, search results are not set to show canceled bookings. Select this option if you want to search for canceled bookings as well.</td>
</tr>
<tr>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>1st Contact</td>
<td></td>
</tr>
<tr>
<td>Reservation Event Name</td>
<td></td>
</tr>
<tr>
<td>Building</td>
<td></td>
</tr>
<tr>
<td>Room</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td></td>
</tr>
<tr>
<td>Booking Status</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 4
Search Tools

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>If the pre-defined list of groups is too extensive to scroll, then click the Search icon to open the Groups window and search for a specific group. See “To search for a group and/or contact” on page 255.</td>
</tr>
<tr>
<td>• 1st Contact • Reservation Event Name</td>
<td>Enter a search string by which to filter your search. The search is not case-sensitive, but your search is limited to the exact order of characters in the string and it must begin with the information for which you are searching. For example, a search string of ed returns include Ed, Edward, Eddie, and so on, but not Ted or Fred.</td>
</tr>
<tr>
<td>Building</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific building, area, or view.</td>
</tr>
<tr>
<td>Building/Room</td>
<td>• If you select a specific building, then (all) rooms in the building are selected by default. You can select a specific room in the building.</td>
</tr>
<tr>
<td></td>
<td>• If you select an area, then you can select a specific building that is contained in the area.</td>
</tr>
<tr>
<td></td>
<td>• If you select a view, then Room is left blank; however, you can select a specific room to search.</td>
</tr>
<tr>
<td>Category</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific category (booking detail).</td>
</tr>
<tr>
<td>Resource</td>
<td>Available only if you select a category that is a resource or service order. The default value is set to (all). You can leave this value as is, or you can select a specific resource item.</td>
</tr>
<tr>
<td>Booking Status</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific booking status.</td>
</tr>
</tbody>
</table>

3. Optionally, click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The number of bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black. See Figure 4-8 on page 209.

*By default, the number of bookings is indicated in red unless you selected a different color for the Change Calendar Day Count Color. Any color that you pick here is carried over to the same option for the Resource Calendar.*
5. Optionally, do one or more of the following:
   • Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-9:  Calendar window, Results tab with list of events for selected dates
• The lower pane on the Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.

• Double-click the event entry on the Results tab to open an event in the Navigator.

• Click Print to print the search results.

• In the Reservation view, select a search result entry, and then click Email to open a pre-addressed SMTP email to the group that is associated with the selected reservation. Complete and send the email as you would normally. See “Sending Email from EMS” on page 414.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• In the Bookings view, click Outlook to download the search results to your personal calendar.

---

Your EMS administrator must set a system parameter to enable this function. If this function is not available, contact your EMS administrator for assistance.

• In the Service Orders view, to mark a service order as Reviewed, select the service order, or CTRL-click to select multiple service orders, and then click Review > Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select the appropriate booking in the Results list, or CTRL-click to select multiple service orders of the same category, and then click Change State. A Change State dialog box opens. The dialog box lists all the available states for the service order. Select the new state for the service order on the State dropdown list.

---

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.

• In the Browse For field, select a different item to search for. The Results tab is refreshed with the search results based on the item that you selected and the search criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.
To carry out an advanced search in the Calendar

**Figure 4-10: Calendar window, Advanced search options**

1. On the Browse For dropdown list, select the item for which to search.

2. Optionally, do one or both of the following:
   - The default values for the month and year are the current month and year. You can enter different values as needed.
   - Click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, Get Data when Calendar Opens, When Filtering By Specific Room, and Change Calendar Day Count Color.

3. For each field level option by which to carry out the search:
   - Select the field level option, and then click the Move button (>).

To filter the list of available fields, in the Field Search field, enter a search string. Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of *add* returns *Added by*, *Date Added*, and *Group Address Line 1*. The list of fields that meet your search criteria is dynamically updated as you enter your search criteria.

- When prompted, enter a value or define the limits for the option, and then click OK. The option is moved to the Filter Summary list.
If you have specific fields and/or values by which you always want to carry out a search, then you can set up these fields to be your Favorite fields. See “To set up favorite fields for a Calendar search” on page 214.

Figure 4-11: Viewing a selected field option in the Filter Summary list

To view a selected field option in its entirety in the Filter Summary list, rest the mouse pointer on the entry. A tooltip showing the complete field option information opens.

Figure 4-11: Viewing a selected field option in the Filter Summary list

4. Click Get Data or Refresh.

The search results are displayed on the Results tab in a calendar view. The number of bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black.

By default, the number of bookings is indicated in red unless you selected a different color for the Change Calendar Day Count Color.

Figure 4-12: Calendar window, Results tab
5. Optionally, do one or more of the following:

- Click on a date in the upper pane of the Results tab to view a list of bookings for the date in the lower pane of the tab.

*Figure 4-13: Calendar window, Results tab with list of events for selected dates*

- The lower pane on the Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.

- To open an event in the Navigator, double-click the event entry on the Results tab.

- Click Print to print the search results.

- In the Reservation view, select a search result entry, and then click Email to open a pre-addressed SMTP email to the group that is associated with the selected reservation. Complete and send the email as you would normally. See “Sending Email from EMS” on page 414.

- Click Export to export the search results to a Microsoft Excel spreadsheet.

- In the Bookings view, click Outlook to download the search results to your personal calendar.

*Your EMS administrator must set a system parameter to enable this function. If this function is not available, contact your EMS administrator for assistance.*
• In the Service Orders view, to mark a service order as Reviewed, select the service order, or CTRL-click to select multiple service orders, and then click Review > Mark as Reviewed. Conversely, to mark a service order as Unreviewed, click Review > Mark as Unreviewed.

• In the Service Orders view, to change the state of a service order in a booking, select the appropriate booking in the Results list, or CTRL-click to select multiple service orders of the same category, and then click Change State. A Change State dialog box opens. The dialog box lists all the available states for the service order. Select the new state for the service order on the State dropdown list.

For more information about reviewing service orders and selecting states, see “Searching with the Service Order Management Browser” on page 222.

• In the Browse For field, select a different item to search for. The Results tab is refreshed with the search results based on the item that you selected and the search criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.

To set up favorite fields for a Calendar search

If you have specific fields and/or values by which you always want to carry out a Calendar search, you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Calendar, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then click Add to Favorites.

   The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog box.

   The next time that you carry out a search, you can simply open the Favorite Fields tab or the Saved Values tab to carry out a search based on your customized list of search fields.
Searching with the Resource Calendar

You use the Resource Calendar to search for a particular resource and determine how much of the resource (that is, how many individual items) is needed for a specific day or month in a specific year. For example, how many slices of key lime pie are needed in November, 2012? You can use the results of the search to assist you in managing the counts of the resources that your organization must ensure are available for scheduled events. When you carry out a search in the Resource Calendar, you can carry out a basic search or an advanced search. A basic search is based on the basic information that you specify for a resource item when you first create it, such as its category and status. An advanced search is a field level search that is carried out the booking level, the booking detail level, the booking detail item level, the reservation level, the service order level, or any combination of these. For example, in an advanced search, you can specify criteria as granular the date that the service order reminder was added. You can open a resource item that has been returned in the search results in the Navigator, and edit the item if needed.

To carry out a search in the Resource Calendar

1. On the EMS menu bar, click Reservations > Reservations > Resource Calendar.

   The first time that the Resource Calendar opens, the Filter tab is set by default to a Basic search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you last carried out.

   Figure 4-14: Resource Calendar, Basic search
2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and then continue to one of the following:
   - “To carry out a basic search in the Resource Calendar.”
   - “To carry out an advanced search in the Resource Calendar” on page 218.

To carry out a basic search in the Resource Calendar

1. Leave the Month and Year set to the default values (current month and year), or optionally, enter different values as needed.

2. Enter the search criteria.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Cancelled</td>
<td>By default, search results are not set to show resource items for canceled reservations. Select this option to search for resource items in canceled reservations as well.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a specific category (booking detail).</td>
</tr>
<tr>
<td>Resource</td>
<td>Available only if you select a category that is a resource or service order. Select a specific resource item.</td>
</tr>
<tr>
<td>Status</td>
<td>The default value is set to (all). You can leave this value as is, or you can select a specific booking status.</td>
</tr>
</tbody>
</table>

3. Optionally, click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, Specific Room Filters, and Change Calendar Day Count Color.

4. Click Get Data or Refresh.

   The search results are displayed on the Results tab in a calendar view. The total number of resources in all bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black. See Figure 4-15 on page 217.

   By default, the number of resources is indicated in red unless you selected a different color for the Change Calendar Day Count Color. Any color that you pick here is carried over to the same option for the Calendar.
5. Optionally, do one or more of the following:
   
   - Click on a date in the upper pane of the Results tab to view a list of bookings for the date in the lower pane of the tab.
Chapter 4
Search Tools

• The lower pane on the Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.

• Double-click an event entry on the Results tab to open the event in the Navigator.

• Click Print to print the search results.

• Click Export to export the search results to a Microsoft Excel spreadsheet.

• Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.

• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.

To carry out an advanced search in the Resource Calendar

Figure 4-17: Resource Calendar, Advanced search

1. Optionally, do one or both of the following:

   • The default values for the month and year are the current month and year. You can enter different values as needed.

   • Click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, Specific Room Filters, and Change Calendar Day Count Color.
2. For each field level option by which to carry out the search:
   • Select the field level option, and then click the Move button (>).

   To filter the list of available fields, in the Field Search field, enter a search string. Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of add returns Added by, Date Added, and Group Address Line 1. The list of fields that meet your search criteria is dynamically updated as you enter your search criteria.

   • When prompted, enter a value or define the limits for the option, and then click OK. The option is moved to the Filter Summary list.

   If you have specific fields and/or values by which you always want to carry out a search, then you can set up these fields to be your Favorite fields. See “To set up favorite fields for a Resource Calendar search” on page 221.

   To view a selected field option in its entirety in the Filter Summary list, rest the mouse pointer on the entry. A tooltip showing the complete field option information opens.

   Figure 4-18: Viewing a selected field option in the Filter Summary list

3. Click Get Data or Refresh.

   The search results are displayed on the Results tab in a calendar view. The total number of resources in all bookings that meet the search criteria is indicated on the dates on which the events occur. The current day’s date is outlined in black. See Figure 4-19 on page 220.

   By default, the number of resources is indicated in red unless you selected a different color for the Change Calendar Day Count Color.
4. Optionally, do one or more of the following:
   • Click on a date in the upper pane of the Results tab to view a list of bookings for the
date in the lower pane of the tab.

Figure 4-20: Resource Calendar window, Results tab with list of events for selected dates
• The lower pane on the Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.
• Double-click an event entry on the Results tab to open the event in the Navigator.
• Click Print to print the search results.
• Click Export to export the search results to a Microsoft Excel spreadsheet.
• Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.
• Click Refresh to requery the database based on the current search criteria.

5. Click Close.

Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.

To set up favorite fields for a Resource Calendar search

If you have specific fields and/or values by which you always want to carry out a Resource Calendar search, you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Resource Calendar, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then click Add to Favorites.

   The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog box.

   The next time that you carry out a search, you can simply open the Favorite Fields tab or the Saved Values tab to carry out a search based on your customized list of search fields.
Searching with the Service Order Management Browser

You use the Service Order Management browser to search for and view the resources with and without service orders for all bookings on a particular day as well as the current state of the resources and their Reviewed status. After viewing a resource, if applicable, you can change the state for a resource. You can review a resource, or you can mark a resource as unreviewed. You can also open a resource in the Navigator, and edit it if necessary.

To search with the Service Order Management browser

1. On the EMS toolbar, click the Manage Services icon. The Service Order Management window opens. When this window first opens, the display is static and you must manually refresh it. To set options for automatically refreshing the window’s display, go to Step 2; otherwise, go to Step 4.

Figure 4-21: Service Order Management window
2. Click Options.

The Options dialog box opens.

Figure 4-22: Options dialog box

3. Edit the display options as needed for the Manage Services window, and then click OK to apply these changes.

4. To filter the search results, do one or more of the following:
   - Leave the Date set to the default value (the current day’s date), or select a different date.
   - On the Building dropdown list, leave the value set to the default value (all buildings), or select a specific building, area, or view.
   - On the Category dropdown list, select the category by which to search.
   - In the Status pane, select one or more specific booking statuses, or select (all) statuses.

5. Click Refresh.

A list of all bookings that meet your search criteria is displayed in the upper pane of the window.

   - If states are assigned to any of the resources in a booking, then the name of the state and if applicable, its color, is displayed in the State column for the booking. If a resource for a booking is of the type to which states can be assigned, but none has been assigned, then (none) is displayed in the State column for the booking.

   - If a resource has been reviewed for a booking, then “Yes” is displayed in the Reviewed column for the booking.

   - If your Options are set to show deleted service orders/items, then an “x” appears next to the booking for which the orders/items were deleted and a single line through the booking is displayed.

See Figure 4-23 on page 224.
6. Optionally, do one or more of the following:

- The upper pane on the Service Order Management window is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.

- To view the resources (individual items) for a booking, select the booking. The resources are displayed on the Items tab in the lower pane of the window. See Figure 4-23 above.

- To open an event in the Navigator and edit the resource item as needed, double-click the event entry on the Results tab. See Chapter 3, “The Navigator,” on page 77.

*If you edit any information for a resource (quantity, notes, and so on) or the service order (service order time, estimated count, or so on) for a booking, then a Changed icon is displayed next to the booking.*

- To mark a resource for a booking as reviewed, select the booking, or CTRL-click to select multiple bookings, and then click Reviewed. A message opens asking you if you are sure that you want to mark the resource as reviewed. Click Yes to close the message. “Yes” is displayed in the Reviewed column for the booking.
• To reverse the Reviewed status for a resource in a booking, select the appropriate booking, or CTRL-click to select multiple bookings, and then click Unreviewed. A message opens asking you if you are sure that you want to mark the selected resource as unreviewed. Click Yes to close the message. “Yes” is cleared from the Reviewed column for the booking.

• To change the state of the resources for a booking, select the booking, or CTRL-click to select multiple service orders of the same category, and then click Change State. A Change State dialog box opens. The dialog box lists all the available states for the resource. Select the new state for the resource on the State dropdown list.

• To view the changes made to the resources for a booking, select the booking, and then open the Changes tab in the lower pane of the window.

Figure 4-25: Viewing changes to a resource in the Service Order Management window
• To print the list of service orders that are displayed, click Print. An onscreen preview of the Service Orders list opens. The preview window contains options for printing a hard copy of the list, for emailing the list, and so on.

Figure 4-26: Onscreen preview for a printed reminder

• The Items tab and the Changes tab in the lower pane of the Service Order Management window have some of the same basic features as an EMS browser window. You can rearrange the column order by dragging a column to a new location using the column heading, you can change the width of the data columns, and you can sort the data columns on a tab in either ascending or descending sort order. See “An EMS Browser Window” on page 33.

• Make any necessary changes to the search criteria, and then click Refresh to repeat the search based on the new search criteria.

7. Click Close.

Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.
Chapter 5
EMS Dashboard

The Dashboard is a window that centralizes critical information about reservations in a single location. The information that is displayed on this window, including notifications, reminders, web reservations, and so on, provides you with the necessary input to manage your work in EMS.

This chapter covers the following topics:

• “Overview of the EMS Dashboard and Dashboard Options” on page 229.
• “Notifications Tab” on page 232.
• “Reminders Tab” on page 234.
• “Web Reservations Tab” on page 240.
• “Web Requests Tab” on page 241.
• “Wait List Tab” on page 245.
• “Reconfirm Dates Tab” on page 246.
• “Building Hours Exceptions Tab” on page 247.
• “Analytics Tab” on page 248.
• “At A Glance Tab” on page 251.
Chapter 5
EMS Dashboard
Overview of the EMS Dashboard and Dashboard Options

The Dashboard is a window that centralizes critical information about reservations in a single location. The information that is displayed on this window provides you with the necessary input to manage your work EMS. By default, when the window first opens, it has nine tabs—Notifications, Reminders, Web Reservations, Web Requests, Wait List, Reconfirm Dates, Building Hours Exceptions, Analytics, and At A Glance. If any tab on the Dashboard window has at least one record displayed on it, then, by default, when you log into EMS, the Dashboard window opens and the Dashboard icon on the main toolbar flashes briefly. Also, an asterisk (*) is displayed to the right of the tab name. All the tabs in the upper pane of the window have some of the basic features of an EMS browser window. You can sort the data columns on a tab in either ascending or descending sort order, you can rearrange the column order by dragging a column to a new location using the column heading, and you can change the width of the data columns.

For information about working with data columns on a Dashboard tab, see “To group data by columns in an EMS Browser window” on page 36 and “” on page 39.

You can change the default behavior of the Dashboard in the Dashboard Options dialog box. See “Dashboard options” on page 230. You can also click the Dashboard icon at any time to open the Dashboard window.

Figure 5-1: Dashboard window
Dashboard options

The appearance and functioning of your Dashboard window are determined by the values that you set for the Dashboard options. To view, and if needed, edit these values, in the upper right corner of the Dashboard window, click Options to open the Dashboard Options dialog box.

*Figure 5-2: Dashboard options dialog box*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Dashboard At Startup If Items Exist</td>
<td>Selected by default. The Dashboard window opens automatically after you log into EMS if any tab displays at least one item.</td>
</tr>
<tr>
<td>• Show Reminders</td>
<td>Selected by default. Indicates the tabs that are to be displayed on the Dashboard window.</td>
</tr>
<tr>
<td>• Show Web Reservations</td>
<td></td>
</tr>
<tr>
<td>• Show Web Requests</td>
<td></td>
</tr>
<tr>
<td>• Show Analytics</td>
<td></td>
</tr>
<tr>
<td>• Show Wait List</td>
<td></td>
</tr>
<tr>
<td>• Show Reconfirm Dates</td>
<td></td>
</tr>
<tr>
<td>• Show Building Hours Exceptions</td>
<td></td>
</tr>
<tr>
<td>• Show At A Glance</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>“Thru Today” includes xx Days Prior to Today</td>
<td>Indicates how far into the past that reminders are to be displayed in the “Thru Today” view. The default value is seven.</td>
</tr>
<tr>
<td>Activate Flashing Indicator For:</td>
<td>Set on a per tab basis. Indicates when the Dashboard icon on the EMS toolbar is to flash if at least one item is displayed on any tab. Values are:</td>
</tr>
<tr>
<td></td>
<td>• Automatically—Immediately when there is at least one record that is displayed on the indicated tab, even when you are working in EMS.</td>
</tr>
<tr>
<td></td>
<td>• At Startup Only</td>
</tr>
<tr>
<td></td>
<td>• Never</td>
</tr>
<tr>
<td>Activate Flashing Indicator For:</td>
<td>Set on a per tab basis. Indicates when the Dashboard icon on the EMS toolbar is to flash if tasks on the tab require your attention. Values are:</td>
</tr>
<tr>
<td></td>
<td>• At Startup Only</td>
</tr>
<tr>
<td></td>
<td>• Never</td>
</tr>
</tbody>
</table>
Notifications Tab

Your EMS administrator can configure notification rules to alert you or groups of which you are a member when additions or modifications have been carried out in the EMS database such as the creation or modification of a booking, the creation or modification of a service order, the creation of a new web account, and so on.

Figure 5-3: Dashboard window, Notifications tab

When the Notifications tab first opens, all the notification rules that include you are listed in the Notification Rule pane (upper left pane) of the tab. Next to each rule, the number of new notifications (notifications with the current day’s date) is displayed. The tab is interactive. You can:

- Select a rule to view all unreviewed notifications for future bookings.
- Select a rule, and under Show, select Reviewed to view all reviewed notifications for future bookings.
- Select a rule, and under Show, select Old to view all notifications for past bookings.
- Select a notification to view detailed information about the notification (such as new bookings, the changes made to a booking, and the users who were notified of the changes) in a pane at the bottom of the window.
- Select Show New Only to show only new notifications (notifications with the current day’s date) for the notification rules.
- Select a notification, and then click Reviewed to mark a notification as “Reviewed.”
• Select a notification and then click Go To to open the item to which the notification refers.
  • If the notification is attached to a reservation, booking, or booking detail, then the reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically selected.
  • If the notification is attached to a group, then the Group window opens with the group information displayed in the window.
  • Click Refresh to check for notifications that have been issued since you opened the Dashboard.
  • Select a notification, or CTRL-click to select multiple notifications, and then click Delete to delete the notifications from the Notifications tab.
Reminders Tab

A *comment* is a text entry that explains or clarifies a reservation, booking, group, or service order. A *reminder* is a comment that has a due date associated with it. The Reminders tab displays all the reminders for which you are the responsible user and that, by default, have a due date through the current day’s date.

*Figure 5-4: Dashboard window, Reminders tab*

The tab is interactive. You can:

- View a list of reminders for other responsible users and/or set the criteria for which reminders that you want to view. See “To change the Reminders tab view” on page 235.
- Create an unattached reminder. “To create an unattached reminder” on page 236.
- Edit a reminder. “To edit a reminder” on page 237.
- Delete a reminder. “To delete a reminder” on page 237.
- Print a reminder. “To print a reminder” on page 238.
- Go to the item to which a reminder is attached. See “To go to the item to which a reminder is attached” on page 238.
- Complete a reminder. See “To complete a reminder” on page 238.
- Reassign multiple reminders from one EMS user to another. See “To reassign multiple reminders between EMS users” on page 239.
To change the Reminders tab view

By default, when the Dashboard window first opens, the Reminders tab displays all the reminders for which you are the responsible user and that have a due date through the current day’s date. You can do one or more of the following to change this view:

- To view the reminders for which other users are responsible, simply select the user or users in the Responsible User pane.
- To view only a specific group of reminders for which you or others are the responsible users, change the viewing criteria.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>View reminders that have the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.</td>
</tr>
<tr>
<td>Reminder Type</td>
<td>The default value is (all).</td>
</tr>
<tr>
<td>Attached To</td>
<td>The default value is (all). To view reminders that are not attached to any item (reservation, booking, group, or service order), select (none). See “To create an unattached reminder” on page 236.</td>
</tr>
<tr>
<td>Search in Text</td>
<td>Enter the string by which to search for specific reminders. (The search is carried out on the Notes field for the reminder.) Your search is limited to the exact order of the characters in the string, but the search string is not-case sensitive and it can appear anywhere in the search results. For example, a search string of cat returns reminders that have “catering” or “Mary’s catering” in the Notes field.</td>
</tr>
<tr>
<td>Date Completed</td>
<td>Available only if Exclude Complete is not checked.</td>
</tr>
<tr>
<td>Exclude Completed</td>
<td>Selected by default. Clear this option to display completed reminders in the Reminders list. To display completed reminders that meet the other viewing criteria, regardless of their completion dates, leave the Date Completed fields blank; otherwise, to view completed reminders that were completed by a specific date, you can enter a Starting date or a date range in the Date Completed fields.</td>
</tr>
<tr>
<td>Hide Cancelled</td>
<td>Not selected by default. Select this option to display canceled reminders in the Reminders list.</td>
</tr>
</tbody>
</table>
To create an unattached reminder

When you create a reminder on the Navigator, the reminder is attached to a specific reservation, booking, or booking detail. Similarly, when you create a reminder on the Groups window, the reminder is attached to a specific group. If needed, however, you can create a reminder that addresses just your general business needs and is not attached to any specific item. For example, you can create a reminder about “preparing for your organization’s yearly safety inspection.” Any reminder that you create from the Reminders tab on the Dashboard window is an unattached reminder.

1. Click New.

The Reminder dialog box opens.

Figure 5-5: Reminder dialog box

2. Do one of the following:
   - Select a Reminder Type.
   - If none of the pre-configured Reminder Types meets your working needs, then select (user-specified), and in the Description field, enter a description for the reminder type.

The Responsible User field is populated with your User ID and the Date Due field is populated with the current day’s date.

3. Optionally, change the value for the Responsible User, the Date Due, or both.

4. If you are completing the reminder today, select a Date Completed; otherwise, leave this field blank. (This field is populated automatically when you or another user completes the reminder. See “To complete a reminder” on page 238.)

5. Optionally, do one or both of the following:
   - In the Notes field, enter any further explanation or information about the reminder.
   - Click Spelling to spell check the reminder before you save it.
6. Click OK.
   The Reminder dialog box closes. The newly created reminder is not attached to an item. It might or might not be displayed in the Reminders list depending on the values that you have set for filtering the display.

To edit a reminder

1. On the Reminders list, select the reminder that you are editing, and then click Edit.
   The Reminder dialog box opens. The dialog box is populated with the current information for the reminder.
2. Edit the reminder as needed.
3. Optionally, click Spelling to spell check the reminder before you save the edited reminder.
4. Click OK.
   The Reminder dialog box closes. If the reminder is attached to an item such as a reservation, then the reminder remains attached; otherwise, it is saved as an unattached reminder.

To delete a reminder

You can delete any reminder (attached or unattached) regardless of its due date and regardless if it is completed.

1. On the Reminders list, select the reminder that you are deleting, and then click Delete.
   A message opens asking you if it is OK to delete the reminder.
2. Click Yes.
   The message closes and the reminder is deleted.
To print a reminder

1. On the Reminders list, select the reminder that you are printing, and then click Print.

   An onscreen preview of the reminder opens. The preview window contains options for printing a hard copy of the reminder, for emailing the reminder, and so on.

   **Figure 5-6: Onscreen preview for a printed reminder**

2. Select the option or options that best fit your working needs.

To go to the item to which a reminder is attached

On the Reminders list, select a reminder, and then click Go To.

*The Attached To column for the reminder must state anything other than “Unattached.”*

- If the reminder is attached to a reservation, booking, or booking detail, then the reservation opens in the Navigator, and the appropriate folder (Reservation, Booking, or Booking Detail) is automatically selected.
- If the reminder is attached to a group, then the Group window opens, with the group information displayed in the window.

To complete a reminder

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are completing.

2. Click Completed.

   A message opens asking you if it is OK to set the selected reminders as completed.

3. Click Yes.

   The message closes. The reminders are completed with a date equal to the current day’s date. The reminders might or might not be displayed in the Reminders list depending on the values that you have set for filtering the display.
To reassign multiple reminders between EMS users

1. On the Reminders list, select the reminder, or CTRL-click to select the multiple reminders that you are reassigning.

2. Click Reassign.

   The Select User dialog box opens. This dialog box lists all the users for your EMS implementation.

   Figure 5-7: Select User dialog box

3. Select the user to whom you are reassigning the reminder.

   To search for a user, enter a search string in the Search field. The search string is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of Admin returns both Admin users and SysAdmin. The list of users that meet your search string is dynamically updated as you enter the string.

4. Click OK.

   A message opens, asking you if you are sure that you want to reassign the selected reminders to the user.

5. Click Yes.

   The Select User dialog box and message close and the reminder is reassigned.
Chapter 5
EMS Dashboard

Web Reservations Tab

The Web Reservation tab displays any reservation that was submitted through VEMS for web process templates that are set to Self Serve mode.

*Figure 5-8: Web Reservations tab*

The tab is interactive. You can:

- Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.
  - Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.
  - Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.
  - Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Web Requests Tab

The Web Requests tab displays any reservation that was submitted through VEMS for web process templates that are set to Request mode. A request that has not yet been processed has a status of Pending.

Figure 5-9: Dashboard window, Web Requests tab

The tab is interactive. You can:

- Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.
  - Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.
  - Room options are displayed on the Room list at the top of the right pane of the tab. To enable the Room list, you must select a specific building.
- Edit a web request, including processing it. See “To edit a web request” on page 242.
- Delete a web request. See “To delete a web request” on page 244.
- Print a web request. See “To print a web request” on page 244.
To edit a web request

1. Select the web request that you are editing, and then click Edit.

   The Web Request dialog box opens. All of the information that was submitted for the request through VEMS is displayed in the dialog box. The dialog box always has a Description tab, a Web Questions tab, and an Audit tab. If the request included resources or setup notes, it also has a Services tab.

   **Figure 5-10: Web Request dialog box**

   ![Web Request dialog box](image)

2. Do one of the following:

   - Edit the request as necessary *without* processing it and then click OK. When editing the request without processing it, optionally, you can do one or more of the following:
     - If you have questions about the request or want to confirm some information (for example, “Will alcohol be served at the event?”) before you process the request, you can enter these questions or comments in the Notes field on the Description tab. A web user can see these notes when viewing the request in VEMS and you can wait for a response before deciding whether to process the request.
     - In addition, to indicate that you are reviewing the request before you process it, you can set the status of the request to In Progress on the Description tab. A web user can see this status when viewing the request in VEMS.
• If the request required questions to be answered on the web, open the Web Questions tab to see the questions and the user’s answers.

• If the request includes resources, open the Services tab to see what the request includes. To view the details for each category, double-click a category to display its associated details in the right pane.

• To process the request and create a true reservation for the request in your EMS database, on the Description tab, click Process.

The reservation opens in the Reservation Wizard. Continue to “Making a Reservation Using the Reservation Wizard” on page 45.

---

After you create a true reservation using the Wizard and the reservation includes a request for services, the Process Web Request Details window opens. (See Figure 5-11 below.) You can process the services immediately using the options on this window, or to process the services at a later date, click Cancel to close the window. You can then open the reservation on the Web Requests tab, and on the Services tab, click Process.

**Figure 5-11: Process Web Request Details window**
Chapter 5
EMS Dashboard

To delete a web request

1. Select the web request, or CTRL-click to select the multiple requests that you are deleting, and then click Delete.

A message opens asking you if it is OK to delete the selected web requests.

2. Click Yes.

The message closes. The selected web requests are deleted.

To print a web request

1. Select the web request, or CTRL-click to select the multiple requests that you are deleting, and then click Print.

An onscreen preview of the selected requests opens. A variety of options are available from this preview, including the options to print a hard copy of the requests, to export the requests to a .pdf, and to email the requests.

*Figure 5-12: Print preview for a web request*

2. Select the option or options that best fit your working needs.
Wait List Tab

The Wait List tab provides you a way of monitoring wait-listed reservations. It also provides an indicator when the requested room becomes available.

Figure 5-13: Wait List tab

The tab is interactive. You can:

- Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.
  - Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

- Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

- Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
The Reconfirm Dates tab displays reservations that have been booked in a status that requires the Reconfirm Date option (for example, a Tentative or Hold status). The list of reservations is automatically sorted in ascending order by Reconfirm Date. You use this tab as a reminder to reconfirm such reservations.

**Figure 5-14: Reconfirm Dates tab**

The tab is interactive. You can:

- Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.
  
  - Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.

  - Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.

  - Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Building Hours Exceptions Tab

The Building Hours Exceptions tab displays reservations that occur outside of configured building hours.

*Figure 5-15: Building Hours Exceptions tab*

The tab is interactive. You can:

- Select options to filter the reservations that are displayed on the tab. After you select or edit the filtering options, click Refresh.
  - Status and Building/Area/View options are displayed on the left pane of the tab. You can select one or more statuses, or you can select all statuses in a single step. You can select a specific building, area, and/or view, or you can select all buildings, areas, and views in a single step.
  - Date options are displayed on the View list at the top of the right pane of the tab. You can view reservations for the indicated due date. The default value is Thru Today. If a value from the pre-configured list does not meet your needs, then select (user specified) and in the Date Due fields, enter at least a Starting due date. The Ending due date is optional.
- Select the reservation in the Reservations list, and then click Go To to open the reservation in the Navigator.
Analytics Tab

The Analytics tab provides quick access for queries that have been defined using the Query builder and to which you have access as a user. You can run these queries from the Analytics tab.

Figure 5-16: Dashboard window, Analytics tab

To run a query from the Analytics tab, do the following:

1. In the upper left corner of the Analytics tab, click Select Queries.
   
   The Queries dialog box opens. This dialog box lists the queries that have been defined using the Query builder and to which you have access.

2. Select the queries that you want to run, and then click OK.
   
   The Queries dialog box closes. The selected queries are displayed in the Queries pane (upper left) on the Analytics tab.
3. In the Queries pane, select the query that you want to run, and then select the date for which the data in your EMS database is to be queried.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>The starting date is set to the first day of the month and the ending date is set to the last day of the month but you can edit one or both of these dates. Note: For some queries, if you select Custom, a Use Specific Times option becomes available. If you enter the same date for the starting date and ending date, you can select Use Specific Times, and then enter a starting time and ending time to query the data for in specific time range on the same day.</td>
</tr>
<tr>
<td>Last Month</td>
<td>The starting date is set to the first day of the previous month and the ending date is set to the last day of the previous month.</td>
</tr>
<tr>
<td>Last Quarter</td>
<td>Quarters are based on a calendar year:</td>
</tr>
<tr>
<td>This Quarter</td>
<td>• First quarter is 1/1 through 3/31.</td>
</tr>
<tr>
<td>This Quarter To Date</td>
<td>• Second quarter is 4/1 through 6/30.</td>
</tr>
<tr>
<td></td>
<td>• Third quarter is 7/1 through 9/30.</td>
</tr>
<tr>
<td></td>
<td>• Fourth quarter is 10/1 through 12/31.</td>
</tr>
<tr>
<td></td>
<td>For example, if the current day’s date is 11/22/2010, and you select Last Quarter, then the starting date is set to 7/1/2010 and the ending date is set to 9/30/2010.</td>
</tr>
<tr>
<td>Last Year</td>
<td>The starting date is set to 1/1 of the previous year, and the ending date is set to 12/31 of the previous year.</td>
</tr>
<tr>
<td>This month</td>
<td>The starting date is set to the first day of the current month and the ending date is set to the last day of the current month.</td>
</tr>
<tr>
<td>This Year</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to 12/31 of the current year.</td>
</tr>
<tr>
<td>This Year to Date</td>
<td>The starting date is set to 1/1 of the current year, and the ending date is set to the current day’s date.</td>
</tr>
</tbody>
</table>

4. Optionally, in the Report Comment field, enter a description or explanation of the query.

5. Click Get Data.

If the query returns data, then the results are displayed in the Results pane on the Analytics tab.

6. Optionally, do one or more of the following:

- To export the query results to an Excel spreadsheet or to an XML file, click Export, and then select the appropriate file type. A dialog box opens in which you can specify the file name (the default file name is the name of the query, but you can always edit this), and the location to which to save the file.

The file type for an Excel spreadsheet is .xl or .xls and you cannot change this. The file type for an XML file is .xml and you cannot change this.
• To generate an onscreen preview of the printed query results, click Print. The preview window contains options for printing a hard copy of the query results, for emailing the results, and so on. Select the option or options that best fit your working needs.

Figure 5-17: Onscreen preview of a query results

![Onscreen preview of a query results](image)

• If the query has been defined with a Chart, the Chart option is enabled. Click Chart to generate an onscreen preview of the charted data. The preview window contains options for printing a hard copy of the chart, for emailing the chart, and so on. Select the option or options that best fit your working needs.

Figure 5-18: Onscreen preview of query results that are charted/graphed

![Onscreen preview of query results that are charted/graphed](image)
At A Glance Tab

The At A Glance tab provides quick access to high-level booking statistics for events at your organization or facility. You can select to show booking statistics by category, by event type, by group type, by reservation source, by room type, or by status.

*Figure 5-19: At A Glance tab*

By default, when the tab first opens, the date is set to the current day’s date, and category is the selected display type. To view booking statistics for your facility on a given date, do the following:

1. Select options (Status and Building) on the left pane of the tab to filter the results that are displayed on the tab.
2. Change the date and/or the display type as needed to view the bookings statistics for a selected date.
A group is an entity for which reservations are made at your facilities. A group is one of the four core data items that your EMS administrator must configure so that you can make reservations. A group can be an internal or external entity and it can be an organization or an individual. A contact is a person who serves as the coordinator or focal point for a group.

This chapter covers the following topics:

- “Searching for and Configuring Groups” on page 255.
- “Configuring Additional Information for a Group” on page 263.
- “Configuring Contacts for a Group” on page 278.
- “Editing Group Information” on page 286.
- “Importing Groups” on page 294.
- “Working with Reservations for a Group” on page 295.
- “Emailing a Group” on page 300.
- “Printing and Exporting Group Information” on page 301.
- “Printing and Exporting Web User Information” on page 303.
Searching for and Configuring Groups

A group is an entity for which reservations are made at your facilities. A group can be an internal or external entity and it can be an organization or an individual. A group must be configured before you can make reservations for it in EMS. Optionally, if you want to first confirm that a group has not already been configured, then you can search for the group.

Typically, your EMS administrator carries out basic configuration of the groups for which you need to make reservations. You always have the option of modifying any group that your EMS administrator has configured and you always have the option of configuring new groups when needed.

Your organization might use a different term (such as client, customer, and so on) to identify the entities for which reservations are made at your facilities. Contact your EMS administrator if you need assistance in clarifying this term.

To search for a group and/or contact

1. On the toolbar, click the Groups icon .

The Groups window opens. The Results tab is the active tab. By default, when the Results tab first opens, it lists the first 1000 groups that are currently configured in your EMS database and that have a status of Active.

Figure 6-1: Groups window, Results tab
Optional, to change the number of records that are displayed in the Groups window, click Options, and then on the Group Options dialog box, select a different number of records to return.

2. Open the Filter tab and set your search criteria.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display     | • Groups—Display all groups that meet your search criteria on the Results tab.  
• Contacts—Display all contacts that meet your search criteria on the Results tab.  
**Note:** When a list of contacts is displayed, the contact’s group is also displayed. |
| Search Fields| • Starts with—The string is not case-sensitive, but your search is limited to the exact order of the characters in the string, and the string must begin with the information for which you are searching. For example, **Assoc** returns **Association of Broadcasters** but not **Biomedical Student Association**.  
• Contains—Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive, and the string can be found anywhere in your search results. For example, **Assoc** returns both **Association of Broadcasters** and **Biomedical Student Association**. |
| Group       | Fields are available if you select Groups for Display. Enter values as needed in any or all fields.                                          |
| Contact     | Fields are available only if you select Contacts for Display. Leave all fields set to their default search values to search for all active contacts that are currently configured in your EMS database, or enter values as needed in any or all fields.  
**Note:** If you select Contact, then both the Group fields and the Contact fields are available for searching. If you enter data in both sets of fields when you are searching for a contact, then your search criteria must be met for both the contact and the contact’s group to be displayed on the Results tab. |

**Note:** To reset the Filter at any time to its default settings, click Reset Filter.

3. Click Get Data.

The Results tab opens with a list of search results that meet all your search criteria.

4. To further filter the display on the Results tab, in the Search field, enter a search string.

The list of groups is dynamically updated as you enter your search string.

---

*Your search is limited to the exact order of the characters in the string, but the search string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of **Assoc** returns both **Association of Broadcasters** and **Biomedical Student Association**.*
To configure groups

Typically, your EMS administrator carries out basic configuration of the groups for which you need to make reservations. You always have the option of modifying any group that your EMS administrator has configured and you always have the option of configuring new groups when needed.

Remember that before you configure a group, you might want to search for the group to verify that it has not already been configured. See “To search for a group and/or contact” on page 255.

1. On the toolbar, click the Groups icon .

The Groups window opens. The Results tab is the active tab. By default, when the Results tab first opens, it lists up the first 1000 groups that are currently configured in your EMS database and that have a status of Active.

Figure 6-2: Groups window, Results tab
Chapter 6  
Groups and Contacts

2. Click New.

The Group dialog box opens. The Group tab is the active tab.

*Figure 6-3: Group dialog box, Group tab*

3. Enter the summary information for the new group.

*The only required information is the group name. All other information on all tabs is optional and can be added at a later date when needed.*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required field. The name of the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The name can be a maximum of 50 characters, including spaces.</td>
</tr>
<tr>
<td>Address, City, ST</td>
<td>The street or mailing address for the group.</td>
</tr>
<tr>
<td>Country, Zip</td>
<td></td>
</tr>
<tr>
<td>International</td>
<td>Select this option to drop the State and Zip fields for an international group.</td>
</tr>
<tr>
<td>Group Type</td>
<td>Pick a group type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If calculations have been assigned to a group type, then these calculations are applied only to new groups of this type.</td>
</tr>
</tbody>
</table>
4. Optionally, do one or both of the following; otherwise, go to Step 5.

- Open the Billing Information tab and add the default billing information for the group.

Figure 6-4: Group dialog box, Billing Information tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Fax</td>
<td>The phone number and fax number for the group. Note: The Phone and Fax fields have a dropdown list available on which you can select a different value (Fax, Mobile, Other, or Phone) for the field label, or you can enter a user-defined value. To enter a user-defined value, double-click the current field label to select it, and then enter the user-defined value over the selected label.</td>
</tr>
<tr>
<td>Email Address</td>
<td>The email address for the group. Note: If your computer is connected to a network, click the Search icon to open a Global Address Lookup dialog box and search for the email address.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL for the group’s website. Note: Web users can link to this group's website on VEMS.</td>
</tr>
<tr>
<td>Default Contact</td>
<td>Populated with the name of the default contact for the group after you have defined default contacts for the group.</td>
</tr>
<tr>
<td>Require Contacts</td>
<td>Select this option if the group is to always require a contact when a reservation is being made for the group.</td>
</tr>
<tr>
<td>VIP</td>
<td>Select this option if the group is to be designated as a VIP group.</td>
</tr>
<tr>
<td>Available to Web Users</td>
<td>Select this option if users are to be able to select the group on the Group Lookup page in VEMS.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave this option blank to add the group as an active group. Select this option to inactivate the group.</td>
</tr>
</tbody>
</table>
Chapter 6
Groups and Contacts

The values that you specify here are the default values that are applied when a new reservation is made for the group. Any EMS user can change these values if needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pricing Plan</td>
<td>Pick a pricing plan.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Pick a payment type.</td>
</tr>
<tr>
<td>Salesperson</td>
<td>Pick a salesperson.</td>
</tr>
<tr>
<td>Event Coordinator</td>
<td>Pick an event coordinator.</td>
</tr>
<tr>
<td>Sales Category</td>
<td>Pick a sales category.</td>
</tr>
</tbody>
</table>
| Status               | The status is a way to indicate the standing or ranking of the group. The default values are the following:  
  • OK—A reservation can be made for the group. (In your organization, this status could indicate that the group is current in payments due.)  
  • Warning—If a group status is set to Warning, then a Warning message opens when you make a reservation for the group. It does not, however, prevent a reservation from being made for the group.  
  • Bad—If a group status is set to Bad, then reservations cannot be made for the group. |
| Billing Reference Number | You can manually enter data into the field, or you can click the Search icon [🔍] to open a master list of billing reference numbers and select a reference.  
  **Note:** To define a list of eligible billing references that are specific to the group, see “Configuring Additional Information for a Group” on page 263. |
| PO Number            | You can manually enter data into the field, or you can click the Search icon [🔍] to open a master list of PO Numbers and select a PO number.  
  **Note:** To define a list of eligible PO numbers that are specific to the group, see “Configuring Additional Information for a Group” on page 263. |
| External Reference   | Links the group to a web user record and/or HR Toolkit. |
| Account              | Pick an account. |
• Open the Other tab and add any other identifying information for the group as needed.

*Figure 6-5:  Group dialog box, Other tab*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network ID</td>
<td>The Windows login for the group.</td>
</tr>
<tr>
<td>Personnel Number</td>
<td>Organization number for the group.</td>
</tr>
<tr>
<td>Badge Number</td>
<td>Badge number for the group.</td>
</tr>
<tr>
<td>Other ID</td>
<td>Any secondary ID for the group.</td>
</tr>
</tbody>
</table>

5. Click OK.

The Group dialog box closes and a group-specific window opens with the newly configured group automatically selected. (See *Figure 6-6 on page 262.*) You can use the options on this window to carry out additional configuration for the group. See “Configuring Additional Information for a Group” on page 263.
Figure 6-6: Example of a group-specific window
Configuring Additional Information for a Group

After you have configured a new group in your EMS database with the basic group information (group identifying information, billing information and/or other information), you have the option of configuring additional information for the group. You can:

- Create a web user from the group. See “To create a web user from a group” on page 263.
- Assign the group to a web user. See “To assign the group to a web user” on page 266.
- Add reminders to the group. See “To add a reminder to a group” on page 268.
- Add comments to the group. See “To add a comment to a group” on page 269.
- Add attachments to the group. See “To add attachments to a group” on page 271.
- Add user defined fields to the group. See “To add user defined fields to a group” on page 272.
- Assign calculations to the group. See “To assign calculations to a group” on page 273.
- Configure a master list of group-specific billing reference numbers. See “To configure a list of billing reference numbers” on page 275.
- Configure a master list of group-specific PO numbers. See “To configure a list of PO numbers” on page 276.

When you select a configuration item (contacts, reminders, and so on) in the left pane in the group-specific window, the right pane for the window is an EMS browser window. See “An EMS Browser Window” on page 35.

For information about adding a contact to a group, including creating a web user for a contact, see “Configuring Contacts for a Group” on page 278. For information about editing a contact for a group, see “Editing Group Information” on page 286.

To create a web user from a group

A web user is a registered user who can submit requests for reservations or schedule reservations in VEMS. When you add a new group in your EMS database, you decide the “level” of the group that you are adding. For a group that is added at the individual (personnel/employee) level, you might also need to create a web user from the group. This user can then create and view reservations on behalf of a group or groups in VEMS. You can create only one web user from a group. When you create a web user, you can also specify one or more delegates for the web user. A delegate is a web user who can create and view reservations on behalf of another web user.

1. Open the Groups window and search for the group for which you are creating the web user. See “To search for a group and/or contact” on page 255.
2. On the Groups window, select the group, and then click Tools > Create Web User.

   A group-specific dialog box opens. The Web User tab is the active tab.

   The User Defined Fields tab displays the questions that a web user was required to answer when the user requested to create an account through VEMS and it is not relevant to the procedure that is described below.

   Figure 6-7: Group-specific dialog box, Web User tab

3. Enter the information for the web user.

   Ideally, you should enter all the necessary information for your web user before you save the web user; however, at any time if you need to access your web user, on the EMS menu bar, click Configuration > Web > Web Users.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Automatically populated after you select the group from the Groups window.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that a web user must enter to log in to VEMS.</td>
</tr>
<tr>
<td>Email address</td>
<td>If this information has been entered in the Groups window for the group, then this field is automatically populated after you select the group from the Groups window. If the field is blank, you must enter the full email address for the user. (The user must enter this address to log in to VEMS.)</td>
</tr>
</tbody>
</table>
4. Open the Process Templates tab and on the Available list, select the web process template, or CTRL-click to select the multiple templates to which you are assigning the user, and then click the Move button (>) to move the selected templates to the Selected list.

5. Open the Groups tab and do one of the following to specify the groups on whose behalf the web user can view and make reservations in VEMS.

- The group (web user) is selected by default. You can leave this group in the Selected list, or you can select the group and click the Remove button (<).
- Specify any combination of search criteria for the Find field and Group Type, and then click Display to produce a list of all groups that meet the criteria. In the Available list, select a group, or CTRL-click to select multiple groups, and then click the Move button (>) to move the selected groups to the Selected list.

A web process template defines the functions that are available to each type of web user in VEMS when the user is submitting a request for a reservation.

If you leave the Find field blank, then a list of all currently active groups for the selected group type is displayed. If you enter a search string in the Find field, the string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, And returns Anderson, Scott, but not Cooper, Anderson.
Chapter 6
Groups and Contacts

6. Open the Delegates tab, and on the Search by dropdown list, do one of the following to specify the delegates for the web user:

- Leave the Find field blank, and then click Display to open a list of all currently available web users. Select a user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected web users to the Selected list.

- On the Search By dropdown list, select the option by which to search (Email Address or User Name), and in the Find field, enter the string by which to filter your search, and then click Display. Select a web user, or CTRL-click to select web multiple users, and then click the Move button (>) to move the selected users to the Selected list.

The string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bob.worth@dea.com but not dbobbett@dea.com.

7. Optionally, click Spelling to spell check any information that you manually entered for the web user.

8. Click OK.

The dialog box for creating a web user closes and a message opens indicating that the web user was created successfully.

9. Click OK to close the message and return to the Groups window.

To assign the group to a web user

When you add a new group in your EMS database, you should also assign the group to a web user. This web user can then create and view reservations on behalf of the group in VEMS. You can assign a group to one or more web users.

1. Open the Groups window and search for the group to which you are assigning the web user. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Tools > Assign to Web Users.

The Assign Group dialog box opens. See Figure 6-8 on page 267.
Figure 6-8: Assign Group dialog box

3. Do one of the following to select the web users that are being assigned to the group:
   - Leave the Find field blank, and then click Display to open a list of all currently active web users. Select the web user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected web users to the Selected list.
   - In the Search By dropdown list, select the option by which to search (Email Address or User Name) and then in the Find field, enter the string by which to filter your search, and then click Display. Select the web user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected users to the Selected list.

   The string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bob.worth@dea.com but not dobbett@dea.com.

4. Click Finish.
   A message opens indicating that the group was assigned successfully.

5. Click OK to close the message and return to the Groups window.
To add a reminder to a group

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a booking detail that is a service order. A reminder is a comment that has a due date associated with it.

1. Open the Groups window and search for the group to which you are adding the reminder. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

   A group-specific window opens. The group is automatically selected in the window.

   For an example of a group-specific window, see Figure 6-6 on page 262.

3. In the left pane of the group-specific window, select Reminders.

   A list of all reminders that are currently configured for the group is displayed in the right pane of the window.

4. Click New.

   The Reminder dialog box opens. The Responsible User field is populated with the your User ID.

   Figure 6-9: Reminder dialog box

5. On the Reminder Type dropdown list, select the type of reminder that you are adding; otherwise, if none of the pre-configured reminder types meets your working needs, select (user specified comment), and then in the Description field, enter a description for the reminder type.

   The Date Due field is populated with the current day’s date.

   The description can be a maximum of 30 characters, including spaces.
6. Optionally, change the value for the Responsible User, the Date Due, or both.

7. If you are completing the reminder today, select a Date Completed; otherwise, leave this field blank.

If you leave this field blank, then it is automatically populated when you or another user completes the reminder on the Reminders tab of the Dashboard window. See “To complete a reminder” on page 238.

8. Optionally, do one or both of the following:
   • In the Notes field, enter any further explanation or information about the reminder.
   • Click Spelling to spell check the reminder before you save it.

9. Click OK.

   The Reminder dialog box closes. The newly added reminder is automatically selected in the group-specific window.

To add a comment to a group

A comment is a text entry that explains or clarifies a reservation, a booking, a group, or a booking detail that is a service order.

1. Open the Groups window and search for the group to which you are adding the comment. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

   A group-specific window opens. The group is automatically selected in the window.

   For an example of a group-specific window, see Figure 6-6 on page 262.

3. In the left pane of the group-specific window, select Comments.

   A list of all comments that are currently configured for the group is displayed in the right pane of the window.
4. Click New.

   The Comment dialog box opens.

   *Figure 6-10: Comment dialog box*

5. On the Comment Type dropdown list, select the type of comment that you are adding; otherwise, if none of the pre-configured comment types meets your working needs, select (user specified comment), and then in the Description field, enter a description for the comment type.

   *The description can be a maximum of 30 characters, including spaces.*

6. In the Notes field, enter the comment.

7. Optionally, do one or both of the following:

   - To alert any EMS user who opens this group or a reservation that is assigned to this group that this comment has been added to the group, select Alert Users.
   - Click Spelling to spell check the comment before you add it to the group.

8. Click OK.

   The Comment dialog box closes. The newly added comment is automatically selected in the group-specific window.
To add attachments to a group

An attachment is used to describe any file that you can add to or store on a reservation, a booking, or a group.

1. Open the Groups window and search for the group to which you are adding the attachment. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

   A group-specific window opens. The group is automatically selected in the window.

   For an example of a group-specific window, see Figure 6-6 on page 262.

3. In the left pane of the group-specific window, select Attachments.

   A list of all attachments that have already been added to the group is displayed in the right pane of the window.

   To view any attachment in this list, select it, and then click View.

4. Click New.

   The Attachment dialog box opens.

   Figure 6-11: Attachment dialog box

5. In the Description field, enter a name or description for the attachment.

   The description can be a maximum of 50 characters, including spaces. If you leave this field blank, then the Description field is populated with the name of the file after you attach it to a group.
6. On the Type dropdown list, select the attachment type.

7. Click the Search icon to open the Find Attachment dialog box, and then browse to and select the attachment.

   The Find Attachment dialog box closes. The file name for the attachment is displayed in the Attachment field.

8. Optionally, do one or both of the following as needed:
   • If you left the Description field blank, then the name of the attached file is used by default for the file description, and you can edit this if needed.
   • Click Spelling to spell check the description before you attach the drawing to the group.

9. Click OK.

   The Attachment dialog box closes. The newly added attachment is automatically selected in the group-specific window.

To add user defined fields to a group

A user defined field (UDF) is a custom field that stores additional data for a group. Typically, your EMS administrator configures the types of fields that are available as well as the allowed values (text, numeric, and so on) for the fields. When you add a user defined field to a group, you must specify a value for the field.

1. Open the Groups window and search for the group to which you are adding the UDF. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

   A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select User Defined Fields.

   A list of all UDFs that have already been added to the group is displayed in the right pane of the window.

4. Click New.

   The User Defined Field dialog box opens. See Figure 6-12 on page 273.
5. On the Field dropdown list, select the UDF that you are adding to the group.
6. In the Value field, enter a value for the UDF.
7. Click OK.

The User Defined Field dialog box closes. The newly added UDF is automatically selected in the group-specific window.

To assign calculations to a group

*Calculations* are additional charges that can be applied to billable items (a category, a group, a group type, a resource, or a room) such as gratuity or sales tax. When you configure a group, you can assign the calculations that are to always apply to the group.

1. Open the Groups window and search for the group to which you are assigning the calculations. See “To search for a group and/or contact” on page 255.
2. On the Groups window, select the group, and then click Open.

   A group-specific window opens. The group is automatically selected in the window.

3. In the left pane of the group-specific window, select Calculations.

   The right pane of the group-specific window displays any calculations that have already been assigned to the group.
4. Click Edit.

The Calculations dialog box opens. The group name is displayed at the top of the dialog box.

Figure 6-13: Calculations dialog box

5. On the Available list, select the calculation, or CTRL-click to select the multiple calculations that are to always apply to this group, and then click the Move button (>) to move the selected calculations to the Selected list.

Your EMS administrator can also assign calculations to a group type. If your EMS administrator has already assigned calculations for this group’s type, then these calculations are automatically applied to the group. The calculations are displayed in the Selected list after you click OK and save the group; however, you can always edit these calculations.

6. Continue with any other optional configuration for the group as needed; otherwise, click OK to close the Calculations dialog box and return to the group-specific window.
To configure a list of billing reference numbers

You can configure a list of billing reference numbers that are specific to the group.

1. Open the Groups window and search for the group for which you are configuring the master billing reference numbers list. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

   A group-specific window open. The group is automatically selected in the window.

   For an example of a group-specific window, see Figure 6-6 on page 262.

3. In the left pane of the group-specific window, select Billing Reference.

   A list of all currently active billing reference numbers for the group is displayed in the right pane of the group-specific window.

4. Optionally, to display all billing reference numbers regardless of status, click Show Inactive.

   Any inactive billing reference numbers are displayed in red italics in the right pane.

5. Click New.

   The Billing Reference dialog box opens.

*Figure 6-14: Billing Reference dialog box*
6. Enter the information for the new billing reference number.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Reference Number</td>
<td>The billing reference number that is associated with the group. <strong>Note:</strong> The reference can be alphanumeric and it has a maximum of 100 characters, including spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the billing reference number.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any other comments or statements that are applicable for the billing reference number.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave this option blank to add the reference as an active reference (the billing reference number is to be available when a reservation is made for the group). Select this option to inactivate the billing reference number.</td>
</tr>
</tbody>
</table>

7. Optionally, click Spelling to spell check the information for the billing reference number before you save it.

8. Continue with any other optional configuration for the group as needed; otherwise, click OK to close the Billing Reference Number dialog box and return to the group-specific window.

**To configure a list of PO numbers**

You can configure a list of PO numbers that are specific to the group.

1. Open the Groups window and search for the group for which you are configuring the master PO numbers list. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then click Open.

   A group-specific window open. The group is automatically selected in the window.

   *For an example of a group-specific window, see Figure 6-6 on page 262.*

3. In the left pane of the group-specific window, select PO Numbers.

   A list of all currently active PO numbers for the group is displayed in the right pane of the group-specific window.

4. Optionally, to display all PO numbers regardless of status, click Show Inactive.

   Any inactive PO numbers are displayed in red italics in the right pane.
5. Click New.

The PO Number dialog box opens.

*Figure 6-15: PO Number dialog box*

6. Enter the information for the new PO number.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Number</td>
<td>The PO number that is associated with the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The reference can be alphanumeric and it has a maximum of 100 characters, including spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the PO number.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any other comments or statements that are applicable for the PO number.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave this option blank to add the PO number as an active number (the PO number is to be available when a reservation is made for the group). Select this option to inactivate the PO number.</td>
</tr>
</tbody>
</table>

7. Optionally, click Spelling to spell check the information for the PO number before you save it.

8. Continue with any other optional configuration for the group as needed; otherwise, click OK to close the PO Number dialog box and return to the group-specific window.
Configuring Contacts for a Group

A contact is a person who serves as the coordinator or focal point for a group. You have two options for configuring a contact for a group. You can configure a “free form” contact, which requires you to manually enter the contact information, or you can configure a contact from another group, which means that you do not have to manually enter the contact information. Instead, the group information is automatically used for the contact.

You can also configure and edit a contact “on the fly” during the reservation process. See “Making a Reservation Using the Reservation Wizard” on page 45 for details.

To configure contacts

1. Open the Groups window and search for the group for which you are configuring the contact. See “To search for a group and/or contact” on page 255.

2. Select the group, and then click Open.

A group-specific window opens. The group is automatically selected in the window.

Figure 6-16: Group-specific window

3. In the left pane of the group-specific window, select Contacts.

A list of all currently active contacts for the group is displayed in the right pane of the group-specific window.
4. Continue to one of the following:
   - “To configure a contact manually” below.
   - “To configure a contact from a group” on page 281.

**To configure a contact manually**

1. Click New.
   
The Contact dialog box opens.

*Figure 6-17: Contact dialog box*

2. Enter the information for the new contact.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>The name of the contact. <strong>Note:</strong> The name can be a maximum of 50 characters, including spaces.</td>
</tr>
<tr>
<td>Title</td>
<td>The title (Mr., Ms., Dr., and so on) of the contact.</td>
</tr>
<tr>
<td>Group</td>
<td>Populated with the name of the group that you selected. You cannot change this value.</td>
</tr>
<tr>
<td>Address</td>
<td>Populated with the address of the group that you selected. If the contact address is not the same as the group address, then clear Use Group Address and enter the appropriate values in the Address fields.</td>
</tr>
</tbody>
</table>
Chapter 6
Groups and Contacts

3. Optionally, do one or both of the following:
   
   • Click Spelling to spell check the information for the contact before you save it.
   
   • Make sure that the newly created contact is selected so that you can create a web user from the contact. See “To create a web user from a contact” on page 283.

4. Click OK.

   The Contact dialog box closes. The contact is added to the group. The group-specific window remains open.
Chapter 6
Groups and Contacts

To configure a contact from a group

1. Click Tools > Click Create Contact from Another Group.
   A second Groups window opens.

2. Search for the group that is to be the source of the contact, and then click Select.

   See “To search for a group and/or contact” on page 255.

The Contact dialog box opens. The name of the group (contact source) is displayed in the Group field and you cannot edit this value. The remainder of the fields (Contact Name, Address, Phone, and so on) display the information for the group that you selected in Step 2 of “To configure contacts” on page 278.

Figure 6-18: Contact dialog box

3. If needed, edit the information for the contact.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>The name of the contact. <strong>Note:</strong> The name can be a maximum of 50 characters, including spaces.</td>
</tr>
<tr>
<td>Title</td>
<td>The title (Mr., Ms., Dr., and so on) of the contact.</td>
</tr>
<tr>
<td>Group</td>
<td>Populated with the name of the group that you selected first (the group for which you are configuring the contact). You cannot change this value.</td>
</tr>
</tbody>
</table>
Chapter 6
Groups and Contacts

4. Optionally, do one or both of the following:
   - Click Spelling to spell check the information for the contact before you save it.
   - Make sure that the newly created contact is selected so that you can create a web user from the contact. See “To create a web user from a contact” on page 283.

5. Click OK.

The Contact dialog box closes. The contact is added to the group. The group-specific window remains open.
To create a web user from a contact

A web user is a registered user who can submit requests for reservations or schedule reservations in VEMS. When you add a contact to a group in your EMS database, you might also need to create a web user from the contact. This web user can then create and view reservations on behalf of the contact’s group in VEMS. You can create only one web user from a contact. When you create a web user, you can also specify one or more delegates for the web user. A delegate is a web user who can create and view reservations on behalf of another web user.

1. If needed, open the group that contains the contact from which you are creating the web user in the group-specific window. See “To configure contacts” on page 278.

2. In the left pane of the group-specific window, make sure that Contacts is selected.

3. In the right pane of the window, select the contact from which you are creating the web user.

4. Click Tools > Create Web User from Contact.

A contact-specific dialog box opens. The Web User tab is the active tab.

---

The User Defined Fields tab displays the questions that a web user was required to answer when the user requested to create an account through VEMS and it is not relevant to the procedure that is described below.

Figure 6-19: Contact-specific dialog box, Web User tab
5. Enter the information for the web user.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Automatically populated after you select the contact. You can edit this information.</td>
</tr>
<tr>
<td>Password</td>
<td>The password that a web user must enter to log in to VEMS.</td>
</tr>
<tr>
<td>Email address</td>
<td>If this information has been entered for the contact, then this field is automatically populated after you select the contact. If the field is blank, you must enter the full email address for the user. (The user must enter this address to log in to VEMS.)</td>
</tr>
<tr>
<td>Phone/Fax</td>
<td>Optional fields. If this information has been entered for the contact, then these fields are automatically populated after you select the contact. If the fields are blank, you can enter values if needed.</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional field.</td>
</tr>
<tr>
<td>External Reference</td>
<td>Optional field. Links the web user to an outside program if needed.</td>
</tr>
<tr>
<td>Network ID</td>
<td>Optional field. The web user’s network ID.</td>
</tr>
<tr>
<td>Email Opt Out</td>
<td>Select this option if the web user is not to receive automatic emails (such as reservation summary emails) from VEMS. The user will still receive manually sent emails.</td>
</tr>
<tr>
<td>Status</td>
<td>Required field. Select the status for the web user:</td>
</tr>
<tr>
<td></td>
<td>• Active—The web user can log in to VEMS.</td>
</tr>
<tr>
<td></td>
<td>• Inactive—The user cannot log in to VEMS and is instructed to contact the EMS administrator.</td>
</tr>
<tr>
<td></td>
<td>• Pending—The web user cannot log in to VEMS and is informed that he/she must check back at a later time.</td>
</tr>
<tr>
<td>Security Template</td>
<td>Required field. This determines the web user’s access to the system—the menu items that the user can see and the information that the user can view in a tooltip when ‘rolling-over’ an event in VEMS.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Required field. Select the time zone for the user.</td>
</tr>
</tbody>
</table>

6. Open the Process Templates tab and on the Available list, select the web process template or CTRL-click to select the multiple templates to which this user is to be assigned, and then click the Move button (>) to move the selected templates to the Selected list.

*A web process template defines the functions that are available to each type of web user in VEMS when the user is submitting a request for a reservation.*
7. Open the Groups tab and do one of the following to specify the groups on whose behalf the web user can view and make reservations in VEMS.
   - The contact’s group is selected by default. You can leave this group in the Selected list, or you can select the group and click the Remove button (<).
   - Specify any combination of search criteria for the Find field and Group Type, and then click Display to produce a list of all groups that meets the criteria. In the Available list, select a group, or CTRL-click to select multiple groups, and then click the Move button (>) to move the selected groups to the Selected list.

8. Open the Delegates tab, and on the Search by dropdown list, do one of the following to specify the delegates for the web user:
   - Leave the Find field blank, and then click Display to open a list of all currently available web users. Select a web user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected web users to the Selected list.
   - On the Search By dropdown list, select the option by which to search (Email Address or User Name), and in the Find field, enter the string by which to filter your search, and then click Display. Select a web user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected web users to the Selected list.

9. Optionally, click Spelling to spell check any information that you manually entered for the user.

10. Click OK.
    The dialog box for creating a web user closes and a message opens indicating that the web user was created successfully.

11. Click OK to close the message and return to the group-specific window.
You can **edit** any and all information for a group. The way that you edit the information depends on the information itself. You can edit the Summary information, the Billing information, and the Other information through the Edit function on the group-specific dialog box. You must edit the group’s contacts, reminders, comments, attachments, UDFs, calculations, billing reference numbers, PO numbers, and web users on the group-specific window.

**To edit group information**

1. Open the Groups window and search for the group for which you are editing the information. See “To search for a group and/or contact” on page 255.

2. Select the group, and then click Open to open the group in the group-specific window. The group is selected by default. The Summary tab is the active tab.

3. Continue to one of the following:
   - “To edit summary, billing, and/or other group information” on page 287.
   - “To edit the contacts for a group” on page 287.
   - “To edit the reminders for a group” on page 288.
   - “To edit the comments for a group” on page 288.
   - “To edit the attachments for a group” on page 289.
• “To the edit user defined fields (UDFs) for a group” on page 290.
• “To edit the calculations for a group” on page 290.
• “To edit the billing reference numbers for a group” on page 291.
• “To edit the PO numbers for a group” on page 291.
• “To edit the web users for a group” on page 292.

To edit summary, billing, and/or other group information

1. To edit the summary information, billing information, and/or other information for the group, click Edit.
   The group-specific dialog box opens.

2. Open the appropriate tab, and then edit the information as needed.
   See Step 3 and Step 4 of “To configure groups” on page 257.

3. After you edit the information, click OK.
   The group-specific dialog box closes. You return to the group-specific window with the group still selected.

To edit the contacts for a group

1. In the left pane of the group-specific window, select Contacts.
   A list of all contacts that are currently configured for the group is displayed in the right pane of the window.

2. In the right pane of the window, select the contact that you are editing, and then do one of the following:
   • To set the selected contact as the default contact for the group, click Set Default, and then click Yes at the prompt.
   • To edit the information for the contact, click Edit.
     The Contact dialog box opens. The dialog box displays the information for the selected contact.

3. Edit the information for the contact as needed. See “To configure a contact manually” on page 279.

4. Click OK.
   The Contact dialog box closes. You return to the group-specific window with Contacts still selected.
To edit the reminders for a group

1. In the left pane of the group-specific window, select Reminders.

   A list of all reminders that are currently configured for the group is displayed in the right pane of the window.

2. In the right pane of the groups-specific window, select the reminder that you are editing, and then click Edit.

   The Reminder dialog box opens. The Reminder tab is the active tab.

3. Do any or all of the following to edit the reminder as needed:
   • On the Reminder Type dropdown list, select a different reminder type.
   • Optionally, change the value for the Responsible User, the Date Due, or both.
   • If you are completing the reminder today, select a Date Completed; otherwise, leave this field blank.

   If you leave this field blank, then it is automatically populated when you or another user completes the reminder on the Reminders tab of the Dashboard window. See “To complete a reminder” on page 238.

   • In the Notes field, enter any further explanation or information about the reminder.

4. Optionally, click Spelling to spell check the edited reminder before you save it.

5. Click OK.

   The Reminder dialog box closes. The newly edited reminder is automatically selected in the group-specific window.

To edit the comments for a group

1. In the left pane of the group-specific window, select Comments.

   A list of all comments that are currently configured for the group is displayed in the right pane of the window.

2. In the right pane of the group-specific window, select the comment that you are editing, and then click Edit.

   The Comment dialog box opens. The Comment tab is the active tab.
3. Do any or all of the following to edit the comment as needed:
   - On the Comment Type dropdown list, select a different comment type.

   *If none of the pre-configured comment types meets your working needs, select (user specified comment), and then in the Description field, enter a description for the comment type. The description can be a maximum of 30 characters, including spaces.*

   - In the Notes field, enter or modify the comment.
   - To alert any EMS user that opens this group that this comment has been added to the group, select Alert Users.

4. Optionally, click Spelling to spell check the edited comment before you save it.

5. Click OK.
   The Comment dialog box closes. The newly edited comment is automatically selected in the group-specific window.

**To edit the attachments for a group**

1. In the left pane of the group-specific window, select Attachments.
   A list of all attachments that have been added for the group is displayed in the right pane of the window.

2. In the right pane of the group-specific window, select the attachment that you are editing, and then click Edit.
   The Attachment dialog box opens.

3. Do any or all of the following to edit the attachment as needed:
   - Edit the description for the attachment.

   *The description can be a maximum of 50 characters, including spaces. If you leave this field blank, then the Description field is populated with the name of the file after you attach it to a group.*

   - On the Type dropdown list, select a different attachment type.

   - Click the Search icon to open the Find Attachment dialog box, and then browse to and select a different attachment.

   - If you left the Description field blank, then the name of the attached file is used by default for the file description, and you can edit this if needed.

4. Optionally, click Spelling to spell check the edited attachment before you save it.
Chapter 6
Groups and Contacts

5. Click OK.

The Attachment dialog box closes. The newly edited attachment is automatically selected in the group-specific window.

To the edit user defined fields (UDFs) for a group

1. In the left pane of the group-specific window, select User Defined Fields. All user defined fields that are currently configured for the group are displayed in the right pane of the group-specific window.

2. In the right pane of the group-specific window, select the UDF that you are editing, and then click Edit.

The User Defined Field dialog box opens. The User Defined Field tab is the active tab.

3. Do one or both of the following to edit the UDF:
   • On the Field dropdown list, select a different UDF.
   • In the value field, edit the value for the UDF.

4. Click OK.

The User Defined Field dialog box closes. The newly edited UDF is automatically selected in the group-specific window.

To edit the calculations for a group

1. In the left pane of the group-specific window, select Calculations, and then click Edit. The Calculations dialog box opens.

2. Do one or both of the following:
   • On the Available list, select the calculation, or CTRL-click to select the multiple calculations that are to always apply to this group, and then click the Move button (>) to move the selected calculations to the Selected list.
   • On the Selected list, select the calculation, or CTRL-click to select the multiple calculations that are not to apply to this group, and then click the Remove button (<) to move the selected calculations to the Available list.

3. Click OK.

The Calculations dialog box closes. You return to the group-specific window with Calculations still selected.
To edit the billing reference numbers for a group

1. In the left pane of the group-specific window, select Billing References.
2. In the right pane of the window, select the billing reference number that you are editing, and then click Edit.
   
   The Billing Reference dialog box opens. The dialog box displays the information for the selected billing reference number.
3. Edit the information for the billing reference number as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Reference</td>
<td>The billing reference number that is associated with the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The reference can be alphanumeric and it has a maximum of 100 characters, including spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the billing reference number.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any other comments or statements that are applicable for the billing reference number.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Leave this option blank to add the reference as an active reference (the billing reference number is to be available when a reservation is made for the group). Select this option to inactivate the billing reference number.</td>
</tr>
</tbody>
</table>

4. Optionally, click Spelling to spell check the information for the billing reference number before you save it.
5. Click OK.
   
   The Billing Reference dialog box closes. You return to the group-specific window with Billing References still selected.

To edit the PO numbers for a group

1. In the left pane of the group-specific window, select PO Numbers.
2. In the right pane of the window, select the PO number that you are editing, and then click Edit.
   
   The PO Number dialog box opens. The dialog box displays the information for the selected PO number.
3. Edit the information for the PO number as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Number</td>
<td>The PO number that is associated with the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The reference can be alphanumeric and it has a maximum of 100 characters, including spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the PO number.</td>
</tr>
</tbody>
</table>
4. Optionally, click Spelling to spell check the information for the billing reference number before you save it.

5. Click OK.

The PO Number dialog box closes. You return to the group-specific window with PO Numbers still selected.

To edit the web users for a group

When you edit the web users for a group, you can select additional web users for the group, or you can remove web users for the group. You cannot edit the web user itself, nor can you edit the delegates for a web user.

1. In the left pane of the group-specific window, select Web Users.

2. In the right pane of the group-specific window, select the web user whom you are editing, and then click Edit.

The Web Users dialog box opens.

3. Do one or both of the following:
   - To add a new web user for the group:
     - Leave the Find field blank, and then click Display to open a list of all currently active web users. Select the web user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected web users to the Selected list.
     - In the Search By dropdown list, select the option by which to search (Email Address or User Name) and then in the Find field, enter the string by which to filter your search, and then click Display. Select the web user, or CTRL-click to select multiple web users, and then click the Move button (>) to move the selected users to the Selected list.

The string is not case-sensitive, but your search is limited to the exact order of the characters in the string and the string must begin with the information for which you are searching. For example, if searching by Email Address, a search string of \textit{bob} returns \textit{bob.worth@dea.com} but not \textit{dbobbett@dea.com}.
• To remove a web user from a group, in the Selected field, select the user, or CTRL-click to select the multiple web users that you are removing from the group, and then click the Remove button (<) to move the selected web users to the Available list.

4. After you edit the information, click OK.

The Web User dialog box closes. You return to the group-specific window with Web Users still selected.
Importing Groups

You can import groups into your EMS database from a tab-delimited text file. (See Import File Specification in the EMS Setup Guide for the file specifications.)

To import groups

1. On the EMS toolbar, click the Groups icon.

   The Groups window opens.

   Figure 6-21: Groups window

2. Click Import.

   The Open File dialog box opens.

3. Browse to and select the text file that lists the groups that you are importing.

   A dialog box opens, indicating the number of groups that you are about to import, and asking you if you want to continue.

4. Click Yes.

   A message opens indicating that the import was successful.

5. Click OK to close the message and return to the Groups window.
Working with Reservations for a Group

You have a variety of options for working with the reservations for a group. You can:

• Search for and make a reservation for a group from the Groups window.
• Search for and make a reservation for a group from the group-specific window.
• Search for reservations by group, and then open and view any existing reservations in the Navigator for a group from the group-specific window.
• Reassign the reservations for a group or contact from the group-specific window.

In EMS Workplace, you can also make a group reservation from the Group Reservation window.

To work with reservations for a group

1. Open the Groups window and search for the appropriate group. See “To search for a group and/or contact” on page 255.

2. On the Groups window, select the group, and then do one of the following:
   • Click New Reservation at the top of the window to open the Reservation Wizard, and then continue to “Making a Reservation Using the Reservation Wizard” on page 45.
   • Click Open to open the group-specific window (the group is automatically selected in the window), and then continue to one of the following:
     • “To search for and view reservations by group from the group-specific window” below.
     • “To search for and make a reservation for a group from the group-specific window” on page 296.
     • “To reassign a reservation for a group from the group-specific window” on page 296.

To search for and view reservations by group from the group-specific window

1. In the left pane of the group-specific window, select Reservations.

   All reservations that have been made for the group in your EMS database and that have a date greater than or equal to the current day’s date are displayed in the right pane of the group-specific window.

   Optionally, to show all reservations that have been made for the group, click Show Old.
2. In the right pane of the group-specific window, select the appropriate reservation, and then click Open.

   The reservation opens in the Navigator.


**To search for and make a reservation for a group from the group-specific window**

1. In the left pane of the group-specific window, select Reservations.

   All reservations that have been made for the group in your EMS database and that have a date greater than or equal to the current day’s date are displayed in the right pane of the group-specific window.

   Optionally, to show all reservations that have been made for the group, click Show Old.

2. Click New.

   The Reservation Wizard opens.

3. Continue to “Making a Reservation Using the Reservation Wizard” on page 45.

**To reassign a reservation for a group from the group-specific window**

1. In the left pane of the group-specific window, select Reservations.

   All reservations that have been made for the group in your EMS database and that have a date greater than or equal to the current day’s date are displayed in the right pane of the group-specific window.

   Optionally, to show all reservations that have been made for the group, click Show Old.

2. In the right-pane of the group-specific window, select the appropriate reservation, or CTRL-click to select multiple reservations, and then click Reassign.

   The Reassign Group/Contact on Reservations dialog box opens. See Figure 6-22 on page 297.
3. On the Group dropdown list, select the group to which you are reassigning the reservation, or click the Search icon \( \text{\textbullet}\) to open the Groups window and search for the group. See “To search for a group and/or contact” on page 255.

4. Optionally, edit any and/or all of the group information as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Contact</td>
<td>The contact for the group to which you are reassigning the reservation. [Note: If none of the pre-configured contacts is appropriate, then select (temporary contact) and in the Temp Contact field, enter the name of the temporary contact.]</td>
</tr>
<tr>
<td>2nd Contact</td>
<td>[Note: If none of the pre-configured contacts is appropriate, then select (temporary contact) and in the Temp Contact field, enter the name of the temporary contact.]</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone, fax, and email address for the contacts for the group to which the reservation is being reassigned. If you selected from the list of the pre-configured contacts, then some or all of this information might be automatically populated, but you can still edit the values. If you selected a (temporary contact), then you must enter this information for the contact.</td>
</tr>
<tr>
<td>Fax</td>
<td>[Note: If none of the pre-configured contacts is appropriate, then select (temporary contact) and in the Temp Contact field, enter the name of the temporary contact.]</td>
</tr>
<tr>
<td>Email Address</td>
<td>[Note: If none of the pre-configured contacts is appropriate, then select (temporary contact) and in the Temp Contact field, enter the name of the temporary contact.]</td>
</tr>
</tbody>
</table>
| Web User        | The web user for the group. Initially, this field is set to (no change) which means that the web user for the group to which you are reassigning the reservation is to remain as is; however, if needed, you can click the Search icon \( \text{\textbullet}\) to open the Web Users dialog box and select a different web user.  
  \[\begin{itemize} \item You can search by User Name or Email Address. \item To search a list of all available web users, leave the Search field in the Web Users dialog box blank, and then click Display. \item To search for a specific web user, enter a search string in the Search field, and then click Display. \end{itemize}\] \[Note: The string is not case-sensitive, but your search is limited to the exact order of characters in the string and the string must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bobworth@dea.com but not dbobbett@dea.com.\] |
5. Click OK.

A Reassign Reservations message opens, asking you if it is OK to reassign the selected reservations to the group.

6. Click Yes.

The Reassign Reservations message closes and a second Reassign Reservations message opens, indicating the reservations were successfully reassigned.

7. Click OK.

The message closes, and the reassigned reservations are no longer displayed in the group-specific window.

---

You might have to click Reservations in the left-pane of the group-specific window to refresh the display.

---

To make a group reservation from the Group Reservation window (EMS Workplace only)

1. On the EMS Workplace toolbar, click the Group Reservation icon.

The Group Reservation window opens. The Results tab is the active tab.

*Figure 6-23: Group Reservation window*
2. Open the Filter tab, and search for the group for which you are making a reservation. See “To search for a group and/or contact” on page 255.

3. Select the group for which you are making the reservation, and then click Reservation. A dropdown list of the available Reservation Wizard templates opens.

4. Select the appropriate template.

The Reservation Wizard opens. The name of the group for which you are making the reservation is displayed in the title bar of the Reservation Wizard. The Reservation Wizard template that you selected is displayed on the Wizard Template dropdown list at the top of the Reservation Wizard. (You can always select a different template if needed.)

![Figure 6-24: Reservation Wizard with Wizard Template option](image)

*Depending on how your EMS administrator has configured the template that you selected, you might be prompted to select a reservation start date before the Reservation Wizard opens.*

5. Continue making the reservation as you normally would. See “Making a Reservation Using the Reservation Wizard” on page 45.
Emailing a Group

Whether your organization uses Microsoft Outlook or SMTP, you can always email an EMS group.

If your organization uses Microsoft Outlook, you can continue to use this email system to send emails to EMS groups; otherwise, to email an EMS group using the SMTP option, your user account must have an email address.

To email a group

1. Search for the group that you are emailing. See “To search for a group and/or contact” on page 255.

2. Do one of the following:
   - On the Groups window, select the group and then click Email.
     Depending on how your system is configured, either a pre-addressed Outlook email form or a pre-addressed SMTP email form opens. The To field is populated with the email address that is defined for the group, but you can edit this value if needed. Go to Step 4.
   - On the Groups window, select the group, and then click Open.
     The group-specific window opens. Go to Step 3.

3. On the group-specific window, make sure that the group is selected in the left pane, and then click Email.
   Depending on how your system is configured, either a pre-addressed Outlook email form or a pre-addressed SMTP email form opens. The To field is populated with the email address that is defined for the group, but you can edit this value if needed.

4. Complete and send the email as you normally would.
Printing and Exporting Group Information

You can print a variety of information for selected groups such as contact summary information, status exceptions, group import format information, and billing information, and you can also export a list of selected groups and the summary information for each group (type, name, address, and so on) to an Excel spreadsheet.

To print group information

1. Search for the groups for which you are printing the information. See “To search for a group and/or contact” on page 255.
2. On the Groups window, click Print.

   A list with a variety of options for printing information for the groups that are currently displayed in the Groups window opens.

   \textit{Figure 6-25: Group print options}

   \begin{table}[h]
   \centering
   \begin{tabular}{|m{0.2	extwidth}|m{0.75	extwidth}|}
   \hline
   \textbf{List} & \textbf{Description} \\
   \hline
   List & Opens an onscreen preview of all groups (group name, address, phone number, email address, pricing plan, and status) that are currently displayed in the Groups window. The groups are sorted by group type. \\
   \hline
   Contact Summary & Opens an onscreen preview of all the contacts (group name, group phone number, contact name, and contact phone number) that have been configured for all the groups that are currently displayed in the Groups window. \\
   \hline
   Status Exceptions & Opens an onscreen preview of a list of groups that is derived from all the groups that are currently displayed in the Groups window that have any status other than OK. The groups are sorted by group type. \\
   \hline
   Import Format & Opens an onscreen preview of the required format for the tab-delimited file that is to be used when importing groups. \\
   \hline
   \end{tabular}
   \end{table}

3. Select the information that you want to print for the displayed groups.
To export a list of groups to an Excel spreadsheet

1. Search for the groups that are you exporting to an Excel spreadsheet. See “To search for a group and/or contact” on page 255.

2. On the Groups window, click Export.

A Save As dialog box opens for naming the file and selecting the location in which to save the file. (The file details the summary information—type, name, address, and so on—for each group.) By default, the file is named Groups.xls, and the file location is your Document Library, but you can change the name if needed, and you can also select a different location in which to save the file. After you name and save the file, you have the option of previewing the exported file.

To preview the file, Microsoft Excel must be installed on your EMS client.
Printing and Exporting Web User Information

You can print a variety of information for selected web users and you can also export a list of selected web users (name and email address) to an Excel spreadsheet.

To print or export web user information

1. On the EMS menu bar, click Configuration > Web > Web Users.
   
The Web Users window opens. In the upper left hand corner, the number of web users currently in use for VEMS is displayed.

   Figure 6-27: Web Users window

2. Enter any combination of the following search criteria:
   
   - On the Group Type dropdown list, leave the group type set to the default value of (all), or select a specific group type.
   
   - On the Search by dropdown list, select User Name or Email Address.
   
   - On the Status dropdown list, select the user status by which to search.
   
   - On the Process Template dropdown list, leave the default value of (all), or select a specific web process template.
3. To further filter the displayed search results do one or both of the following:
   • To filter the search results based on either the User Name or Email Address, in the Filter field, enter a search string.
   • To filter the search results based on city, in the City field, enter a search string.

   *For either field, the string is not case-sensitive, but your search is limited to the exact order of the characters in the string and it must begin with the information for which you are searching. For example, if searching by Email Address, a search string of bob returns bobworth@dea.com but not dbobbett@dea.com.*

4. Click Display.

   The web users who meet your search criteria are displayed in the lower pane of the Web Users window.

5. Continue to one of the following:
   • “To print web user information” below.
   • “To export a list of web users to an Excel spreadsheet” on page 305.

To print web user information

1. On the Web Users window, click Print.

   A list with a variety of options for printing information for the web users *that are currently displayed* in the Web Users window opens.

*Figure 6-28: Web User print options*

```
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Opens an onscreen preview of a list of all the web users (web user name, email address, status, security template, process template, and last login) who are currently displayed in the Web Users window. The list is sorted alphabetically by web user name.</td>
</tr>
<tr>
<td>Web Delegates</td>
<td>Opens an onscreen preview of a list of all the web delegates (delegate name, delegate email address, delegate status, web user, web user email address, and web user status) for all the active web users who are currently configured in your EMS database. The list is sorted alphabetically by web delegate name and then by web user name for web users that have multiple delegates.</td>
</tr>
</tbody>
</table>
```
Chapter 6
Groups and Contacts

Figure 6-29: Example of an onscreen preview of the Web Delegates by Web User report

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Delegates by Web User</td>
<td>Opens an onscreen preview of a list of all the web delegates (web user name, web user email address, web user status, delegate name, delegate email address, and delegate status) for all the active web users who are currently configured in your EMS database. The list is sorted alphabetically by web user name and if a web user has multiple delegates, the delegate is then sorted alphabetically by delegate name.</td>
</tr>
</tbody>
</table>

**Note:** A variety of options is available from an onscreen preview, including the options to print a hard copy of the information, to export the information to a .pdf, and to email the printed information. See Figure 6-29 below.

To export a list of web users to an Excel spreadsheet

On the Web Users window, click Export.

A Save As dialog box opens for naming the file and selecting the location in which to save the file. (The file contains the name and address for each web user that is currently displayed in the Web Users window.) By default, the file is named Web User List.xls, and the file location is your Document Library, but you can change the name if needed, and you can also select a different location in which to save the file. After you name and save the file, you have the option of previewing the exported file.

To preview the file, Microsoft Excel must be installed on your EMS client.
Chapter 7
Confirmations

In EMS, a confirmation is a document that details the critical information for a reservation—the date, the time, the location, the scheduled resources, and so on. You send a confirmation to the group who is sponsoring or hosting the event as verification that the reservation has been correctly set up—the time and location are correct, all the necessary resources have been scheduled, and so on. You can also use the confirmation to inform the group of any outstanding issues related to the reservation (such as a balance due) and to provide other information that is not necessarily reservation-specific such as your organization’s cancellation policies, your organization’s alcohol policies, and so on. You can generate a confirmation for all the bookings in a reservation, or just for a selected booking in a reservation.

This chapter covers the following topics:

- “Specifying your Confirmation Settings” on page 308.
- “Generating a Single Confirmation at a Time” on page 311.
- “Generating Word Merge Documents for Custom Documentation” on page 316.

Remember, a fast way to view reservations is through the Reservation Book. See “Viewing and Editing Reservations in the Reservation Book” on page 62.

This chapter details the generation of a single confirmation at a time. To generate confirmations for multiple reservations in a single step, see “Generating Multiple Confirmations” on page 420.
Specifying your Confirmation Settings

The Confirmation Settings dialog box provides a variety of options that you can specify for manual and automatic generation of a confirmation for a reservation or a booking. You can specify your confirmation settings one time and use these settings for all confirmations that you generate, or you can change the settings on as-needed basis and tailor them for each confirmation that you generate.

To specify your confirmation settings

1. Open a reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the upper right hand corner of the Navigator, click Settings > Confirmation Settings.
   The Confirmation Settings dialog box opens.

   Figure 7-1: Confirmation Settings dialog box

3. Specify the settings for your system’s confirmations.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Range tab</td>
<td>The department name that appears at the top of a printed confirmation.</td>
</tr>
<tr>
<td>Buildings tab</td>
<td>Select the specific buildings that are to be included in the confirmation.</td>
</tr>
<tr>
<td>Categories tab</td>
<td>Select the specific booking details that are to be included in the confirmation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Statuses tab</strong></td>
<td>Select the specific statuses that are to be included in the confirmation.</td>
</tr>
<tr>
<td><strong>Options tab</strong></td>
<td>Format settings for a printed confirmation.</td>
</tr>
<tr>
<td>Confirmation Title</td>
<td>Appears bold and centered at the top of the printed confirmation.</td>
</tr>
<tr>
<td>Header Message</td>
<td>Pre-configured blocks of text that appear in the header and footer of the</td>
</tr>
<tr>
<td>Footer Message</td>
<td>printed confirmation.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>The size of the paper on which the confirmation is printed. Values are</td>
</tr>
<tr>
<td></td>
<td>Letter, Legal, and A4.</td>
</tr>
<tr>
<td>Print Comments</td>
<td>Include the comments for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Print Reminders</td>
<td>Include the reminders for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Print Cancel Reasons</td>
<td>Include the reasons for cancellation in the printed confirmation.</td>
</tr>
<tr>
<td>Print User Defined</td>
<td>Include user-defined fields and their values in the printed confirmation.</td>
</tr>
<tr>
<td>Fields</td>
<td></td>
</tr>
<tr>
<td>Print Room Phone</td>
<td>Include the phone number for the room in which the event is being held in</td>
</tr>
<tr>
<td></td>
<td>the printed confirmation.</td>
</tr>
<tr>
<td>Print Room Notes</td>
<td>Include any notes for the room in which the event is being held in the</td>
</tr>
<tr>
<td></td>
<td>printed confirmation.</td>
</tr>
<tr>
<td>Print Building Notes</td>
<td>Include any notes about the building in the printed confirmation.</td>
</tr>
<tr>
<td>Print Billing Reference Allocation</td>
<td>Include the billing reference numbers for the event as well as the</td>
</tr>
<tr>
<td></td>
<td>percentage of charges that is allocated to each number in the printed</td>
</tr>
<tr>
<td></td>
<td>confirmation.</td>
</tr>
<tr>
<td>Print PO Allocation</td>
<td>Include the PO numbers for the event as well as the percentage of charges</td>
</tr>
<tr>
<td></td>
<td>that is allocated to each number in the printed confirmation.</td>
</tr>
<tr>
<td>Print Category</td>
<td>Include the subtotal charges by category in the printed confirmation.</td>
</tr>
<tr>
<td>Subtotals</td>
<td></td>
</tr>
<tr>
<td>Print Room Type</td>
<td>Include the room type for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Print Item Selection</td>
<td>Include the notes for each resource selection item for the event in the</td>
</tr>
<tr>
<td>Notes</td>
<td>printed confirmation.</td>
</tr>
<tr>
<td>Suppress Reserved</td>
<td>Do not show the reserved time for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Time</td>
<td></td>
</tr>
<tr>
<td>Suppress Location</td>
<td>Do not show the location for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Pricing</td>
<td>Do not show the reservation’s room charges or resource charges in the</td>
</tr>
<tr>
<td></td>
<td>printed confirmation.</td>
</tr>
<tr>
<td>Suppress Logo</td>
<td>Do not show your organization’s logo in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Notes</td>
<td>Do not show notes for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item</td>
<td>Do not show special instructions for any booking items in the printed</td>
</tr>
<tr>
<td>Special Instructions</td>
<td>confirmation.</td>
</tr>
<tr>
<td>Suppress Item</td>
<td>Do not show any resource item selections in the printed confirmation.</td>
</tr>
<tr>
<td>Selections</td>
<td></td>
</tr>
<tr>
<td>Always Display Time</td>
<td>Always show the time zone for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Zone</td>
<td></td>
</tr>
</tbody>
</table>
4. You can now generate a confirmation (manually or automatically) based on the settings that you have specified. See “Generating a Single Confirmation at a Time” on page 311.
Generating a Single Confirmation at a Time

You can generate a confirmation for all the bookings in a reservation, or just for a selected booking in a reservation. In the default implementation of EMS, when you request to generate a confirmation for a reservation or a booking, the Confirmation dialog box opens. The Confirmation dialog box has the same tabs as the Confirmation Settings dialog box. (Remember, the values that you specified on the Confirmation Settings dialog box determine the information that is included in a confirmation. See “Specifying your Confirmation Settings” on page 308.) It also contains options for generating a print preview of the confirmation and for manually printing or emailing an EMS-generated confirmation. If you want to automatically generate a printed or emailed confirmation according to your confirmation settings, then you must edit the Confirmation setting on the General tab of the Navigator Options dialog box.

To manually generate a single confirmation at a time

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, do one of the following:
   - Select the reservation for which you are generating the confirmation.
   - Select the reservation for which you are generating the confirmation, and then in the Bookings (lower right) pane, select the booking for which you are generating the confirmation.

3. Do one of the following:
   - If you are generating a confirmation for a reservation, then open the Reservation Summary tab or Properties tab in the upper right pane of the Navigator, and then click Confirmation.
   - If you are generating a confirmation for a selected booking, then open the Booking Summary tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The dialog box has the same tabs as the Confirmation Settings dialog box with one exception, the Date Range tab. (Additional options are available on the Date Range tab that you can use to limit the confirmation to specific bookings and/or specific booking times.) It also has options for saving, or memorizing, the displayed confirmation settings so that you do not have to adjust the settings every time you generate the confirmation. When the dialog box first opens, the Setup is set to (user-specified). See Figure 7-2 on page 312.
4. Do one of the following:

- Review the selections on this dialog box, and optionally, make any needed modifications.

  If you use specific times, then you must also click Options and indicate how the confirmation is to be limited—to bookings that start within the range or to bookings that occur within the time range.

  If needed, you can always save, or memorize, these settings. See “Working with Memorized Reports” on page 323.

- On the Setup dropdown list, select a saved, or memorized, confirmation.

  If you select a memorized confirmation, then the only changes that you can make are to the dates and/or times on the Date Range tab.
5. Do one of the following:

- To manually generate a printed confirmation, edit the number of copies to print as needed in the Copies to Print field (the default value is 1), and then click Print. A Print dialog box opens in which you can specify information such as the printer to use, the page range, and so on. Click Print in this dialog box to manually generate the printed confirmation.

Before you print the confirmation, you can click Print Preview to open an onscreen preview of the printed confirmation. A variety of options are available from this preview, including the options to email the confirmation, to export the confirmation to a .pdf, and to print the confirmation.

- To manually generate an emailed confirmation, click Email. See “Sending Email from EMS” on page 414.

If you are using SMTP email, then Figure 7-3 below is an example of the SMTP email window that opens.

Figure 7-3: SMTP email window for a confirmation
To automatically generate a confirmation

If you want to always automatically generate a printed or emailed confirmation based on your confirmation settings, then you must edit the Confirmation setting on the General tab of the Navigator Options dialog box.

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the upper corner of the Navigator window, click Settings > Options.

   The Navigator Options dialog box opens. The General tab is the active tab.

*Figure 7-4: Navigator Options dialog box, General tab*
3. Under Confirmation, select one of the following:
   - Email—To always automatically generate an emailed confirmation based on your confirmation settings.
   - Print—To always automatically generate a printed confirmation based on your confirmation settings.

4. Click OK to close the dialog box and return to the Navigator.

The next time you select any reservation or booking in the Navigator and click Confirmation, the following happens:
   - If your Navigator Options are set to Print, then a Print dialog box opens in which you can specify information such as the printer to use, the page range, and so on. Click Print in this dialog box to generate a printed confirmation that is based on your confirmation settings.
   - If your Navigator Options are set to Email, then see “Sending Email from EMS” on page 414.

If you are using SMTP email, then Figure 7-5 below is an example of the SMTP email window that opens.

Figure 7-5: SMTP email window for a confirmation
Chapter 7
Confirmations

Generating Word Merge Documents for Custom Documentation

EMS provides options for producing pre-formatted documents that contain reservation information such as confirmations. Your organization, however, might have organization-specific information that must be included in these documents. If your organization has purchased and implemented the optional Word Merge module, you can generate Word Merge documents to produce custom confirmations, contracts, and so on that contain not only selected reservation information from EMS, but also, any information that is required by your organization. Because these documents are generated in a Word format (.docx), you cannot print them or email them from EMS; however, you can manually print them and send them as an attachment in an email just as you would any other Word document.

To generate Word Merge Documents

1. Open the reservation in the Navigator. See:
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through the Reservation Book” on page 80.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.

2. In the left pane of the Navigator, do one of the following:
   - Select the reservation for which you are generating the confirmation.
   - Select the reservation for which you are generating the confirmation, and then in the Bookings (lower right) pane, select the booking for which you are generating the confirmation.

3. Do one of the following:
   - If you are generating a confirmation for a reservation, then open the Reservation Summary tab or Properties tab in the upper right pane of the Navigator, and then click Confirmation.
   - If you are generating a confirmation for a selected booking, then open the Booking Summary tab in the upper right pane of the Navigator, and then click Confirmation.

The Confirmation dialog box opens. The Date Range tab is the active tab. See Figure 7-6 on page 317.
4. At the top of the Confirmation dialog box, click Word Merge.

The Word Merge Documents dialog box opens. This dialog box displays all the Word Merge documents that your EMS administrator has configured for your organization-specific documents such as confirmations, contracts, and so on.

Figure 7-6: Confirmation dialog box, Date Range tab

Figure 7-7: Word Merge Documents window
5. Select the appropriate Word Merge document, and then optionally, do one or both of the following:
   • To attach the document at the reservation-level for the selected reservation, click Attach to Reservation.
   • Select the attachment type.

6. Click Generate.

   A message opens, indicating that the Word Merge was successful, and asking you if you want to view the document.

7. Optionally, click Yes.

   The document opens in Microsoft Word. You can now use any of the standard Word functions to save the document, to print the document, attach the document to email, and so on.

---

To save a copy of the document in your EMS database, you must either attach the document to the reservation, or you must open and view the document and save it as a Word document.
EMS contains six different categories of general reports to assist you in monitoring and maintaining your organization’s reservation records and associated transactions. The application also contains a Query Builder function which you can use to define custom criteria for searching for information in your organization’s EMS database.

This chapter covers the following topics:

• “Generating an EMS Report” on page 321.
• “Working with Memorized Reports” on page 323.
• “Report Descriptions and Options” on page 328.
• “Working with a Query” on page 348.

Reports that are specific for the Billing function in EMS are detailed in Chapter 9, “Billing,” on page 361.
Chapter 8
Reports and Queries
Chapter 8
Reports and Queries

Generating an EMS Report

All EMS reports are available under the Reports option on the menu bar. For any EMS report, you can specify the parameters, options, and format for the report, or you can generate the report according to memorized settings. Not all reports require the same parameters, nor do they all have the same options available. In addition, you can generate different reports in different formats.

To generate a report

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option for the report that you are generating. For example, to generate the Event Schedule report, click Reports > Daily > Event Schedule.

2. On the Setup dropdown list, do one of the following:
   • To generate the report according to the filter settings that you specify (parameters, options, and so on), leave (user specified) selected on the Setup list, and then go to Step 3.
   • To run the report with filter settings that have been saved, or memorized, select the memorized report on the Setup list, and then go to Step 5.

3. On the Options list, select the Date/Time filter by which to generate the report.

4. Specify the report parameters, options, and format. See:
   • “Daily reports” on page 329.
   • “Sales reports” on page 334.
   • “Statistics reports” on page 337.
   • “Other reports” on page 340.
   • “Exceptions reports” on page 342.
   • “Hoteling reports (EMS Workplace only)” on page 345.

For detailed information about memorized reports, see “Working with Memorized Reports” on page 323.

For brevity and ease, the parameters and options that are available for each report are not discussed here. Instead, the options are discussed in “Report Descriptions and Options” on page 328. Billing reports are discussed in Chapter 9, “Billing,” on page 361. Academic reports are discussed in Chapter 13, “Academic Planning (EMS Campus),” on page 443. Contact your EMS administrator if you need assistance in generating any of these reports.
5. Optionally, do one or more or all of the following:
   • In the Report Comment field, enter a comment that is to be printed on the report.

   The comment can be a maximum of 255 characters, including spaces.

   • Click Print Preview.
     A preview of the report opens onscreen.
   • To print a hard copy of the report, specify the number of copies that you are printing, and then click Print.

6. Click Close.

   Unless you change the filter settings, all subsequent reports are generated and printed according to the parameters and options that you have specified and in the format that you specified. If you want to save certain settings so that you do not have to adjust the filter settings every time you run the report, you can memorize the report. See “Working with Memorized Reports” on page 323.
Working with Memorized Reports

A memorized report is a report for which the filter settings have been saved, or memorized, so that you do not have to adjust the filter settings every time you run the report. You can create a memorized report “from scratch,” or you can copy an existing memorized report, and edit the filter settings as needed to create a new memorized report. If you are the owner of a memorized report, you can also edit the name of an existing memorized report and you can delete a memorized report.

Although this topic is written from the perspective of reports, it is also applicable for working with memorized confirmations and invoices.

To create a memorized report “from scratch”

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option for the report that you are memorizing. For example, to memorize the Event Schedule report, click Reports > Daily > Event Schedule to open the Event Schedule dialog box.

![Event Schedule report dialog box](image)

2. On the <Report> dialog box, click Options, and then select the Date/Time filter by which to generate the report.

3. Specify the report parameters, options, and format.
Chapter 8
Reports and Queries

   
The Memorize Report Setup dialog box opens.

   *Figure 8-2: Memorize Report Setup dialog box*

5. In the Description field, enter a name or description for the report.

   *The description can be a maximum of 50 characters, including spaces.*

6. If you are an administrative user, and the report is to be available to all users, then select Public (Available to All Users); otherwise, if the report is to be available only to you (the owner), then leave this option blank.

   *If you are not an administrative user, then only your EMS administrator can make your memorized reports available to all users. Contact your EMS administrator for assistance.*

7. Click OK.
   
The Memorize Report Setup dialog box closes. You return to the <Report> dialog box. The memorized report is now an option on the Setup dropdown list.
To create a memorized report by copying

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option for the report that you are memorizing. For example, to memorize the Event Schedule report, click Reports > Daily > Event Schedule to open the Event Schedule dialog box.

![Event Schedule report dialog box](image)

2. On the Setup dropdown list, select the memorized report from which you are copying the filter settings, and then click Copy.

   The Memorize Report Setup dialog box opens. By default, the Description field indicates that you are naming a copy of a memorized report.

![Memorize Report Setup dialog box](image)

3. In the Description field, enter a name or description for the new memorized report.

   The description can be a maximum of 50 characters, including spaces.
4. If you are an administrative user, and the report is to be available to all users, then select Public (Available to All Users); otherwise, if the report is to be available only to you (the owner), then leave this option blank.

If you are not an administrative user, then only your EMS administrator can make your memorized reports available to all users. Contact your EMS administrator for assistance.

5. Click OK.

The Memorize Report Setup dialog box closes. You return to the <Report> dialog box. The filter settings are populated with the settings for the memorized report.

6. Click Edit, and then edit the filter settings for the report as needed.

7. Click Memorize.

The memorized report is now an option on the Setup dropdown list.

To edit or delete a memorized report

1. On the EMS menu bar, click Reports to open the Reports menu, and then click the option for the memorized report that you are editing. For example, to edit a memorized Event Schedule report, click Reports > Daily > Event Schedule to open the Event Schedule dialog box.

*Figure 8-5: Event Schedule report dialog box*

The Memorized Report Setups dialog box opens. This dialog box lists all the memorized report setups for which you are the owner, and therefore can edit the name and/or delete the report.

Administrative users can edit and delete all memorized reports in the system. See Managing Memorized Reports in the EMS Setup Guide.

Figure 8-6: Memorized Report Setups dialog box

3. Select a memorized report setup, and then do one of the following:
   - To edit the name of the report, click Edit to open the Memorize Report Name dialog box, and edit the name of the report in the Description field.

   The description can be a maximum of 50 characters, including spaces.

   - To delete the report, click Delete, and then click Yes in the message that asks you if you are sure that you want to delete the selected report.
Report Descriptions and Options

This section provides a description of every EMS report in the categories listed below and it also defines the options that are available for each report.

See:

- “Daily reports” on page 329.
- “Sales reports” on page 334.
- “Statistics reports” on page 337.
- “Other reports” on page 340.
- “Exceptions reports” on page 342.
- “Hoteling reports (EMS Workplace only)” on page 345.
# Daily reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Event Schedule   | A summary of the events that are scheduled at your facility, sorted by date and event start time. The report shows event start and end time, group name, event name, and location. You typically print and post the Event Schedule in a lobby or entry way to help visitors find their events. | • Use Page Breaks - If the report is run across multiple days, then each day starts on a new page.  
• Show Bookings on Start Date Only—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3P Thursday through 10A Friday. If this option is selected, then the booking is displayed only for Thursday in the report.  
• Show Holidays—Displays any holidays that are configured in the EMS database on the report.  
• Show Building Hours—Displays building hours on the report.  
• VIP Events Only—Only the events that are marked as a “VIP” are displayed in the report.  
• Use Calendar Styles: Events are displayed in the font/color of the Calendar Style that is associated with each event.                                                                 |
| Event Calendar   | A chronological list of scheduled events in a wall calendar format.                                                                                                                                                                                                     | • Use Calendar Styles—Events are displayed in the font/color of the Calendar Style that is associated with each event.  
• Weekly Calendar—One week per page is displayed in the report.  
• Show Adjacent Calendar Days—Works in conjunction with the Weekly Calendar option to display events that occur on Saturday and Sunday in the report.  
• Grey Out Adjacent Calendar Days—Works in conjunction with The “Show Adjacent Calendar Days” option to display events that occur on adjacent days in gray instead of in black.  
• Hide Holidays—By default, holidays are displayed on the Daily Calendar Report. Select this option to hide holidays in the report.  
• By Room—Displays events one room at a time in a calendar view.                                                                 |
### Room Cards
A list of events that is designed to be posted outside a room or event space. The report notes the date, event time, and location for events, as well as the group sponsoring each event. The report can be a single list of all events that are scheduled for the room on a particular date, or it can be a single page per event.

- **Show Bookings on Start Date Only**—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3P Thursday through 10A Friday. If this option is selected, then the booking is displayed only for Thursday in the report.
- **Print Blank Room Cards**—Prints a room card for a space that does not have any events scheduled.
- **Print Logo**—Prints the facility logo on each room card. You can specify the logo location on the right or left side of the room card.
- **Sort Room Cards By Book Sequence**—If Book Sequencing is being used on Room Configuration, then a facility can print room cards in the Book Sequence order.
- **Print Combo Room Components**—Prints an individual room card for each component of a combo room.
- **Suppress End Time**—Do not show the end times for bookings in the report.

### Activity Schedule
A list of bookings in all rooms in a building, or just in a specific room in the building. The report, which shows event start and end times, event name, group name and room, can be generated for a range of dates. The report can generated in one of two formats—by Date or by Building.

- **Use Page Breaks**—A new page is generated for each date or for each building.
- **Show Bookings on Start Date Only**—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3P Thursday through 10A Friday. If this option is selected, then the booking is displayed only for Thursday in the report.
### Setup Worksheet

An internal report that sets up crews, custodial, or operations personnel use to ensure that each room is arranged properly for each event. The report displays detailed information about each booking, including setup type, setup notes, required resources, user defined fields, special instructions and resource item notes.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Setup Worksheet  | An internal report that sets up crews, custodial, or operations personnel use to ensure that each room is arranged properly for each event. The report displays detailed information about each booking, including setup type, setup notes, required resources, user defined fields, special instructions and resource item notes. | • Use Page Breaks—If this report is run across multiple days, then each day starts on a new page.  
• Highlight Changes Made Within:(days)—Changes that have been made within the specified number of days are highlighted in the report.  
• Limit Bookings To Those With Details In Selected Categories—Only bookings with a booking detail from the specified categories are displayed in the report.  
• Show Bookings on Start Date Only—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3P Thursday through 10A Friday. If this option is selected, then the booking is displayed only for Thursday in the report.  
• Keep Detail Together—If an event has booking details, then the details are kept together on one page instead of being split across two pages.  
• Show Holidays—Holidays are displayed in the report.  
• Show Building Hours—Building hours that are associated with each building are displayed in the report.  
• Show Item Notes—Any notes that have been entered for a booking detail item are displayed in the report.  
• Show Item Special Instructions—Any special instructions that have been entered in VEMS for a booking detail item are displayed in the report.  
• Show User Defined Fields—Any user defined fields and their answers for a reservation are displayed in the report.  
• Show Booking Changes Only—Bookings that have been edited within the specified number of days are displayed in the report. |
### Service Order Schedule
- Lists the service orders that are scheduled for a date or date range. Produced by category.
  - **Use Page Breaks**—If this report is run across multiple days, then each day starts on a new page.
  - **Show Details**—Booking item details that associated with each event are displayed in the report.
  - **Highlight Changes Made Within:(days)**—Changes that have been made within the specified number of days are highlighted in the report.
  - **Show Pricing**—Any pricing that is associated with an item is displayed in the report.
  - **Show Item Notes**—Any notes that have been entered for a booking detail item are displayed in the report.
  - **Show Item Special Instructions**—Any special instructions that have been entered in VEMS for a booking detail item are displayed in the report.

### Service Orders
- Separate pages for each service order in a date range. The report provides information on the event and the items or services needed. Produced by category.
  - **Highlight Changes Made Within:(days)**—Changes that have been made within the specified number of days are highlighted in the report.
  - **Footer Message**—Used to specify the Footer message that is displayed on each page of the report.
  - **Show Item Notes**—Any notes that have been entered for a booking detail item are displayed in the report.
  - **Show Item Special Instructions**—Any special instructions that have been entered in VEMS for a booking detail item are displayed in the report.
## Reports and Queries

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Banquet Event Order     | Separate pages for each booking that occurs on a date or within a date range that has the “Primary Category” specified. Service orders, resource information, notes, and information for resource with order type categories are included in the report. | • Highlight Changes Made Within:(days)—Changes that have been made within the specified number of days are highlighted in the report.  
• Show Pricing—Any pricing that is associated with an item is displayed in the report.  
• Limit Bookings To Those With Details In Selected Categories—Only bookings with a booking detail from the specified categories are displayed in the report.  
• Show Item Notes—Any notes that have been entered for a booking detail item are displayed in the report.  
• Show Item Special Instructions—Any special instructions that have been entered in VEMS for a booking detail item are displayed in the report.  
• Show Item Selection Notes—Any notes that have been entered for a booking detail item selection are displayed in the report.  
• Show Service User Defined Fields—Any user defined questions and their answers for any listed category are displayed in the report.  
• Set Page Numbers By Booking—Resets page number for every unique booking.  
• Use Page Breaks—If this report is run across multiple days, then each day starts on a new page. |
| Resource Schedule       | Lists by category and date, how many of each resource item is needed, as well as the event time, event name, location, and group. | • Use Page Breaks—If this report is run across multiple days, then each day starts on a new page.  
• Highlight Changes Made Within:(days)—Changes that have been made within the specified number of days are highlighted in the report.  
• Show Overbooked Resources Only—Only those bookings where the selected resource exceeds the number available in inventory at that time are displayed in the report. |
Chapter 8
Reports and Queries

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Order Change Report</td>
<td>List the service orders to which a change has been made by Booking/Service Order ID. Includes the service order category, a description of the change, the old value for the service order, the new value for the service order, the date of the change, and the ID for the user who made the change.</td>
<td>N/A</td>
</tr>
<tr>
<td>Attendee Visitor Report</td>
<td>Lists the attendees for an event by date or date range, and indicates whether they are visitors and shows their group name, phone number, event name, the room they will be in, and the start and end times for their event.</td>
<td>• Use Page Breaks—If this report is run across multiple days, then each day starts on a new page.</td>
</tr>
<tr>
<td>Production Report</td>
<td>Lists production items and their quantities grouped by production area.</td>
<td>• Show Item Notes—Any notes that have been entered for a booking detail item are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Item Special Instructions—Any special instructions that have been entered in VEMS for a booking detail item are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Item Selections—Any selections that have been entered for a booking detail item are displayed in the report.</td>
</tr>
</tbody>
</table>

Sales reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales by Group Type</td>
<td>Lists the sales for each group type for a date or date range.</td>
<td>• Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
</tbody>
</table>
### Chapter 8
Reports and Queries

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales by Group</td>
<td>Lists the sales for each group, divided by group type, for a date or date range.</td>
<td>• Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Category</td>
<td>Lists the revenue generated by each resource category for a date or date range.</td>
<td>• Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Resources</td>
<td>Lists the sales for each resource item for a date or date range.</td>
<td>• Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Reservation</td>
<td>Lists the reservations that have bookings for a specified date or date range and shows the charges, by category, for the reservation. Also gives a grand total for all reservations. If a reservation also has bookings that fall outside the specified date or date range, these figures are not included in the report.</td>
<td>• Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
<tr>
<td>Sales by Billing Reference</td>
<td>Lists the total sales for a date or date range, based on the billing reference number on the reservations that have bookings in the specified range. Sales that are associated with reservations that have no billing reference number are not included in the report.</td>
<td>• Display Amount—Select from Net Sales, Gross Sales, or Discounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report.</td>
</tr>
</tbody>
</table>
## Chapter 8
### Reports and Queries

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Sales by Booking        | Lists the sales for a particular date or for each date in a date range, broken down by booking. This report displays the following information—Start/End Times, Group, Event Name, Location, Billing Reference#, PO Number, Payment Type, Status, Reservation ID, Booking ID, and Sales amount. | • Display Amount—Select from Net Sales, Gross Sales, or Discounts.  
• Include Report Criteria—The filter settings for the report are displayed in the report.  
• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report. |
| Status Changes by Reservation | Lists the sales that are associated with a reservation where the reservation or booking status was changed. | • Display Amount—Select from Net Sales, Gross Sales, or Discounts.  
• Include Report Criteria—The filter settings for the report are displayed in the report.  
• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report. |
| Status Changes by Booking | Lists the sales that are associated with bookings where the bookings status was changed. | • Display Amount—Select from Net Sales, Gross Sales, or Discounts.  
• Include Report Criteria—The filter settings for the report are displayed in the report.  
• Show Zero Amounts—Group Types with zero sales/discounts are displayed in the report. |
Statistics reports

All Statistics reports, except Hourly Room Utilization and Hourly Resource Inventory Utilization, provide an “Analyze” feature to view data. Click Analyze to open a Browser window that displays the queried data. You can group the information by column, you can export the raw data to an Excel file, and you can click Details to provide more detailed information about the queried data.

The Room Utilization report, the Hourly Room Utilization report, and the Hourly Room Utilization report are available only in EMS Enterprise. They are not available in EMS Professional.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Statistics</td>
<td>Lists all rooms by building and for each room, indicates the following information—the number of bookings for the date range selected, the reserved hours, the event hours, the estimated attendance (i.e., setup count), and the actual attendance.</td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
</tbody>
</table>
| Room Utilization| Lists the number of bookings, hours used, hours available, percent utilization, and hours vacant for rooms, by building, for the date range specified. | • Day Selection—Specify which day(s) of the week to include in the report.  
• Group By Utilization Category—Groups rooms by utilization (low, high, unused).  
• Include Cost—The cost for vacancies is displayed in the report.  
• Include Unused—Include rooms that contain no bookings in the report.  
• Cap Utilization at 100%?—Percent utilization cannot exceed 100%.  
• Low Utilization—Specify what percentage equals “Low” utilization.  
• High Utilization—Specify what percentage equals “High” utilization.  
• Availability Based On—Select to base availability on one of the following - Building Hours, Hours per Day, or Specific Hours.  
• Include Report Criteria—The filter settings for the report are displayed in the report. |
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Hourly Room Utilization        | Displays room utilization broken down by hours in the day, by percentage utilized. | • Day Selection—Specify which day(s) of the week to include in the report.  
• Display Chart—Includes a chart on the final page of the report that summarizes the reported data. |
| Hourly Resource Inventory Utilization | Displays resources, and the number of items used on an hourly basis for a specified date range. | • Day Selection—Specify which day(s) of the week to include in the report.  
• Display Chart—Includes a chart on the final page of the report that summarizes the reported data. |
| Group Statistics               | Displays Number of Bookings, Reserved Hours, Event Hours, Estimated Attendance, and Actual Attendance by Group Type for a given date or date range. The format can be set to “Detail” to provide statistics for each specific group. | • Include Report Criteria—The filter settings for the report are displayed in the report.                                                   |
| Event Type Analysis            | Provides information by event type on the following—the number of reservations, the number of bookings, the percentage of total reserved hours, the percentage of total event hours, the percentage of total estimated attendance, the percentage of total attendance, the actual attendance, and the percentage of total. | • Include Report Criteria—The filter settings for the report are displayed in the report.  
• Display Chart—Includes a chart on the final page of the report that summarizes the reported data. |
| Reservation Source Analysis    | Displays the number of reservations, the number of bookings with percentage, reserved hours with percentage, event hours with percentage, estimated attendance with percentage, and actual attendance with percentage by reservation source. | • Include Report Criteria—The filter settings for the report are displayed in the report.  
• Display Chart—Includes a chart on the final page of the report that summarizes the reported data. |
| Resource Statistics            | Lists the quantity and the hours used by category and by resource item.        | • Include Report Criteria—The filter settings for the report are displayed in the report.  
• Show Zero Quantities—Includes all resources even if the resource is not used during the date range specified.  
• Show Inactive Resources—Includes all inactive resources used during the date range specified. |
# Reports and Queries

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Availability</td>
<td>Provides a count of room availability by room type for a given date range.</td>
<td>N/A</td>
</tr>
<tr>
<td>Setup Count Analysis</td>
<td>Lists the total number of bookings by setup count.</td>
<td>N/A</td>
</tr>
<tr>
<td>Seat Occupancy</td>
<td>Displays the capacity for each room, the number of bookings for the date range, the seats available for the bookings, the total estimated attendance based on setup count on each booking, the average estimated attendance, and the estimated percentage of seats filled for the specified date range. Figures are also provided for total actual attendance, average actual attendance, and actual percentage of seats filled.</td>
<td>• Include Report Criteria—The filter settings for the report are displayed in the report.</td>
</tr>
</tbody>
</table>
| Benchmark Metrics Report| Compiles metrics for a number of different areas within EMS, for example, Rooms By Number of Bookings, Reservations By Source, and so on. | • Days Open Per Week—Indicates the number of days per week your facility is open per week. The default value is 7.  
• Hours Open Per Day—Indicates the number of hours per day that your facility is open. The default value is 10. |
Other reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancellation Report</td>
<td>Lists the bookings that have a status that was changed to “Cancelled” on the date or dates specified, or lists the bookings on the date or dates specified that have a status type of “Cancelled.” The report also lists the date that the booking status was changed, the date the bookings were to have taken place, and the location of the event, the name of the person who canceled the booking, the reason for the cancellation, and the booking ID. You can run the report in one of two formats—by Booking Date (the date that the bookings were to occur) or by Cancel Date (the date that the bookings were canceled).</td>
<td>N/A</td>
</tr>
<tr>
<td>Cancellation Summary</td>
<td>Summarizes, by reservation, all charges for bookings on a date or in a date range. The report shows the first and last bookings canceled within the reservation, the Group, the reservation number, the group contact, the event name, the event type, the total charges, and the reason for cancellation of the most recently canceled booking. Reservations that do not have charges associated with the bookings are not displayed on this report. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Reservation Summary

A summary of reservations that occurred within a specific date range. The report also lists complete reservation information (reservation number, event name, group, contact person, and so on) and booking dates. User defined fields can also be printed in this report. You can select Use Specific times and then enter a range of times to limit the report to reservations that occurred within this specified time range.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Summary</td>
<td>A summary of reservations that occurred within a specific date range. The report also lists complete reservation information (reservation number, event name, group, contact person, and so on) and booking dates. User defined fields can also be printed in this report. You can select Use Specific times and then enter a range of times to limit the report to reservations that occurred within this specified time range.</td>
<td></td>
<td>N/A</td>
</tr>
</tbody>
</table>
## Exceptions reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined Setups</td>
<td>Lists the bookings on the selected date or date range for which no setup count has been entered. The report lists the following information for the bookings—the event name, time and location, contact name and phone number, booking status, and ID number. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.</td>
<td>• Show Bookings on Start Date Only—If a booking is scheduled overnight, then only the start date of the booking is displayed in the report. For example, a booking exists for 3P Thursday through 10A Friday. If this option is selected, then the booking is displayed only for Thursday in the report.</td>
</tr>
<tr>
<td>Status Reminder Report</td>
<td>Lists the bookings that have a status with a reconfirm date that falls within the selected date range. You typically use the information in this report to review tentative bookings. The report can be run in one of two formats—by Status Date (the date that the event was put in a “Tentative” status) or by Booking Date (the actual date of the event). You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter a report name or description or any pertinent information about the report in the Comment field.</td>
<td>N/A</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
<td>Options</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Wait List Report</td>
<td>Lists all the bookings with a Wait status for the time period that you have requested. Detects situations where a booking has been canceled and there are one or more bookings with a Wait status that can now be changed to Confirmed, and indicates if the room is available. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Booking Conflict Analysis | Reviews information on all bookings for a date or date range and lists any conflicts  
**Note:** EMS does not allow double-bookings, but they might exist because conversion of data from systems that do allow them, or the result of users failing to restart EMS after encountering error messages. | N/A     |
<p>| Building Hours Exceptions | Lists events for a date or date range that fall outside of the configured building hours. Either event time or reserved time is checked based on the “Validate Building Hours on Event Time” parameter. The report also shows the start and end times, group, event name, location, reservation number, and booking number. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field. | N/A     |</p>
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive Room With Bookings</td>
<td>Lists the bookings for a specified date or date range that are scheduled in inactive rooms. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field. You can click View to open the booking for viewing and editing, changing the status of the booking and/or emailing the group.</td>
<td>N/A</td>
</tr>
<tr>
<td>Inactive Groups With Reservations</td>
<td>Lists the reservations for a specified date or date range that are scheduled for inactive groups. You can click View to go to the reservation for viewing and editing, including changing the status of the reservation and/or its bookings.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Invalid Service Orders     | Lists the service orders that have a start time and/or end time that fall outside the reserved time for the room. Lists the category, date, reserved and event start and end times, location, group, reservation number, booking number, service order number and a description of the invalid order. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.  
**Note:** Service orders that fall outside the reserved time are considered invalid even if the Validate Service Order Times Against Booking parameter is set to "No." | N/A     |

344
### Reports and Queries

#### Invalid Billing References
Lists the bookings for a particular date or date range that are in reservations that have invalid billing reference numbers. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.

**Note:** A billing reference number is considered invalid if it has not been defined in the Billing Reference Configuration area but the Validate Billing Reference parameter is set to “Valid Only.”

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Billing References</td>
<td>Lists the bookings for a particular date or date range that are in reservations that have invalid billing reference numbers. You can select Use Specific times and then enter a range of times to limit the report to bookings that occurred within this specified time range. You can enter information about the report, or a name or description for the report in the Report Comment field.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

| Inactive Web Process Templates | Displays the inactive web process templates that are attached to reservations. | N/A     |

**Hoteling reports (EMS Workplace only)**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Occupancy Summary</td>
<td>Displays, by building and room type, the number and percentage of rooms occupied.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No Show</th>
<th>Lists the bookings for which the reservation holder did not check in.</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>A customer can be checked in via the EMS Kiosk, the EMS desktop client, or VEMS.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Chapter 8
### Reports and Queries

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Early Checkout</td>
<td>Lists the bookings for which the reservation holder checked out before the end of the reserved time.</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A customer can be checked out via the EMS Kiosk, the EMS desktop client, or VEMS.</td>
<td></td>
</tr>
<tr>
<td>Visitor</td>
<td>Lists events for groups that have cities on their group record, other than what is specified in the Exclude Locations field. If multiple locations are to be listed, they should be entered with a comma between them (for example, Denver, Houston, Tampa, and so on).</td>
<td>N/A</td>
</tr>
<tr>
<td>Booking Notice Statistics</td>
<td>Lists the total bookings for a date or date range, divided into three “Amount of Notice” categories, where the Amount of Notice is the time between when the booking was scheduled and the date/time for which it was scheduled. The report can be generated in one of two formats— “standard” or by room type.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Transition              | Tracks the occupants of hoteling spaces during a specified date range. Lists by floor and room where the occupant was last, what room the occupant is moving to, and who was in the space the previous day. Typically this report is run for a two day range and the days of the week must be checked. This report can be used by personnel who are responsible for preparing hoteling spaces for each occupant. | - Show Details—Prints the categories that are associated with the bookings.  
- Highlight Changes Made Within:(days)—Changes that have been made within the specified number of days are highlighted in the report. |
| Arrivals and Departures | Lists the departures and arrivals for a particular room by building and floor. The report shows the time of the departure if the customer is a departure and the time of the arrival if the customer is an arrival. Typically, this report is run for a two day timespan listing the departure date first and the arrival date second. | N/A                      |
### Groups With Multiple Bookings
Lists groups that have multiple bookings for the date or date range specified. The information is organized by date, and lists the start and end times, the room, the room type, and the booking status for each booking.

### Check In Statistics
Lists the percentage of customers who have checked in by building, building-room type, or room type.

**Note:** A customer can be checked in via the EMS Kiosk, the EMS desktop client, or VEMS.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups With Multiple Bookings</td>
<td>Lists groups that have multiple bookings for the date or date range specified. The information is organized by date, and lists the start and end times, the room, the room type, and the booking status for each booking.</td>
<td>N/A</td>
</tr>
<tr>
<td>Check In Statistics</td>
<td>Lists the percentage of customers who have checked in by building, building-room type, or room type. <strong>Note:</strong> A customer can be checked in via the EMS Kiosk, the EMS desktop client, or VEMS.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Working with a Query

A query is the primary mechanism for retrieving information from a database. A query consists of questions that are presented to the database in a predefined format. A Query Builder function is available from the Reports menu. You can use this function to create queries for retrieving information from your EMS database. When you create a query, you can name and save the query so that you can run the query at any time that you choose. You can create a query from “scratch,” or you can create a query by copying an existing query and editing the copied query as needed. You can also edit a query, delete a query, and view and print a query.

To create a query

1. On the EMS menu bar, click Reports.
   The Reports menu opens.
2. On the Reports menu, click Queries.
   The Queries menu opens. This menu always contains the Query Builder option. It also contains options for any queries that have been previously defined in your EMS database.
3. Click Query Builder.
   The Query Definitions dialog box opens. The dialog box displays all the queries that have been previously defined in your EMS database and that have a status of Active.

Figure 8-7: Query Definitions dialog box

Optionally, to view all queries in your EMS database, regardless of status, under Show, click Inactive.
4. Do one of the following:
   - To create a query from scratch, click New.
   - To create a query by editing an existing query, select the query that is to be edited, and then click Copy.

   The Query Builder Filter dialog box opens. The Query Builder Filter tab is the active tab. You use the options on this dialog box to name and define the query.

   **Figure 8-8: Query Builder Filter dialog box, Query Builder Filter tab**

5. Enter or edit the needed information for the query. See:
   - “Query Builder Filter tab” on page 350.
   - “Display Fields tab” on page 351.
   - “Filter tab” on page 353.
   - “Sort tab” on page 354.
   - “Chart tab” on page 355.
   - “Users tab” on page 356.

6. Do one of the following:
   - Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
Chapter 8  
Reports and Queries

Query Builder Filter tab

*Figure 8-9: Query Builder Filter dialog box, Query Builder Filter tab*

1. On the Query Builder Filter tab, name and define the query.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Name</td>
<td>Name of the query filter. <strong>Note:</strong> The name can be a maximum of 50 characters, including spaces.</td>
</tr>
<tr>
<td>Filter Type</td>
<td>The type of information that the filter is to capture. The Filter Type affects the items that are available on the Display Fields tab and the Filter tab. A Filter Type of Group allows you to capture address information that can be exported and subsequently used by other programs to create mailing labels. <strong>Note:</strong> Only a single Filter Type, Reservation, is available in EMS Professional.</td>
</tr>
<tr>
<td>Display in Browser</td>
<td>Available only for a Filter Type of Billing or Reservations. Select this option if the query that you are creating is to be available in the Browser.</td>
</tr>
<tr>
<td>Open in Navigator</td>
<td>Available only if the Filter Type is Reservations and Display in Browser is selected. Indicate what the system should open in the Navigator when a user double-clicks on an item that is retrieved by the query.</td>
</tr>
<tr>
<td>Owner</td>
<td>Available only to administrative users.</td>
</tr>
<tr>
<td>Return First “xx” Number of Records</td>
<td>To limit the number of records that the query returns, select this option, and then enter the number of records in the field.</td>
</tr>
<tr>
<td>Inactive</td>
<td>By default, a query is added as an active query. Select this option to inactivate the query.</td>
</tr>
</tbody>
</table>
2. Continue with any other configuration for the query as needed, or do one of the following:

- Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
- Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

Display Fields tab

*Figure 8-10: Query Builder Filter dialog box, Display Fields tab*

1. Open the Display Fields tab, and then do one of the following:

- Select the field, or CTRL-click to select the multiple fields that are to be displayed in the query results, and then click the Move button (>) to move the selected fields to the Selected list.

- In the Field Search field, enter the string by which to filter your search for available fields. Select the field, or CTRL-click to select multiple fields, and then click the Move button (>) to move the selected fields to the Selected list.

*The search is limited to the exact order of characters in the string, but the string is not case-sensitive and it can be found anywhere in the search results. For example, a search string of Add returns both Added By and Date Added. As you enter the search string, the Available Fields list is dynamically updated with a list of fields that meet the search criteria.*
2. The fields are displayed in the query results in the order in which they are listed in the
Selected list. Optionally, to change the order of the fields, select a field and then click
Move Up/Move Down as needed.

3. Continue with any other configuration for the query as needed, or do one of the
following:

   • Click OK to close the Query Builder Filter dialog box and save the named query.
The named query is displayed on the Reports menu under the Queries option. You
can run this query at any later date when needed.

   • Open the Results tab, and then click Preview to run the query immediately and view
the results on the tab. You can then click OK to close the Query Builder Filter dialog
box and save the named query. The named query is displayed on the Reports menu
under the Queries option. You can run this query at any later date when needed.

---

If you are copying an existing query, then when the Display Fields tab opens, the
Selected list is already populated with a list of fields. You can select one or more of
these fields, and then click the Remove button (<) to move these fields back to the
Available list.
Filter tab

Figure 8-11: Query Builder Filter dialog box, Filter tab

1. Open the Filter Fields tab, and then do one of the following:
   
   • For each field that is to define the query, select the field, and then click the Move button (>) to move the fields to the Filter Summary list.
   
   • In the Field Search field, enter the string by which to filter your search for available fields. For each field that is to define the query, select the field, and then click the Move button (>) to move the fields to the Filter Summary list.

   For each field that you select, a dialog box opens in which you must specify the allowed values for the field. After you specify the values and click OK, the dialog box closes, and the selected field is moved to the Filter Summary list.

   The search is limited to the exact order of characters in the strings but the string is not case-sensitive and it can be found anywhere in the search results. For example, a search string of Contact returns both Contact Name and 1st Contact. As you enter the search string, the Available Fields list is dynamically updated with a list of fields that meet the search criteria.

For each field that you select, a dialog box opens in which you must specify the allowed values for the field. After you specify the values and click OK, the dialog box closes, and the selected field is moved to the Filter Summary list.

If you are copying an existing query, then when the Filter Summary tab opens, the Filter Summary list is already populated. You can select one or more of these fields and then click the Remove button (<) to move these fields back to the Available list. If you want to use the same Filter Summary fields in the “new” query, but with different values, you cannot change the values directly. You must move the appropriate fields back to the Available list, then select the fields again to change their values.
2. Continue with any other configuration for the query as needed, or do one of the following:

- Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
- Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.

Sort tab

*Figure 8-12: Query Builder Filter dialog box, Sort tab*

1. Open the Sort tab, select the field or CTRL-click to select the multiple fields by which the query results are to be sorted, and then click the Move button (>) to move the fields to the Selected list.

2. Continue with any other configuration for the query as needed, or do one of the following:

- Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
- Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
Chart tab

Figure 8-13: Query Builder Filter dialog box, Chart tab

1. Open the Chart tab, and specify the type of chart that is to be used to graph the query results.
2. Manually enter any information for the chart (for example, Chart Title) as needed.
3. Optionally, do one or both of the following:
   • To show a legend with the chart, select Show Legend, and then specify the legend information (alignment, header, footer, and marker style and size).
   • To spell check any charting information that you manually entered, click Spelling.
4. Continue with any other configuration for the query as needed, or do one of the following:
   • Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   • Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
Users tab

The ability to assign specific queries to specific users is available only in EMS Enterprise. It is not available in EMS Professional.

Figure 8-14: Query Builder Filter dialog box, Users tab

1. Open the Users tab, and in the Available list, select the user, or CTRL-click to select the multiple users who can run this query, and then click the Move (>) button to move the selected users to the Selected list.

By default, all administrative users can run any query that any user creates. These users are listed in the Administrative list. You cannot remove any administrative users from this list.

2. Continue with any other configuration for the query as needed, or do one of the following:
   - Click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
   - Open the Results tab, and then click Preview to run the query immediately and view the results on the tab. You can then click OK to close the Query Builder Filter dialog box and save the named query. The named query is displayed on the Reports menu under the Queries option. You can run this query at any later date when needed.
To edit a query

1. On the EMS menu bar, click Reports.
   The Reports menu opens.
2. On the Reports menu, click Queries > Query Builder.
   The Query Definitions dialog box opens. The dialog box displays, by name, any queries
   that have been previously defined in your EMS application. See Figure 8-7 on page 348.
3. Select the query that you are editing, and then click Edit.
   The Query Definitions dialog box opens. All of the tabs are populated with the
   information for the selected query.
4. Edit the query as necessary including one or more of the following:
   • Renaming the query.
   • Changing the fields that are to be displayed in the query results.
   • Changing the fields that define the query.
   • Changing the order of the fields by which the query results are to be sorted.
   • Changing the charting options for the query results.
   • Changing the users who can run the query.
5. Do one of the following:
   • Click OK to close the Query Builder Filter dialog box and save the edited query. The
     edited query is displayed on the Reports menu under the Queries option. You can run
     this query at any later date when needed.
   • Open the Results tab, and then click Preview to run the query immediately and view
     the results on the tab. You can then click OK to close the Query Builder Filter dialog
     box and save the edited query. The edited query is displayed on the Reports menu
     under the Queries option. You can run this query at any later date when needed.

To delete a query

1. On the EMS menu bar, click Reports.
   The Reports menu opens.
2. On the Reports menu, click Queries > Query Builder.
   The Query Definitions dialog box opens. The dialog box displays any queries that have
   been previously defined in your EMS application. See Figure 8-7 on page 348.
3. Select the query that is to be deleted, and then click Delete.
   A message opens, asking you if it is OK to delete the selected query.
4. Click Yes.

The message closes. The query is deleted.

To view and print a query

1. On the EMS menu bar, click Reports.

   The Reports menu opens.

2. On the Reports menu, click Queries > Query Builder.

   The Query Definitions dialog box opens. The dialog box displays any queries that have been previously defined in your EMS application. See Figure 8-7 on page 348.

3. Select the query that is to be printed, and then click Print.

   An onscreen preview of the selected query opens. A variety of options are available from this preview, including the options to print a hard copy of the query, to email the query, and so on.

   Figure 8-15: Print preview for a query

4. Select the option or options that best fit your working needs.
To run a query

When you run a saved query, you can run the query from the Reports menu, or you can run the query from the Query Definitions dialog box.

1. On the EMS menu bar, click Reports and on the Reports menu, click Queries, and then do one of the following:
   • Click the name of the query that you are running.
   • Click Queries > Query Builder and on the Query Definitions dialog box, select the query that you are running, and then click Run.

   The query is run and the results are displayed onscreen in the Query Results dialog box.

   ![Query Results dialog box example](image)

   The Results (lower) pane on the Query Results dialog box is an EMS browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.

   Figure 8-16: Query Results dialog box example

2. Optionally, on the Query Results dialog box, do one or more of the following, and then click Get Data to rerun the query according to the edited definition.
   • Select the date for which the data in your EMS database is to be queried.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>The starting date is set to the first day of the month and the ending date is set to the last day of the month but you can edit one or both of these dates.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For some queries, if you select Custom, a Use Specific Times option becomes available. If you enter the same date for the starting date and ending date, you can select Use Specific Times, and then enter a starting time and ending time to query the data in specific time range on the same day.</td>
</tr>
</tbody>
</table>
Chapter 8
Reports and Queries

3. After you have run the query to your satisfaction, you can then do one or both of the following:

- Change the Starting Date, Ending Date, or both.
- In the Report Comment field, enter a comment that is to be printed on the query.

- The comment can be a maximum of 255 characters, including spaces.

- Click Options and change the settings for specific room filter and/or the number of records to return.

4. After you have run the query to your satisfaction, you can then do one or both of the following:

- To print the query results, click Print. An onscreen preview of the query results opens. A variety of options are available from this preview, including the options to print a hard copy of the query results, to export the query results to a .pdf, and to email the query results. Select the option or options that best fit your working needs.
- To export the query results to an Excel spreadsheet, or to an XML file, click Export, and then click Excel or XML as appropriate.
Chapter 9
Billing

Accurate and timely billing is critical to ensuring a successful experience for organizations that schedule events at your facilities. EMS provides a variety of functions for working with invoices and transactions for reservations and bookings as well as reporting on this information.

This chapter covers the following topics:
• “Overview of Billing in EMS” on page 363.
• “Working with Invoices” on page 364.
• “Searching for Transactions” on page 378.
• “Working with Transactions” on page 385.
• “Generating an EMS Billing Report” on page 394.
• “Report Descriptions and Options” on page 396.
Overview of Billing in EMS

In EMS, at a high-level, billing is a two-step process:

- The first step is to generate invoices. (See “Working with Invoices” on page 364.) You can generate invoices based on reservation number, date range, or both. For example, you could generate invoices for all bookings in Reservation 1829 that occurred last month. After you have generated the invoices, EMS tracks the amount due and the age of the invoices.

Financial transactions in EMS are batched by department. For example, if a user who is a member of the Scheduling department applies a deposit to a reservation, then the deposit is shown on a confirmation only if the user who applied the deposit or other users in the Scheduling department print the confirmation. If a user in another department, for example, the Catering department, prints the confirmation, then the deposit is not shown on the confirmation. Similarly, invoices that are generated by a department are printed on the Ageing report only if the report is generated for the same department. If you invoice a reservation or one of its bookings, any deposit that was previously made on the reservation is then applied and is no longer shown on the confirmation. If you invoice an event, the event is locked and cannot be edited. You can edit the event only after you void the invoice. You cannot void an invoice if payments have been made against it. You must first void the payments. You can use an adjustment with a negative dollar amount to clean up your financial records. For example, you generate an invoice for $102 for a group and the group returns a check for $100. If you do not want to ask the group for a $2.00 check, an adjustment of “$2.00-” balances your books.

As part of this process, you can generate the Billing Worksheet report. (See “Generating an EMS Billing Report” on page 394.) You use this report to review the dollar amounts for the bookings for which you intend to create invoices. You can correct any discrepancies that you note in the report by editing the bookings or booking items in question.

- The second step is to process received payments using the Payment Entry function. (See “Searching for Transactions” on page 378.) You can also use this function to enter deposits made against a reservation before invoicing or booking and to enter adjustments.
Working with Invoices

You can **generate** an invoice in EMS based on a specific booking date or date range, a reservation number, or both. For example, you can generate invoices for all bookings from May 1 through May 14, for all bookings in reservation number 22, or for all bookings in reservation number 22 that occurred between May 1 and May 14. You can generate multiple invoices for the same booking, with each invoice showing the charges for a different category (such as room charges on one invoice, catering charges on another invoice, and so on). This might be necessary in situations in which you must produce multiple invoices for the same booking if the departments within your organization bill separately for the services they provide. You can also **reprint** an invoice and **void** an invoice.

You can work with invoices for a single reservation, or you can batch process multiple invoices. If you want to work with invoices for a single reservation, you do so through the Transactions tab in the Navigator. If you want to work with a batch of invoices, you do so through the EMS Billing menu: Billing > Invoices > Invoicing.

To generate an invoice

**Before you generate an invoice, you should generate the Billing Worksheet report.** See “Generating an EMS Billing Report” on page 394.

1. Do one of the following:
   - Open the reservation in the Navigator (see “Opening a reservation in the Navigator” on page 79), and on the Transactions tab, click New > Invoice.
   - On the EMS menu bar, click Billing > Invoices > Invoicing.

   The Invoicing window opens.

**Figure 9-1: Invoicing window**
2. Do one of the following:

- Review the selections on this dialog box, and optionally, make any needed modifications.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date Range tab</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Department | Select the department that is creating the invoices. The department name and address is printed at the top of the invoice.  
**Note:** This field is automatically populated if you have a default department assigned to your user account but you can select a different value if needed. |
| Reservation Number | Automatically populated if you are generating an invoice from the Transaction tab; otherwise, enter a reservation number. |
| Starting Date | Automatically populated with the first (starting) booking date and the last (ending) booking date for the selected reservation when you are generating an invoice from the Transaction tab; otherwise, enter the date range of the bookings for which you are generating the invoice. |
| Ending Date | |
| Use Specific Times | If only a specific time for the bookings is to be invoiced (for example, the bookings are from 8 am to 5 pm and you want to invoice the booking from only 8 am to noon), then click Use Specific Times, and then enter a specific time period. |
| Invoice Date | The default value is the current day’s date. You can leave this value as is, or enter a different date. |
| Due Date | The system default value is 30 days from the current day’s date. (Your EMS administrator might have configured a different default value for this field.) You can leave in the field as is, or you can enter a different date. |
| **Buildings tab/Categories tab/Statuses tab/Group Types tab** | Open the appropriate tab on the window and select the buildings, resource categories, booking statuses, and group types that are to be invoiced. This information is displayed on the invoice.  
**Note:** A Show Inactive option is available for both categories and statuses. Select this option to show inactive categories and statuses. You can select these inactive items as part of your filtering criteria.  
**Note:** To select a building, category, and so on, select the item in the Available list (CTRL-click to select multiple items), and then click the Move button (>) to move the items to the Selected list. |
| **Options tab**—Format settings for a printed confirmation | |
| Header Message | Select the header message and footer message that is to be printed on the invoice. By default, the header and footer messages are printed on every page of the invoice. To print the header only on the first page of the invoice, clear the Print Header on Each Page option. |
| Footer Message | |
| Currency | Select the currency that indicates how a room or resources in a category should be charged. |
| Print Comments | Include the comments for the reservation in the printed invoice. |
| Print Reminders | Include the reminders for the reservation in the printed invoice. |
| Print User Defined Fields | Include user-defined fields and their values in the printed invoice. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress Reserved Time</td>
<td>Do not show the reserved time on the printed invoice. (Instead, only the event time is included on the printed invoice.)</td>
</tr>
<tr>
<td>Print Item Notes</td>
<td>Include the notes for any booking items in the printed invoice.</td>
</tr>
<tr>
<td>Print Zero Priced Items</td>
<td>Include resources for which there was no charge in the printed invoice.</td>
</tr>
<tr>
<td>Print Item Selections</td>
<td>Include any resource item selections in the printed invoice.</td>
</tr>
<tr>
<td>Print Header On Each Page</td>
<td>Include the selected Header message on each page of the printed invoice.</td>
</tr>
<tr>
<td>Suppress Logo</td>
<td>Do not show your department's/organization's logo on the printed invoice.</td>
</tr>
<tr>
<td>Print Billing Reference Allocation</td>
<td>Include the billing reference numbers for the event as well as the percentage of charges that is allocated to each number in the printed invoice.</td>
</tr>
<tr>
<td>Print Category Subtotals</td>
<td>Include the subtotal charges by category in the printed invoice.</td>
</tr>
<tr>
<td>Display Messages as HTML</td>
<td>If you have defined any HTML messages, then select this option to display the HTML version of these messages in the printed invoice; otherwise, the message is displayed in plain text.</td>
</tr>
</tbody>
</table>

*If needed, you can always save, or memorize, these settings. See “Working with Memorized Reports” on page 323.*

- On the Setup dropdown list, select a saved, or **memorized**, invoice.

*If you select a memorized confirmation, then the only changes that you can make are to the dates and/or times on the Date Range tab.*

3. Click Generate.

The generated invoices are displayed in the Invoicing dialog box. By default, invoices with a zero balance are not shown.

*Figure 9-2: Invoicing dialog box with generated invoices*
4. Optionally, you can do one or more of the following to work with the invoices that are displayed; otherwise, if you are satisfied with the invoices, you can go to Step 5 to post the invoice.

- To show zero balance invoices in the window, clear the Hide Zero Balances option.
- To preview an invoice, select the invoice, or CTRL-click to select multiple invoices, and then click Preview.

An onscreen preview of the selected invoices opens. The preview is titled “Invoice Preview” to distinguish the invoices from invoices that have been posted. The invoices also do not have invoice numbers, which are not issued until you post the invoices. The preview window contains options for printing a hard copy of the invoices, for emailing the invoices (see “Sending Email from EMS” on page 414), and so on. Select the option or options that best fit your working needs.

- To change the criteria for the invoices, click Filter to return to the Invoicing window After changing the criteria, you can generate the invoices again.

Figure 9-3: Onscreen preview of an in-progress invoice

5. To post an invoice, select the invoice (CTRL-click to select multiple invoices), and then click Final.

A message opens warning you that you are about to post and print (#) invoices, and asking you if want to continue.

6. Click Yes.

The message closes and an onscreen preview of the final invoices opens. The preview is titled “Invoices” and each invoice has been issued an invoice number. The preview window contains options for printing a hard copy of the invoices, for emailing the invoices (see “Sending Email from EMS” on page 414), and so on. Select the option or options that best fit your working needs. See Figure 9-4 on page 368.
After you generate and post an invoice, the message “Items have been invoiced” is displayed in red text on the Reservation Summary tab, the Booking Summary tab, and the <Booking Detail> Summary tab in the Navigator. The booking detail folder in which the invoiced items reside now has a green background in the Booking Details pane and the icon for each invoiced item also has a green background in the Items pane. Also, the invoice is permanently saved, and you cannot edit it. You can make changes to the balance due for a reservation only by creating an adjustment or by voiding the invoice and regenerating it after you edit the booking information. (Because invoiced bookings are locked and cannot be edited, you must void the invoice before you can edit the bookings.)

To reprint an invoice

You can reprint both non-voided and voided invoices. You can reprint invoices for only one department at a time from the Billing area of EMS. Reprinting an invoice does not recalculate the invoice. The invoice is simply printed as it appeared when it was first generated. You can specify the invoices that you are reprinting, or you can search for invoices that meet specific criteria, and then select specific invoices to reprint from the list of search results.

To reprint invoices for one or more departments, you must select the reservation in the Navigator, open the Transactions tab and CTRL-click to select the multiple invoices that you are reprinting, and then use the Reprint option on the Transactions tab.

To specify invoices for reprinting

1. On the EMS menu bar, click Billing > Other > Reprint Invoices.

   The Reprint Invoices dialog box opens. See Figure 9-5 on page 369.
2. In the Department field, select the department that generated the invoices.

   *This field is automatically populated if you have a default department assigned to your user account but you can select a different value if needed.*

3. In the Invoice No. field, enter the number of the invoice that you are reprinting, and then click Add.

   The invoice is displayed (by number) in the lower right Invoice pane.

4. Repeat Step 3 until you have added all the invoices that you are reprinting.

5. Leave the reprinting criteria set to their default values, or optionally, edit them as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoices</td>
<td>The invoice type that you are reprinting—Non Voided (the default value) or Voided.</td>
</tr>
<tr>
<td>Format</td>
<td>Select the sort order for the reprinted invoices. The default value is By Reservation.</td>
</tr>
<tr>
<td>First Transaction Date</td>
<td>Leave these values blank to reprint the invoice for all bookings; otherwise, enter the date range of the bookings for which you are reprinting the invoice.</td>
</tr>
<tr>
<td>Last Transaction Date</td>
<td></td>
</tr>
<tr>
<td>Print Header on Each Page</td>
<td>Leave this option selected to print the invoice header on every page of the invoice.</td>
</tr>
<tr>
<td>Print Transactions</td>
<td>Select this option to include any associated transactions (deposits, payments, and so on) in the reprinted invoice.</td>
</tr>
</tbody>
</table>
6. Click OK.

An onscreen preview of the invoices opens. The preview is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf, emailing the invoice (see “Sending Email from EMS” on page 414) and so on. Select the option or options that best fits your working needs.

*Figure 9-6: Onscreen preview of an invoice selected for reprinting*

To search for invoices to reprint

1. On the EMS menu bar, click Billing > Other > Reprint Invoices.

The Reprint Invoices dialog box opens.

*Figure 9-7: Reprint Invoices dialog box*
2. Enter the criteria to search for the invoices that you are reprinting.

As you enter the search criteria, the lower left Invoice pane is dynamically updated with
the invoices that meet the criteria. The Note column in this pane indicates if payments
have been made against the invoice.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>The department that generated the invoice. You can search for invoices for reprinting as long as the invoices were generated by the same department.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is automatically populated if you have a default department assigned to your user account but you can select a different value if needed.</td>
</tr>
<tr>
<td>Invoices</td>
<td>Select the type of invoice for which to search—Non Voided or Voided.</td>
</tr>
<tr>
<td>First Transaction Date</td>
<td>You must enter at least a First Transaction date. By default, the Last Transaction date is set to the same date. You can change the Last Transaction date if needed.</td>
</tr>
<tr>
<td>Last Transaction Date</td>
<td></td>
</tr>
<tr>
<td>Show Paid Invoices</td>
<td>Leave this option selected to include paid invoices in the search.</td>
</tr>
</tbody>
</table>

3. Leave the reprinting criteria set to their default values, or optionally, edit them as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Select the sort order for the reprinted invoices. The default value is By Reservation.</td>
</tr>
<tr>
<td>Print Header on Each Page</td>
<td>Select this option to print the invoice header on every page of the reprinted invoice.</td>
</tr>
<tr>
<td>Print Transactions</td>
<td>Select this option to include any associated transactions (deposits, payments, and so on) in the reprinted invoice.</td>
</tr>
</tbody>
</table>

4. In the lower left Invoice pane, select the invoice, or CTRL-click to select the multiple invoices that you are reprinting, and then click the Move button (>) to move the selected invoices to the lower right Invoice pane.

5. Click OK.

An onscreen preview of the invoices opens. The preview is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf, emailing the invoice (see “Sending Email from EMS” on page 414), and so on. Select the option or options that best fits your working needs. See Figure 9-8 on page 372.
To void an invoice

You can void an invoice only if the invoice has not been paid. If payments have been made against an invoice, you must first void the payments. You can void invoices for only one department at a time. When you void an invoice, the invoice is removed from the Ageing report and its associated bookings are unlocked. You can specify the invoices that you are voiding, or you can search for invoices that meet specific criteria, and then select specific invoices to void from the list of search results.

---

You can also void an invoice from the Transactions tab when a reservation is selected in the Navigator.

To specify invoices to void

1. On the EMS menu bar, click Billing > Other > Void Invoices.

   The Void Invoices dialog box opens. See Figure 9-9 on page 373.
2. In the Department field, select the department that generated the invoices.

3. In the Invoice No. field, enter the number of the invoice that you are voiding, and then click Add.

   Two results are possible:
   
   • If payments have *not* been applied to the invoice, then a Void Reason dialog box opens. Continue to Step 4.

   Figure 9-10: Void Reason

   • If payments have been applied to the invoice, then an error message opens indicating that payments have been applied to the invoice and it cannot be voided. You must void the payments first before you can continue with voiding the invoice. See “To void a transaction” on page 391.

4. Enter a reason for voiding the invoice, and then click OK.

   The invoice is displayed (by number) in the lower right Invoice pane.

5. Repeat Step 3 and Step 4 until you have selected all the invoices from the same department that you are voiding.
6. Do one of the following:
   - To review an invoice before you void it, go Step 7.
   - To void an invoice without reviewing it, go to Step 8.

7. Optionally, before you void a selected invoice, you can review it to ensure that it is indeed an invoice that you want to void. In the lower right Invoice pane, select the invoice, or CTRL-click to select multiple invoices, and then click Preview.

   An onscreen preview of the selected invoices opens. The preview is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf, and so on. (See Figure 9-11 on page 374.) Select the option or options that best fit your working needs. For example, before you void an invoice, you might want to email a copy of the invoice to a colleague to confirm that the invoice should be voided.

   Figure 9-11: Onscreen preview of an invoice selected for voiding

8. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple invoices that you are voiding, and then click OK.

   A message opens asking you if you are sure that you want to void the selected invoices.

9. Click Yes.

   A message opens indicating that the invoices have been voided.

10. Click OK.

    The message and the Void Invoices dialog box close. The Void column is set to Yes on the Transactions tab for each of the voided invoices in the Navigator.
To search for invoices to void

1. On the EMS menu bar, click Billing > Other > Void Invoices.
   
   The Void Invoices dialog box opens.

   **Figure 9-12: Void Invoices dialog box**

2. Enter the criteria to search for the invoices that you are voiding.
   
   As you enter the search criteria, the lower left Invoice pane is dynamically updated with the invoices that meet the criteria. The Note column in this pane indicates if payments have been made against the invoice.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>The department that generated the invoice. You can search for invoices for voiding as long as the invoices were generated for the same department. You cannot void invoices from different departments.</td>
</tr>
<tr>
<td>First Transaction Date</td>
<td>You must enter at least a First transaction date. The Last transaction date is optional.</td>
</tr>
<tr>
<td>Last Transaction Date</td>
<td></td>
</tr>
<tr>
<td>Show Paid Invoices</td>
<td>Leave this option selected to include paid invoices in the search. If you want to void an invoice against which payments have been made, then this reminder serves to prompt to you to first void the payments before you void the invoice. See “To void a transaction” on page 391.</td>
</tr>
</tbody>
</table>

3. Select the invoice, or CTRL-click to select the multiple invoices that you are voiding, and then click the Move button (>).

   **Remember:** you can select an invoice for voiding only if payments have not been applied to the invoice.

   A Void Reason dialog box opens. See Figure 9-13 on page 376.
4. Enter a reason for voiding the invoice, and then click OK.

The Void Reason dialog box closes. The invoices are displayed (by number) in the lower right Invoice pane.

5. Do one of the following:
   • To review an invoice before you void it, go Step 6.
   • To void an invoice without reviewing it, go to Step 7.

6. Optionally, before you void a selected invoice, you can review it to ensure that it is indeed an invoice that you want to void. In the lower right Invoice pane, select the invoice, or CTRL-click to select multiple invoices, and then click Preview.

An onscreen preview of the selected invoices opens. The preview is titled “Invoices.” The preview window contains options for printing a hard copy of the invoices, for exporting the invoices to a .pdf, and so on. Select the option or options that best fit your working needs. For example, before you void an invoice, you might want to email a copy of the invoice to a colleague to confirm that the invoice should be voided.

Figure 9-14: Onscreen preview of an invoice selected for voiding
7. In the lower right Invoice pane, select the invoice, or CTRL-click to select the multiple invoices that you are voiding, and then click OK.
   
   A message opens asking you if you are sure that you want to void the selected invoices.

8. Click Yes.

   A message opens indicating that the invoices have been voided.

9. Click OK

   The message and the Void Invoices dialog box close. The Void column is set to Yes on the Transactions tab for each of the voided invoices in the Navigator.
Searching for Transactions

A transaction in EMS can be one of four types—a deposit (deposit and damage deposit), a payment, an adjustment, or a refund.

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Deposit          | A deposit is the dollar amount paid in advance of a meeting or event before invoicing occurs.  
• A deposit is added to a reservation. After you invoice the reservation, all outstanding deposits are applied to the invoice to reduce the balance due.  
• A damage deposit is used to collect a deposit that is not applied to an invoice and therefore, does not reduce the balance due. Instead, if the customer does not damage the room, any reserved equipment, and so on, then you must return the damage deposit to the customer by voiding the damage deposit transaction. |
| Payment          | A payment is the dollar amount that is applied to an invoice to reduce the balance due. A pre-payment is similar to a deposit and is applied to a reservation. |
| Adjustment       | An adjustment is a modification that is made to the amount due on an existing invoice. For example, if you send out an invoice to a group for $202.00 and the group sends you a check for $200.00, you can make an adjustment of "$2.00-" to close out the invoice. |
| Refund           | A refund is the return of funds that have been applied to an invoiced reservation. |

You can use the Browse Transaction function to search for any of these transaction types. The results are displayed in a list view. When you carry out a search in the for a transaction, you can carry out a basic search or an advanced search. A basic search is based on the basic information that you specify for a transaction when you first create it, such as the group to which the transaction applies, the department that generated the transaction, and so on. An advanced search is a field level search that is carried out the reservation level, the transaction level, or a combination of these. For example, in an advanced search, you can specify criteria as granular as the Bill To Contact at the reservation level.

---

To search for a transaction

1. On the EMS menu bar, click Billing > Other > Browse Transactions.

The Browse Transactions window opens. The *first* time that the Browse Transaction window opens, the Filter tab is set by default to a basic search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you last carried out.

*Figure 9-15: Browse Transactions window, Basic search options*

2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and then continue to one of the following:
   - “To carry out a basic transaction search.”
   - “To carry out an advanced transaction search” on page 381.

To carry out a basic transaction search

1. Enter the search criteria.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Time</td>
<td>The date range during which the transactions were carried out. Both are optional.</td>
</tr>
<tr>
<td>Ending Time</td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>Click the Search icon to open the Groups window and search for a for the group for which the transactions apply. See “To search for a group and/or contact” on page 255.</td>
</tr>
<tr>
<td>Department</td>
<td>Leave the default value set to (all) or select a specific department that generated/issued the transaction.</td>
</tr>
</tbody>
</table>
2. Optionally, click Options and edit the default value the Number of Records to Return search option.

3. Click Get Data or Refresh.

The search results are displayed on the Results tab.

*Figure 9-16: Browse Transactions window, Results tab*
4. Optionally, do one or more of the following:
   - The lower pane on the Results tab is an EMS Browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.
   - Click Print to print the search results.
   - Click Export to export the search results to a Microsoft Excel spreadsheet.
   - Select a search result entry for an invoice, and then click Email to open a pre-addressed SMTP email to the group that is associated with the invoiced reservation. Complete and send the email as you would normally. (The invoice is sent as an attachment.) See “Sending Email from EMS” on page 414.
   - Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.
   - Click Refresh to requery the database based on the current search criteria.
5. Click Close.

Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.

To carry out an advanced transaction search

*Figure 9-17: Browse Transaction window, Advanced search options*

1. Optionally, enter a Starting Date, an Ending Date, or both.
2. Optionally, if the Starting Date and the Ending Date are the same, select Use Specific Times and enter specific time periods to search.

   Use Specific Times is available only if the Starting Date is the same as the Ending Date.

3. For each field level option by which to carry out the search:
   - Select the field level option, and then click the Move button (>).
   - When prompted, enter a value or define the limits for the option, and then click OK. The option is moved to the Filter Summary list.

4. Optionally, click Options and edit the default values for one or more additional search options—Date/Time Filter, Number of Records to Return, and Specific Room Filters.

5. Optionally, click Options and edit the default value the Number of Records to Return search option.
6. Click Get Data or Refresh.

   The search results are displayed on the Results tab.

   Figure 9-19: Browse Transactions window, Results tab

   ![Browse Transactions window, Results tab](image)

7. Optionally, do one or more of the following:
   - The lower pane on the Results tab is an EMS browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this pane.
   - Click Print to print the search results.
   - Click Export to export the search results to a Microsoft Excel spreadsheet.
   - Select a search result entry for an invoice, and then click Email to open a pre-addressed SMTP email to the group that is associated with the invoiced reservation. Complete and send the email as you would normally. (The invoice is sent as an attachment.) See “Sending Email from EMS” on page 414.
   - Click Filter to return to the Filter tab, make any necessary changes to the search criteria, and then repeat the search.
   - Click Refresh to requery the database based on the current search criteria.

8. Click Close.

   Any changes that you made to the search results columns (position and width) remain in effect for any other searches that you carry out. If you want to reset the columns to their default values, see “Resetting Column Settings” on page 408.
To set up favorite fields for a Transaction search

If you have specific fields and/or values by which you always want to carry out a Transaction search, you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Browse Transactions window, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then click Add to Favorites.
   
   The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog box.
   
   The next time that you carry out a search, you can simply open the Favorite Fields tab or the Saved Values tab to carry out a search based on your customized list of search fields.
Working with Transactions

Working with transactions in EMS consists of entering the transaction correctly, and if needed voiding a transaction. You can:

- **Enter** a deposit and **void** a deposit.
- **Enter** a payment and **void** a payment.
- **Enter** an adjustment and **void** an adjustment.
- **Enter** a refund and **void** a refund.

The steps for entering the different types of transactions are specific to the transaction. The steps for voiding a transaction are identical, regardless of the transaction type.

---

If needed, you can first search for a transaction to ensure that it has not already entered or voided. See “To search for a transaction” on page 379.

---

To enter a deposit or damage deposit for a reservation

1. Do one of the following:

   - Open the reservation in the Navigator (see “Opening a reservation in the Navigator” on page 79), and on the Transactions tab, click New > Payment.
   - On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the Payment Entries window, click New.

   The Payment Entry dialog box opens.

   Figure 9-20: Payment Entry dialog box
2. Enter the deposit information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>The default value is the current day’s date. You can edit this value if needed.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the department.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Select the transaction type—Damage Deposit, Deposit (Reservation), or Deposit (Bookings).</td>
</tr>
<tr>
<td></td>
<td>• A Deposit (Reservation) is best suited for reservations with one or more bookings that are to be invoiced in their entirety upon completion of the event.</td>
</tr>
<tr>
<td></td>
<td>• A Deposit (Bookings) is best suited for reservations with multiple bookings, for example, an event with multiple occurrences spanning several months, that is to be billed monthly. A Deposit (Bookings) allows you to spread the deposit across multiple months so that only a portion of the deposit is consumed and applied to the invoice that is generated monthly. In this scenario, a large deposit that is entered as Deposit (Reservation) would be consumed in its entirety by the first invoice that is generated.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Select the payment type.</td>
</tr>
<tr>
<td>Check No.</td>
<td>Enter a check number if you selected “Check” as the payment Type.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the deposit.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the currency for the deposit.</td>
</tr>
<tr>
<td>Reservation No.</td>
<td>Automatically populated if you opened the Payment Entry dialog box from the Transaction tab in the Navigator; otherwise, enter a reservation number or click the Search icon to open the Reservations window and search for a reservation.</td>
</tr>
<tr>
<td>Invoice No.</td>
<td>N/A as deposits are applied before an invoice is generated. The invoicing process totals the charges for the specified date range, consumes any applied reservation deposits, and results in a net balance due for the invoice. The invoicing process does not consume any Damage deposits.</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional. Enter any other comments or statements that explain or clarify the deposit.</td>
</tr>
</tbody>
</table>

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the Transactions tab for the reservation.
To enter a payment or pre-payment

1. Do one of the following:
   - Open the reservation in the Navigator (see “Opening a reservation in the Navigator” on page 79), and on the Transactions tab, click New > Payment.
   - On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the Payment Entries window, click New.

   The Payment Entry dialog box opens.

   Figure 9-21: Payment Entry dialog box

2. Enter the payment information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>The default value is the current day’s date. You can edit this value if needed.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the department.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Select the transaction type—Payment or Pre-payment.</td>
</tr>
<tr>
<td>Note:</td>
<td>Remember that pre-payments act just like deposits in that they are applied to a reservation and are applied to an invoice reducing the balance due. Payments are applied to an invoice.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Select the payment type.</td>
</tr>
<tr>
<td>Check No.</td>
<td>Enter a check number if you selected “Check” as the payment Type.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the payment.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the currency for the payment.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Reservation No.** | • If you selected Payment as the Transaction Type, then this field is not available as payments are applied against invoices, not reservations.  
• If you selected Pre-payment as the transaction type, then the field is automatically populated if you opened the Payment Entry dialog box from the Transaction tab in the Navigator; otherwise, you must enter a reservation number or click the Search icon to open the Reservations window and search for a reservation.

**Invoice No.** | • If you selected Pre-payment as the Transaction Type, then this field is not available as pre-payments are applied before an invoice is generated.  
• If you selected Payment as the Transaction Type, then you must enter an invoice number in this field, or click the Search icon to open the Invoices window and search for an invoice.

**Notes** | Optional. Enter any other comments or statements that explain or clarify the payment.

3. **Click OK.**

The Payment Entry dialog box closes. The transaction information is displayed on the Transactions tab for the reservation.
To enter an adjustment for an invoice

1. Do one of the following:
   - Open the reservation in the Navigator (see “Opening a reservation in the Navigator” on page 79), and on the Transactions tab, click New > Payment.
   - On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the Payment Entries window, click New.

   The Payment Entry dialog box opens.

   *Figure 9-22: Payment Entry dialog box*

   ![Payment Entry dialog box]

2. Enter the adjustment information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>The default value is the current day’s date. You can edit this value if needed.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the department.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Select the transaction type—Adjustment.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Select the payment type.</td>
</tr>
<tr>
<td>Check No.</td>
<td>Enter a check number if you selected “Check” for the payment type.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the adjustment. To decrease the invoice by the indicated amount, enter a minus sign (-) before or after the amount.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the currency for the adjustment.</td>
</tr>
<tr>
<td>Reservation No.</td>
<td>N/A as adjustments are applied to invoices.</td>
</tr>
</tbody>
</table>
Chapter 9
Billing

3. Click OK.
   The Payment Entry dialog box closes. The transaction information is displayed on the
   Transactions tab for the reservation.

To enter a refund

1. Do one of the following:
   • Open the reservation in the Navigator (see “Opening a reservation in the Navigator”
     on page 79), and on the Transactions tab, click New > Payment.
   • On the EMS menu bar, click Billing > Payments > Payment Entry, and then on the
     Payment Entries window, click New.

   The Payment Entry dialog box opens.

   *Figure 9-23: Payment Entry dialog box*
2. Enter the refund information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Date</td>
<td>The default value is the current day's date. You can edit this value if needed.</td>
</tr>
<tr>
<td>Department</td>
<td>Select the department.</td>
</tr>
<tr>
<td>Transaction Type</td>
<td>Select the transaction type—Refund.</td>
</tr>
<tr>
<td>Payment Type</td>
<td>Select the payment type.</td>
</tr>
<tr>
<td>Check No.</td>
<td>Enter a check number if you selected “Check” as the payment type.</td>
</tr>
<tr>
<td>Amount</td>
<td>Enter the amount of the refund.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the currency for the refund.</td>
</tr>
<tr>
<td>Reservation No.</td>
<td>N/A as refunds are applied to invoices.</td>
</tr>
<tr>
<td>Invoice No.</td>
<td>You must enter an invoice number or click the Search icon to open the Invoices window and search for an invoice</td>
</tr>
<tr>
<td>Notes</td>
<td>Optional. Enter any other comments or statements that explain or clarify the refund.</td>
</tr>
</tbody>
</table>

3. Click OK.

The Payment Entry dialog box closes. The transaction information is displayed on the Transactions tab for the reservation.

**To void a transaction**

You can void a transaction for a reservation from the Transactions tab, or you can void a transaction from the Payment Entries window.

**To void a transaction from the Transactions tab**

1. Open the reservation in the Navigator. (See “Opening a reservation in the Navigator” on page 79.)

2. Open the Transactions tab, and on the Transactions tab, select the transaction that is to be voided (CTRL-click to select multiple transactions), and then click Void.

A Void Reason dialog box opens.

*Figure 9-24: Void Reason dialog box*
3. Enter the reason for voiding the transactions, and then click OK.
   The Void Reason dialog box closes and a message opens indicating that the transaction has been voided.

4. Click OK.
   The Void Transaction message closes. The Void column is set to Yes for each of the voided transactions in the Navigator.

To void a transaction from the Payment Entries window

1. On the EMS menu bar, click Billing > Payments > Payment Entry.
   The Payment Entries window opens. This window lists all transactions (voided and non-voided) that were ever made in your EMS system for a selected department on a selected date.

   Figure 9-25: Payment Entries window

2. Select the date (the default value is the current day’s date) and the department for which you are voiding the transaction.
   The Payment Entries window is updated with the list of payments that meet the date and department criteria.

3. Select the transaction that is to be voided, and then click Edit.
   The Payment Entry dialog box opens. This window details specific information for the selected transaction. (See Figure 9-20 on page 385.)

4. Click Void, and, then in the Void Comment field, enter a reason for voiding the transaction.
5. Click OK.

The Payment Entry dialog box closes. You return to the Payment Entries window. The Void column is set to Yes for the voided transaction.
Generating an EMS Billing Report

All EMS Billing reports are available under the Billing option on the menu bar. For any EMS report, you can specify the parameters, options, and format for the report, or you can generate the report according to memorized settings. (For detailed information about a memorized report, see “Working with Memorized Reports” on page 323.) Not all reports require the same parameters, nor do they all have the same options available. In addition, you can generate different reports in different formats.

For brevity and ease, the parameters and options that are available for each report are not discussed here. Instead, the options are discussed in “Report Descriptions and Options” on page 396. Contact your EMS administrator if you need assistance in generating any of these reports.

To generate a report

1. On the EMS menu bar, click Billing to open the Billing menu, and then do one of the following:
   - To generate the Billing Worksheet report, click Billing > Invoices > Billing Worksheet.
   - To generate any other Billing report, click Billing > Reports, and then click the option for the report that you are generating. For example, to generate the Ageing report, click Billing > Reports > Ageing.

   All Billing reports other than the Billing Worksheet report are also available from Reports > Billing.

2. On the Setup dropdown list, do one of the following:
   - To generate the report according to the filter settings that you want (parameters, options, and so on), leave user-specified selected, then go to Step 3.
   - To run the report with filter settings that have been saved, or memorized, select the memorized report, and then go to Step 4.

   For detailed information about memorized reports, see “Working with Memorized Reports” on page 323.

3. Specify the report parameters, options, and format. See:
   - “Invoice reports” on page 397.
   - “Reports” on page 397.
4. Optionally, do one or both of the following:
   - Click Print Preview.
     A preview of the report opens onscreen.
   - To print a hard copy of the confirmation, specify the number of copies that you are printing, and then click Print.

5. Click Close.

Unless you change the setup, all subsequent reports will be generated and printed according to the parameters and options that you have specified and in the format that you specified. If you want to save certain settings so that you do not have to adjust the filter settings every time you run the report, you can memorize the report. See “Working with Memorized Reports” on page 323.
Chapter 9
Billing

Report Descriptions and Options

This section provides a description of every EMS report in the categories listed below and it also defines the options that are available for each report.

See:

- “Invoice reports” on page 397.
- “Reports” on page 397.
## Invoice reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing Worksheet</td>
<td>Provides information on how bookings are to be invoiced. The report can include bookings within a date range, bookings within a reservation, or bookings within a date range inside a reservation. The report breaks down the charges in the same way as an invoice. The report also provides options for printing heading/footer messages and the detail for zero-dollar items.</td>
<td>See “Options tab—Format settings for a printed confirmation” in “To generate an invoice” on page 364.</td>
</tr>
</tbody>
</table>

## Reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ageing Report</td>
<td>A list of outstanding invoices. Current invoices are listed first, followed by past due invoices organized by age. Ageing Reports are based on department.</td>
<td>• Currency—Select the currency for the invoices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Show Unapplied Deposits—Deposits that are applied to reservations that have not been invoiced are displayed on the report.</td>
</tr>
</tbody>
</table>


### Chapter 9
### Billing

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Statements| A list of outstanding invoices for a selected group. Current invoices are listed first, followed by past due invoices organized by age. | - Currency—Select the currency for the invoices.  
- Report Title—Can create a title that is displayed at the top of the statement.  
- Header Message—Select a message from the pre-configured messages that is displayed at the top of every page of the statement.  
- Include Transactions On Zero Balance Invoices Within [ ] days—Statements that have a zero balance within the specified number of days are displayed.  
- Show Billing Reference Number—The billing reference number is displayed under the invoice information.  
- Show Purchase Order Number—The purchase order number is displayed under the invoice information.  
- Show Transaction Notes—Any notes entered for the transaction are displayed under the invoice information.  
- Use Current group Address - The current address of the group is displayed on the statement. (This address might or might not be the address for the group when the reservation was made.) |
<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Report</td>
<td>Shows all the billing transactions during a specified period if you generate the report in the By Transaction Type by Date format. Simply enter the date or date range and click Print. The report lists the group, event name, reservation ID, transaction date, transaction type, invoice number, check number, and amount. <strong>Note:</strong> If the report is generated in Standard format, deposits are not shown as transactions if they have been absorbed by the generation of an invoice. <strong>Note:</strong> You can also generate the Transaction Report from within a reservation to see only transactions for the selected event and you can generate the Transaction Report from the Print option on the Payment Entries window. Click Billing &gt; Payments &gt; Payment Entry, and then on the Payment Entries window, click Print.</td>
<td>Currency—Select the currency for the billing transactions.</td>
</tr>
<tr>
<td>Voided Transaction Report</td>
<td>Lists the payments, deposits, or adjustments that were voided on a specific date or within a date range. Lists the group, event name, reservation ID, transaction date and type, invoice number (if applicable), check number, and amount.</td>
<td>Currency—Select the currency for the voided transactions.</td>
</tr>
<tr>
<td>Invoice Detail Report</td>
<td>Provides detail for all invoices that were generated within a given date range. <strong>Note:</strong> See “To reprint an invoice” on page 368 for detailed instructions about the options that are available for the Print Invoice Detail dialog box.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### General Ledger Distribution

Shows the totals for invoices that were generated within a given date range. Entries are broken down by account, invoice, rate plan, or invoice. You can also generate this report in a Summary format.

<table>
<thead>
<tr>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Currency—Select the currency for the invoices.</td>
</tr>
<tr>
<td>• Invoices With Payments Only—Only invoices where payment has been received are posted on the report.</td>
</tr>
<tr>
<td>• Show Applied Deposits/Prepayments—Applied deposits and prepayments are posted on the report. (An applied deposit is a deposit on a reservation that has been invoiced.)</td>
</tr>
</tbody>
</table>
Chapter 10
User Settings

As an EMS user, you can manage many aspects of your account to better suit your working needs.

This chapter covers the following topics:

• “Setting User Preferences and Default Values” on page 403.
• “Changing your Password” on page 406.
• “Resetting Window Coordinates” on page 407.
• “Resetting Column Settings” on page 408.
• “Defining Your Views” on page 409.
Setting User Preferences and Default Values

Preferences, like system parameters, are settings that affect the basic functioning of your EMS system. The difference is that system parameters are global settings that affect all users on the system, whereas preferences are applicable only to your user account. You can set the values for many preferences for your EMS instance to better suit your working needs. These preferences include whether a report window stays open or closes automatically after you run a report, the time interval for Time dropdown fields, the format in which to send emails from your computer, the default values for specific fields in the Reservation Wizard and other EMS client windows, and the application that is to open all drawings (.png, .jpg, .gif, and so on) that are attached to bookings in the Navigator.

To set user preferences and default values

1. On the EMS menu bar, click Settings > Preferences.
   
The Preferences dialog box opens. The Preferences tab is the active tab.

*Figure 10-1: Preferences dialog box, Preferences tab*
2. Edit your user preferences as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Report Setup Form After Running Reports</td>
<td>Select this option if the window from which you generate a report is to automatically close after you run the report. Do not select this option if you want the window to remain open.</td>
</tr>
<tr>
<td>Time Drop Down Interval</td>
<td>The time interval displayed on a Time dropdown list—i.e., if you select 30 minutes, then options on the dropdown list are displayed as 1:00 1:30, 2:00 and so on. All Time dropdown lists are 24 hour lists.</td>
</tr>
<tr>
<td>Paper Size</td>
<td>The size of the paper on which reports, confirmations, and invoices are printed. Values are Letter, Legal, and A4.</td>
</tr>
<tr>
<td>Review Notifications When Navigator Opens</td>
<td>If this option is selected, then a notification in the Dashboard is automatically marked as “Reviewed” if you select the notification, and then click Go To. If this option is not selected, then you must select a notification, and then click Reviewed to manually mark the notification as “Reviewed.”</td>
</tr>
<tr>
<td>Do Not Save Window Coordinates</td>
<td>All windows in EMS have default coordinates (a position) in EMS. If you move a window from its default position when working in EMS, but you want the window to open in its default position the next time the window opens, then select this option.</td>
</tr>
<tr>
<td>Email Format</td>
<td>The format in which your emails are sent—HTML or Plain Text.</td>
</tr>
<tr>
<td>Send Emails Using Department Email Address</td>
<td>Select this option if you want the From email address for all the emails that you send from EMS to be the email address of the department that is associated with your user account.</td>
</tr>
<tr>
<td>Use Global Email Settings</td>
<td>If you want to use the global email settings that your EMS administrator has defined, then select this option.</td>
</tr>
<tr>
<td>Use Microsoft Outlook</td>
<td>If this option is selected, then EMS uses Microsoft Outlook for your default email client. If this option and the Use Global Email Settings option are not selected, then EMS uses the SMTP Email settings specific to your account. (These settings are specified in the lower pane of the Preferences dialog box.)</td>
</tr>
<tr>
<td>Use Microsoft Outlook Email Signature (HTML)</td>
<td>If the Use Microsoft Outlook option is selected, and your Email Format option is set to HTML, then you can select this option to include your Microsoft Outlook signature when you send emails from EMS.</td>
</tr>
</tbody>
</table>
| SMTP Email | Contact your EMS administrator with assistance in specifying these values.  
**Note:** If you are using SMTP Email settings that are specific to your account, then you also have the option of creating a signature that is to be included in all the emails that you send from EMS. |
3. Open the Defaults tab, and set the default values for the indicated items.

*Figure 10-2: Preferences dialog box, Defaults tab*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building</td>
<td>You can select all buildings, a specific building, or a specific view or area. The value that you select here automatically populates the Building dropdown list in the Reservation Wizard and other EMS client windows, for example, the Visitors window.</td>
</tr>
<tr>
<td>Status</td>
<td>The values that you select here automatically populate the appropriate fields in the Reservation Wizard, and other EMS client windows.</td>
</tr>
<tr>
<td>Event Type</td>
<td></td>
</tr>
<tr>
<td>Event Name</td>
<td></td>
</tr>
<tr>
<td>Event Time</td>
<td></td>
</tr>
<tr>
<td>Reservation Source</td>
<td></td>
</tr>
<tr>
<td>Time Zone/ Display</td>
<td></td>
</tr>
<tr>
<td>Audit Times in This Time Zone</td>
<td></td>
</tr>
<tr>
<td>Payments Currency</td>
<td></td>
</tr>
<tr>
<td>Default Drawing Application</td>
<td>Click the Search icon to open the Find Drawing Application dialog box and select the program that is to open all drawings (.png, .jpg, .gif, and so on) that are attached to bookings in the Navigator.</td>
</tr>
</tbody>
</table>

4. Click OK to close the Preferences dialog box and apply your edited preferences and default values.
Changing your Password

When your EMS administrator first sets up your user account, your password is predefined for you. You can change this password if you want.

To change your password

1. On the EMS menu bar, click Settings > Change Password.
   
The Change Password dialog box opens.

   *Figure 10-3: Change Password dialog box*

2. Do the following:
   
   • In the Old Password field, enter your current EMS password.
   
   • In the New Password field, enter the new password.
   
   • In the Re-enter New Password field, enter your new password again, exactly as you entered it in the New Password field.

3. Click OK to close the Change Password dialog box.
   
The next time that you log in to EMS, you must use your new password.
Resetting Window Coordinates

All windows in EMS have default coordinates (a size and position) in EMS. If you have moved one or more windows or resized one or more windows during an EMS session, and you want the windows to open in their default positions and sizes, you can reset the window coordinates to their default values.

To reset window coordinates

1. On the EMS menu bar, click Settings > Reset Window Coordinates.

   The Window Coordinates dialog box opens.

   *Figure 10-4: Window Coordinates dialog box*

   ![Window Coordinates dialog box]

2. Click OK.

3. If necessary, restart your EMS application.
Chapter 10
User Settings

Resetting Column Settings

All columns in EMS have default values for their positions and widths in EMS. If you have changed the position, width, or both of one more columns during an EMS session, and you want the columns to open with their default values, you can reset the columns to their default values.

To reset column settings

1. On the EMS menu bar, click Settings > Reset Column Settings.
   
   The Column Settings dialog box opens.

   Figure 10-5: Column Settings dialog box

   ![Column Settings dialog box]

2. Click OK.

3. If necessary, restart your EMS application.
Defining Your Views

A view is simply a user-defined grouping of specific rooms. When searching for rooms in which to schedule events, you can select (all) buildings to search, a specific building, an area, or a view. If your job entails making multiple reservations for groups that always book events in specific rooms or locations, then to make your room search easier and more efficient, you can define the views that best meet your working needs. For example, if you are making multiple reservations for your school district’s athletic teams, then you could define a view called School District 1 - Athletic, and this view would contain the following event locations—Baseball Field 1, Baseball Field 2, Gym 1, Gym 2, Pool, and so on.

To define your views

1. On the EMS menu bar, click Settings > My Views.

   The My Views window opens. This window lists all the views that you have defined.

   Figure 10-6: My Views window

2. Click New.

   The View dialog box opens. The View tab is the active tab. See Figure 10-7 on page 410.
3. In the Description field, enter a name or description for the view.

   *The description can be a maximum of 50 characters, including spaces.*

4. Optionally, in the Notes field, enter any additional information that is pertinent for the view.

5. Open the Rooms tab, and do one or both of the following:
   - Select (all) buildings, a specific building, a view, or an area for which to search for rooms to include in the view.
   
   *The views that are available are not only all the views that you have defined for this EMS database, but also, all the views that other users have defined for this EMS database.*
   
   - Leave the Room Type set to the default value of (all), or select a specific room type. As you select your search criteria, the list of rooms that meet the search criteria is dynamically updated.

6. In the Available list, select the room, or CTRL-click to select multiples rooms that you are including in the view, and then click the Move (>) button to move the available rooms to the Selected list.

7. Optionally, click Spelling to spell check the view before you save it.

8. Click OK.

   The View dialog box closes. You return to the My Views window with the newly defined view automatically selected.
Chapter 11
Other Reservation Functions

EMS contains several miscellaneous standalone functions to assist you in managing and maintaining reservations and bookings in your system as well as managing your general work requirements.

This chapter covers the following topics:

- “Recording Actual Attendance Numbers for Bookings” on page 413.
- “Sending Email from EMS” on page 414.
- “Viewing a History of Sent Emails” on page 418.
- “Generating Multiple Confirmations” on page 420.
- “Managing Attendees and Visitors” on page 424.
Chapter 11
Other Reservation Functions
Recording Actual Attendance Numbers for Bookings

You use the Attendance Entry tool to view and record the actual attendance for bookings. (The tool does not address reservation-level attendance.) The actual attendance numbers that you enter do not replace the setup count (i.e., the estimated attendance) that you entered prior to an event. Reports that provide attendance information typically provide both the estimated attendance and the actual attendance.

To record actual attendance numbers for bookings

1. On the EMS main menu, click Reservations > Other > Attendance Entry.

   The Attendance Entry window opens.

   *Figure 11-1: Attendance Entry window*

2. In the Date field, select a date for which you are recording the booking attendance.

   *The date must occur on or before the current day’s date.*

3. Optionally, specify a building and/or a booking status to filter the list of booking results.

4. For each booking as needed, scroll to the Actual Attendance column, double-click in the column to select the currently displayed value, and then enter the actual attendance number in the column.

5. Click Close.
Sending Email from EMS

Multiple email options exist within EMS to email confirmations or invoices to groups or miscellaneous information to your EMS users or groups. If your organization uses Microsoft Outlook, you can continue to use your respective email system within EMS to send confirmations and invoices or any other individual emails to EMS users or groups. To send bulk emails to groups within an EMS Browser window (basic/advanced, transactions, calendar, and so on), however, you must use something called SMTP email. If your organization does not use Microsoft Outlook, then SMTP email is used to send all email from EMS, including emails to EMS users or groups and confirmations and invoices. EMS also provides an emailing function that you can use to send generic emails, which are emails that are not “tied” to a confirmation, invoice, reminder, and so on) to any recipient of your choice.

To send any email, your user account must be configured with an email address. To send generic emails, your user email preferences must also be configured. Contact your EMS administrator if you need assistance with this. See your EMS administrator or internal IT staff for information on how to enable SMTP email.

To send an email from within an EMS Browser window

1. Select a search result entry, and then click Email to open a pre-addressed SMTP email to the group that is associated with the selected reservation.

   *Figure 11-2: SMTP email from an EMS Browser window*

2. Enter the necessary information in the From, Subject, Message and other fields.
3. Optionally, do one or both of the following:
   • To attach a file, click Attachments at the top of the window.
   • To format the body of the email message, use the options on the Formatting toolbar.

4. Click Send.

To send a confirmation or invoice
1. On the Confirmation dialog box or on the onscreen preview of a new or reprinted invoice, click Email.
   • For a confirmation, an Email window that displays the confirmation in the body opens. The From field is populated with the user address that is associated with your user account or, based on your user preferences, the email address of the department that is associated with your user account. You can select either address. (See “Setting User Preferences and Default Values” on page 403.) The To field is blank.
   • For an invoice, an Email window that contains the invoice as an attachment opens. The From field is populated with the user address that is associated with your user account or, based on your user preferences, the email address of the department that is associated with your user account, and you cannot change this value. (See “Setting User Preferences and Default Values” on page 403.) The To is populated with the email address for the associated group, but you change this value if needed.

Figure 11-3: SMTP email window for a confirmation
Chapter 11
Other Reservation Functions

2. Select the recipients for the email.

3. Optionally, do one or both of the following:
   - To format the body of the email message, use the options on the Formatting toolbar.
   - To attach a file, click Attachments at the top of the window.
     - The default format for the attached invoice is PDF. You can select a different format if needed. Other allowed formats are HTML, Microsoft Excel (.xls), Microsoft Word (.rtf), Picture (.tiff), and Text File (.txt).
     - If the emailed confirmation is to include the entire confirmation as an attachment, then you must also select a file format for the attached confirmation. The default value is Adobe (.pdf). Other allowed formats are HTML, Microsoft Excel (.xls), Microsoft Word (.rtf), Picture (.tiff), and Text File (.txt).
     - If the emailed confirmation includes one or more attachments, then the Confirmation Title is also used for the name for all attachments other than an .ics file. If the confirmation includes an .ics file, then the .ics file is always named Confirmation.ics.

4. Click Send.

For an invoice, the SMTP email window also has Header Message and Footer Message fields for including header and footer messages in the email body.

To include the entire confirmation as an attachment, or an .ics file in a confirmation, see “Specifying your Confirmation Settings” on page 308.
To send a generic email

1. On the EMS toolbar, click the Email icon.

   A generic email form opens. Depending on your preferences, the From field is automatically populated either with the email address that is specified for your user account, or the email address of the department that is associated with your user account. (See “Setting User Preferences and Default Values” on page 403.)

   Figure 11-4: Generic email form

2. Enter the necessary information in the To, Subject, Message, and other fields.
3. Optionally, do one or both of the following:
   • To attach a file, click Attachments at the top of the window.
   • To format the body of the email message, use the options on the Formatting toolbar.
4. Click Send.
Chapter 11
Other Reservation Functions

Viewing a History of Sent Emails

You can use the Email History function to review a list of all emails that have been sent from within your organization’s EMS system via SMTP (not via Microsoft Outlook), including confirmation emails, report emails (which includes invoices, reminders, queries, web requests, and group and contact information), and generic emails. You can also view the contents of sent emails and print sent emails.

To view a history of sent emails

1. On the EMS main menu, click Reservations > Other > Email History.
   The Emails window opens. Regardless of your preferences, the From field is automatically populated with the email address for your user account, but you can always change this value.

   Figure 11-5: Emails window

2. Enter the search criteria for the emails, and then click Display.

   Under Source, the Report option collectively refers to confirmations, invoices, reminders, queries, web requests, and group and contact information.

   All of the emails that meet the search criteria are displayed in the bottom pane of the Emails window.
3. Optionally, do one or more of the following:
   • To view an email, select the mail in the search results list, and then click View.
   • To print the complete results list, click Print > List.
   • To print the contents of one or more emails in the results list, select the mail, or
     CTRL-click to select multiple emails, and then click Print > Emails.
Chapter 11
Other Reservation Functions

Generating Multiple Confirmations

A confirmation is a document that details the critical information for a reservation—the date, the time, the location, the scheduled resources, and so on. Through the Navigator, you have the option of generating a single confirmation, either manually or automatically. (See Chapter 7, “Confirmations,” on page 307.) A miscellaneous reservation function is also available for manually generating multiple confirmations at the same time. When you generate multiple confirmations, all the confirmations are contained in a single file, but each confirmation begins at the top of a new page. All the confirmations are “sent” by the same office, all the confirmations use the same format (By Booking Date, By Date Added, or By Date Changed) and all the confirmations use the same print options (Confirmation Title, Header Message, and so on); however, each confirmation can contain unique information for the buildings, statuses, and/or categories that are detailed in the confirmation. Because multiple confirmations are for multiple recipients, you cannot mass email these confirmations. Instead, you can only print them, and then manually mail them. You can specify the settings for multiple confirmations “from scratch,” or you can copy an existing confirmation format, and edit it as needed.

To generate multiple confirmations

1. On the EMS menu bar, click Reservations > Other > Confirmations.

   The Confirmation dialog box opens. The Date Range tab is the active tab.

*Figure 11-6: Confirmation dialog box, Date Range tab*
2. Do one of the following:
   - Review the selections on this dialog box, and optionally, make any needed modifications.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date Range tab</strong></td>
<td><strong>Department</strong> The department name that appears at the top the printed confirmation. <strong>Starting Date Ending Date</strong> The range of dates for which you are generating the confirmations.</td>
</tr>
<tr>
<td><strong>Use Specific Times</strong></td>
<td>Available only if the Starting Date is the same as the Ending Date. If this option is selected, then two fields are displayed on the Date Range tab in which you must specify the time range. After you specify the time range, click Options &gt; Date/Time Filter, and then indicate how the confirmation is to be limited—by bookings that start within the time range, or by bookings that occur within the time range.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>The format/organization of the confirmation—By Booking Date, By Date Added, or By Date Changed.</td>
</tr>
<tr>
<td><strong>Buildings tab</strong></td>
<td>Select the specific buildings that are to be included in the confirmation.</td>
</tr>
<tr>
<td><strong>Categories tab</strong></td>
<td>Select the specific booking details that are to be included in the confirmation.</td>
</tr>
<tr>
<td><strong>Statuses tab</strong></td>
<td>Select the specific statuses that are to be included in the confirmation.</td>
</tr>
<tr>
<td><strong>Options tab</strong></td>
<td>Format settings for a printed confirmation.</td>
</tr>
<tr>
<td><strong>Confirmation Title</strong></td>
<td>Appears bold and centered at the top of the confirmation.</td>
</tr>
<tr>
<td><strong>Header Message</strong></td>
<td>Pre-configured blocks of text that appear in the header and footer of the printed confirmation.</td>
</tr>
<tr>
<td><strong>Footer Message</strong></td>
<td><strong>Note:</strong> Your EMS administrator configures these values. Contact your administrator if you need assistance with adding or editing a value.</td>
</tr>
<tr>
<td><strong>Paper Size</strong></td>
<td>The size of the paper on which the confirmation is printed. Values are Letter, Legal, and A4.</td>
</tr>
<tr>
<td><strong>Print Comments</strong></td>
<td>Include the comments for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print Reminders</strong></td>
<td>Include the reminders for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print Cancel Reasons</strong></td>
<td>Include the reasons for cancellation in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print User Defined Fields</strong></td>
<td>Include user-defined fields and their values in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print Room Phone</strong></td>
<td>Include the phone number for the room in which the event is being held in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print Room Notes</strong></td>
<td>Include any notes for the room in which the event is being held in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print Building Notes</strong></td>
<td>Include any notes about the building in the printed confirmation.</td>
</tr>
<tr>
<td><strong>Print Billing Reference Allocation</strong></td>
<td>Include the billing reference numbers for the event as well as the percentage of charges that is allocated to each number in the printed confirmation.</td>
</tr>
</tbody>
</table>
Chapter 11  
Other Reservation Functions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print PO Number Allocation</td>
<td>Include the PO numbers for the event as well as the percentage of charges that is allocated to each number in the printed confirmation.</td>
</tr>
<tr>
<td>Print Category Subtotals</td>
<td>Include the subtotal charges by category in the printed confirmation.</td>
</tr>
<tr>
<td>Print Room Type</td>
<td>Include the room type for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Print Item Selection Notes</td>
<td>Include the notes for each resource selection item for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Reserved Time</td>
<td>Do not show the reserved time for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Location</td>
<td>Do not show the location for the reservation in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Pricing</td>
<td>Do not show the reservation’s room charges or resource charges in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Logo</td>
<td>Do not show your organization’s logo in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Notes</td>
<td>Do not show notes for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Special Instructions</td>
<td>Do not show special instructions for any booking items in the printed confirmation.</td>
</tr>
<tr>
<td>Suppress Item Selections</td>
<td>Do not show any resource item selections in the printed confirmation.</td>
</tr>
<tr>
<td>Always Display Time Zone</td>
<td>Always show the time zone for the event in the printed confirmation.</td>
</tr>
<tr>
<td>Display Messages as HTML</td>
<td>If you have defined any HTML messages, then select this option to display the HTML version of these messages in the printed confirmation; otherwise, the message is displayed in plain text.</td>
</tr>
<tr>
<td>Limit Bookings to Those With Details in Selected Categories</td>
<td>Show only those bookings in the printed confirmation that contain details for the categories that are selected on the Categories tab.</td>
</tr>
</tbody>
</table>

If needed, you can always save, or memorize, these settings. See “Working with Memorized Reports” on page 323.

- On the Setup dropdown list, select a saved, or memorized, confirmation.

If you select a memorized confirmation, then the only changes that you can make are to the dates and/or times on the Date Range tab.
3. Do one or both of the following:
   
   • Click Print Preview to open an onscreen preview of the printed confirmation. A variety of options are available from this preview, including the options to export the confirmation to a .pdf and to print the confirmation.

   ![Print preview of multiple confirmations](image)

   To manually print the confirmations, edit the number of copies to print as needed in the Copies to Print field (the default value is 1), and then click Print.

   A Print dialog box opens in which you can specify information such as the printer to use, the page range, and so on. Click Print in this dialog box to manually print the confirmations.
Managing Attendees and Visitors

EMS provides standard functionality for managing registered attendees and visitors, which are attendees and visitors who have been added as an attendee type category to a booking. You can search for registered attendees and visitors, and you can check in and check out registered attendees and visitors. The optional Visitor Management module provides functionality for managing unregistered attendees and visitors. If your organization has purchased and installed this module, you can also check in unregistered visitors to an event, check out unregistered visitors from an event, print badges for all attendees and visitors (registered and unregistered), and import a list of attendees using the Add Booking Details Wizard in the Navigator.

To manage registered attendees and visitors

1. On the EMS menu bar, click Reservations > Other > Visitors.

   The Visitors window opens. By default, the Visitors tab is the active tab.

   Figure 11-8: Visitors window, Visitors tab
2. Specify one or more of the following for your search criteria:
   - Start Date/End Date—The default value is the current day’s date.
   - Building—Select (all) buildings, a specific building, an area, or a view to search.
   - Show Cancelled—Select this option to search for registered attendees or visitors for canceled events.
   - Group—To search for registered attendees or visitors regardless of group, leave this field blank; otherwise, to search based on a specific group, enter a search string in the field.
   - Visitor—To search for a specific attendee or visitor, enter a search string in the field.

   For both search fields, your search is limited to the exact order of the characters in the string, but the string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of aca returns Academic Affairs Office, Department of Academic Affairs, and so on.

   - Include Checked In—Selected by default. Clear this option to search only for registered attendees and/or visitors who have not yet been checked in to their events.

3. Click Display.
   The list of registered attendees and/or visitors who meet the search criteria are displayed in the bottom pane of the Visitors window.

4. Optionally, do one or more of the following:
   - Select an attendee or visitor from the search results, and then click open to open the reservation in the Navigator that contains the booking that the attendee/visitor is attending.
   - Select an attendee or visitor from the search results, or CTRL-click to select multiple attendees/visitors, and then click Check In to “check in” the attendees/visitors to the event. A date and timestamp is added to each attendee’s/visitor’s record.
   - Select an attendee or visitor from the search results, or CTRL-click to select multiple attendees/visitors, and then click Check Out to “check out” the attendees/visitors from the event. A date and timestamp is added to each attendee’s/visitor’s record.

   Check Out is available only if the selected attendees/visitors have been checked into the event.
• Select an attendee or visitor from the search results, or CTRL-click to select multiple attendees/visitors, and then on the Tools menu, click Undo Check In to reverse the Checked In status for the attendees/visitors. (The Check In date and timestamp is removed from each attendee’s/visitor’s record and if needed, you can check in the attendees/visitors again). Conversely, if an attendee or visitor has been checked out, click Undo Check Out to reverse the Checked Out status for the attendee/visitor.

• On the Tools menu, click Export to export the list of attendees/visitors to a Microsoft Excel spreadsheet.

• On the Tools menu, or from the Visitors window, click Print to generate an onscreen preview of the list of attendees/visitors. A variety of options are available from this preview, including the options to email the list, to export the list to a .pdf, and so on.

*Figure 11-9: Onscreen preview of a registered attendee/visitor list*
To check in/check out unregistered visitors for an event

1. On the EMS menu bar, click Reservations > Other > Visitors.
   The Visitors window opens.

2. Open the Groups tab.

   *Figure 11-10: Visitors window, Groups tab*

3. Specify one or more of the following for your search criteria:
   - Start Date/End Date—The default value is the current day’s date.
   - Building—Select (all) buildings, a specific building, an area, or a view to search.
   - Group—Enter some or all of the hosting group’s name.

   Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of *aca* returns *Academic Affairs Office, Department of Academic Affairs*, and so on.

4. Click Display.
   The groups that meet your search criteria are displayed in the middle pane of the Visitors window.
5. Select the hosting group from the search results, and then click New Visitor.

The New Visitor dialog box opens.

*Figure 11-11: New Visitor dialog box*

6. Enter the information for the unregistered visitor, and then click OK.

The Visitor dialog box closes. You return to the Visitors window with the group and newly configured visitor automatically selected.

---

**Building and Name are required fields.** Depending on how your EMS administrator configured your system, Company Name, Email Address and/or Phone might be required. Notes are always optional. If you selected a specific building in Step 3, then the Building field is automatically populated with the name of the building in which the event is scheduled and you cannot edit this value; however, if you have set your preferences for buildings such that this building is not available to you, then the Building field cannot be populated with the correct value, and you cannot add the new visitor. See “Setting User Preferences and Default Values” on page 403.

7. Repeat Step 5 and Step 6 as needed to add all the unregistered visitors to the event.

The information that is displayed in the Event column for each unregistered visitor that is added to an event is determined by the settings that your EMS administrator specified when configuring the event building. For example, “Unregistered Visitor” might be displayed. The date and time that you add an unregistered visitor to an event is used as the Check In date and time for the visitor.
8. Optionally, before you check out or check in an unregistered visitor, do one or more of the following:
   - Select the unregistered visitor in the lower pane of the Visitors window, and then click Open to open the reservation in the Navigator that contains the booking that the unregistered visitor is attending.
   - On the Tools menu, click Export to export the list of registered attendees/visitors and unregistered visitors to a Microsoft Excel spreadsheet.
   - On the Tools menu, or from the Visitors window, click Print to generate an onscreen preview of the list of registered attendees/visitors and unregistered visitors. A variety of options are available from this preview, including the options to email the list, to export the list to a .pdf, and to list the confirmation.

   Figure 11-12: Onscreen preview of a registered and unregistered attendee/visitor list

9. To check out/check in an unregistered visitor, do one of the following:
   - Select the unregistered attendee/visitor, or CTRL-click to select multiple unregistered attendees/visitors, and then click Check Out to “check out” the attendees/visitors from the event. A date and timestamp is added to the unregistered visitors’ records.
   - Select the unregistered attendee/visitor, or CTRL-click to select multiple unregistered attendees/visitors, and then on the Tools menu, click Undo Check In to reverse the Checked In status for the unregistered attendees/visitors. (The Check In date and timestamp is removed from the unregistered visitors’ records and if needed, you can check in the unregistered visitors again). Conversely, if an unregistered visitor has been checked out, click Undo Check Out to reverse the Checked Out status for the attendee/visitor.
To print visitor badges

1. On the EMS menu bar, click Reservations > Other > Visitors.
   The Visitors window opens.
2. Do one or both of the following:
   • Locate and select the attendee as described in “To manage registered attendees and visitors” on page 424.
   • Create and select the attendee record as described in “To check in/check out unregistered visitors for an event” on page 427.
3. Click Print Badge.

To import a list of attendees and visitors to an event

1. Create a tab-delimited file that contains the information (in the order listed) for the attendees/visitors that are being imported.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Required/Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Text. 50 characters maximum.</td>
<td>Required</td>
</tr>
<tr>
<td>Company Name</td>
<td>Text. 50 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Email Address</td>
<td>Text. 255 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Phone</td>
<td>Text. 50 characters maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Notes</td>
<td>Text. No maximum.</td>
<td>Optional</td>
</tr>
<tr>
<td>Visitor</td>
<td>True/False</td>
<td></td>
</tr>
</tbody>
</table>

Each attendee/visitor must be a separate line entry. You use the Add Booking Details Wizard to import this file. You can click Print Format on the second page of the Add Booking Details Wizard to see the required format for the tab-delimited file.

2. Open the reservation for the event in the Navigator. See:
   • “Opening a reservation directly in the Navigator” on page 79.
   • “Opening a reservation through the Reservation Book” on page 80.
   • “Opening a reservation through a group” on page 80.
   • Chapter 4, “Search Tools,” on page 195.
3. In the left pane of the Navigator, select the reservation for which you are importing the list of attendees/visitors.
4. In the Bookings pane, click Tools, and then Click Add Booking Details Wizard.
   The Add Booking Details wizard opens.

*Figure 11-13: Add Booking Details wizard*

5. Select Visitors or Attendees, and then click Next.
   The second page of the Add Booking Details Wizard opens with a blank row for adding an attendee/visitor to the event.

*Figure 11-14: Add Booking Details Wizard, Second page*
Chapter 11
Other Reservation Functions

6. Click Import.

The Open File dialog box opens.

7. Browse to and select the attendee/visitor import file, and then click Open to import the file.

The Add Booking Details Wizard is updated with the imported attendee/visitor information. Each imported attendee/visitor is a separate line entry in the Wizard.

*Optionally, you can click Print Format to see the required format for the tab-delimited file.*

*Figure 11-15: Add Booking Details wizard, Attendees/Visitors imported*
8. Click Next.

The Select Bookings window opens. This window displays all the bookings for the selected reservation with a date greater than or equal to the current day’s date, and that do not already have the selected booking detail added.

9. CTRL-click to select the bookings to which the details are being added, or click Select All to select all the displayed bookings in a single step, and then click Finish.

A message opens asking you if you want to add more booking details.

10. Click No.

A message opens indicating that the changes were made successfully.

11. Click OK to close the message and return to the Navigator.

The booking detail (Attendees/Visitors) and its items (individual attendees/visitors) are displayed as folders under the appropriate booking folders in the Navigator.

To show canceled bookings, clear Hide Cancelled Bookings. Conversely, to hide canceled bookings, select Hide Cancelled Bookings. To show all bookings regardless of date, clear Hide Old Bookings.
Chapter 11
Other Reservation Functions
Chapter 12
EMS Workplace

Organizations with a mobile workforce or flexible work arrangements often adopt a hoteling or hot-desking strategy—allotting workspace on an as-needed basis to accommodate more people in less space. EMS Workplace is a facility scheduling system for managing hoteling requirements, as well as the booking of meeting/event space and resources.

This chapter covers the following topics:

• “Managing Groups’ Check In/Check Out Statuses” on page 437.
Managing Groups’ Check In/Check Out Statuses

Employees (referred to as “groups” in this section) can check in using a variety of active and passive EMS Workplace methods including Virtual EMS (VEMS), the EMS Kiosk, and your security badge system. You use the Group Check In Status tool to view the status of all employees, with or without bookings, who have checked into your building. In addition, options are available to check in/check out an individual and to manually “no show” employees who either have not checked in or have checked into another building.

To manage groups’ check in/check out statuses

1. On the EMS Workplace menu bar, click Reservations > Hoteling > Check In Status.

   The Group Check In Status window opens. If this is the first time that you have opened this window, then go to Step 2 to set the default values for your building and home city; otherwise, go to Step 3.

   Figure 12-1: Group Check In Status window
2. In the upper right hand corner of the window, click Options to open the Options dialog box and specify the default values for your home building and home cities.

*Figure 12-2: Options dialog box*

The home building is the building that selected groups are checked in to. You must separate multiple cities by commas, for example, Denver, Chicago, Atlanta. If Visitors Only is checked as one of the search options, then when you search for groups to verify their check in/check out status, the groups that have an address using any of these home cities are not returned in the search results. Only groups that do not have an address using any of these home cities and that meet all the search criteria are returned in the search results.

3. Specify the search criteria to search for the groups that you are checking into or checking out of a building.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building</td>
<td>The default value is (all), but you can select a specific building, an area, or a view.</td>
</tr>
<tr>
<td>Group Type</td>
<td>The default value is (all), but you can select a specific group type.</td>
</tr>
<tr>
<td>Event Type</td>
<td>The default value is (all), but you can select a specific event type.</td>
</tr>
<tr>
<td>Floor</td>
<td>The default value is (all), but you can select a specific floor.</td>
</tr>
<tr>
<td>Room Type</td>
<td>The default value is (all), but you can select a specific room type.</td>
</tr>
<tr>
<td>Visitors Only</td>
<td>Select this option only if you are searching for groups that do not have an address using any of the home cities that you have defined.</td>
</tr>
<tr>
<td>Not Checked In Only</td>
<td>Select this option to search only for groups that have not been checked into the building.</td>
</tr>
<tr>
<td>Multiple Bookings Only</td>
<td>Select this option to search only for those groups that have multiple bookings on the selected date.</td>
</tr>
<tr>
<td>Find Name</td>
<td>Optional field. Enter a search string by which to filter your search. The search is not case-sensitive, but the search is limited to the exact order of characters in the string and the string must begin with the information for which you are searching. For example, a search string of Ed returns Ed, Edward, Eddie, and so on, but not Ted or Fred.</td>
</tr>
<tr>
<td>Date</td>
<td>The default value is the current day’s date, but you can select a different value.</td>
</tr>
</tbody>
</table>
4. Click Display.

All the groups that meet all the search criteria and that have a booking or bookings on the selected date are displayed on the With Bookings tab.

Figure 12-3: Group Check In Status window with results

5. Optionally, do one or more of the following:

- To view all the bookings that a group has scheduled in the selected building, select the group on the With Bookings tab. The bookings are displayed on the <Building> Bookings tab in the bottom pane of the Group Check In Status window.

Figure 12-4: Viewing bookings for a selected group
• To check in a group, select the group, and then click Check In. “Checked In” is displayed in the Status column for the group on the With Bookings tab, the Date/Time column are updated with the date and time that you clicked Check In, and “Client” is displayed in the Source column.

Remember, the group is checked in to the building that you set as your Home building, and the name of this building is displayed in the Building column.

• To check out a group, select the group, and then click Check Out. “Checked Out” is displayed in the Status column for the group on the With Bookings tab, the Date/Time column are updated with the date and time that you clicked Check Out, and “Client” is displayed in the Source column.

If your EMS client is integrated with VEMS or EMS Kiosk, then employees can be checked in/checked out through either of these applications as well, and the Source column indicates this accordingly.

• To end a booking for a group, select the group, and then select the booking on the on the <Building> Bookings tab and click End Now. Answer “Yes” at the prompt about ending the booking immediately.

• To open an event in the Navigator, select the event entry on the <Building> Bookings tab, and then click Go To.

• To manually “no show” a group of employees, continue to “To run the No Show Wizard” on page 441.
To run the No Show Wizard

You use the No Show Wizard to email all groups that have not checked in to a specific building. It also provides options for changing the status of a group’s bookings so that the group’s workspace is released.

When you run the No Show Wizard from the Group Check In Status window, you must manually create and send the email, and you must manually change the status. Both of these processes can be automated by creating a No Show Notification rule. Contact your EMS administrator for assistance.

1. Select the group on the With Bookings tab, and then click No Show.

The No Show Wizard opens.

Figure 12-5: No Show Wizard

2. Do one or both of the following:
   - To send an email to the group, select Send Email to open an email form. Complete and send the email as normally would, and then click Finish.

   You can include variables in the subject line as described in the Legend. For example, %2% is the code for the group name, so “Notification for %2%” would result in “Notification for Academic Affairs” being displayed in the subject line.

   - To change the status for the group’s booking, select Change Status, and then on the Status dropdown list, select a new status, and then click Finish.
Chapter 13
Academic Planning (EMS Campus)

Academic Planning is an optional component of the EMS software that provides all the functionality that is necessary for Domain Schedulers to ensure that every class meets in a location and at a time that is acceptable to departments and instructors. The system provides automatic room assignment within user-supplied parameters, integration with your SIS/ERP software, and efficient online collaboration tools. It also simplifies final exam scheduling and offers a selection of reports to streamline and analyze the room scheduling process. When added to the functionality that meeting and event staff already have access to, it provides a complete campus-wide space management package referred to as EMS Campus.

This chapter covers the following topics:

- “Importing an Academic Term” on page 449.
- “Defining and Editing Courses” on page 455.
- “Specifying Room Preferences” on page 485.
- “Assigning Room Preferences and Optimizing” on page 503.
- “Publishing a Term” on page 529.
- “Post-Publishing Phase” on page 541.
- “Using the Academic Tools” on page 577.
- “Generating Academic Reports” on page 601.
Overview of the Academic Scheduling Process

The academic scheduling process is a multi-step process for enabling online communication between the Domain Scheduler and academic units, optimizing academic space use, and creating reservations in EMS Campus for academic courses. To use the full functionality of EMS Campus, it is important that you understand the academic scheduling specific terms that are used in EMS Campus and that you have a high-level understanding of the academic scheduling configuration process.

Academic scheduling specific terms used in EMS Campus

While meeting/event scheduling and academic scheduling have many features in common, EMS Campus uses terms that are specific to the academic scheduling configuration process.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIS</td>
<td>Generic acronym that is used in EMS Campus to represent a Student Information System. A system parameter controls the term “SIS,” and typically, your EMS administrator changes it to the system-specific term that your organization uses, for example, PeopleSoft, Banner, Colleague, and so on.</td>
</tr>
<tr>
<td>Academic Term</td>
<td>Defines a set of courses that is taught for a specific time period and is synchronized from the SIS.</td>
</tr>
<tr>
<td>Instructors</td>
<td>Instructors are imported from your SIS. Instructors determine who is teaching a course. They are also referred to as a “contact” after publishing.</td>
</tr>
<tr>
<td>Subject</td>
<td>Subjects are imported from your SIS. Subjects describe the topic of the course offered, for example, Math or English. Subjects are assigned to domains and academic units to designate who manages the courses that are taught within a subject.</td>
</tr>
<tr>
<td>Course Type</td>
<td>A course type is imported from your SIS. Course types categorize offerings, for example, a lecture or a lab. Course types are used for limiting the types of rooms in which a course can be taught and for reporting.</td>
</tr>
<tr>
<td>Domain</td>
<td>A level of organization within the institution that defines scheduling responsibility. The subjects defined within a domain determine the courses that are listed for the domain. The rooms that are defined within a domain determine all spaces that are potentially available for the courses. Functions such as synchronizing, optimizing, and running reports are carried out on a per domain basis. (A user who has this type of access is referred to as a Domain Scheduler.) The term “domain” is controlled by a parameter, and in many cases it is changed to “Campus” or “School” to better describe how course scheduling is divided.</td>
</tr>
</tbody>
</table>
### Academic Unit

A level of organization within the institution that defines responsibility for making schedule requests for a portion of a domain. The rooms that are defined within an academic unit give the unit the ability to require these spaces during optimization. The subjects that are defined within an academic unit determine the courses that are listed when filtering by the unit. Academic units are used when assigning permissions to Academic users and when filtering reports. The term “academic unit” is controlled by a parameter, and in many cases it is changed to “Department” or “Division” to better describe how course scheduling requests are divided.

### Campus Planning Interface

The web-based interface that is typically used by academic units to review course schedule data and communicate changes to the domain scheduler. Any computer with a standard Internet browser can be used to access the Campus Planning Interface.

### Course

Equivalent to a section in the SIS. The high level descriptor of a class, such as “CHEM 101 - Introduction to Chemistry,” and other associated information such as instructor and estimated enrollment. After a course is published, it becomes the reservation-level information.

### Course Date

A unique meeting pattern that is associated with a course, such as Tuesday/Thursday, 8:00 am to 9:20 am. Courses can have multiple course dates, such as when a class has both a lecture and a lab component that meet on different days of the week and at different times. After a course date is published, it becomes the booking-level information.

### Cross-listed Courses

Courses are designated in the SIS as cross-listed for a variety of reasons; however, after such a designation is made, there are implications in how EMS handles the courses. If two or more courses are cross-listed and have identical course date records (meeting patterns), then these two courses are linked and they are assigned the same room during optimization and final exam scheduling. They, in essence, share space by default.

### Shared Space

If two courses that have identical course date records are to be scheduled in the same room at the same time, but they are not cross-listed in the SIS, then they can be designated as Shared Space in EMS. This designation links the courses so that they are assigned to the same room during optimization and final exam scheduling. This designation does not affect the SIS.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Academic Unit</td>
<td>A level of organization within the institution that defines responsibility for making schedule requests for a portion of a domain. The rooms that are defined within an academic unit give the unit the ability to require these spaces during optimization. The subjects that are defined within an academic unit determine the courses that are listed when filtering by the unit. Academic units are used when assigning permissions to Academic users and when filtering reports. The term “academic unit” is controlled by a parameter, and in many cases it is changed to “Department” or “Division” to better describe how course scheduling requests are divided.</td>
</tr>
<tr>
<td>Campus Planning Interface</td>
<td>The web-based interface that is typically used by academic units to review course schedule data and communicate changes to the domain scheduler. Any computer with a standard Internet browser can be used to access the Campus Planning Interface.</td>
</tr>
<tr>
<td>Course</td>
<td>Equivalent to a section in the SIS. The high level descriptor of a class, such as “CHEM 101 - Introduction to Chemistry,” and other associated information such as instructor and estimated enrollment. After a course is published, it becomes the reservation-level information.</td>
</tr>
<tr>
<td>Course Date</td>
<td>A unique meeting pattern that is associated with a course, such as Tuesday/Thursday, 8:00 am to 9:20 am. Courses can have multiple course dates, such as when a class has both a lecture and a lab component that meet on different days of the week and at different times. After a course date is published, it becomes the booking-level information.</td>
</tr>
<tr>
<td>Cross-listed Courses</td>
<td>Courses are designated in the SIS as cross-listed for a variety of reasons; however, after such a designation is made, there are implications in how EMS handles the courses. If two or more courses are cross-listed and have identical course date records (meeting patterns), then these two courses are linked and they are assigned the same room during optimization and final exam scheduling. They, in essence, share space by default.</td>
</tr>
<tr>
<td>Shared Space</td>
<td>If two courses that have identical course date records are to be scheduled in the same room at the same time, but they are not cross-listed in the SIS, then they can be designated as Shared Space in EMS. This designation links the courses so that they are assigned to the same room during optimization and final exam scheduling. This designation does not affect the SIS.</td>
</tr>
</tbody>
</table>
Academic scheduling configuration process

Before academic scheduling can even be carried out, the following must be in place in your EMS database:

- Core data—building, rooms, instructors, course types, and subjects—must be synchronized with the Student Information System (SIS).
- Academic domains and academic units must be configured.
- Academic users must be configured with the appropriate security settings.
- Default values for academic parameters must be set.

Although the academic scheduling configuration process varies from one academic site to another, typically, the same two-phase process, the Academic Planning phase and the Post-Publishing phase, is carried out, and each process typically has the same high-level steps.

Academic Planning phase

The Academic Planning Phase is the first phase carried out in the academic scheduling process. This phase typically has the following high-level steps:

1. Importing an Academic Term. See “Importing an Academic Term” on page 449.
2. Defining and Editing Courses. See “Defining and Editing Courses” on page 455.
3. Settings Preferences. See “Specifying Room Preferences” on page 485.
4. Assigning rooms and optimizing. See “Assigning Room Preferences and Optimizing” on page 503.
5. Publishing terms in EMS. See “Publishing a Term” on page 529.

Post-Publishing phase

The Post-Publishing Phase is the second phase carried out in the academic scheduling process. This phase typically has the following high-level steps:

1. Reviewing reservations and resolving room assignments. See “Post-Publishing Phase” on page 541.
2. Creating a synchronization schedule. See “Post-Publishing Phase” on page 541.
3. Creating and publishing a final exam session. See “Post-Publishing Phase” on page 541.
Chapter 13
Academic Planning (EMS Campus)
Importing an Academic Term

Section Contents

• Overview of Importing an Academic Term on page 451
• Synchronizing an Academic Term on page 452
• Synchronizing Courses on page 453
Chapter 13
Academic Planning (EMS Campus)
Overview of Importing an Academic Term

The first step in the academic planning phase is to import a term. Importing an academic term consists of the following three steps:

1. A new term is created in the Student Information System (SIS), either by rolling forward a previous term, or by creating it from scratch. The term is then synchronized into EMS. See “Synchronizing an Academic Term” on page 452.

2. The Domain Scheduler synchronizes course data from the SIS into EMS Campus. See “Synchronizing Courses” on page 453.

3. Synchronized courses are reviewed before the term is made available to academic units. See “Using the Academic Tools” on page 577.
Synchronizing an Academic Term

When you synchronize your Student Information System (SIS) term data, all the SIS terms are flagged with a status of New. To create these terms in your EMS database, you select each term, click Create, and then Process.

To synchronize an academic term

1. On the EMS Campus menu bar, click Academic Planning > Configuration > Synchronize Terms.

   The EMS Campus Terms window opens.

   *Figure 13-1: EMS Campus Terms window*

2. Select the SIS term, or CTRL-click to select the multiple SIS terms that you are creating in your EMS database, click Create, and then click Process.

   A message opens indicating that the terms were successfully processed.

   *If you do not want to create an SIS term in your EMS database, select the term, and then click Do Not Import.*

3. Click OK to close the message and return to the EMS Campus Terms window.

   The status of the terms is set to Synchronized to indicate that the SIS data has been synchronized.

4. Click Cancel or Close (x) to close the window.
Synchronizing Courses

After you synchronize terms, the term record that is created in EMS is initially empty. You must then synchronize the courses.

To synchronize courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms. The Terms window opens.

Figure 13-2: Terms window

2. On the Domain dropdown list, select the domain for which you are synchronizing the term.

3. Select the term for which you are synchronizing the courses, and then click Sync. Two results are possible:

   • If the term contains edited courses, then a message that states the following opens: WARNING: You have made changes to 'n' Course(s) in “Define & Edit Mode” that will be overwritten. Is it OK to continue. You must click Yes to continue and then a Synchronizing Courses dialog box opens that shows the progress of the course synchronization. When the courses are synchronized, a dialog box opens with the message that the courses were synchronized.

   • If the term does not contain edited courses, then a Synchronizing Courses dialog box
opens that shows the progress of the course synchronization. When the courses are synchronized, a dialog box opens with the message that the courses were synchronized.

4. Click OK to close the message and return to the Terms window.

---

*After you synchronize the courses, you can review them in the Academic Browser.*

See “Searching with the Academic Browser” on page 579.
Defining and Editing Courses

Section Contents

• Overview of Defining and Editing Courses on page 457
• Enabling/Disabling a Term for Define & Edit Mode on page 458
• Reviewing and Editing Courses on page 461
• Working with Shared Space on page 475
Chapter 13
Academic Planning (EMS Campus)
Overview of Defining and Editing Courses

After the Domain Scheduler has imported a term and synchronized the courses for the term, he/she has the option of selecting the mode for the term. Each mode is optional, but each mode provides mode-specific functionality so that the mode can be carried out. Organizations use the Define & Edit mode to solicit information about new, changed, or canceled courses, or course dates for a term. Additionally, courses that share space can be indicated. After the academic units enter this information, the Domain Scheduler can run reports and based on the information in the reports, make the selected modifications in the SIS.


2. Academic units review the course schedule data, make change requests as appropriate for new, edited, and/or canceled courses, and mark those courses that share space. See “Reviewing and Editing Courses” on page 461 and “Working with Shared Space” on page 475.

3. The Domain Scheduler generates and reviews the Course Change report, enters the needed modifications into the SIS, and resynchronizes the courses. See “Synchronizing Courses” on page 453.

4. The Domain Scheduler reviews and/or indicates the shared space settings. See “Working with Shared Space” on page 475.

---

When you are defining and editing courses, you have the option of selecting Define and Edit mode, or Dual mode. Dual mode enables a term for both Define & Edit Mode and Set Preference mode at the same time. If you select Define and Edit mode, then the steps that you carry out during this mode are distinct and unique from the steps that you carry out in the next mode, which is the Set Preferences mode. Although these two modes are presented as distinct modes and discussed in two separate sections in this manual, if you select Dual mode, then the steps listed in both these sections are applicable at the same time.
Enabling/Disabling a Term for Define & Edit Mode

After you have imported a term and synchronized the courses for the term, you can set the mode to Define & Edit and make the term available to the academic units.

To enable/disable a term for Define & Edit mode

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms. The Terms window opens.

2. On the Domain dropdown list, select the appropriate domain.
3. Select the term for which you are setting Define & Edit mode, and then click Edit. The Term dialog box opens. The Term tab is the active tab.

*Figure 13-4: Term dialog box*

4. Optionally, in the Phase and Notes fields, enter information that indicates to the academic units what part of the academic scheduling process is currently taking place, for example, “Course Review,” or “Planning” along with any supporting information or instructions.

   *If you are going to select Dual mode, then make sure to note that both course review/planning and setting preferences are currently taking place. Academic units can view this information in the Campus Planning Interface.*

5. Do one of the following:
   - If academic unit-level users are to have access to the term, select Available to Academic Units.
   - To remove the users’ access to the term, clear Available to Academic Units.

6. Optionally, if you have configured time block templates, select the appropriate template for this term.

   *At this stage, the only active scenario that is available is SIS, and you cannot change this value.*
7. Select the enrollment that is to be compared to room capacity throughout the academic planning process.

8. In the Mode section, do one of the following:
   • To enable Define & Edit mode, select Define & Edit Courses.
   • To disable Define & Edit mode, select Read Only or Set Preferences.
   • To enable both Define & Edit mode and Set Preferences mode, select Dual.

9. Click OK to close the Term dialog box and return to the Terms window, with the term still selected in the window.

10. On the Terms window, click Email to open an email that is pre-addressed to all academic unit-level users that have been defined in your EMS database. Complete and send the email as you normally would.

Figure 13-5: SMTP Email window
Reviewing and Editing Courses

After a term has been made available to the academic units, the academic units can begin reviewing their courses and requesting additions, deletions, and modifications as appropriate using the Campus Planning Interface (typical) or the EMS Campus desktop client (if granted access).

To review and edit courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.
   The Academic Browser opens.
2. If needed, open the Filter tab.
   Figure 13-6: Academic Browser, Filter tab

3. Make sure that the Browse For option is set to Courses.
4. On the Domain dropdown list, select the appropriate domain and then on the Term dropdown list, select the appropriate term.
5. Continue to one of the following:
   - “To add a new course in EMS Campus” below.
   - “To add a new section for a course” on page 464.
   - “To add a course date in EMS Campus” on page 465.
   - “To edit a course in EMS Campus” on page 467.
   - “To edit a course date in EMS Campus” on page 469.
   - “To cancel a course date in EMS Campus” on page 471.
   - “To cancel a course in EMS Campus” on page 473.

To add a new course in EMS Campus

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating an existing course, and then click Get Data.
   The courses that meet your search criteria are displayed on the Results tab.

   *For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.*

2. Click New Course.
   The New Course dialog box opens. The Course tab is the active tab.

   *Figure 13-7: New Course dialog box*

3. Complete the required information—title, course number, section, subject, instructor, estimated enrollment, credit hours, course type—on the Course tab.
4. For each course meeting pattern (days and times) that you are adding to the new course, do the following:
   - In the Course Dates section, click New to open the Course Dates dialog box and on the Course Type dropdown list, select the course type.
   - Do one of the following:
     - Manually enter the meeting pattern information (start and end dates, start and end times, and meeting days) for the course.
     - Click Time Blocks to open the Time Blocks dialog box, and then select a time block from a list of time blocks that have been made available for the term.

5. Optionally, in the Notes field, enter any information about the course that might be relevant to the Domain Scheduler.

6. Open the User Defined Fields tab, and for any user-defined questions that are displayed on the tab, do the following:
   - Select the question, and then click Set Value to open a dialog box in which you can enter the answer to the question.
   - Click OK to close the dialog box and return to the User Defined Fields tab.

7. Click OK to close the New Course dialog box and return to the Academic Browser.

---

**Figure 13-8: Course Dates dialog box**

![Course Dates dialog box]

- Make sure to select Room Not Required if the course does not require a room, for example, an independent study class, a research class, and so on.

- Depending on how your EMS administrator has configured EMS Campus, only the Time Blocks option might be available to you.

- User-defined fields, or UDFs, are typically used by a Domain Scheduler to solicit additional user-supplied information about a course.
8. Click Refresh.

“New” is displayed for the course state.

If you have selected Dual mode for the term, then you can set preferences during this step as well. See “To use the Course Navigator to set preferences and requirements” on page 498.

To add a new section for a course

To add a new section of an existing course, you must copy an existing course, and then edit the section number and any other pertinent information.

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating an existing course, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

2. Select the course that is to be copied, and then click New Section.

   The New Section dialog box opens. The fields are automatically populated with the information for the copied course.

   Figure 13-9: New Section dialog box

3. Edit the section number and any other pertinent information as needed, and then click OK.

   Depending on how your EMS administrator has configured EMS Campus, only the Time Blocks option might be available to you.

   A message opens indicating that the course was created successfully.
4. Click OK to close the message and return to the Academic Browser.

If you have selected Dual mode for the term, then you can set preferences during this step as well. See “To use the Course Navigator to set preferences and requirements” on page 498.

To add a course date in EMS Campus

To add a new date to a course in EMS Campus, you must find the course using the Academic Browser, and then edit the course date and other pertinent information in the Course Navigator.

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the course, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

2. In the search results, double-click the course to which you are adding a course date.

   The course opens in the Course Navigator.

   For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

Figure 13-10: Course opened in the Course Navigator
3. Click New.

The New Course Dates dialog box opens.

*Figure 13-11: New Course Dates dialog box*

4. For *each* new course meeting pattern (days and times) that you are adding to the course, do the following:

   • On the New Course Dates dialog box, click New to open the Course Dates dialog box and on the Course Type dropdown list, select the course type.

   • Do one of the following:
     
     • Manually enter the meeting pattern information (start and end dates, start and end times, and meeting days) for the course.

     • Click Time Blocks to open the Time Blocks dialog box, and select a time block from a list of time blocks that have been made available for the term.

*Figure 13-12: Course Dates dialog box*

Make sure to select Room Not Required if the course does not require a room, for example, an independent study class, a research class, and so on.
5. Click OK to close the Course Dates dialog box, and then click OK to close the New Course Dates dialog box and return to the Course Navigator.

   The state for each newly added course date is set to “New” in the middle pane of the Course Navigator.

   Depending on how your EMS administrator has configured EMS Campus, only the Time Blocks option might be available to you.

   If you have selected Dual mode for the term, then you can set preferences during this step as well. See “To use the Course Navigator to set preferences and requirements” on page 498.

To edit a course in EMS Campus

To edit a course in EMS Campus, you must find the course using the Academic Browser, and then edit the course information in the Course Navigator.

1. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the course, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

2. In the search results, double-click the course that you are editing.

   The course opens in the Course Navigator. See Figure 13-13 on page 468.

   For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.
3. Click edit in the top pane of the Navigator.

The Course dialog box opens.

4. Edit the course information as needed, and then click OK to close the Course dialog box and return to the Course Navigator.

The course state is set to “Edited” in the top pane of the Course Navigator.
To edit a course date in EMS Campus

To edit a course date in EMS Campus, you must find the course using the Academic Browser, and then edit the course date in the Course Navigator.

1. Set any other criteria (academic unit, subject and so on) as needed to provide assistance in locating the course, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

2. In the search results, double-click the course for which you are editing the course date.

   The course opens in the Course Navigator.

For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

Figure 13-15: Course opened in the Course Navigator
3. In the *middle pane* of the Course Navigator, select the course date record that you are editing, and then click Edit.

The Course Dates - (SIS) dialog box opens.

*Figure 13-16: Course Dates - (SIS) dialog box*

4. Edit the course dates as needed.

   - To edit the course dates, do one of the following:
     - Manually edit the start/end dates, start/end times, course type, and/or the days that the course meets.
     - Click Time Blocks to open the Time Blocks dialog box, and select a time block from a list of time blocks that have been made available for the term.

     *Depending on how your EMS administrator has configured EMS Campus, only the Time Blocks option might be available to you. (You cannot manually edit the course days and times.)*

   - The room assigned to this course in the SIS is listed in the SIS Room text box. You cannot edit this value; however, make sure to select Room Not Required if this course date does not require a room (for example, independent study, research, and so on).
• The Seat Fill Percentage, in conjunction with the estimated enrollment, is used to determine the size of the room needed for the class. For example, a Seat Fill Percentage of 50% and an estimated enrollment of 100 means that the course should be held in a room that can accommodate 200 people.

The Seat Fill Percentage is initially set to the default value that is specified in EMS (Campus) system parameters, but you can update the value on a per course date basis. See System Parameters in the EMS Setup Guide.

• If you are editing a course date for a course that is cross-listed or sharing space with another course, you are provided with an option in the bottom pane of the Course Dates dialog box to apply your changes to the related course dates. To apply changes to the cross-listed courses, check the appropriate course date listings.

Figure 13-17: Applying changes to related course dates

5. Click OK to close the Course dialog box and return to the Course Navigator.

The course date state is set to “Edited” in the middle pane of the Course Navigator.

If you have selected Dual mode for the term, then you can set preferences during this step as well. See “To use the Course Navigator to set preferences and requirements” on page 498.

To cancel a course date in EMS Campus

To cancel a course date in EMS Campus, you must find the course using the Academic Browser, and then cancel the course date in the Course Navigator.

1. Set any other criteria (academic unit, subject and so on) as needed to provide assistance in locating the course, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.
2. In the search results, double-click the course for which you are canceling a course date. The course opens in the Course Navigator.

For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

**Figure 13-18: Course opened in the Course Navigator**

3. In the middle pane of the Course Navigator, select the course date record that you are canceling, and then in the top pane of the Navigator, click Cancel.

   A dialog box opens, asking you if it is OK to cancel the selected course.

4. Click Yes to close the dialog box and return to the Course Navigator.

   The course date state is set to “Cancelled” in the middle pane of the Course Navigator.

To reverse a course date cancellation, select the canceled course date in the Course Navigator, and then click Uncancel.
To cancel a course in EMS Campus

To cancel a course in EMS Campus, you must find the course using the Academic Browser, and then cancel the course in the Course Navigator.

1. Set any other criteria (academic unit, subject and so on) as needed to provide assistance in locating the course, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

2. In the search results, double-click the course that you are canceling.

   The course opens in the Course Navigator.

3. In the top pane of the Navigator, click Cancel.

   A dialog box opens, asking you if it is OK to cancel the selected course.

For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.
4. Click Yes to close the dialog box and return to the Course Navigator.

The course state is set to “Cancelled” in the top pane of the Course Navigator. The state for every course date that is displayed in the middle pane of the Course Navigator is also set to “Cancelled.”

---

To reverse a course cancellation, open the canceled course in the Course Navigator; and then in the top pane of the Course Navigator, click Uncancel.
Working with Shared Space

The *shared space* designation is used for two or more courses that are not cross-listed in the SIS, but that have matching patterns and are meant to be held in the same room. The shared space designation links the courses together for the set preferences, optimization, publishing, and final exam scheduling functions. Shared space is *assigned* in a parent-child relationship. If needed, you can *change* the parent designation. In addition, if a course that is cross-listed in the SIS is not meant to be held in the same room, or if courses that are marked as shared space are no longer meant to share space, then you can *reverse* the shared space designation. You can also *review* shared spaced designations.

Academic units that have the appropriate permissions can indicate shared space using the Campus Planning Interface. You might want to review these shared space settings before working with shared space.

To assign shared space to courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.
   
The Academic Browser opens.
2. If needed, open the Filter tab.
   
   ![Figure 13-20: Academic Browser, Filter tab](image)
   
   On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.
Chapter 13
Academic Planning (EMS Campus)

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses that are to share space, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

5. CTRL-click to select the courses that are to share space.

6. On the Tools menu, click Shares Space.

A message opens asking you if you are sure that the selected courses are to share space?

7. Click Yes.

The message closes and you return to the Academic Browser. The Shares Spaces designation is indicated in the browser. The parent item is indicated with *Parent, and the child item is indicated with the parent’s Course Number and Section Number.
To change the parent designation for shared space/cross-listed spaces

When you set the shared space designation for courses, EMS Campus arbitrarily specifies one of the courses as the parent course. The academic unit that controls the parent course is the unit that sets the preferences for the shared courses in the Set Preferences mode. If the academic unit that you want to set the preferences in the Set Preferences mode is not currently the parent course, then you can change the parent designation for the courses. Also, after you publish courses, you can change the room only for the parent course and the child course “just follows along.” If the course on which you want to base the room change is not currently the parent course, then you can change the parent designation for the courses.

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.
   The Academic Browser opens.

2. If needed, open the Filter tab.

   Figure 13-21: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the shared spaces courses, and then click Get Data.
   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.
5. CTRL-click to select the parent course and the child courses.

6. On the Tools menu, click Change Shared Space parent.

   The Shares Space Change Parent dialog box opens. This dialog box lists the parent class and all its child classes that share space.

   *Figure 13-22: Shares Space Change Parent dialog box*

   ![ Shares Space Change Parent dialog box ]

7. Select the course that is to be the new parent, and then click Set Parent.

   A Set Parent dialog box opens, indicating that the selected course will be set as the parent for all the listed courses, and asking you if it is OK to continue.

8. Click Yes.

   The Set Parent dialog box closes. You return to the Academic Browser with the new parent designation indicated in the browser.
To reverse the shared space designation

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.

   The Academic Browser opens.

2. If needed, open the Filter tab.

   Figure 13-23: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses that are to no longer share space, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

5. CTRL-click to select the courses that are to no longer share space.


   A message opens asking you if you are sure that the selected courses are to no longer share space.

7. Click Yes.

   The message closes. You return to the Academic Browser, with the Shared Space designation removed for the selected courses.

For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.
To review shared space designations

*Academic units might designate shared space that they can review in the Campus Planning Interface.*

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.

   The Academic Browser opens.

2. If needed, open the Filter tab.

   *Figure 13-24: Academic Browser, Filter tab*

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses that you are reviewing, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab. Use the information in the Shared Space column to identify and review the courses that share space. You can also click the column heading to sort by shared space. See *Figure 13-25 on page 481.*

   *For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.*
Figure 13-25: Academic Browser search results showing Shared Space designation
Identifying New/Edited/Canceled Courses

After the academic units have made their modifications to the course schedule, you must identify and compile a list of modifications and enter the approved changes in the Student Information System (SIS). EMS Campus flags course changes using a field named Course State. New, edited, and canceled courses are marked as “New,” “Edited,” and “Cancelled,” respectively. Typically, you generate the Course Changes report to view and identify the requested course changes; however, if further clarification is needed, then you can use the Academic Browser and/or Course Navigator.

For detailed information about generating the Course Changes report, and the information that is contained in the report, see “Generating Academic Reports” on page 601.

Prior to reviewing the modifications, you can remove access to the term from your academic units. See “Enabling/Disabling a Term for Define & Edit Mode” on page 458.

To identify new/edited/canceled courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.
   The Academic Browser opens.
2. If needed, open the Filter tab.

Figure 13-26: Academic Browser, Filter tab
3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses that you are reviewing, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab. Use the information in the State column to identify the change made to each course that is listed.

For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

Figure 13-27: Academic Browser search results with State column shown

5. Optionally, double-click a course to open the course in the Course Navigator and view more detailed information about the course. See “Using the Course Navigator” on page 594.

6. After generating the list of course modifications, you must manually enter the approved course changes in the SIS. After data entry is complete, the scheduler must carry out the Sync Courses process (see “Synchronizing Courses” on page 453) to ensure that EMS Campus and the SIS are synchronized.
Specifying Room Preferences

Section Contents

• Overview of Specifying Room Preferences on page 487
• Enabling/Disabling a Term for Set Preferences Mode on page 488
• Specifying Room Preferences/Requirements on page 491
• Reviewing and Verifying Room Preferences on page 501
Chapter 13
Academic Planning (EMS Campus)
Overview of Specifying Room Preferences

Set Preferences is an optional mode in which the Domain Scheduler can solicit preferences from academic units about the type of rooms that would be suitable for each course that they teach. These preferences can then be used to run an optimization, or to have EMS automate room scheduling based on preferences and additional user-specified criteria. To enable and use Set Preferences Mode, the following steps are carried out:

1. The Domain Scheduler enables Set Preferences mode. See “Enabling/Disabling a Term for Set Preferences Mode” on page 488.

2. The academic units review courses and specify their room preferences and requirements using the Campus Planning Interface (typical) or the EMS Campus desktop client (if granted access). See “Specifying Room Preferences/Requirements” on page 491.

3. The Domain Scheduler verifies and reviews the room preferences and requirements that the academic units have specified. See “Reviewing and Verifying Room Preferences” on page 501.
Enabling/Disabling a Term for Set Preferences Mode

To enter the academic units’ room preferences and requirements, you must enable Set Preferences mode. Additionally, if you want to solicit these preferences and requirements from the academic units, you must make the term available to the academic units. Likewise, after the deadline has been reached for expressing room preferences and requirements, you must make the term unavailable to the academic units.

To enable/disable a term for Set Preferences mode

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.
   
The Terms window opens.

2. On the Domain dropdown list, select the appropriate domain.
3. Select the term for which you are setting the Set Preferences mode, and then click Edit. The Term dialog box opens. The Term tab is the active tab.

   Remember, if you selected Dual mode, (see “Specifying Room Preferences” on page 485) then the Set Preferences mode has already been enabled for this term.

   Figure 13-29: Term dialog box

4. Optionally, in the Phase and Notes fields, enter information that indicates to the Domain Scheduler what part of the academic scheduling process is currently taking place, for example, “Enter Preferences,” or “Room Information” along with any supporting information or instructions.

   The Phase field and the Notes field are displayed in the Campus Planning Interface.

5. Do one of the following:
   • To give academic unit-level users access to the term, select Available to Academic Units.
   • To remove the users’ access to the term, clear Available to Academic Units

6. If you did not select Dual mode, then in the Mode section, select Set Preferences.

7. Click OK to close the Term dialog box and return to the Terms window, with the term still selected in the window.
8. On the Terms window, click Email to open an email that is pre-addressed to all academic unit-level users that have been defined in your EMS database. Complete and send the email as you normally would.

*Figure 13-30: SMTP Email window*
Chapter 13
Academic Planning (EMS Campus)

Specifying Room Preferences/Requirements

After you place the term in Set Preferences mode, three options that can be used in conjunction with each other are available for completing the preferences and requirements phase. In addition, you can complete the phase independently, or you can solicit input from the academic units.

- You can use the Manage Terms Copy Preferences tool to copy the preferences and requirements from a previous term. See “To use the Manage Terms Copy Preferences tool” on page 493.
- You can use the Academic Browser Set Course Preferences tool to set preferences and requirements for multiple courses in a single step. See “To use the Academic Browser Set Course Preferences tool” on page 495.
- You can use the Course Navigator to set preferences and requirements on a course by course basis. See “To use the Course Navigator to set preferences and requirements” on page 498.

For any of these methods, the following caveats apply:

- An academic unit-level user can request any building, area, or view and up to three rooms that have been defined for the domain with which it is associated.

- An academic unit can require only those buildings and rooms that have been assigned to its unit within the Academic Planning > Configuration > Academic Units area of EMS Campus. If the academic units specify requirements, then only a single room can be specified.
- Room types can be requested or required for all courses. By default the “limit by course type” selection is designated, but you can change it to honor a specific room type. Configuration of the Course Types/Room Types matches is carried out in the Academic Planning > Configuration > Match Course Types/Room Types area of EMS Campus. See the EMS Setup Guide for detailed information.
You can set features to Preferred or Required. The # of Rooms Available label that is displayed above the Features pane is dynamically updated based on the building, room type, and features selected.

The Seat Fill Percentage, in conjunction with the estimated enrollment, is used to determine the size of the room needed for the class. For example, a Seat Fill Percentage of 50% and an estimated enrollment of 100 means that the course should be held in a room that can accommodate 200 people.

The Seat Fill Percentage is initially set to the default value that is specified in EMS (Campus) system parameters, but you can update the value on a per course date basis. See System Parameters in the EMS Setup Guide.

Ignore Term Excluded Dates schedules bookings on all dates that adhere to the meeting pattern, regardless of the Excluded Dates that are marked on the term when the course dates are published.

Publish In SIS Room (No Optimization) allows the course dates to avoid the optimization process. Bookings are published in the room that was carried over from the SIS.

Require SIS Room flags buildings/rooms that come across from the SIS as Required. Courses with requirements still go through the optimization process.

Requires Different Room (For Courses That Share Space) identifies a meeting pattern that should be in its own room despite the cross-listed or shared space status. You can set preferences for this room.

Same Room (ALL Selected Course Dates are to be in the same Room) flags courses that should be in the same room but at different times when optimized.
To use the Manage Terms Copy Preferences tool

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

   The Terms window opens.

   *Figure 13-31: Terms window*

2. Click Copy Prefs.

   The Copy Preferences dialog box opens.

   *Figure 13-32: Copy Preferences dialog box*
3. In the Copy Preferences From pane, select the domain and term \textit{from} which you want to copy room preferences and requirements.

4. In the Copy Preferences To pane, do the following:
   • Select the domain and term \textit{to} which you want to copy your room preferences and requirements.
   
   \textit{A term can be displayed in the To pane only if it is in Set Preferences mode.}

   • Indicate if the preferences are to be copied only if the instructors match.

5. Click OK.

   A message opens, informing you that copying preferences will overwrite any existing preferences, and asking you if it is OK to continue.

6. Click Yes.

   The message closes. After the preferences are copied, you return to the Terms window.

\textit{Preferences are copied based on the Course Section (Math 101 01) and Course Type information (lecture or lab). If you have added new sections or changed course type designations on course dates within a section, then even after you complete this procedure, some courses still will not have preferences. Be sure to review your list of courses and set preferences where applicable.}
To use the Academic Browser Set Course Preferences tool

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.

   The Academic Browser opens.

2. If needed, open the Filter tab.

   Figure 13-33: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject and so on) as needed to provide assistance in locating the courses for which you want to set preferences and requirements, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

5. CTRL-click to select the courses for which you are setting the room preferences and requirements.
6. On the Tools menu, click Set Course Preferences. The Set Course Preferences dialog box opens.

Figure 13-34: Set Course Preferences dialog box

7. Indicate whether the preferences that you set are to override any existing preferences, or whether they are to be added to existing preferences.

8. Set your preferences for the selected courses. See “Specifying Room Preferences/Requirements” on page 491.

9. Optionally, do one or both of the following:
   - In the Notes field, enter any pertinent or supporting information that substantiates or explains your preferences.
   - By default, the preferences/requirements that you specify are applied to all course dates for all selected courses. If the preferences/requirements are applicable for only specific course dates, open the Selected Course Dates tab, select the course dates for which these preferences/requirements are not applicable and then click Remove.
10. Click OK.

Two results are possible:

- If any of the selected courses are cross-listed and/or share space, and you did not select the corresponding cross-listed/shared space courses, then a Related Course Dates dialog box opens. This dialog box lists all the related courses that have not been selected. Go to Step 11.

- If none of the selected courses are cross-listed and/or share space, then a message opens indicating whether the selected preferences will override any existing preferences, or be added to existing preferences and asking you if it is OK to continue. Go to Step 12.

Figure 13-35: Related Courses Dates

11. Optionally, select any or all of the related courses for which you want to set the same preferences/requirements, or do not select any of these related courses, and then click OK.

A message opens indicating whether the selected preferences will override any existing preferences, or be added to existing preferences and asking you if it is OK to continue.

12. Click Yes.

The message closes and another message opens indicating that the preferences were set successfully.

13. Click OK to close the second message and return to the Academic Browser.
To use the Course Navigator to set preferences and requirements

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.

   The Academic Browser opens.

2. If needed, open the Filter tab.

   Figure 13-36: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses for which you want to set preferences and requirements, and then click Get Data.

   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

5. In the search results, double-click the course for which you are setting the preferences/requirements.

   The course opens in the Course Navigator. See Figure 13-3 on page 458.

   For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.
6. In the middle pane of the Navigator, select the specific course date for which you are setting preferences/requirements, and then click Edit.

The Course Dates dialog box opens.

**Figure 13-38: Course Dates dialog box**
7. Set the preferences/requirements for the course as needed, and then click OK. See “Specifying Room Preferences/Requirements” on page 491.

The Course Dates dialog box closes and you return to the Course Navigator. The preferences/requirements that you set for the course date are displayed on the Preferences tab in the lower pane of the Navigator.
Reviewing and Verifying Room Preferences

After room preferences and requirements are set, you can review the individual course preferences, verify that the preferences are complete, and quantify these preferences. You can also run the Course Preferences report and the Course Preferences Summary report to assist in this task.

For detailed information about generating the Course Preferences and Course Preferences Summary reports and the information that is contained in each report, see “Generating Academic Reports” on page 601.

Prior to reviewing or reporting on preferences, you can make the term unavailable to the academic units. See “Enabling/Disabling a Term for Set Preferences Mode” on page 488.

To review and verify room preferences

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.

   The Academic Browser opens.

2. If needed, open the Filter tab.

   Figure 13-39: Academic Browser, Filter tab
3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses for which you want to review preferences and requirements, and then click Get Data.

The courses that meet your search criteria are displayed on the Results tab.

5. In the search results, double-click the course for which you are reviewing the preferences/requirements.

The course opens in the Course Navigator.

6. In the middle pane of the Course Navigator, select the course date for which you are reviewing the preferences.

The preferences for the selected course date are displayed in the bottom pane of the Course Navigator on the Preferences tab.

---

To identify preferences and requirements for a Basic search, you should set Preferences Exist to Yes. For an Advanced search, you should select the Preferences Exist field (a Course Dates level field), and set the Preferences Exist filter to Yes. For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

---

Figure 13-40: Course opened in the Course Navigator showing preferences
Assigning Room Preferences and Optimizing

Section Contents

• Overview of Room Assignments and Optimization on page 505
• About Creating Scenarios and Optimization on page 506
• Creating Scenarios on page 513
• Assigning Rooms on page 522
• Evaluating Optimization Scenarios on page 527
Overview of Room Assignments and Optimization

After the Domain Scheduler reviews and verifies the room preferences and requirements, room assignments must take place. If the room assignment process has already occurred outside of EMS within the SIS, the Domain Scheduler could simply publish the course schedule in EMS without any further effort. In most situations, however, courses will need to be assigned a room through the optimization process before the term can be published. To optimize the room assignments, and then assign rooms, the Domain Scheduler carries out the following steps either separately or in any combination as necessary to best suit their working needs:

1. Pre-assignment—The Domain Scheduler manually assigns a selection of courses to rooms. Typically, the manual assignment takes place if these rooms are to be excluded in an optimization scenario after pre-assignment. For instance, if only a swimming course should be assigned to “Pool,” then the Domain Scheduler could manually pre-assign Swimming and then exclude the pool in the optimization scenario. See “About Creating Scenarios and Optimization” on page 506 and “Creating Scenarios” on page 513.

2. Optimization—The EMS system automatically assigns rooms to courses based on course preferences, requirements, and weighted criteria. See “About Creating Scenarios and Optimization” on page 506 and “Creating Scenarios” on page 513.

3. Locking In Assignments—After carrying out an optimization scenario, the Domain Scheduler locks in desired room assignments, and then re-optimizes the remaining portion of the optimization scenario. See “Assigning Rooms” on page 522.

4. Evaluating Optimization Scenarios—The Domain Scheduler can test an unlimited number of potential scenarios and compare results using various tools before choosing the final scenario for publishing. See “Evaluating Optimization Scenarios” on page 527.

The information in this section is presented as an ordered series of standalone procedures; however, the Domain Scheduler can carry out any of the procedures either separately or in any combination as necessary to best suit his/her working needs. This allows the Domain Scheduler to test a number of potential scenarios and compare placement results using various tools before choosing the final scenario for publishing.
You create scenarios to test room assignments that have been given to courses for a term. In EMS, you can create two types of scenarios—a pre-assignment scenario and an optimization scenario. A pre-assignment scenario is a scenario in which a selection of courses are manually assigned to rooms, typically because the assigned rooms are to be excluded in an optimization scenario. In a pre-assignment scenario, the assignments are automatically considered “locked in.” An optimization scenario is a scenario in which EMS automatically assigns rooms to courses based on course preferences, requirements, and weighted criteria. The optimization process can support simultaneous optimization of all academic units, incremental optimization by academic unit, and/or a combination of pre-assignment and automated optimization.

In the optimization process, a ranking is assigned to each course in a term. Rooms are assigned one course at a time based on the order of these rankings (from the most important ranking of one to the least important ranking of “n”). Throughout the optimization process, the Optimizer considers room capacity (the course’s adjusted enrollment must fit within a room’s capacity), looks for the best seat fill (a room with a capacity* that most closely accommodates the estimated enrollment), and the best room utilization (completely filling one room before moving on to another room with equal attributes) to achieve the best room optimization possible. You use the options that are available on the Scenario dialog box to create optimization scenarios.

*The room's capacity based on the setup type that has been defined for the Default Setup Type parameter in the Campus area.
Scenario dialog box

The Scenario dialog box has three tabs—Scenario, Excluded Rooms, and Audit. You use the options on the Scenario tab and Excluded Rooms tab when you are creating, evaluating, and testing scenarios.

Figure 13-41: Scenario dialog box, Scenario tab

The following options are available on the Scenario tab of the Scenario dialog box for creating a scale of weighed criteria for a scenario:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td>Locks the room assignments for the selected Optimization scenario. You can clear this option to unlock the scenario and carry out optimization.</td>
</tr>
<tr>
<td>Back to Back Gap Minutes</td>
<td>Instructors are considered to be teaching Back to Back courses when their consecutive teaching assignments fall within the indicated time period. (The end time of one class and the start time of the next class fall within the indicated time period.) The default value is 15 minutes.</td>
</tr>
<tr>
<td>Boost Requirement Weights</td>
<td>Select this option to increase the weights of preferences that are marked as requirements to 150% of their assigned weights.</td>
</tr>
</tbody>
</table>
Chapter 13  
Academic Planning (EMS Campus)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Weights</td>
<td>All courses are assigned points in an optimization scenario based on factors and selected preferences. The sum total of these points determines the ranking for a course. Factors are always included in any optimization scenario; however, you can exclude the standard weight of a factor, which means that the factor does not contribute to the total number of points for a room assignment ranking for a course but it is still considered when searching for a room.</td>
</tr>
<tr>
<td></td>
<td>• Instructor Importance—Instructor Importance is assigned in the Academic Planning (Configuration &gt; Instructors) area of EMS Campus. The indicated weight is given to any course that is taught by an instructor who is marked as “High Importance.”</td>
</tr>
<tr>
<td></td>
<td>• Enrollment—Enrollment uses a combination of the assigned weight and the following EMS Campus system parameters to determine the courses that are assigned rooms first.</td>
</tr>
<tr>
<td></td>
<td>• Small Class Size (if less than xx students) - Determines what constitutes a “small” class.</td>
</tr>
<tr>
<td></td>
<td>• Small Class Size Weight Adjustment - Subtracts this number from the Enrollment weighting that is set in the optimization scenario.</td>
</tr>
<tr>
<td></td>
<td>• Large Class Size (if more than xx students) - Determines what constitutes a “large” class.</td>
</tr>
<tr>
<td></td>
<td>• Large Class Size Weight Adjustment - Adds this number to the Enrollment weighting that is set in the optimization scenario.</td>
</tr>
<tr>
<td></td>
<td>• Time Block Conformance—Ranks those courses that conform to the time block template for the term higher than those courses that do not.</td>
</tr>
<tr>
<td></td>
<td>• Course Length—Course Length factors in the number of meeting occurrences for a class. For example, a class that meets five times per week might be given room assignment priority over a class that only meets twice per week.</td>
</tr>
<tr>
<td>Preference Weights</td>
<td>Preferences vary according to configuration but they include such things as building or room preferences, room type preferences, or feature preferences.</td>
</tr>
<tr>
<td></td>
<td>• By default, all preferences are automatically included in an optimization scenario. To exclude a preference completely from an optimization scenario, clear the Include option for it.</td>
</tr>
<tr>
<td></td>
<td>• You can also simply exclude the weight of a preference, which means that although the preference is not excluded from the optimization logic, it does not contribute to the total number of points for a room assignment ranking for a course.</td>
</tr>
<tr>
<td></td>
<td>• If a preference has been marked as a requirement during the Set Preferences mode, you can select Ignore Requirements for it to downgrade it to a preference only for the optimization scenario.</td>
</tr>
</tbody>
</table>
When you are creating a scenario, all the rooms in your domain are eligible to hold a course. If there are rooms offline for the term that you are scheduling, or there are rooms that should not be considered for the scenario, you can exclude them from the scenario on the Excluded Rooms tab of the Scenario dialog box.

**Figure 13-42: Scenario dialog box, Excluded Rooms tab**

---

**Optimization logic**

After you have set the weights for the Optimization scenario factors and preferences as well as all other needed options, you can run the Optimizer. The Optimizer works as follows:

1. Courses are ranked.
   - If a course is identified as Publish in SIS Room (which means use the room to which the course is already assigned in the SIS), then the course receives a “0” ranking.
   - If a course is identified as Locked In, either from being locked in in a previous scenario or from being pre-assigned in the current scenario, then the course receives a “0” ranking.
   - All other courses are ranked according to the sum of the weights that are assigned to their factors and preferences on the Scenario tab. The larger the sum of the weights, the higher the score that is assigned to a course and therefore, the more important the room ranking, with the most important room ranking having a rank = 1.
   - If Boost Requirements Weight is selected for a course, then 100% of the indicated weight is assigned to each preference and 150% of the indicated
weight is assigned to each preference that is marked as Required. If Boost Requirements Weight is *not* selected for a course, then 100% of the indicated weight is assigned to both the preferences and the preferences that are marked as Required.

- If a course is identified as “Same Room,” then the partners of the course are elevated sequentially based on the ranking of the partner course with the most important room assignment ranking. For example, with three total courses and the most important course in this set having a rank = 3, then the other two courses are set to rank = 4 and rank = 5.

- If a course is cross-listed, then the parent course is the course to which the most important (lowest) room rank is assigned and the children courses adopt the ranking of the parent course.

---

*Because the child course always follows the parent course, children course preferences are not factored when rooms are being assigned to courses. Only the parent course is relevant in assigning room rankings.*

2. Rooms are assigned to courses one course at a time based on the order of the room assignment rankings (from the most important ranking of rank = 1 to the least important ranking of “n”).

- If the course is a single room without an Instructor Back to Back or Same Room designation, then:
  - The list of rooms that meet the course’s preferences and requirements criteria are identified. Of the rooms that are identified, the subset of rooms that most closely meet the course’s capacity are identified. The Optimizer then looks to maximize seat fill. If multiple rooms all have the same capacity and all the rooms have the same preferences and/or requirements, the Optimizer selects the room that has already received course assignments, which increases the utilization of an already-scheduled space before scheduling another.
  - If no room meets all the requirements for a course, and no requirement has been marked as Ignore, then the course is left unassigned.
  - If no room meets all the preferences for a course, then the course preferences are removed one at a time from least important to most important based on the assigned weight until a room can be assigned to the course.
  - If all preferences are removed and no room can be assigned to the course, then the course is left unassigned and it is displayed on the Exceptions list on the Resolve Room Assignments window.
• If the course has a Same Room designation, then each course is reviewed first to determine if it has any Same Room partners before any attempt is made to assign a room to the course.

• If all the courses in the set can be addressed with a single room that meets all the preferences and requirements for the set, then the room is assigned to the courses in the set.

• If all the courses in the set cannot be addressed with a single room that meets all the preferences and requirements for the set, then the all the courses are left unassigned and they are displayed on the Exceptions list on the Resolve Room Assignments window.

• If the course has an Instructor Back to Back designation, then each course is reviewed first to determine if it has any Back to Back partners before any attempt is made to assign a room to the course. The partner courses are provisionally elevated to the rank of the most importantly ranked course.

• If all the courses in the set can be addressed with a single room that meets all the preferences and requirements for the set, then the room is assigned to the courses in the set.

• If all the courses in the set cannot be addressed with a single room that meets all the restrictive requirements is removed from the set and an attempt is made to assign the same room to the remaining courses. (The course that is removed receives a Back to Back exclusion note and its ranking is returned to its original ranking and a room assignment is made based on this original ranking.) This process of removing the course with the most restrictive requirements and then attempting to assign the same room to the remaining courses is repeated until a single room is found for the remaining courses or until the course that is being addressed is alone. If the course that is being addressed becomes alone, then preferences are removed one at a time, beginning with the least weighted preference, until a room can be assigned to the course.

The following examples demonstrate how the Optimizer would ultimately assign rooms to courses based on this logic.

**Class Size and Instructor Importance Examples** - With all other weightings set to zero, consider the following configuration for these four settings:

- Weight assigned to Enrollment in scenario = 500
- Small Class Size (if less than xx students) = 10
- Large Class Size (if more than xx students) = 750
- Large Class Size Weight Adjustment = +100
- Instructor Importance = 400
The figure below summarizes how these three courses would be scored and ranked for room assignment:

<table>
<thead>
<tr>
<th>Course</th>
<th>Instructor Importance</th>
<th>Instructor Importance Score</th>
<th>Estimated Enrollment</th>
<th>Class Size</th>
<th>Enrollment Score</th>
<th>Class Adjustment Size</th>
<th>Final Score</th>
<th>Room Assignment Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Yes</td>
<td>400</td>
<td>Large</td>
<td>500</td>
<td>+100</td>
<td>1000</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>No</td>
<td>0</td>
<td>50</td>
<td>500</td>
<td>2</td>
<td>500</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Yes</td>
<td>400</td>
<td>Small</td>
<td>500</td>
<td>-100</td>
<td>800</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

**Back to Back Example** - Four courses have been identified as Back to Back for a scenario based on the Back to Back default value of 15 minutes.

- The four courses receive an initial ranking of 2, 50, 75, and 100.
- When it is time for the course with rank = 2 to have a room assigned, the other three courses are elevated provisionally to the same rank and a room search is carried out for a room that can be assigned to all four courses.
  - No single room can be assigned to all four courses. The course with rank = 100 has the most restrictive requirements. It is removed from the set, returned to its original rank (rank = 100) and receives a Back to Back Exclusion note.
  - The courses with ranks of 2, 50, and 75 are re-validated as fitting the 15 minute Back to Back criteria, and the room search is repeated for these courses.
    - No single room can be assigned to all three courses. The course with rank = 50 has the most restrictive requirements. It is removed from the set, returned to its original rank (rank = 50) and receives a Back to Back Exclusion note.
  - The courses with rank = 2 and rank = 75 are re-validated as fitting the 15 minute Back to Back criteria, and the room search is repeated for these courses.
    - A single room can be assigned to both these courses. The room rankings are reset to rank = 2 and rank = 3.
  - The assignment of rooms continues for courses with ranks 3 through 49.
  - When it is time to assign a room to the course with rank = 50, it is re-validated as fitting the 15 minute Back to Back criteria with the course with rank = 100. The course with rank = 100 is elevated provisionally to the same rank as the course with rank = 50. A room search is carried out for a single room that can be assigned to both courses.
    - A single room cannot be assigned to both courses. The course with rank = 100 is removed from the set, returned to its original rank (rank = 100) and receives a Back to Back Exclusion note.
    - If needed, preferences are removed one at a time, beginning with the least weighted preference, until a room can be assigned to the course with rank = 50.
  - The assignment of rooms continues for courses, up and to including the course with rank = 100.
Creating Scenarios

Although the process for your organization might vary, a typical approach for using scenarios to optimize room assignments is to first create a pre-assignment scenario to partially complete the assignment of rooms to courses for a term. You would then copy this pre-assignment scenario and edit it as needed to make an optimization scenario, and then run this optimization scenario to continue with the assignment of rooms to courses. You can create as many optimization scenarios as needed, either by copying an existing scenario or creating an entirely new scenario.

To create a pre-assignment scenario

1. On the EMS Campus menu bar, click Academic Planning > Courses > Optimization Scenarios.

   The Scenarios window opens. This window lists all the scenarios (pre-assignment and optimization) that are currently configured in your EMS database.

   Figure 13-43: Scenarios window

2. On the Domain dropdown list, select the domain for which you are creating the scenario, and on the Term dropdown list, select the term.

3. Click New.

   The Scenario dialog box opens. The Scenario tab is the active tab.

   To review the different features on the Scenario dialog box, see “Scenario dialog box” on page 507.
4. In the Description field, enter a name or description for the scenario, for example, Pre-assignment.

The description can be a maximum of 30 characters, including spaces.

Because all assignments in a pre-assignment scenario are manual, you do not need to set any weighted criteria or exclude any rooms.

5. Click OK.

The Scenario dialog box closes. You return to the Scenarios window with the newly created scenario automatically selected.

6. Click Preassign.

A message opens informing you that preassigning will set this term to Read Only and asking you if it is OK to continue.

7. Click Yes.

The message closes and an Initializing Scenario progress dialog box opens. After the scenario is initialized, the progress dialog box closes, and the Preassign Rooms window opens. This window lists all the courses for the selected term and domain. Any courses that were previously pre-assigned are listed as Locked In.

Figure 13-44: Preassign Rooms window
8. Optionally, do one or both of the following; otherwise, go to Step 9.
   - To view a course in the Course Navigator, double-click the course.

   For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

   - To filter this list, do one or more of the following:
     - On the Academic Unit dropdown list, select an academic unit.
     - On the Subject Dropdown list, select a subject.
     - At the bottom of the window, select Unassigned Only.
     - Click on a column heading to sort by the heading.

9. If you do not want to copy pre-assignments that you have carried out in a previous scenario, continue to “Assigning Rooms” on page 522; otherwise, do the following:
   - Click Copy Locations to open the Import Room Assignments dialog box.

   Figure 13-45: Import Room Assignments dialog box

   - Select the appropriate Domain and Term from which you want to copy the pre-assignments.
   - Select the appropriate scenario to copy, and then click Select.

   Where possible, the locations are copied for the courses that are displayed in the Preassign Rooms window. If a location was successfully copied for a course, then (unassigned) is no longer displayed in the Locations column. Instead, the copied room assignment is displayed. If a location could not be copied for a course, then (unassigned) is still displayed in the Locations column.

To create an optimization scenario

1. On the EMS Campus menu bar, click Academic Planning > Courses > Optimization Scenarios.

   The Scenarios window opens. This window lists all the scenarios (pre-assignment and optimization) that are currently configured in your EMS database.

   Figure 13-46: Scenarios window

2. On the Domain dropdown list, select the domain for which you are creating the scenario, and on the Term dropdown list, select the term.

3. Do one of the following:
   - To create a new optimization scenario, click New.
   - To create an optimization scenario by copying an existing scenario, select the scenario that you want to copy, and then click Copy

   The Scenario dialog box opens. The Scenario tab is the active tab.

   To review the different features on the Scenario dialog box, see “Scenario dialog box” on page 507.

4. In the Description field, enter a name or description for the scenario, for example, Scenario A.

   The description can be a maximum of 30 characters, including spaces.
5. Do one or more of the following to set the options and weighted criteria for the optimization scenario:

- Modify the Back to Back Gap Minutes value. (The allowed value is 0-60.)
- Select the Boost Requirements Weight to increase the weights of preferences that are marked as requirements to 150% of their assigned preference weights.
- Use the Weight slider bar or enter a number in the Weight field to modify the weight as needed for a factor. If you do not want the factor to contribute to room assignment ranking for a course, then select Exclude Weight for the factor. (The factor is still considered when searching for a room.)

\[ Weights \text{ are arbitrary numbers that simply indicate the relative importance of one criterion to another. The weights do not have to add up to a particular “whole,” for example, 100.} \]

- By default, all preferences are included in an optimization scenario. For the preferences that you are including, use the Weight slider bar to specify a weight for each preference, or enter a number in the Weight field. If you do not want a preference to contribute to room assignment ranking for a course, select Exclude Weight for the preference. (The preference is still considered when searching for a room.)

\[ \text{Only the features that were selected during Set Preferences mode are displayed—this is not an exhaustive list of all your features.} \]

- Some preferences might have been marked as Required by some academic units during the Set Preferences mode. Select Ignore Requirements to indicate that a requirement should be ignored and treated only as a preference.

6. Open the Excluded Rooms tab, and do the following to specify the rooms that should not be assigned to a course in this scenario (for example, rooms that have previously been assigned using a pre-assignment scenario):

- On the Building dropdown list, select (all) buildings, or select a specific building.
- On the Room Type dropdown list, leave the default value of (all), or select a specific room type.
- In the Available list, select the room, or CTRL-click to select multiple rooms, and then click the Move (>) button to move the rooms to the Selected list.

\[ \text{If a room assignment is already “locked in” for a course, then the room assignment is maintained for the course, even if the room is excluded from the scenario.} \]

7. Repeat Step 6 as needed until you have selected all the rooms in specific buildings that should be excluded.
8. Click OK.

The Scenario dialog box closes. You return to the Scenarios window with the newly created scenario automatically selected.

9. Click Optimize.

The Run Scenario dialog box opens. This dialog box lists all the academic units that have courses for the selected term and domain.

Figure 13-47: Run Scenario dialog box

10. In the Available list, select the academic unit that you want to run in the optimization scenario, or CTRL-click to select multiple units, and then click the Move (>) button to move the units to the Selected List.

11. Click Run.

Two results are possible:

- If the term contains edited courses, then a message that states the following opens: WARNING: You have made changes to 'n' Course(s) in “Define & Edit Mode” that will be overwritten. Is it OK to continue. You must click Yes to continue and then a message opens informing you that optimizing will set this term to Read Only for the selected academic units and asking you if it is OK to continue.

- If the term does not contain edited courses, then a message opens informing you that optimizing will set this term to Read Only for the selected academic units and asking you if it is OK to continue.
12. Click Yes.

The message closes and an Initializing Scenario progress dialog box opens. After the scenario is initialized and the term is synchronized, the progress dialog box closes. An Optimization Results dialog box opens on top of the Resolve Room Assignments window. This dialog box indicates that the optimization was complete and it also indicates the number of courses assigned, the percent of total courses assigned, and the number of exceptions (the number of courses that could not be assigned).

At any time, if you need to review this information, click Print > Scenario Results.

13. Click OK.

The Optimization Results dialog box closes and the Resolve Room Assignments window is now the active window. By default, this window lists only those courses for which rooms could not be assigned.

Figure 13-48: Resolve Room Assignments window

14. If you are satisfied with the overall results of the Optimization scenario, then you can continue to resolve any remaining room assignments. (See “To resolve room assignments” on page 520.) Otherwise, you can test other potential scenarios and compare results using various tools before you choose your final scenario for publishing. See “Evaluating Optimization Scenarios” on page 527.
To resolve room assignments

After an Optimization scenario, courses can remain unassigned for the following reasons:

- Conflicts with another course: A course or courses that were ranked higher in preference criteria was assigned the room that this course required.
- No space can hold course: The course had requirements that were so specific, no room was available that met the criteria either because the room does not exist, or it was excluded from the scenario.

1. Optionally, you can do one or more of the following:
   - To view all the courses that are in conflict with a course, select the course, and then click Search to open the Search tool and carry out a filtered search of rooms that are available for the course's meeting pattern. Rooms that meet all the search criteria and that are available are displayed on an Available tab. The rooms that are already in use during the selected course's meeting time are displayed on a Conflicts tab.
   - To view a course in the Course Navigator, double-click the course.

For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

- Clear Exceptions Only to view a list of all courses (assigned and unassigned) for the selected term and domain.
- To view the final room assignment ranking, scroll to the Ranking column.

Remember, any room that was pre-assigned or was Publish to SIS has rank = 0.

- To filter the course list, do one or more of the following:
  - On the Academic Unit dropdown list, select an academic unit.
  - On the Subject Dropdown list, select a subject.
  - Click on a column heading to sort by the heading.
- To view notes about the course, scroll to the Notes field. This field displays the following information, if applicable, for a course:
  - Back to Back with Grouping ID, indicating how courses were paired as a set.
  - Back to Back Exclusion to indicate a course that was initially identified as Back to Back, but returned to its original ranking because a single room could not be assigned to the full set.
  - Same Room with Grouping ID, indicating how courses were paired as a set.
  - Publish in SIS Room.
Chapter 13
Academic Planning (EMS Campus)

- Locked In status for the room.

2. Continue to “Assigning Rooms” on page 522.

If you are carrying out incremental optimization by academic unit, you must repeat this procedure for every academic unit that is to be optimized.
Assigning Rooms

After you have completed pre-assignment of rooms and/or room optimization, four options are available to resolve room assignments for rooms that are not flagged as Publish in SIS or locked in to an assignment:

• **Assign.** The Assign option lists all rooms regardless of availability or preferences. It is intended to provide a means for you to quickly assign a room without going through the search process.

• **Search.** The Search option initially lists any preferences and requirements that were specified during the Set Preferences mode. You can use these preferences as a basis for a room search or you can specify and/or clear other criteria to complete the room search.

• **Unassign.** The Unassign option removes the Assigned status for a course. You can then use the Assign option or the Search option to assign a different room to the course. The Unassign option is available after you assign a room to a course, or search for a room, and then assign it to a course.

• **Swap.** The Swap option allows you to swap the room assignments of two courses. The swap option is only available after selecting two courses that have identical meeting patterns and that have been assigned to rooms.

To assign rooms to courses

1. Select the course, or CTRL-click to select the multiple courses to which a room is to be assigned.

2. On the Preassign Rooms window, or the Resolve Room Assignments window, click Assign.

   The Room Selector dialog box opens.

*Figure 13-49: Room Selector dialog box*
3. On the Building dropdown list, select (all) buildings or select a specific building that contains the rooms that you are considering for assignment.

The rooms are displayed in the dialog box. By default, only those rooms that can meet the enrollment expectations, regardless of availability are displayed. Rooms that are excluded from the scenario are marked with an asterisk (*), but, if necessary, you can select an excluded room.

4. Optionally, to display all rooms in the Room Selector dialog box, clear the Limit to Est. Enrollment option.

5. Select a room, and then click OK.

If the room could not be assigned to one or more courses because of a conflict, then a message opens indicating this. Click OK to close the message, and repeat this step until you successfully assign a room to the courses.

6. Repeat **Step 2** through **Step 5** until you have successfully assigned rooms to all courses for the term. After you have assigned a room to a course, at any time, you can do any of the following:

- To change a room assignment for a course, select a course for which a room has been assigned, and then click Unassign. You can then repeat **Step 2** through **Step 5** to assign a room to the course.

- Courses that were pre-assigned are listed as Locked In. To re-optimize any portion of the course assignments, select one or more assigned courses (CTRL-click to select multiple courses), and then click Lock In to lock in these additional courses, and then rerun your optimization scenario.

- To swap the room assignments of two courses, CTRL-click to select two courses with identical meeting patterns, and then click Swap.

---

*You can open the Resolve Room Assignments window at any time by clicking Resolve on the Scenarios window. The system does not require all courses to be assigned to rooms. Those courses that are left unassigned are placed in a special TBD room when publishing and can be assigned post-publish.*
To search for rooms to assign to a course

1. Select the course to which a room is to be assigned.

2. On the Preassign Rooms window, or the Resolve Room Assignments window, click Search.

   The Room Search dialog box opens. The preferences or requirements that the academic unit specified for the selected course during the Set Preferences mode are displayed at the top of the dialog box. By default, these preferences are included in the search criteria.

   *Figure 13-50: Room Search dialog box*

3. In the Search Preferences (lower) pane of the dialog box, edit the search criteria as needed, and then click Next.

   The Room Search dialog box is updated with a list of rooms that meet your search criteria. Rooms that have been excluded from the scenario are marked with an asterisk (*). See *Figure 13-51 on page 525.*
Figure 13-51: Room Search dialog box

4. Optionally, to view information about a room, select the room, and then click Room Info; otherwise, go to Step 5.

The Room Info dialog box opens. The dialog box displays information about the room, including the room’s properties, the setup type, the room’s features, and so on. After you are done viewing the room’s information, click Close to close the Room Info dialog box.

5. On the Room Search dialog box, select the room that is to be assigned to the course, and then click Select.

The room is assigned to the course. You remain on the Preassignment window or the Resolve Assignments window. If the room is assigned from the Preassigned window, then it is also marked as Locked In.

If there are rooms that meet your search criteria, but they have already been scheduled by other courses, then a Conflicts tab opens. Open the tab to review a list of these rooms.
6. Repeat this procedure as needed to assign rooms to courses. After you have assigned a room to a course, at any time, you can do one or both of the following:

- If you want to change a room assignment for a course, select a course for which a room has been assigned, and then click Unassign. You can then repeat Step 2 through Step 5 to assign a room to the course.

- Courses that were pre-assigned are listed as Locked In. If you would like to re-optimize any portion of the course assignments, select one or more assigned courses (CTRL-click to select multiple courses), and then click Lock In to lock in these additional courses, and then rerun your optimization scenario.

- To swap the room assignments of two courses, CTRL-click to select two courses with identical meeting patterns, and then click Swap.

---

You can open the Resolve Room Assignments window at any time by clicking Resolve on the Scenarios window. The system does not require all courses to be assigned to rooms. Those courses that are left unassigned are placed in a special TBD room when publishing and can be assigned post-publish.
Evaluating Optimization Scenarios

You can test an unlimited number of potential scenarios and compare results using various tools before you choose your final scenario for publishing. Both the Academic Browser and the Academic Book contain a Scenario dropdown list from which a specific scenario can be selected for viewing and evaluation. (See “Searching with the Academic Browser” on page 579 and “Using the Academic Book” on page 586.) The Scenarios window contains a Print option that provides access to the following reports that can be used to for evaluating scenarios—Scenario Results, Scenario Exceptions, Unmet Preferences, and Preferences Summary. Additional reports within the Academic Planning > Reports area are also available, including Classroom Optimization, Hourly Classroom Utilization, and Course Preferences. (See “Generating Academic Reports” on page 601.)
Chapter 13
Academic Planning (EMS Campus)
Publishing a Term

Section Contents

• Overview of Publishing an Academic Term on page 531
• Publishing a Term on page 533
• Manually Updating Course Locations in the SIS on page 537
• Unpublishing a Previously Published Term on page 539
Overview of Publishing an Academic Term

After the Domain Scheduler has finalized the assignment of courses to rooms, either with the help of the EMS room optimization process or by using the scenario that was pulled from the SIS, the next step is to publish the course schedule for the term in EMS Campus. Publishing the course schedule causes the system to book the space in EMS, creating reservations and bookings. If the EMS Campus system parameter Manually update SIS is set to “No,” then the publishing process also updates course location information directly in the SIS; otherwise, the Domain Scheduler must manually update the SIS. Publishing an academic term consists of the following steps:

1. The Domain Scheduler publishes the term, which includes specifying statuses for courses in conflict and cross-listed courses. See “Publishing a Term” on page 533.

2. If needed, the Domain Scheduler manually updates the course locations in the SIS. See “Manually Updating Course Locations in the SIS” on page 537.

3. If needed, the Domain Scheduler can unpublish a previously published term. See “Unpublishing a Previously Published Term” on page 539.
Publishing a Term

After you have finalized the assignment of courses to rooms, either with the help of the EMS room optimization process or by using the scenario that was pulled from the SIS, the next step is to publish the course schedule for the term in EMS Campus. Publishing the course schedule causes the system to book the space in EMS, creating reservations and bookings.

To publish a term

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms. The Terms window opens.

*Figure 13-52: Terms window*

2. On the Domain dropdown list, select the domain for which the term is being published.

3. Select the term that is being published, and then click Edit.

The Term dialog box opens. The Term tab is the active tab. See *Figure 13-53 on page 534.*
4. Do the following:
   - Make sure that the Mode is set to Read Only and if the academic unit-level users are to have View access to the term, make sure that Available to Academic Units is selected.
   - On the Active Scenarios dropdown list, select the scenario that is being published.

4. The SIS scenario publishes room assignments that were previously defined in the SIS.

5. Optionally, in the Phase field and the Notes field, enter any information that is pertinent to the published schedules, for example, “Published” in the Phase field.

6. Open the Excluded Dates tab.

7. Select the dates that should be excluded during the publishing process.

   This would include any dates where regularly scheduled classes do not take place, for example, breaks, holidays, and if applicable, final exams week.

   The Term dialog box closes. You return to the Terms window with the term that is to be published automatically selected.

   Bookings are not created for excluded dates, which means that rooms can be scheduled for events and meetings, if needed.
8. Click Publish.

The Publish Term dialog box opens. The Domain field, the Term field, and the Scenario field are automatically populated with the values that you previously selected and you cannot edit them.

*Figure 13-54: Publish Term dialog box*

9. Select the statuses required for publishing the term.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The status that is used to book all rooms for course reservations and bookings that are created during the publishing process. <strong>Note:</strong> The status should be a Booked Space type.</td>
</tr>
<tr>
<td>Conflict Status</td>
<td>If you are publishing course room placements that were assigned in your SIS (the SIS scenario), then potentially you could have room booking conflicts created. If a double booking is encountered during the publishing process, then the reservation and bookings for the conflicting course are published in this conflict status. <strong>Note:</strong> The status should be an Info Only type.</td>
</tr>
<tr>
<td>Cross List Status</td>
<td>The status that is used to book all cross-listed and shared space course reservations and bookings that are created during the publishing process. <strong>Note:</strong> The status should be an Info Only type.</td>
</tr>
<tr>
<td>Override Existing Bookings/Override Conflict Status</td>
<td>If another scheduling unit on campus, for example, the Student Union, is allowed to book events in academic space before the publishing process has taken place, then an event and course might be assigned to the same space. If Override Existing Bookings is selected and this situation is encountered during the publishing process, the event is “bumped” and its reservation and bookings are booked into this status. If Override Existing Bookings is not selected, then the conflicted bookings for the course are placed into the Override Conflict Status. <strong>Note:</strong> The Override Conflict Status should be an Info Only type.</td>
</tr>
</tbody>
</table>
10. Specify the Domain Settings for the term.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reservation Source</td>
<td>Select the reservation source that is used for the course reservations and bookings that are created during the publishing process.</td>
</tr>
<tr>
<td>Room for Unassigned</td>
<td>Click the Search icon to open the Room Selector dialog box and select the room in which to book the courses that have not been assigned in the SIS or in an optimization scenario. Note: Unassigned courses are typically booked in a special To Be Determined (TBD) room. Some organizations create a specific TBD building and/or room to accommodate this situation. The room must be an override description room. See the EMS Setup Guide for information about configuring a TBD building and/or room.</td>
</tr>
</tbody>
</table>

11. Click Publish.

   A message opens stating that publishing the term will set the term to Read Only and asking you if it is OK to continue.

12. Click Yes.

   A Publishing progress dialog box opens. After the term is published, the progress dialog box closes, and a message opens indicating that the term was published successfully.

13. Click OK to close the message and return to the Terms window.

   *If any errors are encountered during the publishing process, or if the EMS Campus system parameter Manually Update SIS/ERP System After Publishing is set to “Yes,” then you can access your course list and manually update the course locations in your SIS. See Manually Updating Course Locations in the SIS on page 537*
Manually Updating Course Locations in the SIS

If any errors are encountered during the publishing process, or if the EMS Campus system parameter Manually Update SIS/ERP System After Publishing is set to “Yes,” then you can access your course list and manually update the course locations in your SIS.

To manually update course locations in the SIS

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

   The Terms window opens.

   *Figure 13-55: Terms window*

2. On the Domain dropdown list, select the domain for which you are manually updating the course locations.

3. Select the term for which you are manually updating the course locations, and then click Update SIS.

   The Courses Not Updated in SIS window opens. This window lists all the courses that were not updated in the SIS along with an accompanying reason. If the reason is an error, you must resolve the error before you can continue with the manual publishing. If “Manual Publish” required is listed, then you can continue with this procedure. See *Figure 13-56 on page 538.*
4. Select the course record or CTRL-click to select multiple records that you are updating, and then click Update, or click Update All to update all records in a single step. A message opens indicating that the updates were successful.

5. Click OK to close the message and return to the Terms window.
Unpublishing a Previously Published Term

For a variety of reasons, you might need to unpublish a previously published term, for example, you accidentally published the term using the wrong scenario, or you forgot to mark excluded dates before you published the term.

Even though you might have a valid reason for unpublishing a term, do not do so without great consideration. Unpublishing a term deletes all reservations and bookings that are associated with the term.

To unpublish a term

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.
   
   The Terms window opens.

   Figure 13-57: Terms window

2. On the Domain dropdown list, select the domain for which you are unpublishing the term.

3. Select the term that you are unpublishing, and then click Unpublish.

   A message opens indicating that unpublishing will remove all reservations and bookings for the selected term, and asking you if it is OK to continue.
4. Click Yes.

The message closes. After the term is unpublished, a second message opens indicating that the term was successfully unpublished.

5. Click OK to close the second message and return to the Terms window.
Post-Publishing Phase

Section Contents

• Reviewing Reservations and Resolving Room Assignments on page 543
• Post-Publish Processing of Courses on page 546
• Setting a Final Exam Schedule on page 562
• Publishing a Final Exam Session on page 572
Chapter 13
Academic Planning (EMS Campus)

Reviewing Reservations and Resolving Room Assignments

After a course has been published, you can use the EMS Navigator (referred to simply as the Navigator) or the Reservation Book (referred to simply as the Book) to manage it just like any other EMS reservation and/or booking. The Course Info tab on the Navigator displays the course and the course date records for the course as it exists in your SIS. If you open a course in the Navigator that is cross-listed or shares space with another course, the Navigator displays both sets of reservations and bookings. You can review the reservations that have been made for a course and if needed, change the course room (location) for one or more of its bookings. If courses have an identical meeting pattern, you can also swap rooms (locations) between courses.

If you select a course date record, on the Course Info tab, and then click Course, the course opens in the Course Navigator.

Figure 13-58: Navigator with reservation and bookings for a course

After a term has been published, you can continue using the Academic Browser, the Academic Book and/or the Course Navigator to locate courses; however, for automation reasons, after a term is published, you should make room changes in EMS Campus and not in your SIS.
In a typical process, you would want to locate and review the following types of courses immediately after publishing:

- Courses in conflict—Use the Browser to search for bookings in the academic conflict status that you designated, for example, Academic Conflict. (See “Searching with the Browser or with the Web Reservation Tool” on page 197.) You can change the location to resolve the conflict (see “To change the course rooms (locations) for one or more bookings” below), or if the conflict was intentional, you can change the status to the academic share status that you designated, for example, Academic Shared. (See “To edit a booking in the Navigator” on page 110 or “To edit multiple bookings in the Navigator” on page 112.)

  When you manually update the status to Shared, the courses are not linked in the same way as when marking them as Shared Space prior to publishing; however, manually updating the status does not result in these course being “cleared” from your Conflict list.

- Courses or events that were overridden by publishing—Use the Browser to search for bookings in the status that you designated for override bookings, for example, Academic Bumped. (See “Searching with the Browser or with the Web Reservation Tool” on page 197.) You might want to move these bookings to another location. (See “To change the course rooms (locations) for one or more bookings” below.)

- Courses that were left unassigned—Use the Browser to search for bookings in the TBD room (See “Searching with the Browser or with the Web Reservation Tool” on page 197.) You might want to move these courses to an actual room. (See “To change the course rooms (locations) for one or more bookings” below.)

  You can also use the Advanced search features in the Academic Browser to locate and review the three types of courses that are listed above after publishing. See “Searching with the Academic Browser” on page 579.

To change the course rooms (locations) for one or more bookings

1. Open the course reservation in the Navigator. See:
   - “Viewing and Editing Reservations in the Reservation Book” on page 62.
   - “Opening a reservation directly in the Navigator” on page 79.
   - “Opening a reservation through a group” on page 80.
   - Chapter 4, “Search Tools,” on page 195.
2. Do one of the following:

- To update a course location for a single booking, see “To edit a booking in the Navigator” on page 110.
- To update course locations for multiple bookings, see “Editing Multiple Bookings in the Navigator” on page 112.

The course location in the SIS does not update automatically unless all bookings that are specific to a meeting pattern within a reservation are changed to an identical alternate location. If for some reason, you want to manually update the SIS with a new location that was not assigned to all bookings, select the course date record on the Navigator Course Info tab, and then click the Update button.

To swap rooms between courses

If courses have an identical meeting pattern, you can also swap rooms between courses.

1. Open the Reservation Book. See “Viewing and Editing Reservations in the Reservation Book” on page 62.
2. In the Reservation Book, locate your course bookings.
3. Right-click one of the two bookings that you want to swap, and on the context menu that opens, click Swap Rooms With Another Course.
4. Select the second of your two bookings.
   A message opens asking you if you are sure that you want to swap rooms for the two courses.
5. Click Yes.
   The message closes. After the locations are swapped, the Reservation Book is updated to reflect the swap.
Post-Publish Processing of Courses

In most cases, courses are added, changed, or canceled in the SIS after the course schedule has been published in EMS. You can manually resynchronize and process these courses, or you can set options in EMS Campus to automatically resynchronize these courses. After these courses are automatically resynchronized, they can be automatically processed as well, or you can manually process them. Also, at the point that actual enrollment should determine room assignment (that is, can a room’s capacity handle the actual enrollment), you can process courses post-publish so that the courses are updated with the actual enrollment.

For automatic synchronizing to occur, the EMS Campus Auto Sync Service must be installed and configured. Refer to the EMS Installation manual for details.

To manually process courses post-publish

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms. The Terms window opens.

Figure 13-59: Terms window
2. Select the term which requires post-publish processing, and then click Sync.

The Course Updates window opens. The Course tab is the active tab. This tab displays all the new courses, new course dates, changed courses, or canceled courses from the SIS. After processing, it also lists “Room Capacity Violations,” or courses in which the designated enrollment (estimated or actual) has surpassed the capacity of the room. The Course Updates window also has a Crosslist Validation tab. When EMS changes a cross-list parent to accommodate a new course, course date, or change that is being processed, the cross-listed courses are displayed on the Crosslist Validation tab. The Crosslist Validation tab is for informational purposes only so that you are kept abreast of parent changes. If you are satisfied with the parent assignments, you can simply click Reviewed and the cross-listed courses are cleared from the tab; otherwise, a Set Parent option is available.

Figure 13-60: Course Updates window, Courses tab

3. Continue to one of the following:
   • “To process a canceled course post-publish” on page 548.
   • “To process a changed course post-publish” on page 548.
   • “To process a new course date post-publish” on page 550.
   • “To process a new course post-publish” on page 553.
   • “To process a Room Capacity Violation post-publish” on page 555.

The following procedures are presented in the order in which the post-publish processing should be carried out—cancellations, changes, new course dates, new courses, and then Room Capacity Violations.
To process a canceled course post-publish

1. Select the canceled course, or CTRL-click to select multiple courses.
2. Click Process.
   
   A message opens asking you if you are sure that you want to process the selected course dates.
3. Click Yes.
   
   After processing is complete, the message closes and the canceled courses are removed from the Course Updates window. The bookings are canceled in EMS.

To process a changed course post-publish

A course is listed as changed if there has been a change to the start or end date, a day of the week, the start or end time, and/or the room in the SIS.

1. Select the changed course, or CTRL-click to select multiple courses.
   
   The change history for the selected courses is displayed on the History tab in the lower pane of the Course Updates window.
2. Click Process.
   
   A message opens asking you if you are sure that you want to process the selected course dates.
3. Click Yes.
   
   Two results are possible:
   
   - If the changes were successfully completed for the reservations and bookings, then the courses are removed from the Course Updates window.
   
   - If the changes resulted in a room conflict, Room Not Available is displayed in the Notes column. Go to Step 4.
4. Click Conflicts to view the conflicts for the course.
   
   The View Conflicts dialog box opens. Each course and/or event that is causing the conflict is displayed.
5. If the conflict was caused by the switching of the rooms in the SIS, select the two course dates that are in conflict, and then click Swap to swap and process the rooms in the same step; otherwise, go to Step 6.
6. Do one of the following:
   • Click Process again to process the course with conflicts. A Warning message opens asking you if you are sure that you want to process with conflicts. Click Yes to close the message and complete the processing.
   
   If needed, at a later date, you can use the Browser to manually search for these conflicts and resolve them. See Courses in Conflict on page 544.

   • Click Assign to search for a new room. The Select a Room dialog box opens. Go to Step 7.

   Figure 13-61: Select A Room dialog box

7. Specify your search criteria, and then click Next.
   A list of rooms that meets your search criteria is displayed.

8. Select the room that is to be assigned to the new courses, and then click Finish.
   The Select a Room dialog box closes and you return to the Course Updates window with the new courses still selected.

9. Click Process.
   A message opens asking you if you are sure that you want to process the selected course dates.
10. Click Yes.

After processing is complete, the message closes and the changed courses are removed from the Course Updates window. If a Day of the Week change has been made, then processing course changes deletes and recreates the bookings that were previously made in EMS.

If bookings are deleted and recreated, then any manual changes that have been made to these bookings and/or any services that have been added to the booking are lost.

To process a new course date post-publish

1. Select the new course dates, or CTRL-click to select multiple new course dates.
2. If rooms have already been assigned to the course dates in the SIS and you want to keep these rooms, then go to Step 5; otherwise, click Assign to open the Select A Room dialog box, and then go to Step 3.

Figure 13-62: Select A Room dialog box

3. Specify your search criteria, and then click Next.

A list of rooms that meets your search criteria is displayed.
4. Select the room that is to be assigned to the new courses, and then click Finish.

The Select a Room dialog box closes and you return to the Course Updates window with the new courses still selected.

Rooms can be processed without a room assignment. In this case, the course date is published in the TBD room that was specified when the term was published.
5. Click Process.
   A message opens asking you if you are sure that you want to process the selected course dates.

6. Click Yes.
   Two results are possible:
   - If the changes were successfully completed for the reservations and bookings, then the courses are removed from the Course Updates window.
   - If the changes resulted in a room conflict, Room Not Available is displayed in the Notes column. Go to Step 7.

7. Click Conflicts to view the conflicts for the course.
   The View Conflicts dialog box opens. Each course and/or event that is causing the conflict is displayed.

8. If the conflict was caused by the switching of the rooms in the SIS, select the two course dates that are in conflict, and then click Swap to swap and process the rooms in the same step; otherwise, go to Step 9.

9. Do one of the following:
   - Click Process again to process the course with conflicts. A Warning message opens asking you if you are sure that you want to process with conflicts. Click Yes to close the message and complete the processing.
   - Click Assign to search for a new room. The Select a Room dialog box opens. Go to Step 10.

Figure 13-63: Select A Room dialog box

---

If needed, at a later date, you can use the Browser to manually search for these conflicts and resolve them. See Courses in Conflict on page 544.

---

- Click Assign to search for a new room. The Select a Room dialog box opens. Go to Step 10.
10. Specify your search criteria, and then click Next.

   A list of rooms that meets your search criteria is displayed.

11. Select the room that is to be assigned to the new courses, and then click Finish.

   The Select a Room dialog box closes and you return to the Course Updates window with
   the new courses still selected.

12. Click Process.

   A message opens asking you if you are sure that you want to process the selected course
   dates.

13. Click Yes.

   After processing is complete, the message closes and the changed courses are removed
   from the Course Updates window. If a Day of the Week change has been made, then
   processing course changes deletes and recreates the bookings that were previously made
   in EMS.

   If bookings are deleted and recreated, then any manual changes that have been
   made to these bookings and/or any services that have been added to the booking
   are lost.
To process a new course post-publish

1. Select the new course, or CTRL-click to select multiple new courses.

2. Do one of the following:

   • If rooms have already been assigned to the courses in the SIS and you want to keep these rooms, then go to Step 6.

   • If a room has already been assigned to the course (the first course) in the SIS, but it is meant to share a room with another course (the second course), then click Share to open the Course Selector dialog box, and then go to Step 5.

   ![Figure 13-64: Course Selector dialog box](image)

   • If a room has not been assigned to the course in the SIS, and you want to search for a room, then click Assign to open the Select A Room dialog box and then go to Step 3. See Figure 13-65 on page 554.

Rooms can be processed without a room assignment. In this case, the course date is published in the TBD room that was specified when the term was published.
3. Specify your search criteria, and then click Next.
   A list of rooms that meets your search criteria is displayed.

4. Select the room that is to be assigned to the new course, and then click Finish.
   The Select a Room dialog box closes and you return to the Course Updates window with
   the new course still selected.

5. If the course is not meant to share a room with another course, go to Step 6; otherwise, if
   the course is meant to share a room with another course, then do the following:
   - Click Share to open the Course Selector dialog box.

   **Figure 13-66: Course Selector dialog box**

   ![Course Selector dialog box]

   - Click Share to open the Course Selector dialog box.
Enter the appropriate search criteria (CRN, Course Title, Subject and/or Instructor) to search for the second course.

Select the second course, and then click OK. You are returned to the Course Updates window.

6. Click Process.

A message opens asking you if you are sure that you want to process the selected course dates.

7. Click Yes.

After processing is complete, the message closes and the new courses are removed from the Course Updates window.

To process a Room Capacity Violation post-publish

If the enrollment for a class violates the minimum or maximum capacity for its assigned room, then the course is displayed on the Course Updates window with a change status of Room Capacity Violation.

1. Select the course, or CTRL-click to select multiple courses.

2. Do one of the following:

   • To assign the course to a new room, click Assign to open the Select a Room dialog box, then go to Step 3; otherwise, to leave the course in the same room, go Step 5.

   Figure 13-67: Select a Room dialog box

3. Specify your search criteria, and then click Next.

   A list of rooms that meets your search criteria is displayed.
4. Select the room that is to be assigned to the new course, and then click Finish. The Select a Room dialog box closes and you return to the Course Updates window with the new course still selected.

5. Click Process.

A message opens asking you if you are sure that you want to process the selected course dates.

6. Click Yes.

After processing is complete, the message closes and the new courses are removed from the Course Updates window.

---

If you did not assign a new room to the course, then clicking Process merely acknowledges the room violation. The course remains in its same room.

---

To automatically process courses post-publish

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms. The Terms window opens.

   Figure 13-68: Terms window

2. Select the term which requires post-publish processing, and then click Edit.

   The Term dialog box opens. The Term tab is the active tab.
3. Open the Auto Sync Settings tab.

*Figure 13-69: Auto Sync Settings tab*

4. Specify your auto sync settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically Sync Courses</td>
<td>Select this option to automatically synchronize courses in your SIS.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>To automatically synchronize courses, a user who can carry out this function must be created, and this user must be specified for the Auto Sync User EMS (Campus) system parameter. See EMS system parameters (Campus) in the <em>EMS Setup Guide</em>.</td>
</tr>
<tr>
<td><strong>Automatically Process Course Updates</strong></td>
<td>Select this option if EMS is to automatically process new courses, changes, and cancellations if possible. Leave the option blank to manually process new courses, changes and cancellations from the EMS Dashboard. (See <em>&quot;To manually process courses post-publish&quot;</em> on page 546.)</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If this option is selected, and EMS <em>cannot</em> automatically process new courses, course dates and/or changes because of a conflict (for example, a room is not available), then you must manually process these courses. You must open the Course Updates tab on the EMS Dashboard, and then open the Courses sub-tab to view the courses in conflict that you must manually process. (See <em>Figure 13-70 on page 558.</em>) The Courses sub-tab is identical to the Course Updates window. See Chapter 5, <em>&quot;EMS Dashboard,&quot;</em> on page 227 for information about working with tabs on the Dashboard window.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In addition to this setting, three Campus system parameters determine the specific types of updates that you are auto-processing. See EMS system parameters (Campus) in the <em>EMS Setup Guide</em>.</td>
</tr>
</tbody>
</table>
5. Click OK.

The Term dialog box closes. You return to the Terms window.

*Figure 13-70: Dashboard window, Course Updates tab*
To process courses post-publish for enrollment

Typically, you publish your term in EMS prior to registration beginning. As a result, estimated enrollment is the most relevant value for searching for rooms with appropriate capacities. Closer to the start of the term, however, actual enrollment might become more relevant and you might need to change the setting so that EMS uses this value when searching for new rooms in the Navigator wizards and Course Updates window.

1. On the EMS Campus menu bar, click Academic Planning > Courses > Manage Terms.

The Terms window opens.

*Figure 13-71: Terms window*
2. Select the term which requires post-publish processing, and then click Edit.

The Term dialog box opens. The Term tab is the active tab.

Figure 13-72: Term dialog box, Term tab

3. On the Post Publish Enrollment dropdown list, select Actual, and then click OK.

The Term dialog box closes. You return to the Terms window with the term still selected.

4. Click Sync.

A Synchronizing progress dialog box opens. After the synchronization is complete, the Course Updates window opens. If the actual enrollment for a class violates the minimum or maximum capacity for its assigned room, then the course is displayed on the window with a Change Status of Room Capacity Violation. See Figure 13-73 on page 561.
5. To assign the course to a new room, click Assign; otherwise, go to Step 8.
   The Select A Room dialog box opens.

6. Specify your search criteria, and then click Next.
   A list of rooms that meets your search criteria is displayed. The list includes any TBD rooms that have been configured.

7. Select the room that is to be assigned to the new courses, and then click Finish.
   The Select a Room dialog box closes and you return to the Course Updates window with the new courses still selected.

8. Click Process.
   A message opens asking you if you are sure that you want to process the selected course date.

9. Click Yes.
   After processing is complete, the message closes and the courses are removed from the Course Updates window.

---

*If you did not assign a new room to the course, then clicking Process merely acknowledges the room violation. The course remains in its same room.*
Chapter 13
Academic Planning (EMS Campus)

Setting a Final Exam Schedule

At some point after a term has been published in EMS Campus, you must schedule the final exams for the term. EMS Campus provides the functionality to automate the final exam scheduling process using templates. You create a final exam schedule template based on all unique course schedule patterns (for example, MWF 9am-9:50am, TR 1pm-2:20pm, and so on), and their corresponding final exam days and times. In addition to creating a template, you have the flexibility to define common exams, specify the final exam schedules for specific courses, specify the final exam for multiple courses, and/or exclude certain courses from the final exam scheduling process.

Unless otherwise specified in Final Exam Settings, EMS Campus attempts to schedule the final exam for a course in the same room that the course has been using for the term. The final exam session publishing process adds the final exam as a separate booking in the course’s reservation.

To create a final exam schedule template

1. On the EMS Campus menu bar, click Academic Planning > Courses > Final Exam Schedule Templates.

The Final Exam Schedule Templates window opens. This window lists all the final exam schedule templates that are currently configured in your EMS database.

Figure 13-74: Final Exam Schedule Templates window
2. Click New.

The Final Exam Schedule Template dialog box opens. The Final Exam Schedule Template tab is the active tab.

*Figure 13-75: Final Exam Schedule Template dialog box, Final Exam Schedule Template tab*

3. In the Description field, enter a name or description for the final exam schedule template, for example, Fall Finals.

   The description can be a maximum of 50 characters, including spaces.

4. Open the Schedule tab.

*Figure 13-76: Final Exam Schedule Template dialog box, Schedule tab*
5. Continue to one of the following to create a list of unique course schedule patterns:
   - “To manually create a final exam schedule template” below.
   - “To import a term to create a final exam schedule template” on page 565.
   - “To import a file to create a final exam schedule template” on page 566.

To manually create a final exam schedule template

1. Click New.
   The Final Exam Schedule Days dialog box opens.

2. Enter the information for a unique course schedule pattern and the corresponding final exam day and time, and then click OK.
   The Final Exam Schedule Days dialog box closes. You return to the Schedule tab with the pattern displayed on the tab.

   *Figure 13-77: Final Exam Schedule Days dialog box (shown with information for a final exam schedule)*

3. Repeat this procedure as many times as needed to create a final exam schedule template for each unique course schedule pattern in the term.

4. Click OK on the Final Exam Schedule Template dialog box.
   The dialog box closes. You return to the Final Exam Schedule Templates window with the newly configured final exam schedule template automatically selected.

*If any meeting patterns are left without a corresponding final exam time, then courses that fit that meeting pattern in the term will not have a final exam scheduled for them.*
To import a term to create a final exam schedule template

1. Click Import, and on the dropdown list that opens, select Term.
   
   The Term Picker dialog box opens. The dialog box lists all the terms that are currently configured in your EMS database.

2. Select your Domain and Term for which you are creating the final exam schedule template, and then click OK.
   
   EMS scans the term and identifies unique meeting patterns to begin the template building process. After the import is complete, a message opens indicating this.

3. Click OK to close the message and return to the Schedule tab.
   
   The imported patterns are displayed on the Schedule tab.

4. Select an individual pattern, or CTRL-click to select multiple patterns, and then click Edit to open the Final Exam Schedule Days dialog box and assign the final exam day of the week and the final exam start and end times.

5. Click OK to close the Final Exam Schedule Days dialog box and return to the Schedule tab.

6. Click OK on the Final Exam Schedule Template dialog box.
   
   The dialog box closes. You return to the Final Exam Schedule Templates window with the newly configured final exam schedule template automatically selected.

If any meeting patterns are left without a corresponding final exam time, then courses that fit that meeting pattern in the term will not have a final exam scheduled for them.
To import a file to create a final exam schedule template

You can import your course schedule patterns from a tab-delimited text file. To view the import file specifications, on the Final Exam Schedule Templates window, click Print > Import Format.

See Appendix E, Import File Specifications in the EMS Setup Guide for a table that details the Course Schedule Patterns import file specifications.

Figure 13-79: Course Schedule Patterns import file format

<table>
<thead>
<tr>
<th>EMS Campus Demo</th>
<th>Final Exam Template Import Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>(import file must be tab delimited)</td>
<td></td>
</tr>
<tr>
<td>Sequence</td>
<td>Column</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
</tr>
<tr>
<td>1</td>
<td>Day Pattern</td>
</tr>
<tr>
<td>2</td>
<td>Start Time</td>
</tr>
<tr>
<td>3</td>
<td>End Time</td>
</tr>
<tr>
<td>4</td>
<td>Final Exam Day Of Week</td>
</tr>
<tr>
<td>5</td>
<td>Final Exam Start Time</td>
</tr>
<tr>
<td>6</td>
<td>Final Exam End Time</td>
</tr>
</tbody>
</table>

1. Click Import, and then on the dropdown list that opens, click File.
   The Open File dialog box opens.

2. Browse to and select the import file, and then click Open.
   The Open dialog box closes and the course schedule patterns are imported. After the import is complete, a message opens indicating this.

3. Click OK to close the message and return to the Schedule tab.
   The imported patterns are displayed on the Schedule tab.

4. Select an individual pattern, or CTRL-click to select multiple patterns, and then click Edit to open the Final Exam Schedule Days dialog box and assign the final exam day of the week and the final exam start and end times.

5. Click OK to close the Final Exam Schedule Days dialog box and return to the Schedule tab.

6. Click OK on the Final Exam Schedule Template dialog box.
   The dialog box closes. You return to the Final Exam Schedule Templates window with the newly configured final exam schedule template automatically selected.

If any meeting patterns are left without a corresponding final exam time, then courses that fit that meeting pattern in the term will not have a final exam scheduled for them.
To specify final exam settings for a specific course

1. Open the specific course in the Course Navigator through either the Academic Browser, the Academic Book, or the Navigator.

   Figure 13-80: Course opened in the Course Navigator

2. In the middle pane of the Navigator, select a course date record, and then click Edit.

   The Course Dates dialog box opens. The Course Dates tab is the active tab.

3. Open the Final Exam Settings tab.

   Figure 13-81: Course Dates dialog box, Final Exam Settings tab
4. Do any of the following:
   • If a final exam is not required for the course, then clear the Final Exam Required option, and go to Step 5.

   Typically, courses with multiple course dates, lab components, or short-term courses are marked as “No Exam Required.”

   • If the course is having a final exam at a day/time other than what is specified by the template (see “To create a final exam schedule template” on page 562), select Special/Common Exam, and then enter the date, and start and end times for the special/common exam.
   • Optionally, if you would like the seat fill percentage to be a different value than the default value, update the seat fill percentage for the exam.
   • If the exam is to take place in a different room (not the same room that the course has been using all semester), click the Search icon next to Room Required to open the Room Selector dialog box and select a different room for the exam.
   • If the exam is to take place in the same room that the course has been using all semester, then select Require Current Room.

   During publishing of the final exam session, if the same room is unavailable, EMS leaves the course unassigned for a manual search.

5. Optionally, in the Notes field, enter any information that is pertinent to the course or final exam.

6. Click OK.

   The Course Dates dialog box closes. You return to the Course Navigator with the course date still selected.
To specify final exam settings for multiple courses

1. On the EMS Campus menu bar, click Academic Planning > Courses > Academic Browser.
   
   The Academic Browser opens.

2. If needed, open the Filter tab.

   Figure 13-82: Academic Browser, Filter tab

3. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.

4. Set any other criteria (academic unit, subject, and so on) as needed to provide assistance in locating the courses for which you want to set preferences and requirements, and then click Get Data.
   
   The courses that meet your search criteria are displayed on the Results tab.

   For detailed information about searching with the Academic Browser, see “Searching with the Academic Browser” on page 579.

5. In the search results, CTRL-click to select the multiple courses for which you are setting the final exam schedule.

6. On the Tools menu, click Set Final Exam Settings.
   
   The Set Course Final Exam Settings dialog opens. See Figure 13-83 on page 570.
7. Do one of the following:
   - If a final exam is not required for the courses, then select Final Exam Not Required, and then go to Step 8.

   **Typically, courses with multiple course dates, lab components, or short-term courses are marked as “No Exam Required.”**

   - If the courses are having their final exams at a day/time other than what is specified by the template (see “To create a final exam schedule template” on page 562), select Special/Common Exam, and then enter the date, and start and end times for the special/common exam.

   **All the selected courses will meet at the date/time specified**

   - If the final exams for all the selected courses are to be in the same room, then select Common Exam Room.

   - If the exam/exams are to take place in a different room (not the same rooms that the courses have been using all semester), click the Search icon next to Room Required to open the Room Selector dialog box and select a different room for the exams.

   **All courses will meet in this room for the final exams.**
- If the exams are to take place in the same rooms that the courses have been using all semester, then select Require Current Room.

If no room is requested, or Require Current Room is selected, then each course will have the final exam in its own room. During publishing of the final exam session, if the same room is unavailable, EMS leaves the course unassigned for a manual search.

8. Optionally, do one or both of the following:
   - If you want the seat fill percentage to be a different value than the default value, update the seat fill percentage for the exam.
   - In the Notes field, enter any information that is pertinent to the course or final exam.

9. Click OK.

The Related Courses Dates dialog box opens. This dialog box lists all the courses that you selected on the Results tab of the Academic Browser.

*Figure 13-84: Related Course Dates dialog box*

10. Select the courses to which the final exam settings are to be applied, or click Select All to select all the courses in a single step, and then click OK.

A message opens indicating that any final exam settings that exist for the selected courses will be overwritten, and asking you if it is OK to continue.

11. Click Yes.

A second message opens indicating that the final exam settings were successfully set.

12. Click OK to close the second message and the Related Course Dates dialog box.

You return to the Results tab of the Academic Browser, with the courses still selected on the tab.
Chapter 13
Academic Planning (EMS Campus)

Publishing a Final Exam Session

After you have created the final exam schedule template for the term, and updated any final exam settings, you must publish the final exam session. Publishing a final exam session is a two part process. First, you must create a final exam session and specify a start date for the session. Second, you must then apply a final exam schedule template to the final exam session and then you can publish the session.

To create a final exam session

1. On the EMS Campus menu bar, select Academic Planning > Courses > Final Exam Sessions.

   The Final Exam Sessions window opens. The window lists all the final exam sessions that have been published in your EMS database.

   Figure 13-85: Final Exam Sessions window

2. On the Domain dropdown list, select the campus for which you are publishing the final exam session, and on the Term dropdown list, select the term.
3. Click New.

The Final Exam Session dialog box opens. The Final Exam Session tab is the active tab.

*Figure 13-86: Final Exam Session dialog box, Final Exam Session tab*

4. In the Description field, enter a name or description for the session, for example, Fall Finals 2011.

*The description can be a maximum of 30 characters, including spaces.*

5. Select a start date for the final exam session.

*The final exam session will start on this date. Use the final exam template day of the week to schedule specific final exam dates. EMS can accommodate up to a two week final exam session.*

6. Open the Rooms tab and select the rooms that are available to host final exams by doing the following:

   • On the Building dropdown list, select (all) buildings, or select a specific building, area, or view.
   
   • On the Room Type dropdown list, leave the default value of (all), or select a specific room type.
   
   • In the Available list, select the room, or CTRL-click to select multiple rooms, and then click the Move (>) button to move the rooms to the Selected list.

*If needed, you can repeat these steps for specific buildings until you have selected all the rooms in specific buildings that can host a final exam.*
7. Click OK.

The Final Exam Session dialog box closes. You return to the Final Exam Sessions window with the newly configured session automatically selected.

8. Continue to “To publish the final exam session” below.

To publish the final exam session

1. If you have not already done so, open the Final Exam Session dialog box and select the session that is to be published.

2. Click Publish.

The Final Exam Scheduling window opens. This window lists all the unique course schedule patterns for the term for which you are publishing the final exam session.

Figure 13-87: Final Exam Scheduling window

3. On the Schedule Template dropdown list, select the final exam template that is to be used for the term, and optionally select Ignore Room Capacity if you do not want EMS to consider room capacity when assigning final exam sessions.

The Final Exam Date, Final Exam Start, and Final Exam End columns are automatically populated based on the applied template.
4. If necessary, do one or more of the following:
   • Select a unique course schedule pattern and click Set Date to open the Final Exam Date dialog box and edit a pattern setting, or create a course schedule pattern that was not in the selected template.
   • Select a unique course schedule pattern and click Clear to clear the pattern setting, and then click Set Date to open the Final Exam Set dialog box and edit the pattern as needed.

5. Click Next.
   The Final Exam Scheduling window lists the summarizing information for any special/common exams that have been set for specific courses.

6. Optionally, select a course, and then click Open to view the course in the Course Navigator.

7. Click Finish.
   A message opens, indicating that you are about to publish the final exam schedule, and asking you if it is OK to continue.

8. Click Yes.
   The message closes. After the final exam session is published, a second message opens indicating this.

9. Click OK.
   The second message closes and the View Bookings window opens. By default, the window initially shows only those final exam bookings for which a room could not be scheduled.

*Figure 13-88: View Bookings window*
10. Optionally, do one or more or all of the following:
   • To view all final exam bookings, clear the Show Unassigned Only option.
   • To view a course in the Navigator, select the course, and then click Open.
   • To export the course list to a Microsoft Excel spreadsheet, click Export.

11. Click Close to close the View Bookings window and return to the Final Exam Sessions window.

The final exam session publishing process adds the final exam for each course as a separate booking in the course's reservation. After you publish a final exam session, you can find the final exam booking for a course by opening the course in the Navigator and expanding the reservation and scrolling to the bottom of the Reservation (left) pane, or to the bottom of the Bookings (lower right) pane. You can use the Final Exam Schedule report to review the final exam schedule or the Final Exam Settings report to view optional settings. (See “Generating Academic Reports” on page 601.) To open the View Bookings window again, click View on the Final Exam Sessions window. If you delete a final exam session, then all final exam bookings that are associated with the session are deleted.
Using the Academic Tools

Section Contents

- Searching with the Academic Browser on page 579
- Using the Academic Book on page 586
- Using the Course Navigator on page 594
- Using the Search for Rooms Tool on page 598
Chapter 13
Academic Planning (EMS Campus)
Searching with the Academic Browser

You can use the Academic Browser to search for courses or course dates. The results are displayed in a list view. When you carry out a search in the Academic Browser, you can carry out a basic search or an advanced search. A basic search is based on the basic information that you specify for a course when you first create it, such as the domain, the term, the academic unit, the subject, and so on. An advanced search is a field level search that is carried out at the course level, the course dates level, or the preference level or for published terms, at the reservation, booking or booking detail levels. For example, in an advanced search, you can specify criteria as granular as “courses with credit hours greater than 3.0.” After the search results are returned, you have a variety of options for working with the results, including sorting and grouping information or using the Tools menu to perform functions. The actions that you can carry out in the Academic Browser depend upon the mode (Read Only, Define and Edit Courses, or Set Preferences) that is enabled for the academic term with which you are working in EMS Campus.

To carry out a search in the Academic Browser

1. Do one of the following to open the Academic Browser:
   - On the EMS Campus toolbar, click the Academic Browser icon.
   - On the EMS Campus menu bar, click Academic Planning > Configuration > Academic Browser.

   The first time that the Academic Browser window opens, the Filter tab is set by default to a basic search; otherwise, the Filter tab is set to the search type (Basic or Advanced) that you last carried out.

   Figure 13-89: Academic Browser, Basic Search options

   ![Academic Browser, Basic Search options](image.jpg)
2. Click the Basic/Advanced toggle to select the type of search that is to be carried out, and then continue to one of the following:
   - “To carry out a basic search in the Academic Browser” below.
   - “To carry out an advanced search in the Academic Browser” on page 582.

To carry out a basic search in the Academic Browser

1. On the Browse For dropdown list, select the item for which to search.
2. Enter the search criteria.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>The domain for the course or course date.</td>
</tr>
<tr>
<td>Term</td>
<td>The term for the course or course date.</td>
</tr>
<tr>
<td>Scenario</td>
<td>Displays results for the specific optimization scenario selected. The “SIS” scenario displays room assignment information from your SIS.</td>
</tr>
<tr>
<td>Academic Unit</td>
<td>The academic unit for the course or course date.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject for the course or course date.</td>
</tr>
<tr>
<td>Instructor</td>
<td>The instructor for the course or course date.</td>
</tr>
<tr>
<td>Preferences Exist</td>
<td>Used to identify the rooms for the courses/course dates that have/do not have room preferences/requirements specified.</td>
</tr>
<tr>
<td>edited Courses Only</td>
<td>Used during the Define and Edit mode to identify courses or course dates that have changed (new, canceled, and/or edited courses/course dates).</td>
</tr>
</tbody>
</table>

3. Optionally, click Options and edit the default value for the additional search option Number of Records to Return.
4. Click Get Data or Refresh.

The search results are displayed on the Results tab. If you have searched for courses, then the results include courses without course dates (meeting patterns). “Multiple” is displayed for those courses with more than one course date. If you have searched for course dates, courses without course dates are suppressed while courses with multiple meeting patterns are expanded. EMS schedules rooms only for courses with course dates. See Figure 13-91 on page 582.
5. Optionally, do one or more of the following:

- The Results tab is an EMS browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this tab.
- To open a course in the Course Navigator, double-click the course entry on the Results tab.
- Click Print to print the search results.
- Click Export to export the search results to a Microsoft Excel spreadsheet.
- In Define & Edit mode or Dual mode, use the New Course and New Section options as needed.
- Select a course, or CTRL-click to select multiple courses, and depending on the mode, the following options are available on the Tools menu:
  - Set Preferences mode—Set Course Preferences (see “Specifying Room Preferences/Requirements” on page 491) and Clear Course Preferences. Click Clear Course Preferences to clear all the current preferences/requirements for the selected courses in a single step.
  - All Modes (including Read Only)—Shares Space, Does Not Share Space, Change Shares Space Parent (see “Working with Shared Space” on page 475) and Set Final Exam Settings. (See “Setting a Final Exam Schedule” on page 562.)
• All Modes (including Read Only)—Unsync Selected Courses, which deletes the selected course records and the corresponding reservations and bookings from EMS.

You should use this option sparingly; however, it might be required post-publish if an error occurred in your SIS or during publish.

• In the Browse For field, select a different item for which to search. The Results tab is refreshed with the search results based on the item that you selected and the search criteria on the Filter tab.
• Click Filter to return to the Filter tab, make any necessary changes to the search criteria and repeat the search.
• Click Refresh to requery the database based on the current search criteria.

6. Click Close.

Any changes that you made to the search results columns (position, width, and so on) remain in effect for any other searches that you carry out. To reset the columns to their default values, see “Resetting Column Settings” on page 408.

To carry out an advanced search in the Academic Browser

Figure 13-91: Browser window, Advanced search options

1. On the Browse For dropdown list, select the item for which to search.
2. Select a domain, term, and/or scenario to search.
3. For each field level option by which to carry out the search:
   • Select the field level option, and then click the Move button (>).

   To filter the list of available fields, in the Field Search field, enter a search string. Your search is limited to the exact order of the characters in the string, but the string is not case-sensitive and it can appear anywhere in the search results. For example, a search string of add returns Added by, Date Added, and Group Address Line 1. The list of fields that meets your search criteria is dynamically updated as you enter your search criteria.

   • When prompted, enter a value or define the limits for the option, and then click OK. The option is moved to the Filter Summary list.

   If you have specific fields and/or values by which you always want to carry out a search, then you can set up these fields to be your Favorite fields. See “To set up favorite fields for an Academic Browser search” on page 585.

   To view a selected field option in its entirety in the Filter Summary list, rest the mouse pointer on the entry. A tooltip showing the complete field option information opens.

   Figure 13-92: Viewing a selected field option in the Filter Summary list

4. Optionally, click Options and edit the default value for the additional search option Number of Records to Return.

5. Click Get Data or Refresh.

   The search results are displayed on the Results tab. If you have searched for courses, then the results include courses without course dates (meeting patterns). “Multiple” is displayed for those courses with more than one course date. If you have searched for course dates, courses without course dates are suppressed while courses with multiple meeting patterns are expanded. EMS schedules rooms only for courses with course dates. See Figure 13-93 on page 584.
6. Optionally, do one or more of the following:

   • The Results tab is an EMS browser window. See “An EMS Browser Window” on page 35 for all the features that are available for this tab.

   • To open a course in the Course Navigator, double-click the course entry on the Results tab.

   • Click Print to print the search results.

   • Click Export to export the search results to a Microsoft Excel spreadsheet.

   • In Define & Edit mode or Dual mode, use the New Course and New Section options as needed.

   • Select a course, or CTRL-click to select multiple courses, and depending on the mode, the following options are available on the Tools menu:

       • Set Preferences mode—Set Course Preferences (see “Specifying Room Preferences/Requirements” on page 491) and Clear Course Preferences. Click Clear Course Preferences to clear all the current preferences/requirements for the selected courses in a single step.

       • All Modes (including Read Only)—Shares Space, Does Not Share Space, Change Shares Space Parent (see “Working with Shared Space” on page 475) and Set Final Exam Settings. (See “Setting a Final Exam Schedule” on page 562.)
• All Modes (including Read Only)—Unsync Selected Courses, which deletes the selected course records and the corresponding reservations and bookings from EMS.

You should use this option sparingly; however, it might be required post-publish if an error occurred in your SIS or during publish.

• In the Browse for field, select a different item for which to search. The Results tab is refreshed with the search results based on the item that you selected and the search criteria on the Filter tab.

• Click Filter to return to the Filter tab, make any necessary changes to the search criteria and repeat the search.

• Click Refresh to requery the database based on the current search criteria.

7. Click Close.

Any changes that you made to the search results columns (position, width, and so on) remain in effect for any other searches that you carry out. To reset the columns to their default values, see “Resetting Column Settings” on page 408.

To set up favorite fields for an Academic Browser search

If you have specific fields and/or values by which you always want to carry out an Academic Browser search, you do not have to filter the list of fields on the All Fields tab for every search. Instead, you can set up each of these fields to be a favorite field with a specific value or limit if needed.

1. Open the Academic Browser, and make sure that the Advanced search features are displayed.

2. For each field that you are setting up as favorite field, select the field on the All Fields tab, and then click Add to Favorites.

   The field is added to the Favorite Fields tab.

3. Optionally, after you define a value or define the limits for a field, click Save Value on the Filter dialog box.

   The next time that you carry out a search, you can simply open the Favorite Fields tab or the Saved Values tab to carry out a search based on your customized list of search fields.
Chapter 13
Academic Planning (EMS Campus)

Using the Academic Book

The Academic Book provides a week-at-a-glance graphical view of the courses that are assigned to a specific room or instructor. The view is for one room at a time as opposed to the Reservation Book, which shows all rooms one day at a time. The Academic Book shows only classes during the Planning phase of academic scheduling, but it shows both classes and events post-publish. To open the Academic Book, do one of the following:

- On the EMS Campus toolbar, click the Academic Book icon.
- On the EMS Campus menu bar, click Academic Planning > Courses > Academic Book.

![Academic Book](image)

When the Academic Book first opens, if you are working with a future term, then the date is set to the first Sunday or Monday of a full week of the term; otherwise, if you are working with a current term, then the date is set to the first Sunday or Monday of the current week.

*Whether the date is set to Sunday or Monday is determined by the setting for the Day Label - First Day of the Week EMS system parameter. See the EMS Setup Guide.*
In both cases, the display is filtered by Room and Building. You have many options for changing the view in the Academic Book to better meet your working needs, including:

- Changing the display date. See “To change the date display” below.
- Changing the view of courses by room. See “To change the view of courses by room” on page 588.
- Changing the view of courses by instructor. See “To change the view of courses by instructor” on page 589.
- Setting options that specify such things as what is displayed in the book when it first opens, mouse actions in the book, what information is displayed in course tooltips, and so on. See “To set options for the Academic Book” on page 590.
- Opening a course in the Course Navigator. See “To open a course in the Course Navigator” on page 592.
- Displaying the details for a room. See “To display the details for a room” on page 593.

To change the date display

- On the Date field, click the dropdown arrow to open the Calendar. Use the scroll features (< and >) at the top of the calendar to change the month or year. To select a different date for a month, click the date.

  Figure 13-95: Academic Book calendar

  ![Calendar](image)

  You can also manually enter a new date into the field. In all cases, the date that you choose specifies the start of the week that you are viewing. To view a full week, always select a Sunday or a Monday.

- Use the scroll features at the top of the reservation book display to scroll to a different day, week, month, year, or any different combination of these.

  Figure 13-96: Academic Book calendar scroll features

  ![Scroll Features](image)
To change the view of courses by room

If the Academic Book is in the Room view, then the default minimum and/or maximum capacities that have been configured for a room are displayed next to the room. To change the view of courses by room, change any and all of the available display options—Domain, Term, Scenario (SIS by default or an Optimization scenario if optimization has taken place), the Building/Domain/View, and/or the Time Zone.

*Figure 13-97: Academic Book, courses grouped by room*
To change the view of courses by instructor

To change the view of courses by Instructor, click Instructor, and then, change any and all of the available display options—Domain, Term, Subject, and/or Time Zone. To filter the list by a specific instructor, enter a search string in the Name field, and then click Go. Click the name of an instructor in the left pane to see a list of courses that are scheduled for the instructor.

---

Your search is limited to the exact order of the characters in the string, but the search is not case-sensitive and it can appear anywhere in the search results. For example, a search string of and returns Anderson, Scott, Sanders, Barry, and so on.

---

Figure 13-98: Academic Book, courses grouped by instructor
To set options for the Academic Book

Click Options in the upper right hand corner of the Academic Book to open the Academic Book options dialog box. You use the options on this dialog box to specify such things as what is to be displayed in the book when it first opens, mouse actions in the book, and so on.

Figure 13-99: Academic Book Options dialog box, General tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General tab</strong></td>
<td></td>
</tr>
<tr>
<td>Start Hour</td>
<td>The starting time for the Time grid that is displayed in the Academic Book.</td>
</tr>
<tr>
<td>Display</td>
<td>• Event Name/Course—Display the event name/course in the course entry.</td>
</tr>
<tr>
<td></td>
<td>• Setup Type—Show the setup type and count in the course entry.</td>
</tr>
<tr>
<td></td>
<td>• Group/Instructor—Show the group name/instructor name in the course entry.</td>
</tr>
<tr>
<td>Published Booking Colors Based On</td>
<td>For published courses, whether the fill color for a course entry is to be</td>
</tr>
<tr>
<td></td>
<td>based on the Status color palette or on the Event Type color palette that</td>
</tr>
<tr>
<td></td>
<td>has been determined in Configuration.</td>
</tr>
<tr>
<td>Rooms Without Bookings</td>
<td>The color with which rooms without bookings are highlighted in the</td>
</tr>
<tr>
<td></td>
<td>Academic Book.</td>
</tr>
</tbody>
</table>
### Chapter 13

**Academic Planning (EMS Campus)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Room Display                | • Room Code—Show the room code in the Room list when the courses are grouped by room.  
                              | • Room Description—Show the room description in the Room list when the course are grouped by room.                                           |
| Building Display            | • Building Code—Show the building code in the Rooms list when the courses are grouped by room.                                             
                              | • Building Description—Show the building description in the Rooms list when the course are grouped by room.                                |
| Go to Today on Startup      | Not applicable.                                                                                                                             |
| Always Prompt for Building on Startup | Opens the Building dropdown list when the Academic Book first opens, which requires that you select a building, domain, or view before you can continue, as opposed to simply opening the building that you last viewed in the Academic Book. |
| Show (all) in Building list | Make (all) buildings an available option in the Building dropdown list, as opposed to having to choose a single building.                                      |
| Show Building in Instructor Bookings | Show the Building Code in the course entry when courses are grouped by instructor (space permitting).                                                                 |
| Show Room in Instructor Bookings | Show the Room Code in the course entry when courses are grouped by instructor (space permitting).                                                                 |

**Tooltip Display (Unpublished)**—Select the information that is to be displayed when the mouse pointer is placed on the entry for an unpublished course in the Academic Book.

**Tooltip Display (Published)**—Select the information that is to be displayed when the mouse pointer is placed on the entry for a published course in the Academic Book.

*Figure 13-100: Tooltip for a course entry in the Academic Book*
Chapter 13
Academic Planning (EMS Campus)

To open a course in the Course Navigator

- Double-click a course entry for a *non-published* course in the Academic Book to open the course in the Course Navigator.
- Double-click a course entry for a *published* course in the Academic Book to open the course in the Navigator, select the course on the Course Info tab, and then click Course to open the course in the Course Navigator.

For detailed information about working with the Course Navigator, see “Using the Course Navigator” on page 594.

*Figure 13-101: Course opened in the Course Navigator*
To display the details for a room

To display details about a room, make sure that the Academic Book is in the Rooms view, and then right-click on any room in the Rooms list to open a Room Info dialog box that provides the following information on the appropriate tabs—the bookings for the room, the properties for the room, the pricing for the room, any images of the room and any user defined fields (UDFs) that are associated with the room.

*Figure 13-102: Room Info dialog box*
Chapter 13
Academic Planning (EMS Campus)

Using the Course Navigator

The Course Navigator is a window in EMS Campus that you use to view and manage all aspects of a course. You can access the Course Navigator from the Academic Browser, the Academic Book, and the EMS Navigator. Different tabs and panes on the Course Navigator provide different information about a course and course dates. The actions that you can carry out in the Course Navigator depend upon the mode (Read Only, Define and Edit Courses, Set Preferences, or Dual) that is enabled for the academic term with which you are working in EMS Campus.

To access the Course Navigator

- To access the Course Navigator from the Academic Browser, for an unpublished course, double-click the course in the search results to open the course in the Course Navigator.

- To access the Course Navigator from the Academic Book, for a published course, double-click the course entry in the Academic Book to open the course in the Navigator, and then click Course on the Course Info tab to open the course in the Course Navigator.

- To access the Course Navigator from the EMS Navigator, do the following in the order indicated:
  - On the toolbar, click the Navigator icon to open the Open Navigator dialog box.
  - On the Open dropdown list, select Course to open a Domain dropdown list and a Term dropdown list.

Figure 13-103: Open Navigator dialog box

- Select a domain and a term.
- In the CRN field, enter the CRN (course reference number) for the course.
• Click OK.
  • If the course is a non-published course, then the course opens in the Course Navigator.
  • If the course is a published course, then the course opens in the Navigator. Select the course on the Course Info tab, and then click Course to open the Course in the Course Navigator.

Course Navigator window layout

*Figure 13-104: Course Navigator*

The top pane of the Course Navigator displays information about a selected course—the course title, the course term, the current course state (New, Edit, Unchanged, or Cancelled), and so on. The middle pane of the Course Navigator displays information about each of the course dates for the course. To view the indicated information for a course date, select a course date in the middle pane of the Course Navigator, and then open the appropriate tab (Dates, User Defined Fields, Shares Spaces, Preferences, or Final Exam Settings). The History tabs in the middle and lower pane provide audit information for course records and
course date records. To view changes made to *course-level* information, open the History tab in the *middle* pane of the Course Navigator. To view changes made to *course date-level* information, select a course date in the middle pane, and then open the History tab in the *bottom* pane of the Course Navigator.
Available Actions in the Course Navigator

The actions that you can carry out in the Course Navigator depend upon the mode (Read Only, Define and Edit Courses, Set Preferences) that is enabled for the academic term with which you are currently working with in EMS Campus.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Available Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The default mode in which the Navigator is placed if you have not selected any other mode. No actions are available.</td>
</tr>
</tbody>
</table>
| Define and Edit | • Add course dates  
• Edit a course  
• Edit course dates  
• Cancel course dates  
• Cancel courses  
**Note:** These changes require an update in the SIS. See “Enabling/Disabling a Term for Define & Edit Mode” on page 458 for more information. |
| Set Preferences | Set preferences for a course on a course date by course date basis.               |
Chapter 13
Academic Planning (EMS Campus)

Using the Search for Rooms Tool

After you publish a term, there are times when you need to identify which rooms are available for a particular meeting pattern and set of criteria. For example, an academic unit might need to add a new section for a course or an instructor might be looking to change the times for a course. The Search for Rooms tool significantly simplifies the process of searching for classrooms in these situations.

To search for rooms using the Search for Rooms tool

1. On the EMS Campus menu bar, click Academic Planning > Courses > Search For Rooms.
   
   The Search For Rooms dialog box opens.

   *Figure 13-105: Search For Rooms dialog box*

2. On the Domain dropdown list, select the appropriate domain and on the Term dropdown list, select the appropriate term.
3. Do one of the following:

- Manually enter the meeting pattern information (start and end dates, start and end times, and meeting days) for the course.
- Click Time Blocks to open the Time Blocks dialog box, and then select a time block from a list of time blocks that have been made available for the term.

4. Enter your search criteria.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Building</td>
<td>The default value is (no preference). You can select a specific building, area, or view.</td>
</tr>
<tr>
<td>Room Type</td>
<td>The default value is (no preference), but you can select from a list of pre-configured types.</td>
</tr>
<tr>
<td>Enrollment Ignore Room Capacity</td>
<td>Available only if Ignore Room Capacity is not selected. You can enter a specific room capacity by which to search.</td>
</tr>
<tr>
<td>Ignore Term Excluded Dates</td>
<td>Not selected by default. Select this option to search for rooms that are available even on dates that have been marked as “Excluded” for the term.</td>
</tr>
</tbody>
</table>

5. In the Available list, select the feature, or CTRL-click to select the multiple features that the rooms are to have, and then click the Move button (>) to move the selected features to the Selected list.

6. Click Next.

The Search for Rooms dialog box opens with up to three tabs displayed:

- Available Rooms tab. By default, the Available tab is always displayed and it is always the active tab. This tab displays all the rooms that meet all your search criteria.
- Academic Conflicts tab. The Academic Conflicts tab is displayed only if there are rooms that meet all your search criteria but they are in academic conflict (a course has already been scheduled in a room for the selected day and time pattern). Optionally, you can open the Academic Conflicts tab to view the list of rooms that are in academic conflict.
- Event Conflicts tab. The Event Conflicts tab is displayed only if there are rooms that meet all your search criteria but they are in event conflict (a non-academic event has already been scheduled in a room for the selected day and time pattern). Optionally, you can open the Event Conflicts tab to view the list of rooms that are in event conflict.

See Figure 13-106 on page 600.
7. Optionally, you can do one or more or all of the following on this tab:

- Use the Scroll feature to scroll the list of available rooms, and then click Close to close the dialog box.
- Click Previous to return to the Search For Rooms dialog box, modify your search criteria, and repeat the search.
- Click Print to open an onscreen preview of the list of available rooms. The preview window contains options for printing a hard copy of the room list, emailing the list, and so on.

Figure 13-107: Onscreen preview of the Available Rooms list
Generating Academic Reports

For any academic report, you can specify the parameters, options, and format for the report, or you can generate the report according to memorized settings. (For detailed information about a memorized report, see “Working with Memorized Reports” on page 323.) Not all reports require the same parameters, nor do they all have the same options available. In addition, you can generate different reports in different formats.

All subjects must belong to an academic unit to be displayed on an academic report. Refer to the EMS Setup Guide for detailed information about configuring academic units and synchronizing subjects.

To generate an academic report

1. On the EMS Campus menu bar, click Academic Planning > Reports to open the Reports menu, and then click the option for the report that you are generating. For example, to generate the Course List report, click Academic Planning > Reports > Course List.

All academic reports are also available under Reports > Academic Planning.

2. On the Setup dropdown list, do one of the following:
   • To generate the report according to the filter settings that you want (parameters, options, and so on), leave user-specified selected, then go to Step 3.

   For brevity and ease, the parameters that are available for each report are not detailed in this section. If you need help with generating any of these reports, contact your EMS administrator.

   • To run the report with filter settings that have been saved, or memorized, select the memorized report, and then go to Step 4.

   For detailed information about memorized reports, see “Working with Memorized Reports” on page 323.
3. Specify the report parameters, options, and format. See:

| “Instructor Summary” on page 606. | “Prime Time Usage” on page 609. |  |

4. Optionally, do one or more or all of the following:
   - In the Report Comment field, enter a comment that is to be printed on the report.

   The comment can be a maximum of 255 characters, including spaces.

   - Click Print Preview.
     A preview of the report opens onscreen.
   - To print a hard copy of the report, specify the number of copies that you are printing, and then click Print.

5. Click Close.

Unless you change the setup, all subsequent reports will be generated and printed according to the parameters and options that you have specified and in the format that you specified. If you want to save certain settings so that you do not have to adjust the filter settings every time you run the report, you can memorize the report. (See “Working with Memorized Reports” on page 323.)
## Course List

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Provides a list of courses and course dates. Note: This report is often sent out to academic units for review when the Domain Scheduler is finished with room assignments. | There are options to include courses without room assignments and to print User Defined Fields that are associated with courses. Formats include:  
• By Course  
• By Instructor  
• By Academic Department By Course  
• By Academic Department By Instructor  
• By Day of Week  
• By Location  
• By Estimated Enrollment  
• By Start Time  
• By Subject  
• By Course Type |
Course Changes

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used during Define and Edit Mode to capture changes made by the academic units to courses and course dates so that the Domain Scheduler can data enter these changes into the SIS.</td>
<td>▪ Show Changes</td>
</tr>
<tr>
<td></td>
<td>▪ All Changes For Term—If selected, all changes for the term (even changes that have possibly already been data-entered into the SIS) are included in the report.</td>
</tr>
<tr>
<td></td>
<td>▪ *Changes Since Last Synchronization—If selected, the report includes only changes that have been made since the last time that the term was synchronized.</td>
</tr>
<tr>
<td></td>
<td>▪ Show Room Changes—If selected, the report includes changes to rooms (post-publish only).</td>
</tr>
<tr>
<td></td>
<td>▪ Show Cancelled Courses Only—If selected, the report includes only cancellations.</td>
</tr>
<tr>
<td></td>
<td>▪ Show New Courses Only—If selected, the report includes only new courses.</td>
</tr>
<tr>
<td></td>
<td>▪ Show Edited Courses Only—If selected, the report includes only changes.</td>
</tr>
<tr>
<td></td>
<td>▪ Show Latest Changes Only—If this option is selected, and a single value has been changed multiple times, the report includes only the most recent change for the field.</td>
</tr>
<tr>
<td></td>
<td>▪ Hide Change Details—If selected, audit trail details are hidden on the report.</td>
</tr>
<tr>
<td></td>
<td>▪ Show All Courses—If selected, all courses, even those without changes, are shown in the report.</td>
</tr>
<tr>
<td></td>
<td>▪ Show User Defined Fields—If selected, the report includes any user defined fields that have been completed.</td>
</tr>
<tr>
<td></td>
<td>▪ *Show Notes—If selected, any user-supplied notes are shown in the report.</td>
</tr>
<tr>
<td><strong>Note:</strong> The options that are marked with an asterisk (*) are the recommended options for the most inclusive reports.</td>
<td></td>
</tr>
</tbody>
</table>
# Course Preferences

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used after Set Preferences mode to provide a list of courses and course dates with their preferences and requirements.</td>
<td>Format Choices:</td>
</tr>
<tr>
<td></td>
<td>• By Course</td>
</tr>
<tr>
<td></td>
<td>• By Academic Department By Course</td>
</tr>
<tr>
<td></td>
<td>• By Academic Department by Instructor</td>
</tr>
</tbody>
</table>

# Preferences Summary

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>After running an optimization scenario, this report is used to summarize the following information:</td>
<td>N/A</td>
</tr>
<tr>
<td>• The number of each type of preference or requirement.</td>
<td></td>
</tr>
<tr>
<td>• The number of the preferences that can be met from the optimization process.</td>
<td></td>
</tr>
<tr>
<td>• The number of preferences that cannot be met from the optimization process.</td>
<td></td>
</tr>
<tr>
<td>You can generate this report for each different scenario that was optimized.</td>
<td></td>
</tr>
</tbody>
</table>

# Unmet Preferences

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>After running an optimization scenario, this report is used to list the courses that had preferences or requirements that were not met during the optimization process. You can generate this report for each different scenario that was optimized.</td>
<td>Format Choices:</td>
</tr>
<tr>
<td></td>
<td>• By Course</td>
</tr>
<tr>
<td></td>
<td>• By Academic Department By Course</td>
</tr>
<tr>
<td></td>
<td>• By Academic Department by Instructor</td>
</tr>
</tbody>
</table>
### Instructor Back to Back

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists the courses that have instructors who are scheduled to teach two</td>
<td>• The days of the week that are to be included in the</td>
</tr>
<tr>
<td>courses at the same time (Conflicts) and instructors who are teaching</td>
<td>instructor’s schedule.</td>
</tr>
<tr>
<td>back to back in different locations within the time gap that is specified</td>
<td>• The time gap (in minutes) between classes on the specified</td>
</tr>
<tr>
<td>in Options.</td>
<td>days that determines “back to back.”</td>
</tr>
</tbody>
</table>

### Instructor Summary

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>This report includes the following values per instructor:</td>
<td>N/A</td>
</tr>
<tr>
<td>• Number of sections.</td>
<td></td>
</tr>
<tr>
<td>• Number of teaching hours.</td>
<td></td>
</tr>
<tr>
<td>• Number of credit hours.</td>
<td></td>
</tr>
<tr>
<td>• Total estimated enrollment.</td>
<td></td>
</tr>
<tr>
<td>• Total actual enrollment.</td>
<td></td>
</tr>
<tr>
<td>• Number of sections in Prime Time.</td>
<td></td>
</tr>
<tr>
<td>• Number of Time Block violations.</td>
<td></td>
</tr>
</tbody>
</table>
### Time Block Violations

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists the courses that are in violation of the Time Block template. In the Summary format, the following values are included:</td>
<td>• Format options:</td>
</tr>
<tr>
<td>• Total number of course dates</td>
<td>• By Course</td>
</tr>
<tr>
<td>• Total in violation</td>
<td>• By Instructor</td>
</tr>
<tr>
<td>• Percent in violation</td>
<td>• By Academic Unit By Course</td>
</tr>
<tr>
<td>• Total that meet the Time Block template</td>
<td>• By Academic Unit By Instructor</td>
</tr>
<tr>
<td>• Percent that meet the Time Block template</td>
<td>• Summary</td>
</tr>
<tr>
<td>• Percent of total violations per academic unit</td>
<td>• Chart - Violation Count</td>
</tr>
<tr>
<td></td>
<td>• Chart - Violation Totals</td>
</tr>
<tr>
<td></td>
<td>• Show All Courses</td>
</tr>
<tr>
<td></td>
<td>• Include Courses Not Assigned To Rooms</td>
</tr>
<tr>
<td></td>
<td>• Show User Defined Fields</td>
</tr>
</tbody>
</table>

### Time Block Room Availability/Usage

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the number of rooms that are either available or in use for each room size (Small, Medium, or Large) for each time block.</td>
<td>• Format options:</td>
</tr>
<tr>
<td><strong>Note:</strong> To generate this report, a Time Block template must be indicated on the term.</td>
<td>• Availability</td>
</tr>
<tr>
<td></td>
<td>• Usage</td>
</tr>
<tr>
<td></td>
<td>• Indicate Low Availability and High Availability Thresholds</td>
</tr>
<tr>
<td></td>
<td>• Include All Active Scenarios in other Domains</td>
</tr>
</tbody>
</table>
Chapter 13
Academic Planning (EMS Campus)

Academic Class Meeting Utilization

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used after publishing to view the percent utilization of your rooms based on the number of class meetings that you specify. For instance, if you hold 50 minute courses from 8:00 - 5:00 (9 meetings) and have one evening course from 6:00 - 9:00 (1 meeting) Monday through Friday (x5), you would have 50 class meetings per week.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Classroom Utilization

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Used to analyze the percent that your rooms are utilized compared to a number of hours and the percentage of seats full (selected enrollment compared to room capacity).  
  **Note:** In Manage Terms, you can specify either estimated enrollment or actual enrollment. The value that you selected is the value that is used to calculate the values for this report. | • Format Options:  
  • Detail  
  • Chart - By Building  
  • Chart - By Room Type  
  • Chart - By Room Size  
  • The days of the week that are to be included in the report  
  • The Hours Per Day that are to be considered  
  • Include All Active Scenarios in other Domains |

Hourly Classroom Utilization

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Calculates the percent that a room is used during each hour of the day. Formats include detailed (percent for each hour of each room specified) and chart (a chart of each hour for overall). | • Format Options:  
  • Detail  
  • Chart  
  • The days of week that are to be reviewed  
  • Include All Active Scenarios in other Domains |
### Over/Under Utilization

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays those courses that have an adjusted enrollment that is either over the maximum capacity for the room or under the minimum capacity for the room and seat fill.</td>
<td>To show or not to Show All Courses (regardless if they fall outside capacity thresholds)</td>
</tr>
<tr>
<td><strong>Note:</strong> In Manage Terms, you can specify either estimated enrollment or actual enrollment. The value that you selected is the value that is used to calculate the values for this report.</td>
<td></td>
</tr>
</tbody>
</table>

### Prime Time Usage

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>This report displays the number of sections (course dates) with room assignments that fall within the specified time range (Prime Time) or that have been indicated as Prime Time on the Time Block template.</td>
<td>• Format options:</td>
<td>• Include courses that have not been assigned into a room</td>
</tr>
<tr>
<td><strong>Note:</strong> In Manage Terms, you can specify either estimated enrollment or actual enrollment. The value that you selected is the value that is used to calculate the values for this report.</td>
<td>• Detail</td>
<td>• The days of the week that are to be included in the report</td>
</tr>
<tr>
<td></td>
<td>• Chart - Sections</td>
<td>• Chart - Class Meetings</td>
</tr>
<tr>
<td></td>
<td>• Chart - Class Hours</td>
<td></td>
</tr>
</tbody>
</table>
## Academic Unit Statistics

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the following statistics for course dates that have been scheduled into rooms:</td>
<td>• Format options:</td>
</tr>
<tr>
<td>• Number of sections per unit</td>
<td>• By Academic Unit</td>
</tr>
<tr>
<td>• Percentage of the total sections</td>
<td>• By Academic Time Block</td>
</tr>
<tr>
<td>• Number of class meetings</td>
<td>• The days of the week that are to be included in the report</td>
</tr>
<tr>
<td>• Percentage of the total class meetings</td>
<td>• Include course dates that have not been assigned into a room</td>
</tr>
<tr>
<td>• Number of class hours</td>
<td></td>
</tr>
<tr>
<td>• Percentage of class hours</td>
<td></td>
</tr>
<tr>
<td>• Average estimated enrollment</td>
<td></td>
</tr>
<tr>
<td>• Average actual enrollment</td>
<td></td>
</tr>
<tr>
<td>• Average seat fill</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> In Manage Terms, you can specify either estimated enrollment or actual enrollment. The value that you selected is the value that is used to calculate the values for this report.</td>
<td></td>
</tr>
</tbody>
</table>

## Course Type Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the following statistics indicated by course type:</td>
<td>• Format options:</td>
</tr>
<tr>
<td>• Number of sections</td>
<td>• Detail</td>
</tr>
<tr>
<td>• Percentage of the total sections</td>
<td>• Chart - Sections</td>
</tr>
<tr>
<td>• Number of class meetings</td>
<td>• Chart - Class Meetings</td>
</tr>
<tr>
<td>• Percentage of the total class meetings</td>
<td>• Chart - Class Hours</td>
</tr>
<tr>
<td>• Number of class hours</td>
<td>• Chart - Actual Enrollment</td>
</tr>
<tr>
<td>• Percentage of class hours</td>
<td>• The days of the week that are to be included in the report</td>
</tr>
<tr>
<td>• Average estimated enrollment</td>
<td>• Include course dates that have not been assigned into a room</td>
</tr>
<tr>
<td>• Average actual enrollment</td>
<td></td>
</tr>
</tbody>
</table>
## Final Exam Settings

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Outlines any final exam settings that are marked on courses for preparation of publishing the final exam schedule. | • Show All Courses - Displays all courses and their corresponding settings  
• Show Final Exam Not Required - Limits the report to those courses that had “No Exam Required” specified  
• Show Special/Common Exams - Limits the report to only those courses with special/common exams settings |

## Final Exam Schedule

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
</table>
| Displays a list of courses with the corresponding final exam date, time, and room as assigned by the final exam session. | • All Assigned - All courses that have been assigned to a room by the final exam session  
• Different Rooms - All courses that have been scheduled in room that was not the same that was used all semester for the course for the final exam  
• Unassigned - All courses that have not been scheduled in a room for the final exam  
• Final Exam Not Scheduled - All courses for which no final exam was scheduled |
**Trend Report**

<table>
<thead>
<tr>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows how the following statistics are trending term by term:</td>
<td>• Format options:</td>
</tr>
<tr>
<td>• Percent utilization</td>
<td>• By Term</td>
</tr>
<tr>
<td>• Percent estimated seat fill</td>
<td>• By Term By Academic Unit</td>
</tr>
<tr>
<td>• Percent actual seat fill</td>
<td>• Chart</td>
</tr>
<tr>
<td>• Percent sections in Prime Time</td>
<td>• The days of the week that are to be included in the report</td>
</tr>
<tr>
<td>• Percent sections over maximum capacity</td>
<td>• The number of hours per day that are to be used to calculate utilization</td>
</tr>
<tr>
<td>• Percent sections under minimum capacity</td>
<td>• Include course dates that have not been assigned into a room</td>
</tr>
<tr>
<td>• Percent Time Block violations</td>
<td></td>
</tr>
</tbody>
</table>
Index

A

academic term
see term

Academic Book
accessing the Course Navigator from ........................................... 594
using to view courses by room or instructor .............................. 586

Academic Browser
accessing the Course Navigator from ........................................... 594
searching with, overview of .................................................. 579
setting up favorite fields for searching .................................. 585
using to search for a course .................................................. 579
using to search for a course date .......................................... 579

Academic Browser Set Course Preferences tool
using to specify room preferences ........................................... 495

Academic Class Meeting Utilization report ........................... 610
academic planning phase, steps in ........................................ 447

Academic reports
generating ................................................................. 601

Academic Class Meeting Utilization .................................. 610

Academic Unit Statistics ................................................. 611
Classroom Utilization ................................................. 610
Course Changes ......................................................... 606, 607
Course List ................................................................. 605

Course Type Analysis ..................................................... 612
Final Exam Schedule ..................................................... 612
Final Exam Settings ....................................................... 612
Hourly Classroom Utilization .......................................... 610
Instructor Back To Back .................................................. 608
Instructor Summary ....................................................... 608
Over/Under Utilization ..................................................... 611
Preferences Summary ..................................................... 607
Prime Time Usage .......................................................... 611
Time Block Room Availability/Usage .................................. 609
Time Block Violations ...................................................... 609
Trend ................................................................. 613
Unmet Preferences .......................................................... 607
academic scheduling configuration process .................................... 445
academic planning phase .................................................. 447
overview of ............................................................... 447
post-publishing phase ..................................................... 447
academic scheduling specific terms
academic unit ............................................................... 446
Campus Planning Interface .............................................. 446
course ................................................................. 446
course date ............................................................... 446
course type ............................................................... 445
cross-listed course ....................................................... 446
domain ................................................................. 445
instructor ................................................................. 445
shared space ............................................................. 446
SIS ................................................................. 445
subject ................................................................. 445
term ................................................................. 445
academic unit defined .................................................... 446
Academic Unit Statistics report ........................................ 611
actions available in the Course Navigator .................................... 597
activities
see booking details
Activity Schedule report ...................................................... 330
adjustment
defined ............................................................... 378
entering for an invoice .................................................. 389
searching for ........................................................... 379
voiding ................................................................. 391
Ageing report .............................................................. 397
Analytics tab on the Dashboard window .................................. 248
Arrivals and Departures report .......................................... 346
Assumptions for the manual ............................................. 25
At A Glance tab on the Dashboard window .................................. 251
At A Glance tab on the Navigator Options dialog box .................. 92
attachment
adding to a group ..................................................... 271
adding to a reservation or booking in the Navigator .................. 184
defined ............................................................... 184, 271
deleting from a reservation or booking in the Navigator .......... 184
editing for a group .................................................... 286
editing for a reservation or booking in the Navigator .............. 184
viewing for a reservation or booking in the Navigator .......... 184
attendance
editing for multiple bookings in the Navigator ....................... 112
recording the actual value for a booking ................................. 413
Attendee Visitor report .................................................. 334
attendees/visitors
adding to an event - see booking
details and items, adding
checking in if registered ........424
checking in when unregistered 427
checking out if registered .......424
checking out when unregistered ............................427
importing a list of for an
event .................................................430
printing badges for ............430
searching for if registered ......424

B
badges
printing for attendees/visitors ..430
Banquet Event Orders report ....333
Benchmark Metric report .......339
billing in EMS
overview of ....................................363
billing information
editing for a group ..........286
billing reference numbers
configuring a list of for a
group ...........................................275
editing for a group ..........286
setting up multiples for a
reservation, booking, and/or
booking detail .........................83
Billing reports
generating .................................394
Ageing ........................................397
Billing Worksheet ..........397
General Ledger Distribution
report ........................................400
Invoice Detail report ..........399
moving to a different reservation in
the Navigator .......................... 127
recording actual attendance
for .............................................. 413
searching for with the
Browser .................................. 197
searching for with the
Calendar .................................... 206
searching for with the Web
Reservation Tool ................. 197
working with comments for in the
Navigator ................................. 175
working with reminders for in the
Navigator ................................. 175
Booking Conflict Analysis
report ....................................... 343
booking detail folder
defined ....................................... 81
structure ............................. 88, 133
booking detail items
adding to multiple bookings in the
Navigator ................................. 155
defined ....................................... 133
deleting for multiple bookings in
the Navigator ............................. 170
deleting multiple bookings in the
Navigator .................................. 161
editing charges for multiple items
in the Navigator ............................. 157
overview of .......................... 133
booking details
allocating the charge for across
multiple billing reference and/or
PO numbers ......................... 83
copying between bookings in the
Navigator ................................. 167
defined ....................................... 43, 88, 133
deleting for multiple bookings in
the Navigator ............................. 173
overview of .......................... 133
booking details and items
adding to individual bookings in the Navigator ................................ 138
adding to multiple bookings in the Navigator .................................. 148
overview of .................................. 133
booking folder
defined ...................................... 81
structure ................................... 86, 133
Booking Notice Statistics report .................................................. 346
bookings
allocating the charge for across multiple billing reference and/or PO numbers .................. 83
copying details between ............ 167
Browser
setting up favorite fields for searching ......................................... 205
using to search for a booking ............................................. 197
using to search for a query ....... 197
using to search for a reservation ....................................... 197
using to search for a resource ........................................... 197
using to search for a service order ....................................... 197
using to search for a web reservation ..................................... 197
browser window
changing the sort order of data in ........................................... 40
context menu for data columns in ......................................... 37
defined ..................................... 35
filtering the data in .................... 38
grouping data by columns in ...... 36
building
setting the default value to use in the Reservation Wizard ........ 403
Building Hours Exceptions report ........................................... 343
Building Hours Exceptions tab on the Dashboard window .......... 247
C
calculations
assigning to a group ............... 273
defined .................................... 273
editing for a group ................. 286
Calendar
setting up favorite fields for searching ......................... 214
using to search for a booking ......................... 206
using to search for a reservation ......................... 206
using to search for a service order ......................... 206
Campus Planning Interface
defined ..................................... 446
Cancellation report ...................... 340
Cancellation Summary report .... 340
categories
see also booking details
defined ....................... 88, 133
repricing for a reservation in the Navigator ..................... 100
catering services
see booking details
charges
allocating for a reservation, booking, or booking detail across multiple billing reference and/or PO numbers .................. 83
editing for multiple booking detail items in the Navigator .... 161
Check In Statistics report ......... 347
Classroom Utilization report ...... 610
column settings
defined ................................... 408
resetting ................................ 408
combination room
appearance of in the Reservation Book ............................ 63
combination room components
appearance of in the Reservation Book ............................ 63
commands in the Navigator .... 89, 94
comment
adding multiple comments to a reservation ................... 179
adding to a group ...................... 269
adding to a reservation, booking, or service order in the Navigator .................. 175
defined ....................... 175, 269
deleting from a reservation, booking, or service order in the Navigator .................. 175
editing for a group ................. 286
deleting for a reservation, booking, or service order in the Navigator .................. 175
viewing the history of for a reservation, booking, or service order in the Navigator .................. 175
confirmation
defined ....................... 307, 420
e-mailing ......................... 414
generating a single confirmation at a time automatically .......... 311
generating a single confirmation at a time manually.........................311
generating multiple confirmations at the same time ......................420
generating using a Word Merge document................................316
specifying the settings for ............................................311
contact
configuring for a group, overview of ....................................287
configuring from a group..................................................278
creating a web user from ..................................................285
defined.................................................................................278
editing for a group..............................................................286
manually configuring for a group.............................................278
searching for .................................................................255
context menu for data columns in a browser window .........37
context menus in the Navigator .........................................95
Conventions used in the manual ........................................23
Copyright .........................................................................3
count information
 editing for a booking in the Navigator.................................163
course
adding .................................................................461
adding a new section to ..............................................461
adding course dates to ................................................461
adding sections to .......................................................461
assigning a room to ......................................................522
assigning shared space to .............................................475
automatic post-publish processing of ................................546
canceling a course date for ............................................461
changing the room (location) for one or more of its bookings ....544
clearing preferences for ................................................581, 584
defined.............................................................................446
defining and editing, overview of ........................................457
defining.................................................................461, 467
defining course dates for .............................................461
excluding from the final exam schedule...............................562
identifying new, modified, or canceled................................482
manually post-publish processing of ................................546
manually updating the location for in the SIS .........................537
post-publishing, overview of..............................................546
reviewing and verifying room preferences for .........................541
searching for a room to assign to ........................................524
searching for with the Academic Browser ..............................579
specifying a final exam schedule for (multiple courses) ..........562
specifying final exam schedule for ......................................562
specifying the room preferences for, caveats .........................491
specifying the room preferences for, overview of ..................487
swapping its room .......................................................522, 545
synchronizing ................................................................453
unassigning the room for .............................................522
undoing the shared space for ............................................479
viewing in the Academic Book ........................................586
Course Changes report ..................................................606, 607
course date
adding to a course ......................................................461
canceling .................................................................461
defined .............................................................................446
defining and editing, overview of ........................................457
defining.................................................................461
searching for with the Academic Browser ..............................579
Course List report .........................................................605
Course Navigator
accessing .......................................................................594
available actions in .........................................................597
overview of .....................................................................594
using to specify room preferences ......................................498
window layout .....................................................................595
course type
defined .............................................................................445
Course Type Analysis report .............................................612
courses
reviewing the shared space designation for ..........................480
cross-listed courses
changing the parent for ..................................................477
defined .............................................................................446
D

Daily reports
generating .................................................................321
Activity Schedule ..........................................................330
Attendee Visitor ............................................................334
Banquet Event Orders .....................................................333
Event Calendar ...............................................................329
Event Schedule ..............................................................329
Production ......................................................................334
Resource Schedule ........................................................333
Room Cards .................................................................330
Service Order Change .....................................................334
Service Order Schedule........... 332
Service Orders................... 332
Dashboard window
Analytics tab ...................... 248
At A Glance tab ................. 251
Building Hours Exceptions
tab.................................. 247
Notifications tab ................. 232
options for ......................... 230
overview of....................... 229
Reconfirm Dates tab ............ 246
Reminders tab .................... 234
Wait List tab ..................... 245
Web Requests tab ............... 241
Web Reservations tab .......... 240
data
changing the sort order of in a
browser window .................... 40
context menu for in a browser
window.................................. 37
filtering in a browser window.... 38
grouping by columns in a browser
window................................. 36
data column
changing the width for in a browser
window................................. 37
data columns
rearranging in a browser
window................................. 36
date
editing for multiple bookings in the
Navigator.............................. 112
Define & Edit mode
disabling for a term ............. 458
enabling for a term............... 458
delegate
defined................................ 263, 283
specifying for a web user (for a
contact)............................... 283
specifying for a web user (for a
group)................................. 263
deposit
defined................................. 378
entering for a reservation....... 385
searching for ....................... 379
voiding................................ 391
discount
applying to a reservation in the
Navigator.............................. 165
display
changing for the Reservation
Book................................. 64
domain
defined................................. 445
drawing
defined................................. 188
deleting from booking in the
Navigator.............................. 188
detaching from a reservation in the
Navigator.............................. 184, 188
editing the description for in the
Navigator.............................. 184, 188
setting the default program for
opening one attached to a booking
in the Navigator...................... 403
Dual mode
defined................................. 457
enabling for a term.............. 458
email
sending from EMS.................. 414
sending to a group from within
EMS.................................. 300
viewing history of............... 418
EMS
main menu............................ 33
starting............................... 29
EMS main window
menu bar............................... 32
structure.............................. 31
title bar............................... 31
toolbar................................. 32
Event Calendar report............ 329
event name
editing for multiple bookings in the
Navigator.............................. 112
setting the default value to use in
the Reservation Wizard............ 403
Event Schedule report .......... 329
event status
setting the default value to use in
the Reservation Wizard............ 403
event time
defined................................. 44
setting the default value to use in
the Reservation Wizard............ 403
event type
setting the default value to use in
the Reservation Wizard............ 403
Event Type Analysis report..... 338
Exceptions reports
generating............................ 321
Booking Conflict Analysis........ 343
Building Hours Exceptions..... 343
Inactive Groups with Reservations .......................... 344
Inactive Room with Bookings .................................. 344
Inactive Web Process Templates .................................. 345
Invalid Billing References ......................................... 345
Invalid Service Orders ............................................. 344
Status Reminder report ............................................. 342
Undefined Setup ..................................................... 342
Wait List .............................................................. 343
Excluded Rooms tab on the Scenario dialog box ................. 509

F

Favorite fields
setting up for a Browser search ................................ 205
setting up for a Calendar search ................................. 214
setting up for a Resource Calendar search ...................... 221
setting up for a Transaction search ............................... 384
setting up for an Academic Browser search .................... 585

Final exam schedule
creating a template for ............................................ 562
defining common exams for ...................................... 562
excluding a course from ........................................... 562
setting ................................................................. 562
setting for a specific course ....................................... 562
setting for multiple courses ....................................... 562
Final Exam Schedule report ...................................... 612
final exam session
publishing .............................................................. 572
Final Exam Settings report ......................................... 612
folder structure
book detail folder ..................................................... 88, 133
booking folder ......................................................... 86, 133
Navigator ............................................................... 81
reservation folder ..................................................... 81

G

General Ledger Distribution report .................................. 400
General tab on the Navigator Options dialog box ................. 90
generic email
defined ................................................................. 414
group
adding a comment to .............................................. 269
adding a reminder to ............................................... 268
adding a user defined field to .................................. 272
adding an attachment to ......................................... 271
assigning calculations to ....................................... 273
assigning to a web user ......................................... 266
checking in to an event ......................................... 437
checking out for an event ..................................... 437
configuring .......................................................... 257
configuring a contact for from another group .................. 278
configuring a list of billing reference numbers for ............ 275
configuring a list of PO numbers for ............................ 276
creating a web user .................................................. 263
defined ................................................................. 255
editing the attachments for .................................... 286
editing the billing reference numbers for ....................... 286
editing the calculations for .................................... 286
editing the comments for ....................................... 286
editing the contacts for ........................................... 286
editing the PO numbers for .................................... 286
editing the reminders for ..................................... 286
editing the user defined fields for ................................ 286
editing the web users for ...................................... 286
editing, overview of ............................................. 286
emailing from EMS ................................................. 414
emailing from within EMS ....................................... 300
exporting a list of to an Excel spreadsheet ......................... 302
importing into your EMS database ............................... 294
making a reservation for using a reservation wizard template ... 295
manually "no showing" for an event ................................ 437
manually configuring a contact for ................................ 278
printing information for ........................................... 301
reassigning the reservations for .................................. 295
searching and making a reservation for ................................ 295
searching for .......................................................... 255
using to search for a reservation .................................. 295
Group Statistics report ............................................. 338
Groups With Multiple Bookings report .......................... 347

H

Highlight tab on the Navigator Options dialog box ................. 93
Hoteling reports
generating .............................................................. 321
Arrivals and Departures ............................................ 346
Booking Notice Statistics ........... 346
Check In Statistics .................. 347
Early Checkout ....................... 346
Groups with Multiple Bookings 347
No Show ............................ 345
Room Occupancy Summary ... 345
Transition ........................... 346
Visitor .............................. 346
Hourly Classroom Utilization report ................. 610
Hourly Resource Inventory Utilization report ....... 338
Hourly Room Utilization report ................... 338

Inactive Groups With Reservations report .......... 344
Inactive Room With Bookings report ................. 344
Inactive Web Process Templates report ............. 345
instructor
defined ................................ 445
Instructor Back to Back report ........ 608
Instructor Summary report .............. 608
Invalid Billing References report ....... 345
Invalid Service Orders report .......... 344
Invoice
emailing ................................ 414
entering an adjustment for .......... 389
generating ............................. 364
generating, overview of .......... 364
reprinting ............................ 368
voiding ................................ 372
Invoice Detail report ................. 399

location
see room
locked booking
defined .............................. 109
insufficient security ................. 109
invoiced booking ................... 109
old booking ......................... 109

Main menu
structure ................................ 33
Manage Terms Copy Preferences tool
using to specify room preferences 493
memorized report
creating by copying ................. 323
creating from scratch ............... 323
defined .............................. 323
deleting .............................. 323
editing .............................. 323
menu bar for the EMS main window ..................... 32

Navigator
accessing the Course Navigator from .......... 594
adding a booking to a reservation in .......... 97
adding booking detail items to
multiple bookings in ............... 155
adding booking details and items
to individual bookings in .......... 138
adding bookings to a reservation in .......... 97
applying a discount to a reservation in .......... 165
commands ......................... 89, 94
commands available on a context menu ................ 95
copying a reservation in .......... 106
copying multiple bookings in ........ 170
deleting booking detail items for
multiple bookings in ............... 173
deleting booking details for
multiple bookings in ............... 173
ingoing a booking in, overview of ................ 109
ingoing a reservation in .......... 98
ingoing a single booking in ........ 110
ingoing booking detail items for
individual bookings in ............ 157
ingoing count information for a
booking in ......................... 163
ingoing miscellaneous information
for multiple bookings in .......... 112
ingoing multiple bookings in .... 112
ingoing the charges for multiple
booking detail item in ............. 161
ingoing the date and/or time for
multiple bookings in ............. 112
ingoing the room for multiple
bookings in ......................... 112
ingoing the status for multiple
bookings in ....................... 102, 112
folder structure ...................... 81
layout of ............................ 81
manually opening a reservation in .................... 79
moving bookings to a different
reservation in ..................... 127

EMS User’s Manual

619
overview of .................................. 79
repricing categories and room charges for a reservation in .... 100
working with attachments in .... 184
working with comments in ...... 175
working with reminders in .... 175
working with user defined fields in ............................................. 181

Navigator Options dialog box...... 90
At A Glance tab..................... 92
General tab.......................... 90
Highlight tab.......................... 93
No Show report...................... 345
notes
see booking details
Notifications tab on the Dashboard window............................. 232

O
optimization logic .................... 509
optimization process
stages of .................................. 506
optimization scenario
creating ...................... 516
defined .................................. 506
evaluating ...................... 527
Organization of the manual...... 25
other information
editing for a group.............. 286
Other reports
generating ...................... 321
Cancellation ...................... 340
Cancellation report .............. 340
Reservation Summary ............ 341
Over/Under Utilization report .... 611
override room
defined .......................... 55

P
parent
changing for shared space/cross-listed courses .................. 477
password
changing .............................. 406
payment
defined .................................. 378
entering ...................... 387
searching for ...................... 379
voiding .............................. 391
phases in the academic scheduling configuring process .......... 447
PO numbers
configuring a list of for a group 276
editing for a group ................. 286
setting up multiples for a reservation, booking, and/or booking detail ................. 83
post-publish processing of courses automatically .............. 546
post-publish processing of courses manually .................. 546
post-publishing phase
steps in ...................... 447
post-publishing phase, steps in 447
pre-assignment scenario
creating ...................... 513
defined .................................. 506
preferences
clearing for a course...... 581, 584
Preferences Summary report .... 607
Prime Time Usage report ........ 611
Production report .................. 334
Q
query
creating ...................... 348
deleting ...................... 357
editing ...................... 357
printing ...................... 358
running ...................... 359
searching for with the Browser 197
searching for with the Web Reservation Tool .................. 197
viewing ...................... 358
R
Reconfirm Dates tab on the Dashboard window............... 246
refund
defined ...................... 378
entering ...................... 390
searching for ...................... 379
voiding ...................... 391
reminder
adding multiple reminders to a reservation .................. 179
adding to a group .................. 268
adding to a reservation, booking, or service order in the Navigator .................. 175
defined ...................... 268
deleting from a reservation, booking, or service order in the Navigator .................. 175
editing for a group .................. 286
editing a reservation, booking, or service order in the Navigator .................................. 175
viewing the history of a reservation, booking, or service order in the Navigator ........ 175
working with on the Dashboard window ................................................................. 234
reminder (attached) defined .............................................................. 175, 236
reminder (unattached) defined ........................................................................ 236
Reminders tab on the Dashboard window ............................................................... 234
reports generating ................................................................. 321
reservation adding a booking to in the Navigator .............................................. 97
adding an attachment to in the Navigator ......................................................... 184
adding bookings to in the Navigator ................................................................. 97
adding multiple comments to ................................................................... 179
adding multiple reminders to ................................................................... 179
allocating the charge for across multiple billing reference and/or PO numbers .............. 83
applying a discount to in the Navigator ......................................................... 165
attaching a drawing to in the Navigator ......................................................... 184, 188
detaching a drawing from in the Navigator ..................................................... 184, 188
determining if resources for are in conflict ...................................................... 192
editing a drawing for in the Navigator ......................................................... 184, 188
editing an attachment for in the Navigator ..................................................... 184
ing the Navigator .............................................................. 98
editing in the Reservation Book ................................................................. 74
entering a deposit for ........................................................................ 385
making a for a group after searching for the group ................................ 295
making for a group using a reservation wizard template .................................. 295
making in the Reservation Book ................................................................... 74
making using the Reservation Wizard .......................................................... 45
opening manually in the Navigator ............................................................... 79
reassigning to a group ........................................................................ 295
repricing categories and room charges for in the Navigator ................................ 100
searching for by group ........................................................................ 295
searching for with the Browser ..................................................................... 197
searching for with the Calendar .................................................................... 206
searching for with the Web Reservation Tool ............................................... 197
structure ................................................................................................. 43
viewing in the Reservation Book .................................................................... 70
working with comments for in the Navigator ................................................ 175
working with reminders for in the Navigator ................................................ 175
reserved time defined ........................................................................ 44
resource see also booking detail items defined ............................................. 133
determining if in conflict for a reservation ....................................................... 192
searching for with the Browser ................................................................. 197
searching for with the Resource Calendar ...................................................... 215
searching for with the Service Order Management browser ... 222
searching for with the Web Reservation Tool ............... 197

Resource Calendar

setting up favorite fields for searching ......................... 221
using to search for a resource ............................. 215

Resource Schedule report ............. 333

Resource Statistics report .............. 338

Resource Utility Conflicts tool

overview of ........................................... 192
running to determine if resources for a reservation are in conflict ............................... 192

room

assigning to a course ................................. 522
changing for a course booking ....................... 544
editing for multiple bookings in the Navigator ........... 112
options for resolving assignments, overview of .......... 522

searching for to assign to a course ....................... 524
searching for with the Search for Rooms tool ........... 598

swapping between courses .......... 522, 545
swapping with another booking in the Reservation Book ............. 75
unassigning for a course ............................. 522

room assignments and optimization, overview of .................. 505

Room Availability report ............. 339

room capacity violation

defined ............................................... 555

Room Cards report ......................... 330

room charges

see also booking details

repricing for a reservation in the

Navigator ............................................. 100

Room Occupancy Summary report ............. 345

room preferences

caveats for specifying for a course 491

clearing all ...................................... 579
reviewing and verifying for a course ....................... 501

specifying for a course, overview of ....................... 487

specifying using the Academic Browser Set Course Preferences tool ......................... 495

specifying using the Course Navigator ......................... 498

specifying using the Manage Copy Preferences tool ......................... 493

Room Statistics report ............. 337

Room Utilization report ............. 337

Sales by Billing Reference report ........................................ 335

Sales by Booking report ................. 336

Sales by Category report ................. 335

Sales by Group report ................. 335

Sales by Group Type report ................. 334

Sales by Reservation report ................. 335

Sales by Resources report ................. 335

Sales reports

generating ........................................ 321

Sales by Billing Reference ................. 335

Sales by Booking ................................ 336

Sales by Category ................................ 335

Sales by Group ................................ 335

Sales by Group Type ......................... 334

Service Order Change report ............. 334

Sales by Reservation ................. 335

Sales by Resources ................. 335

Status Changes by Booking ................. 336

Status Changes by Reservation ................. 336

scenario
defined ........................................... 506

optimization, defined ................. 506

pre-assignment versus optimization, overview of ........... 513

pre-assignment, defined ................. 506

Scenario dialog box

Excluded Rooms tab ......................... 509

Scenario tab ....................................... 507

Scenario tab on the Scenario dialog box ....................... 507

Search for Rooms tool

using to search for rooms ................. 598

seat fill percentage
defined ............................................... 471, 492

Seat Occupancy report ................. 339

section

adding to a course ....................... 461

service order
defined ........................................... 136

searching for with the Browser ............... 197

searching for with the Calendar ............... 206

searching for with the Web Reservation Tool ............... 197

working with comments for in the Navigator ............... 175

working with reminders for in the Navigator ............... 175

working with the user defined fields for in the Navigator ............... 181

Service Order Change report ............. 334
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Order Management browser using to search for resources</td>
<td>222</td>
</tr>
<tr>
<td>Service Order Schedule report</td>
<td>332</td>
</tr>
<tr>
<td>Service Orders report</td>
<td>332</td>
</tr>
<tr>
<td>settings specifying for a confirmation</td>
<td>308</td>
</tr>
<tr>
<td>setup count editing for multiple bookings in the Navigator</td>
<td>112</td>
</tr>
<tr>
<td>Setup Count Analysis report</td>
<td>339</td>
</tr>
<tr>
<td>setup hours defined</td>
<td>44</td>
</tr>
<tr>
<td>setup type editing for multiple bookings in the Navigator</td>
<td>112</td>
</tr>
<tr>
<td>Setup Worksheet report Daily reports Setup Worksheet</td>
<td>331</td>
</tr>
<tr>
<td>shared space assigning to courses</td>
<td>475</td>
</tr>
<tr>
<td>changing the parent for</td>
<td>477</td>
</tr>
<tr>
<td>defined</td>
<td>446</td>
</tr>
<tr>
<td>reviewing for courses</td>
<td>480</td>
</tr>
<tr>
<td>undoing for courses</td>
<td>479</td>
</tr>
<tr>
<td>SIS defined</td>
<td>445</td>
</tr>
<tr>
<td>manually updating course locations in</td>
<td>537</td>
</tr>
<tr>
<td>sort order changing for data in a browser window</td>
<td>40</td>
</tr>
<tr>
<td>Special information about the manual</td>
<td>23</td>
</tr>
<tr>
<td>Statements report</td>
<td>398</td>
</tr>
<tr>
<td>Statistics reports generating</td>
<td>321</td>
</tr>
<tr>
<td>Benchmark Metrics</td>
<td>339</td>
</tr>
<tr>
<td>Event Type Analysis</td>
<td>338</td>
</tr>
<tr>
<td>Group Statistics</td>
<td>338</td>
</tr>
<tr>
<td>Hourly Resource Inventory Utilization report</td>
<td>338</td>
</tr>
<tr>
<td>Hourly Room Utilization</td>
<td>338</td>
</tr>
<tr>
<td>Reservation Source Analysis</td>
<td>338</td>
</tr>
<tr>
<td>Resource Statistics</td>
<td>338</td>
</tr>
<tr>
<td>Room Availability</td>
<td>339</td>
</tr>
<tr>
<td>Room Statistics</td>
<td>337</td>
</tr>
<tr>
<td>Room Utilization</td>
<td>337</td>
</tr>
<tr>
<td>Seat Occupancy</td>
<td>339</td>
</tr>
<tr>
<td>Setup Count Analysis report</td>
<td>339</td>
</tr>
<tr>
<td>status changing for a reservation in the Reservation Book</td>
<td>75</td>
</tr>
<tr>
<td>editing for multiple bookings in the Navigator</td>
<td>112</td>
</tr>
<tr>
<td>Status Changes by Booking report</td>
<td>336</td>
</tr>
<tr>
<td>Status Changes by Reservation report</td>
<td>336</td>
</tr>
<tr>
<td>Status Reminder report</td>
<td>342</td>
</tr>
<tr>
<td>structure EMS main menu</td>
<td>33</td>
</tr>
<tr>
<td>EMS main window</td>
<td>31</td>
</tr>
<tr>
<td>Student Information System see SIS</td>
<td></td>
</tr>
<tr>
<td>subject defined</td>
<td>445</td>
</tr>
<tr>
<td>summary information editing for a group</td>
<td>286</td>
</tr>
<tr>
<td>teardown hours defined</td>
<td>44</td>
</tr>
<tr>
<td>term defined</td>
<td>445</td>
</tr>
<tr>
<td>disabling for Define &amp; Edit Mode</td>
<td>458</td>
</tr>
<tr>
<td>disabling for Set Preferences mode</td>
<td>488</td>
</tr>
<tr>
<td>enabling for Define &amp; Edit Mode</td>
<td>458</td>
</tr>
<tr>
<td>enabling for Dual mode</td>
<td>458</td>
</tr>
<tr>
<td>enabling for Set Preferences mode</td>
<td>488</td>
</tr>
<tr>
<td>importing, overview of</td>
<td>451</td>
</tr>
<tr>
<td>publishing</td>
<td>533</td>
</tr>
<tr>
<td>scheduling final exams for</td>
<td>562</td>
</tr>
<tr>
<td>time editing for multiple bookings in the Navigator</td>
<td>112</td>
</tr>
<tr>
<td>Time Block Room Availability/Usage report</td>
<td>609</td>
</tr>
<tr>
<td>Time Block Violations report</td>
<td>609</td>
</tr>
<tr>
<td>time designators used for an EMS event</td>
<td></td>
</tr>
<tr>
<td>reserved time</td>
<td>44</td>
</tr>
<tr>
<td>setup hours</td>
<td>44</td>
</tr>
<tr>
<td>teardown hours</td>
<td>44</td>
</tr>
<tr>
<td>time zone setting the default value to use in the Reservation Wizard</td>
<td>23</td>
</tr>
<tr>
<td>title bar for the EMS main window</td>
<td>31</td>
</tr>
</tbody>
</table>
toolbar
  customizing ............................................... 32
  for the EM main window .................................... 32
transaction
  see deposit, payment, adjustment, or refund
Transaction report ........................................... 399
transaction search
  setting up favorite fields for searching................ 384
Transition report ............................................ 346
Trend report .................................................... 613

U
UDF
  see user defined fields
Undefined Setsups report ................................. 342
Unmet Preferences report ................................. 607
Update Pricing Plan Wizard
  using to reprice categories and room charges for a reservation in the Navigator.................. 100
user defined field
  adding to a group ........................................... 272
  adding to a reservation or service order in the Navigator ............................................. 181
defined ......................................................... 181, 272
deleting for a reservation or service order in the Navigator ............................................. 181
editing for a group ........................................... 286
editing for a reservation or service order in the Navigator ............................................. 181
viewing the history of for a reservation or service order in the Navigator............................. 181
user preferences
  defined ........................................................ 403

W
Wait List report ................................................. 343
Wait List tab on the Dashboard window ..................... 245
web delegate
  printing a list of for web users ......................... 303
web requests
  working with on the Dashboard window .................. 241
Web Requests tab on the Dashboard window ................ 241
web reservation
  searching for with the Browser ................................ 197
  searching for with the Web Reservation Tool ............ 197
Web Reservation Tool
  using to search for a booking ......................... 197
  using to search for a query ............................ 197
  using to search for a reservation ..................... 197
  using to search for a resource ......................... 197
  using to search for a service order ..................... 197
  using to search for a web reservation .................. 197
Web Reservations tab on the Dashboard window ............ 240
web user
  assigning a group to ....................................... 266
  creating from a contact .................................. 283
  creating from a group ..................................... 263
defined ......................................................... 263, 283
  editing for a group ......................................... 286
  exporting a list of to an Excel spreadsheet ............... 303
  printing a list of delegates for .......................... 303
  specifying a delegate for (for a contact) ................. 283
  specifying a delegate for (for a group) .................... 263
width
  changing for a data column in a browser window .......... 37
window layout
  Course Navigator ........................................... 595
windows coordinates
  defined ........................................................ 407
  resetting ...................................................... 407
Word documents
  integrating with EMS ....................................... 316
Word Merge document
  defined ........................................................ 316
  using to generate a confirmation ......................... 316